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Introduction

What Is GRADE?

GRADE is the acronym for Graphical Re-engineering Analysis & Design Environment.

This comprehensive technology, which encompasses a PC-based GRADE modeling and 
simulation tool, is

• a technique for representing complex sociotechnological systems in the form of models 
(“blueprints”)

• a graphical language making it possible to use these models to simulate and dynamically 
analyze a current or planned system.

More specifically, GRADE is implemented to create models of business processes, structures and 
information in order to clarify the complex interactions and interrelationships among 
organizations, people and technology. When GRADE is used for simulation, it lets you collect 
statistics about your current or planned sociotechnological system to let you analyze and 
optimize the use of time, money and resources.

In the GRADE philosophy, the term “sociotechnological system” is used to describe a part of 
the real world, usually a business enterprise or some part of it; it typically consists of people, 
computers, communications, etc., unified in an effort to achieve a common goal. Thus, a 
GRADE model of a system can contain the following elements:

• the business processes of an enterprise,

• its organizational structure,

• the tasks and competencies of all involved individuals and organizational units,

• the “ownership” of resources and data,

• events, task sequences, interfaces, flows of materials and information,

• and much more.

The model can be used to effectively plan and communicate planned changes to different 
audiences (managers, IT professionals, users, etc.).
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Why Use GRADE?

Because of the complex interdependencies in today’s sociotechnological systems, it is impossible 
to fully comprehend them without the aid of a system model that is clear, consistent and as 
complete as necessary for the task at hand. Just as no architect would dream of building a 
skyscraper without a blueprint, it is logical that the design or redesign of any complex business, 
organization or IT system also calls for a graphical model in which the structure, processes and 
communications can be examined and understood by all affected. Without such a blueprint, 
attempts to structure or develop a system often result in a waste of time, money and effort.

Usually, such blueprints are not created, simply for the lack of an adequate methodology. As a 
result, over 50% of major systems or re-engineering projects fail or fall short of meeting their 
objectives, because there is no clear understanding of the “as is” and “to be” situation. 
Application of the GRADE modeling technology can eliminate this problem by providing an 
overview of the system and making the complexity manageable; it will not guarantee that your 
project will succeed, but will substantially increase that probability.

Similar re-engineering tools let you model individual aspects of a system, but not the total 
system in an integrated manner, as GRADE does by combining all relevant system aspects 
within a single model. And similar re-engineering tools lack the GRADE graphical language, 
with its defined syntax and semantics, which makes the simulation of a system, and statistics 
gathering, possible. 

Simulation lets you carry out the following tasks:

• Analyze your model to make certain it is consistent;

• “Run” your model step-by-step or for a given length of model time, with the option of 
pausing at arbitrary times or at predefined breakpoints;

• Inspect tasks, performers, etc., at the end of any simulation session or during any pause (e.g., 
you can check how often a given task has been performed);

• Change a set of values in a model (e.g., change the hourly wages of employees and the 
durations of tasks), then restart the simulation with the new values;

• Gather maximum, minimum, average and total statistics, such as the time it takes for a task 
to be completed, the cost of task execution, the time that a task is delayed because no 
performer is available to execute it, and the percentage of time that a performer is utilized or 
idle;

• View the generated statistics in the form of a table or chart, and export these charts and tables 
to Microsoft Excel for further analysis;

• Record a trace to learn more about the model’s behavior.

GRADE also provides an animation feature, which lets you view the operation of your system 
“live” on your computer screen. You can see which tasks are active and how events flow through 
the system.
 



In addition, you can turn your model into an audiovisual presentation: First, record a series of 
texts, each of which is associated with a given part of the model. Then activate Play, and sit back 
and listen to your model talk!

GRADE models can be printed out or plotted as black-and-white or color diagrams; you can 
even print out models several meters in length or create posters for use in business presentations. 
Thanks to a new feature of GRADE, you can use GIF (Graphics Interchange Format) pictures in 
your diagrams. That means you can “jazz up” your models with screen shots and photographs. In 
addition, you can export your diagrams in HTML format to share the information with others 
via Internet/intranet. GRADE also lets you insert external links in your diagrams: by double-
clicking the external-link icon, you can open a corresponding Web site, Word document, audio 
or video file, or start an executable program. External links can be used both during GRADE 
work sessions and after the diagram has been exported to HTML.

You can work with GRADE individually or have an entire team work on different parts of a 
GRADE model; their efforts can then be merged.

If you decide to create object models using class and package diagrams (see Page 121), other 
special features are available:

• You can create models in Unified Modeling Language (UML) notation. UML has become 
the de facto industry standard for software-system modeling. 

• You can export your diagrams to Rational Rose, a UML modeling tool. Take advantage of 
GRADE’s more sophisticated capabilities for modeling extremely large diagrams, then export 
to Rational Rose for source-code generation.

You also may want to make use of the GRADE Registrator, which is included in the GRADE 
Modeler package as a complementary tool. The Registrator is particularly useful in the early 
stages of modeling, when gathering facts about the system. You can use the Registrator to start 
modeling from the “bottom up,” simply entering data without specifying a hierarchy; this type 
of data gathering can be compared to filling out a set of registration cards. In a step-by-step 
process, you can incorporate the various relationships among the registered objects, thus 
completing your Registrator model. This model can be analyzed for completeness and 
consistency and simulated. In addition, Registrator models can be transferred in export/import 
(EI) format for further use in the GRADE Modeler. The Registrator is particularly useful for 
modeling information-processing systems. For more information, see the Registrator Guide.

To Summarize: What Can GRADE Do For You?

GRADE can reduce the time, cost and risk of any major re-engineering project.

GRADE can significantly increase the probability of meeting cost and schedule targets of major 
projects.
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GRADE can give you a competitive advantage by permitting you to approach major projects 
with “blueprints,” as in the mature engineering disciplines, thus distinguishing you from most 
other service providers.

What Is the GRADE Language?

The GRADE language is a set of graphical elements, or building blocks, used to create 
business/organizational/system models with all the elements described above. As noted, these 
graphical elements have a defined syntax and semantics.

The basic building blocks of this system are described in the following chapters of this manual; 
for a history of the GRADE language, see the Introduction to the Language Reference Guide.

About these Manuals

What Is Covered?

The manual you are reading is the first in a set of four volumes: 

• User Guide

• Language Guide

• Language Reference

• Simulation Guide.

This User Guide shows you how to start working with GRADE and how to create GRADE 
diagrams representing organizational structures, business processes, etc. Some of the more 
advanced features of GRADE are not discussed here. If you have questions about them, consult 
the additional manuals or the online helps.

The Language Guide explains some aspects of business modeling in more detail: You will learn 
more about describing tasks and their triggering conditions, how to illustrate data flows, and so 
on. You will also read about the step-by-step use of GRADE in real-life situations. 

The Language Reference deals, as the name implies, with the GRADE language. Here, you will 
find the notational conventions used, for example, to specify times (the hours an employee is 
available, the duration of a task). You will also read about the parameters that can be changed 
for simulation purposes and the variables used for statistics gathering. 
 



The last of these four handbooks is the Simulation Guide. Once you are familiar with the 
underlying principles of GRADE, this manual can be very useful as a tutorial for learning about 
the more advanced GRADE functions. It takes you through an example in which you view a 
business model “in action” with the help of animation, then use the simulation function to 
operate the system while generating performance statistics.

Which of these Manuals Should I Read?

If you simply want to become familiar with GRADE’s modeling function and learn how to 
generate models, read this User Guide. It provides an overview of GRADE’s three major 
approaches to modeling: via business models, object models and system models.

If you additionally want to learn about GRADE’s simulation, animation and statistics-gathering 
features, read the Simulation Guide.

If your goal is to produce a detailed GRADE model with advanced simulation and statistics-
gathering, you may need to consult the Language Guide, Language Reference and Simulation 
Guide in addition to this User Guide.

Conventions Used in this Manual

Two symbols are used in this manual to point out special types of information:

�
For more information about supplementary GRADE handbooks, covering specialized topics, please 
contact INFOLOGISTIK GmbH.

This manual contains a Glossary on Page 443. It provides a quick reference to GRADE 
terminology.

�
This indicates a helpful hint.

This draws your attention to important information, such as warnings.
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Various Ways of Executing Commands

In GRADE, there are often various possibilities for executing the same command. For example, 
you can save your work by using the Ctrl+S key combination, by activating the Save menu 
command or by clicking the Save active diagram icon:

Rather than mentioning all these possibilities every time, we will mention various possibilities 
on first reference, and usually note only one possibility in later references.

Target Readership

This manual is intended for first-time users of GRADE, as well as for those who merely wish to 
get acquainted with the tool. Readers may include managers, entrepreneurs, information 
technology specialists, software engineers, etc. Though the ability to work with a PC is assumed, 
no knowledge of computer programming or other such skills is required. 
 



How Do I Install GRADE?

This section explains how to install the single-user version of GRADE. If you plan to install the 
multi-user version, or have any other questions about installation, please consult the Installation 
Guide.

Recommended System Configuration

Before installing GRADE, make sure the following hard- and software requirements are 
fulfilled.

If you are an experienced computer user who plans to make full use of GRADE’s features, you 
will need the following:

• A personal computer, Pentium class or better

• 32 MB RAM (recommended)

• 30 MB free hard-disk space

• A high-resolution monitor

• Windows 95, Windows 98, Windows NT 4.0, or Windows 2000 operating system; 
Windows 3.1 or Windows for Workgroups 3.11 can be used if you do not plan to record/play 
back presentations, nor export diagrams to Rational Rose.

• A sound card, speakers (or headphones) and microphone (required only if you wish to record 
and play back presentations, i.e., “talking” models).

If you are a beginner, a 486-class PC with 16 MB RAM can serve quite adequately.

Licensing

INFOLOGISTIK GmbH uses license numbers to discourage illegal distribution of the 
GRADE software. Together with the GRADE CD you received one license number, which 
must be entered during the installation of GRADE. This number can be found on your software 
license. (Do not confuse the license number with the serial number, which must not be entered 
during installation.)

Step-by-Step Installation Instructions

Installation on Windows 95, Windows 98, Windows NT 4.0, Windows 2000

1 Start your computer.

2 Insert the GRADE CD in your CD drive.
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3 The installation starts automatically and a welcome window appears. (If no welcome 
appears, it probably means you have disabled the autorun feature. In that case, select Run 
from the taskbar Start menu, then type X:\GRADE\SETUP.EXE, where X represents the 
CD drive letter, and press the Enter key.)

4 Read the Welcome window and click Next.

5 Read the Information window. A warning will appear regarding the conversion of models 
created in a previous version of GRADE.

6 If you want to continue with the installation at this time, click Next.

7 When prompted, enter your name, company and license number (not the serial 
number!) exactly as they appear on your software license. Note that the license number 
is case sensitive. After entering the complete license number, click Next.

8 Once the system has accepted your entered license number, a dialog will appear 
requesting the destination directory for the installation. The default destination, 
C:\GRADE4, is entered automatically. (If necessary, you can change the destination: 
click Browse..., enter the new directory, click OK.) Then click Next.

9 The installation is started. At the end of the installation, you will be prompted to click 
Finish. When you do this, the About GRADE window appears. Click OK.

10The Readme file appears. Take a look at it, then close the window.

If GRADE Version 2.0 or 3.0 was previously installed, we recommend that you convert all 
GRADE Modeler models that you wish to keep to export/import format (EIF) prior to installing 
GRADE V.4.0. (Although it is possible to use an earlier version of GRADE and the new version 
of GRADE alternately, problems may arise if you try to use one version of GRADE to open a 
model created in another version.)

If you do convert the models, the EIF files of each model should be stored in a separate directory. 
For more information about this, see “Exporting and Importing Diagrams, Models in 
Export/Import Format” on Page 421. If you want to convert the models at this point, click Cancel 
to interrupt the installation.

Also note that you should not try to install GRADE 4.0 over GRADE 2.0 or 3.0 in the same 
directory.

�
Do not install GRADE in Program_Files or in any other directory in which the directory names 
exceed eight characters or include blanks.
 



11SETUP presents start-up icons for the individual modules of GRADE. If you wish, you 
can drag any of these icons to your desktop, then right-click your mouse and select Copy 
here. Close the GRADE Family window. (If you created the start-up icon, you can start 
GRADE by simply double-clicking it.)

Installation on Windows 3.1, Windows for Workgroups 3.11

Proceed as follows:

1 Start your computer.

2 Insert the GRADE CD in your CD drive.

3 In the Windows Program Manager, open the File menu, then activate Run. A dialog box 
will open.

4 In the Command Line field enter X:\GRADE\SETUP.EXE (where X represents the CD 
drive letter) and click OK.

5 For the rest of the installation, follow Steps 4-11, above.

6 Then read the following information on system configuration, and take any necessary 
steps.

After completing the SETUP program, ensure that your CONFIG.SYS file has been correctly 
configured and that the command line

FILES = 120

(or more) is included.

For Windows 3.X users, the Enhanced Mode of Windows should be selected for use with 
GRADE. In most cases, this is the default operations mode of Windows.

Furthermore, write caching should be enabled on all drives upon which a GRADE repository 
will reside. The recommended cache size in Windows depends upon the amount of memory 
(RAM) in the computer. The cache size should be 1.6 MB with 8 MB of memory, or 2 MB with 
16 MB of memory.

GRADE’s performance is also affected by the Virtual Memory settings in Windows 3.X. The 
following settings are recommended:

• The Windows swap file should be of the permanent type, and should be the same size as the 
system memory (RAM).

GRADE repositories should not be stored on drives that have been compressed in any manner 
(STACKER, DBLSPACE, etc.), as this will negatively affect the program’s performance.
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• 32-bit disk access should be activated.

• If you are using Windows for Workgroups 3.11, 32-bit file access also should be activated.

After making any changes to the configuration, you must restart your computer.

Installing Updates

From time to time, INFOLOGISTIK GmbH offers GRADE updates. Typically, these include 
new GRADE features, but occasionally they may be issued to correct minor bugs.

You can download updates from the INFOLOGISTIK Web site, www.infologistik.com. 
Instructions for installing the update can be found at the Web site and in the corresponding 
README file.

When installing an update of the GRADE Modeler 4.0, do not uninstall the previous release of 
GRADE 4.0. Rather, install your update over it (in the same folder). Your previous models will 
be “inherited by” the newer release of GRADE.

If you are using Windows 3.1, the SHARE.EXE command should be included in the 
AUTOEXEC.BAT file.

�
Models created with a previous release of GRADE 4.0 are upwardly compatible with newer releases 
of GRADE 4.0. That means you can use a newer release of GRADE 4.0 to open a model created 
with an earlier release; the model is then converted for use with the new release and generally cannot 
be opened with a previous release.
 



How Do I Uninstall GRADE?

To uninstall GRADE, proceed as follows:

1 Hold down your left mouse button on the Start menu, then select Programs, then the 
GRADE folder, then Uninstall GRADE.

2 Follow the instructions on the screen.

�
If you wish to keep any of the models created with the GRADE application that is to be uninstalled, 
export them in EI format before uninstallation (later, you can import these models into the new 
GRADE application).

If you receive an error message about a missing .dll, simply click Close. The uninstallation process 
will proceed normally.

Make sure you delete the GRADE folder (by default, c:\Grade4) at the end of the uninstall process.
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Chapter 1
How to Start Modeling

1.1 Preliminary Considerations

When we refer to GRADE modeling, we are talking about using graphical elements to represent 
a system. These graphical elements appear in standardized diagrams, which are created in 
accordance with GRADE principles. These diagrams are usually in “picture” format, i.e., 
containing box symbols and connectors, but may be in tabular form.

Diagram Types: Deciding Which to Use

GRADE offers three basic ways of representing systems: via business modeling, object modeling 
and system modeling. If you wish, you can combine two or three modeling types in a single 
model to represent different aspects of your system.

Below, you will find information about the various model types and the diagrams associated 
with them.

Business modeling is the most popular approach. The fundamental business-modeling diagrams 
are the following:

• Organizational (ORG) diagrams. If you own a taxi business, your organizational diagram 
might include an administrative department (with office equipment), a group of dispatchers 
(with telephones) and a group of drivers (with taxis).

• Business process (BP) diagrams, which are similar to flowcharts. For a taxi business, a typical 
business process would be the handling of customer calls. This BP diagram might start with 
a customer calling the taxi service and end with a driver collecting the fare. For each task, you 
define a performer (e.g., the driver) from the ORG diagram, as well as other task details. This 
information will automatically appear again in a task details diagram (TD). Similarly, as you 
connect the symbols in your BP diagram with lines representing events (e.g., customer call 
comes in), most of these will automatically appear in an event table (ET).

In some cases, you might decide to use a different modeling type:

• Object modeling uses class (CL) diagrams to describe the static structure of a system by 
reflecting relationships between organizational units, individuals, resources, data, etc. In 
some cases, this type of model may be all you need to describe your system. In other cases, 
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you may want to use this model to help you organize your thoughts and create a first-draft 
model; the CL diagram can then be exported to a business model. Object modeling makes 
use of the Unified Modeling Language (UML), which has become the industry’s de facto 
standard for software-system development.

• System modeling uses communicating object (CO) and other diagrams to describe systems 
in terms of active objects (like departments that do work), processes (the work that is done), 
and passive objects (objects that are produced, sent, received, etc., by the active objects). If 
your focus is on a complete and detailed description of the system’s components, system 
modeling may be the option for you. You also may choose to start with a business model and 
have GRADE convert it to a system model to give you a different view.

• Component modeling uses package (PCK), BP, CL, data definition (DD) and other types 
of diagrams to describe systems in terms of business components. A component model 
typically depicts applications (e.g., Online Banking), business processes (typically, processes 
initiated by a customer online, such as Apply for Loan) and data structures (e.g., Loan 
Application Form). Component modeling is a technique for component-based development 
of systems and high-level design specification.

This manual provides an introduction to all these modeling types. Business modeling with 
ORG and BP diagrams is covered in Chapters 2 and 3; object modeling is described in Chapters 
4, 5 and 6; system modeling is the subject of Chapter 7; and component modeling is briefly 
discussed in Chapter 8.

Assumptions Made

Before you start, take note of the two assumptions we have made:

• You are using the single-user version of GRADE and the GRADE-M (Modeler) 
configuration.

• You are working in a Windows 95, Windows 98, Windows NT 4.0 or Windows 2000 
environment.

For those using Windows 3.X, the functionality described in this document remains valid, but 
some figures will appear slightly different.

If you have obtained a different configuration of GRADE than GRADE-M, everything remains 
valid, but your configuration will offer additional features not described here.

�
For a quick reference to the diagrams used in each type of modeling, consult “Appendix A: Overview 
of GRADE Diagrams” on Page 437.
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How this Manual Can Help You

Now you are just about ready to begin modeling. This chapter shows you how to start GRADE 
and create a new model. In subsequent chapters, you will learn how to work with the various 
types of models.

1.2 Your First Steps After Installing GRADE

You may have noticed during installation that there is no need for special option settings; only 
the target directory must be chosen. The examples in this manual assume that the default 
directory is being used.

For users who are accustomed to shortcuts on the Windows desktop, one additional step is 
highly recommended. After the GRADE installation is complete, the following icons remain on 
the screen:

Figure 1-1: Icons seen following GRADE installation

If you have not already done so, copy the shortcut to the GRADE Modeler

to your desktop.

If you forgot to take this step after installation, you can carry out this task later (see Section 
“More on Shortcuts and Repositories” on Page 29).

Make sure you copy the icon, rather than move it. For example, drag the icon via the right mouse 
button and then select Copy Here from the pop-up menu.
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1.3 Starting a GRADE Session

You can start GRADE in any of the following ways:

• If you have the GRADE shortcut

on your desktop, double-click it.

• If you do not have the GRADE shortcut, click the Start button at the bottom of your screen, 
then select Programs, GRADE Family and Modeler.

• Run the application bambapp.exe from the Run dialog.

When GRADE starts, it opens its main window, and possibly additional windows. GRADE 
displays the screen as it was when you last exited; in other words, it remembers the settings from 
your previous session.

If you are starting GRADE for the first time, you can use your Windows Explorer or File 
Manager to take a look in the default GRADE directory, C:\Grade4. Here, you will see that 
during installation a directory named Reposit has been created. This is a repository, or storage 
site, for models. If GRADE has just been installed, this directory should contains six sample 
Chapter 1 



models: My1st Model, Athletic, Automatic Teller Machine, Check In, Order and OrderToBe. These 
examples will also appear in the REPOSITORY window when you open GRADE for the first 
time:

Figure 1-2: REPOSITORY window

By double-clicking the icons (rectangles) to the left of the names, you can open any of these 
models and explore the diagrams they contain.

In some cases, you may start GRADE and see only an empty field: 

Figure 1-3: The main window of GRADE
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The only action you can perform here is to open a repository (or create a new repository; see 
“How Do I Create a Repository?” on Page 431). To open a repository, click the Open repository 
button:

Or select Repository/Open repository from the menu. The Open Repository dialog box appears:

Figure 1-4: Open Repository dialog box

Immediately after installation only one repository should be present, so simply click OK (or 
double-click the repository name). If more than one repository is available, as seen in the 
previous figure, select the one you need and click OK, or simply double-click it.

You can close any model or diagram by selecting Model/Close or Diagram/Close from the menu, 
or by clicking the following symbol of the model or diagram window

or by clicking the Close button of the given window (if available):
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1.4 Creating a New Model and Opening an Existing One

If a repository already contains models, their names appear in the repository window, as seen in 
the following figure:

Figure 1-5: REPOSITORY window

In other words, this window serves as the repository’s table of contents; it is the only gateway for 
access to the individual models.

To create a new model, click the New model button

in the REPOSITORY window or select the New... command from the Model drop-down menu.
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The New Model dialog box appears, as seen in the following figure:

Figure 1-6: New Model dialog box

Choose a name for the new model, for example, Office, and enter it into the Name field. (For a 
list of name restrictions, see “Rules for the Selection of Names in GRADE” on Page 29.)

Now you can select the type of modeling:

• Object modeling via class (CL) and package (PCK) diagrams

• Business modeling via BP and ORG diagrams

• System modeling via communicating objects (CO) and process (PD) diagrams

• Component modeling via a combination of the diagrams mentioned above.

Starting with an empty model (all three boxes unchecked) is also allowed.

Once you have made your selection(s), click OK and the model is created.

Template diagrams for the selected type of modeling will then appear, as seen in Figure 1-9, Page 
24. In other words, the system provides a framework on the basis of which you can start 
modeling. This framework is organized into corresponding subtrees. You can supplement this 
model with more diagrams or delete redundant diagrams at any time.

Any model, new or existing, can be opened by double-clicking its name in the REPOSITORY 
window. Alternatively, click the name of the model to highlight it, then press Return or click the 
Open button:
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1.5 Working With a Model

An overview of any existing model is offered by its model tree, as seen in the following figure:

Figure 1-7: Model-tree example

The rectangular symbols (such as CL, BM, etc.) represent diagrams. The diagram types will be 
explained as we go along; definitions also can be found in “Appendix A: Overview of GRADE 
Diagrams” on Page 437. For now, refer to the following list: GLO=glossary table, 
STE=stereotype table, PIC=picture table, TAG=tag table, EXT=external link table, 
PCK=package diagram, CLA=class definition table, CL=class diagram, BM=business model, 
VT=variable table, ET=event table, CMP=competencies table, SP=simulation parameter table, 
ORG=organizational structure diagram, ATR=attribute table, DD=data definition diagram, 
BP=business process diagram, TD=task details diagram, AT=access table, PD=process diagram.

BM and PCK are the “root” diagrams here, because the other diagrams “grow” from them.
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The “sheets of paper” seen to the right of diagram names are comment diagram (CMT) 
symbols:

(For more information about comment symbols, please see “Comment Diagrams (CMT)” on 
Page 339.)

You may have noticed the - (minus) button next to some icons:

Sometimes, there may be a plus instead of a minus:

A plus means you can click it to expand the subtree (view hidden diagrams). A minus means 
that the subtree already is in the expanded state; click the minus to collapse it. (See also 
“Collapsing/Expanding Model Trees” on Page 27.)

In addition, you may have noticed small, three-dimensional cubes next to some icons:

Their colors are significant. Some of these colors are associated with the syntax analysis of 
GRADE models (for more information, see the Simulation Guide); others are related to the 
design status of a diagram, which can be assigned if a team is working on a model (see “Can a 
Whole Team Work on a GRADE Model, Then Merge the Results?” on Page 368).

Front Color of Cube

• white: empty diagram

• gray: diagram not analyzed

• green: diagram analyzed, no errors found

• red: diagram contains errors

• yellow: diagram contains warning messages.

Top Color

• white: design status Not Started

• gray: design status In Work

• cyan: design status Approved

• blue: design status Final.

�
These cubes may be displayed or hidden by using the option Hide diagram status. This is described 
on Page 390.
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The model tree serves as a hierarchical table of contents of the model. Any diagram can be 
accessed directly from the tree by double-clicking its abbreviation (CL, PCK, etc.). You have the 
option of replacing these abbreviations with icons, as shown in the following figure:

Figure 1-8: Model tree displayed as icons

If you prefer this view of the model tree, simply open the Options menu, then activate Settings..., 
then mark the Use diagram icons check box on the General card.

Regardless of whether you display the model tree with abbreviations or with icons, one diagram 
in the model is always the “current” or “active” one. It is framed in red (see the PCK diagram in 
the following figure). You activate a diagram by clicking it once with your left mouse button.
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When you open a new model, a model tree containing empty templates appears. For example, 
if you have selected object and business modeling for a new model called Office4, you will see 
the following tree:

Figure 1-9: Templates for object and business modeling

New in this model tree is the ER, or entity-relationship diagram, which can serve to describe 
database or data-store structures.

The model templates created by GRADE consist of groups of empty diagrams organized into 
subtrees; in the previous figure, there is a PCK subtree and a BM subtree. If all three model types 
had been checked when creating the model, the model tree would have resembled the following 
figure:

Figure 1-10: Templates with all three subtrees (PCK, BM, CO)
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Note that this model tree contains a CO subtree, used for system modeling. Within the CO 
subtree are TOs, or transfer object tables, which reflect the contents of communication in a CO. 
(There is no need to memorize all of the diagram types; the most important ones will be 
explained in detail as we go along!)

Once you have reached this point, you can start opening and filling in the diagrams. You will 
find more information about this in the following chapters:

• Chapter 2, Organizational Structure Modeling (ORG Diagrams)

• Chapter 3, Business Process Modeling (BP Diagrams) 

• Chapter 4, Object Modeling (CL Diagrams), as well as Chapter 5 and Chapter 6

• Chapter 7, System Modeling (CO Diagrams)

• Chapter 8, Component Modeling.

To get hands-on experience with GRADE, we recommend that you read Chapter 2 and create 
the described ORG diagram, then continue with Chapter 3 and build the related BP diagram. 
Before you do, however, it is important that you at least skim this chapter to the end to get a 
better overview of how to perform basic GRADE operations.

1.5.1 Creating New Diagrams

When you insert new elements into an existing model, the model tree usually will be updated 
automatically to display these new diagrams. However, some diagram types, for example, a new 
top-level business process (BP) diagram, must be created by you. For more information about 
this, please see “How Can I Create a Diagram?” on Page 429.

1.5.2 Dragging and Dropping Diagrams/Subtrees

You can rearrange your model tree by the “drag and drop” method. In other words, GRADE 
lets you “grab” a diagram or subtree and move it to another position in the model tree. In some 
cases, you can even use this method to replace the contents of a diagram with contents from 
another.

To use this method, simply open a model tree and activate the given diagram by clicking it with 
your left mouse button (if it is the top diagram in a subtree, the entire subtree will be affected). 
Then, holding down the left mouse button, drag the diagram or subtree to its new position; i.e., 
position it on top of the diagram to which it is to be attached or which it should replace.
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If your proposed attachment/replacement is not allowed by GRADE’s internal logic, the 
program displays this message:

Figure 1-11: Incompatible diagram message

If your proposed change is allowed, GRADE will ask you to confirm your action. In some 
circumstances, you will even have a choice between attachment and replacement:

Figure 1-12: Confirmation dialog for rearranging a model tree

The attachment/replacement mechanism differs somewhat, depending on the diagram type(s) 
involved.

1.5.3 Deleting, Duplicating and Renaming Diagrams in the Model Tree

In the model tree, you need to activate or select diagrams before you can perform operations on 
them.

To activate a diagram, click it with your left mouse button. To select/deselect a diagram, 
position your cursor on it, press Ctrl, and click the left mouse button. To select/deselect several 
diagrams, repeat this as necessary.

To delete a diagram, activate it and press Del. Alternatively, you can select the Delete command 
from the Diagram menu. To delete a set of selected diagrams, open the Diagram menu, then 
activate Delete and Selected diagrams.

Some diagrams, such as ETs (event tables) and ATs (access tables), cannot be deleted.

To duplicate (“clone”) a diagram, proceed as follows:

1 Activate the diagram by clicking it with your left mouse button.

2 In the model-tree menu, select Diagram, then Duplicate as free, then the desired option, 
Diagram or Subtree.
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You can duplicate a selected set of diagrams, as well. In that case, after activating Duplicate as 
free, you would choose Selected diagrams.

To rename a diagram, proceed as follows:

1 Click with your right mouse button on the diagram in the model tree. The popup menu 
appears. Select Rename... (Alternatively, you can select the Rename... command from the 
Diagram menu.)

2 In the Rename dialog box, enter a new name.

3 Click OK.

1.5.4 Collapsing/Expanding Model Trees

When working with larger models, it is frequently desirable to view only a portion of the model 
tree. For this purpose, GRADE allows you to temporarily collapse subtrees that are currently 
not of interest.

To collapse a subtree, proceed as follows:

1 Activate the top diagram of the subtree in the model tree.

2 Click the small - (minus) button near the diagram symbol. (Alternatively, select the 
Collapse/Expand command from the Diagram menu or press the minus, -, key.) The 
subtree below the current diagram is no longer visible in the model tree.

Collapsed subtrees are indicated by a + symbol.

Collapsing a subtree affects only its visual representation in the model tree; the contents of the 
model are not affected.

To make a collapsed subtree visible again (to expand it), proceed as follows:

Click the small + button near the diagram symbol. Alternatively, you can select the 
Collapse/Expand command from the Diagram menu, or press the minus, -, key.

1.5.5 Printing Models

For information on this, please see “How Can I Optimize the Printouts of My Models?” on Page 
376.
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1.5.6 Exporting Models/Subtrees in HTML Format

For information on this, please see “Exporting a Model/Subtree in HTML Format” on Page 
417.

1.5.7 Exporting and Importing in EI Format

For information on this, please see “Exporting and Importing Diagrams, Models in 
Export/Import Format” on Page 421.

1.6 Closing a GRADE Session

There are many ways of terminating the GRADE application. The major ones are described 
here:

If you are working in a diagram and would like to close it before quitting, click this symbol once

or this symbol once

or this symbol twice

to close it.

Or open the Diagram menu and select Close. Or, to end the session without closing the diagram, 
use Alt+F4. If you try to exit GRADE while a diagram window with unsaved changes is open, 
you will be asked whether you want to save these changes.

Once the diagram is closed, you can click this symbol once (far upper-right corner)

or this symbol twice

to quit GRADE.

If you are working in the REPOSITORY window, open the Repository menu and select Exit 
modeler, or press Alt+F4, or click this symbol in the far upper-right corner

or on this symbol
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to end the session.

Before GRADE is actually terminated, a window will appear asking you to confirm your 
decision, as seen in the following figure:

Figure 1-13: Close message box

1.7 More on Shortcuts and Repositories

Creating a GRADE Shortcut Manually

If you forgot to create a GRADE icon on your desktop immediately after installation, you still 
have the chance to do it later.

The procedure differs, depending on your operating system. Consult your operating system’s 
manual or the online help. The command line to use is
c:\Grade4\bam\bamba.exe c:\Grade4\bamba.cfg

You also have the option of using several different cfg files.

Creating a New Repository

Managing your models is done via the repository. You can have any number of models in a 
repository, and many repositories on your computer. If you want to create separate repositories 
for different groups of models, please see “How Do I Create a Repository?” on Page 431.

1.8 Rules for the Selection of Names in GRADE

When selecting names (e.g., names of models, diagrams, diagram elements), keep the following 
restrictions in mind.

• The length of a name may not exceed 64 characters.

• Blanks may be entered, but the GRADE Modeler will automatically replace them with 
underscores.
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• No distinction is made between uppercase and lowercase letters; thus, CUSTOMER, 
customer and Customer represent identical names.

The rules for names (formally known as “identifiers”) differ somewhat, depending on whether 
your model is to be used for simulation:

• In a model to be used for simulation, a name is a string beginning with a letter and containing 
only letters, digits and blanks (underscores).

• In a semiformal model, an identifier is a string containing at least one letter and possibly 
additional letters, digits or special characters. All characters may be used except the following: 
parentheses ( ), brackets ] [, periods ., commas ,, colons :, semicolons ;, asterisks *, equal signs 
=, and less than/greater than signs < >. 

If you plan to use your model for simulation or prototyping (prototyping means “running” a 
system model, analogous to simulation of business models), certain reserved “keywords” cannot 
be used as names: ALL, AND, ANY, AS, ATTRIBUTE, BASED_VARIABLE, 
BINARY_ASSOCIATION, BINARY_LINK, BOOLEAN, CHAR, CLASS, COMPETENCE, 
COMPLEX, CONSTANT, DATE, DECIMAL, DEFREF, DEPENDENCY, DURATION, 
EXPONENTIAL, FALSE, FLOAT, FROM, INTEGER, MATERIAL, MESSAGE, NORMAL, 
NULL, OBJECT, OPERATION, OR, RANDOM, RANGE, REPETITION, RESULT, SIGNAL, 
STRING, TIME, TIMER, TRUE, UNIFORM, VALUE, VARIABLE, WHERE, WITH, and 
ZERO.

Keep in mind that no distinction is made between uppercase and lowercase letters; it is the 
sequence of letters that counts. Also keep in mind that GRADE will replace any spaces with 
underscores. Thus, if you enter binary link, GRADE will read it as the keyword BINARY_LINK.

If you use these keywords as names, they will not appear in the GRADE model dictionary and 
this could lead to problems (see also “How Can the Data Dictionary Facilitate My Work?” on 
Page 402). Note that you can use these terms as parts of names, but they must not constitute 
the whole name. 

In addition, built-in procedure names (in process diagrams, PDs) may not be used as names of 
user-defined procedures/functions nor as type names.

The Simulatable syntax option should be switched on for model simulation; for more 
information, see “How Can I Modify the User Settings According to My Needs?” on Page 387.

�
Note that the prototyping function mentioned earlier is not part of the standard GRADE package. 
If you are interested in purchasing GRADE-P, which includes this function, please contact 
INFOLOGISTIK GmbH.
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1.9 The Concept of Visibility

The concept of visibility is used in GRADE to keep the complexity of models manageable. This 
concept limits the diagrams that are “visible” from a given diagram. To better understand this, 
imagine creating an extremely large model, containing dozens of entity-relationship diagrams 
(ERs). Each represents one of the databases used by a multinational company. The model also 
contains dozens of data definition diagrams (DDs), where data structures for these databases are 
defined. For example, one ER diagram might show the structure of an employee database, while 
a DD reflects the structure of each employee record in that database.

As you draw the ER diagrams, you select record data types from DDs. For this, you use the 
“pick” function, choosing the data type from a drop-down list. If there were no concept of 
visibility (or if you set visibility to All), then this drop-down list would include all record data 
types from all DDs throughout the model; the list could have hundreds of names. Thanks to 
the concept of visibility, however, the list of data types will be limited to those “visible” from the 
given ER diagram. These will be the DDs “neighboring” the ER in the same branch of the 
subtree, and those “above” the ER, that is, higher in the subtree. This is illustrated in the 
following figure. From the ER diagram Branch Office Employee Database the DD diagrams Data 
Types Used at Branch Office and Types of Employee Records are visible. The DD diagrams Data 
Types for Financial Documents and Data Types for Business Model are not, because they do not 
belong to the subtree. Data Types Used for Free-Lancers also is not visible, because it is lower in 
the subtree.

Figure 1-14: Creating a model of a multinational corporation
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An additional benefit of visibility is that you are not required to come up with a unique name 
for each and every object throughout the model. For example, assume you are modeling a 
multinational corporation and use three independent subtrees to represent operations in 
Germany, France, and the United States. In each subtree, you have defined a record data type 
named Address to represent a customer’s address. Because an address in the United States has a 
different format than a European address (due to variations in postal codes), the Address data 
type for the United States will differ from that in Europe. This is no problem for GRADE, as 
the Address data type defined for the United States belongs to a subtree that is not visible from 
the German or French subtree, and vice versa. As you work on the U.S. part of your model and 
attempt to pick the name Address, only the U.S. Address data type will be offered in the selection 
list. (To select a data type that is not visible, simply activate the All visibility option when 
creating the corresponding diagram element.)
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Chapter 2
Organizational Structure Modeling: ORG 
Diagrams

2.1 Description of Organizational Structure

Now it’s just about time to get some hands-on experience by creating your first GRADE model. 
In this chapter and the next, we will be building a model showing how orders are processed at 
the High Value Auto Parts Company.

This model will consist of two major components:

• the organizational (ORG) diagram, which will represent the company’s relevant 
departments, employees and resources, and

• the business process (BP) diagram, which will reflect the actual processing of orders.

It makes sense to create the ORG diagram first, since the “performers” used in a BP diagram are 
copied in from an ORG diagram. (By performers we mean those who execute tasks, for 
example, departments, employees and customers. A PC or a truck also may be referenced as a 
performer.) The following figure shows the ORG diagram we will be creating:
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Figure 2-1: Example of an ORG diagram

ORG diagrams may contain the following elements:

• Organizational units, represented as yellow rectangles. These companies, departments, 
groups, etc., are organized as a hierarchy: The name of the company typically appears at the 
top level, with the departments that make up the company at lower levels. 

• Positions, represented as light blue, rounded rectangles. Positions represent a particular job 
or role within a company (e.g., vice president, accountant, secretary, industrial spy) and may 
include the individual’s name. 

• Resources, represented as green, rounded rectangles with a line down the left side. These are 
non-expendable, nonhuman resources that are referenced as performers, such as a PC, car, 
factory or assembly line.

• Persons, represented as white, rounded rectangles. A person is a particular individual 
(usually, an employee). Note: Do not use the person symbol in models that are to be 
simulated.

• Functions, represented as pink ellipses. As the name implies, this symbol represents a 
function carried out within the given business process.

SE
System and Its Environment

HVAPC

Customer

Supplier

HVAPC
High Value Auto Parts Company

Sales Department

Vice President Sales

Salesman Associate VP

Salesman
Instances: 12

Clerical staff
Instances: 3

PC
Instances: 10

Manufacturing
Operations

Manufacturing VP

Quality Tester
Instances: 5

Warehouse personnel
Instances: 5

Purchasing Officer
Instances: 2

Assembler
Instances: 5

Manufacturing
equipment

Finance Department

Finance VP

Secretary

PC
Instances: 2
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• References, represented as yellow rectangles in dotted frames. These are references to a 
performer depicted elsewhere in the model. For example, if Mark Johnson works as a graphic 
designer for Department A, but is sometimes “loaned out” to Departments B or F, he will 
appear in the organizational structure of Department A, but references to him can appear in 
Departments B and F.

Each symbol in an ORG diagram must be supplied with a name (normally, a unique one). With 
the exception of reference symbols, which are really just “pointers” to something else, the 
symbols in an organizational diagram can be assigned a wide range of characteristics and 
attributes, as described below.

Diagram elements may be single or multiple. Single elements have a single line as a frame, while 
multiple elements are marked by a double frame along the top and right side (see the following 
figure). A multiple element symbol may contain the number of available instances or, if no 
number is given, be considered unlimited. In the following figure, you will see a multiple 
position symbol representing three secretaries:

As you can see in Figure 2-1, Page 34, the organizational structure consists of one or more 
“trees,” in this case, the HVAPC tree and the SE tree. The trees, in turn, are built from nodes: 
organizational units, positions, etc. Any node of a tree may be refined further by another tree. 
(For example, the SE tree contains the HVAPC node; this node is further refined by the HVAPC 
tree to the right.)

The SE tree can be referred to as the “parent” fragment, since it contains the system to be 
modeled as well as its immediate environment. You could refer to the HVAPC tree as a “child” 
fragment, since it refines part of the SE tree.

As you examine the SE tree more closely, you will notice that the Customer and Supplier boxes 
are framed in dashed, rather than solid, lines. This indicates that they are external elements, i.e., 
an external partner of the system to be modeled. The subject of our model is, after all, the auto 
parts company, of which suppliers and customers are not formally a part. While external 
elements are framed by dashed lines, internal elements are framed by solid lines.

ORG elements may be assigned predefined attributes such as the following::

• list of competencies (skills, qualifications, or the authority to perform certain tasks)

• availability (e.g., time interval when this unit is available)

• cost per hour

�
In this manual, we will describe symbols in terms of their standard (default) color and style. For 
example, GRADE depicts organizational units as yellow rectangles by default. If you wish to change 
the appearance of symbols, please consult “How Can I Custom-Design Symbols Used in 
Diagrams?” on Page 349 or “Stereotype Table (STE)” on Page 317.
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• efficiency level.

In addition, organizational structure elements may be assigned a wide range of user-defined 
attributes. For a given position, you may want to list e-mail and postal addresses, phone and fax 
numbers, database-access rights, etc.

Here is an example of a position symbol with both predefined and user-defined attributes:

2.2 Defining a New ORG Diagram

Our new ORG diagram will be part of the business model (BM) tree. As you can see in the 
following figure, our tree will represent a procedure for handling orders:

Figure 2-2: Model tree for handling orders

This model tree contains many types of diagrams; for now, only the following are of interest to 
us:

• The ORG diagram itself, appearing in the third row from the top,

Salesman Associate VP
Availability: "*.*.(MON-FRI) (09:00-

18:00)"
Cost per hour: 24
Telephone = 08024-30450
Fax = 08024-304525
E-mail = Sales@HVAPC.com
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• The BP diagram, which will illustrate the business process,

• The ET, or events table, which will contain all events in the business model,

• The TD, or task details diagrams, which will describe the properties of tasks and their 
possible links to other tasks, and

• The CMP, or competencies table. It supplements the ORG diagram by listing possible 
competencies, skills, authorizations and qualifications of ORG elements.

Creating a Model

Before we can create the ORG diagram itself, we need to create the model in which it will reside. 
First, make sure a repository is open. Proceed as follows:

• If you are in the GRADE main window (which is basically a gray area), click the Repository 
menu, then Open repository... Select the repository you want (there is probably only one to 
choose from), then click OK.

• If you are somewhere within a diagram or model, you can call up the REPOSITORY window 
by simply clicking the Window menu, then REPOSITORY.

• If you are already in the REPOSITORY window (having one or more rectangles marked MO 
for model), you need do nothing.

Now create the new model:

1 Click the New model icon:

�
For a brief explanation of the other diagrams, see “Appendix A: Overview of GRADE Diagrams” 
on Page 437.
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2 The New Model dialog appears. In the Name field, fill in the name of the new model: 
Handling Orders. In the Start with field, make sure only the second check box, Business 
model (ORG, BP), is marked. (You can delete a check mark by simply clicking it with 
your left mouse button.) The New Model dialog now should look like the following 
figure:

Figure 2-3: New Model dialog

3 Now click OK (or simply press the Return key, which often can be used to confirm your 
last step). The new model tree will appear on the screen, as seen in the following figure:

Figure 2-4: Business model window

(Note that your newly installed GRADE program should contain a similar model, named Order. 
We are creating this new model, Handling Orders, to give you more hands-on experience.)
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2.3 ORG Diagram Window

To open the Handling Orders ORG diagram, double-click its icon in the model tree or, if the 
diagram is already activated (framed in red), simply press the Return key. As you will see in the 
following figure, a window appears with just a bare framework of an ORG diagram:

Figure 2-5: ORG diagram window

Before you begin building the diagram itself, it is recommended that you familiarize yourself 
with the ORG modeling window so that you know what tools, menu commands, etc., are 
available.

In the upper left corner you will see this symbol:

You can click it to open a control menu with standard Windows functions. For example, you 
can use the menu’s Close command to terminate your GRADE session. Opposite it, in the top 
right corner, you will see this:

By clicking these symbols, from left to right, you can minimize the window, maximize the 
window or exit GRADE.
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On the next line, you will see the following menus: Diagram, Edit, Style, Search, Options, Layout, 
View, Window, and Help. Rather than present a long list of the various menu commands and 
their explanations here, we will introduce the commands that are the most relevant to you as we 
go along. Here is a quick overview of major menu functions:

Figure 2-6: Major menu commands

The next line is the GRADE toolbar. To discover the function of each icon, simply place your 
mouse pointer over the icon in question, and wait briefly. A tool tip will appear, as shown below:

On the next line, you will find an icon for another control menu, 

Click it to reveal a menu of commands that can be used to manipulate the open ORG diagram 
(e.g., click Close to close the diagram window). That is followed by the diagram type (ORG 
STRUCTURE) and name.

The symbols on the far right

offer standard Windows functions described earlier.

Save, print,
close

Change the
appearance
of a symbol

Change default
appearance of 
symbols; modify
user settings

Search
in a diagram Change

layout Change
diagram
size; show
borders,
grid

Rearrange, open
GRADE windows

Retrieve
GRADE
online
help

Undo, cut,
copy, paste,
delete,
insert new,
select,
reposition
Chapter 2 



Below that, along the left edge of the screen, you will see the symbol palette, which will help you 
quickly and efficiently build ORG diagrams:

At the bottom and side of the window, you will see standard Windows features, scroll bars,

for moving your picture right, left, up, or down. At the bottom of your screen, a status line 
sometimes appears. If, for example, you position your mouse pointer on the GRADE toolbar, 
a tool-tip window will open and supplementary information will be given in the status bar:

Symbol Name Function

Deselect Cancels a selection in the symbol palette. If you select an 
element in the symbol palette, then decide it was the wrong 
one, click this arrow to deselect your choice. (Note: In the 
case of most symbols, a dialog window will open as soon as 
you select them. In that case, simply click Cancel, then 
select the symbol you want.)

Organizational  unit Creates an organizational unit symbol.

Position Creates a position symbol.

Resource Creates a resource symbol.

Person Creates a person symbol.

Function Creates a function symbol.

Reference Creates a reference symbol.

Fork Creates a fork, which is used to achieve the desired layout 
of the ORG diagram. (See “Use of the Layout Assistant” on 
Page 61.)

Free comment Creates a free comment symbol.

Table 2-1: Symbols in ORG diagram

�
If your symbol palette does not include all of the above symbols, you are probably working with an 
older model. To display the full symbol palette, activate the model tree, then open the Options menu 
and click Restore default stereotypes.

GRADE also lets you define your own stereotypes; for example, you might want to define a special 
position symbol having a particular color and shape to represent a particular type of employee. If 
you wish, you can create an icon for this stereotype and add it to the ORG diagram symbol palette. 
GRADE also lets you modify existing icons in this palette. For more information, see “Stereotype 
Table (STE)” on Page 317.
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2.4 Working With ORG Diagrams

Let’s start creating the diagram symbols pictured in Figure 2-1, Page 34. (If you have just opened 
a new ORG diagram, you will see three empty symbols. Leave these alone for now; they will 
come in handy later.)

As you go along, remember to save your work from time to time. One quick way of doing this 
is to click the Save active diagram icon:

�
Note that you can execute the save function and perform many other functions without using your 
mouse. Please see “What Special Keys and Key Combinations Can Be Used?” on Page 394.
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2.4.1 Creating Diagram Symbols

Organizational Unit Symbol

To create the organizational unit symbol Sales Department, proceed as follows:

1 Use your mouse to click the organizational unit symbol (appears as a yellow rectangle) 
in the symbol palette of the ORG diagram window. (Alternatively, you can open the Edit 
menu, then select Insert symbol and Organizational unit.) The Organizational unit dialog 
appears, as shown in the following figure:

Figure 2-7: Organizational unit dialog
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2 In the Name field, enter the unit’s name (Sales Department). You can enter an 
abbreviation for the name in the Alt.name field, if you wish.

3 Click the OK button to close the dialog window and insert the symbol in the diagram. 
The organizational unit symbol appears:

The symbol is initially active, i.e., marked by a red frame.

Position Symbol

To create the symbol Vice President Sales, which is a position within the Sales Department, 
proceed as follows:

1 First, make sure that the Sales Department symbol is active. If is not, click it. This will 
ensure that the next element you insert in the diagram will appear as part of the Sales 
Department (also called the parent symbol).

Generally, all entries (except Description) are formal names, subject to a specific syntax that must 
be followed if the model is to be simulated. If you enter illegal characters, such as periods or 
parentheses, you may receive the message “Invalid name.” 

For a general overview of the restrictions that apply to names (both in simulatable and in 
semiformal models), please see “Rules for the Selection of Names in GRADE” on Page 29.

For information about how to remove inappropriate names from your diagrams, see “Searching 
for Inappropriate Names” on Page 416.
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2 Now click the position symbol (appears as a light blue, rounded rectangle) in the symbol 
palette of the diagram window. The Position dialog box appears:

Figure 2-8: Position dialog

3 In the Name field, enter the position name (Vice President Sales). 

4 Click OK to insert the symbol in the diagram. The position symbol appears under the 
parent unit symbol:

�
In Step 1, we mentioned the principle of activating a diagram element by clicking it (it will then be 
framed in red). This will be useful throughout your work with GRADE. For edit operations, you 
will need to activate the element first by marking it, i.e., clicking it with your left mouse button. 
Only then can you carry out the desired operation.

For operations involving more than one element, use selection: Hold down your Shift (or Ctrl) key, 
then click with your left mouse button on the items to be selected. They will be marked in blue. For 
a more complete explanation of activation and selection, please see “Activating Versus Selecting 
Diagram Elements” on Page 67.
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Make sure that the Sales Department (the parent symbol) remains active as you create the other 
symbols that belong to this department (see instructions below). These additional symbols can 
be seen in the following figure:

Figure 2-9: Sales Department tree

The Salesman Associate VP symbol can be created by carrying out the steps used for the Vice 
President Sales.

The Salesman and Clerical staff symbols, however, represent multiple positions and thus require 
an additional step. Once you have opened the Position dialog and entered the name of the 
position, move your mouse pointer to the bottom of the dialog and mark the Multiple check 
box. To the right of it, in the Number of instances box, enter 12 for the number of salesmen 
(when you create the Clerical staff symbol, enter 3).

Resource, Person and Function Symbols

Creating the PC symbol is analogous; you must, however, keep in mind that PCs are resources. 
Thus, your first step will be to click the green resource symbol, which will open the Resource 
dialog. Then enter the name, mark the Multiple check box, enter the number of instances and 
click OK.

Person and function symbols can be created analogously. In the Name field of the person 
symbol, enter the individual’s first and last name. In the Name field of the function symbol, 
enter a function that is performed within the business process, such as Set salaries.
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Additional Attributes for ORG Elements

As noted earlier, additional attributes can be specified both for organizational units and for other 
types of ORG diagram elements. We have already seen how to create an external ORG element 
(one that is not an integral part of the system being modeled), by marking the External check 
box. You also can enter an alternate name, a description (use the key combination Ctrl+Enter to 
obtain a new line), etc.

Other information, such as the employee’s cost per hour, availability, etc., can be added by 
clicking on the Predefined tab and filling it out:

Figure 2-10: Card for entering predefined attributes

If you have defined competencies (e.g., particular language or computer skills) in the 
competencies (CMP) table, you can click the down arrow next to Select competency to choose 
one, then click the left-arrow button to the right of the Select competency field to enter it. As an 
alternative, you can click the Competency details... button to define a new competency (simply 
enter the name), which will then appear in the CMP table.

To define availability (performer’s working hours), click the right-arrow button next to the 
Availability field, then fill out the fields as needed and click OK.

�
The use of the Ctrl+Enter key combination, mentioned above, is a standard GRADE feature for 
creating a new line. This is useful when filling in or editing the contents of GRADE symbols.
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Other information can be added by clicking the User defined tab, in which you can enter a wide 
variety of user-defined information, such as the employee’s e-mail address, phone number, 
database access rights, etc.:

Figure 2-11: Entering user-defined attributes
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Data should be entered as shown in the previous figure, e.g., Telephone = 08024-30450. This is 
Unified Modeling Language, or UML, syntax. To make sure that the syntax is correct, you can 
use the New button, which will display the Attribute dialog, and simply fill out the 
corresponding fields, as shown below:

Figure 2-12: Entering an attribute

(For more information on UML and UML attributes, see “Object Modeling: Basic Concepts” 
on Page 121 and “More About Defining Class Attributes” on Page 140.)

If your model is to contain many symbols having the same attributes (e.g., many employees with 
the same phone number), it is recommended that you define a stereotype with those attributes 
(as described in “Defining a Stereotype” on Page 318). Then you can either define new symbols 
with that stereotype or assign the stereotype to existing symbols (as described in “Applying 
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Stereotypes” on Page 320). One final step is needed to make sure that the stereotype attributes 
are applied to the given symbol: Click on the User defined tab and click the Copy from stereotype 
button.

Free Comments

Sometimes it is impossible or impractical to show all the information relating to an ORG 
diagram or diagram element within the normal diagram framework. For this reason, GRADE 
allows you to insert informal comments at arbitrary locations.

These so-called free comments are rectangular diagram symbols with rounded corners. Free 
comments can contain text or graphics and can be placed at any location in the diagram 
regardless of the diagram’s contents. An example can be seen in the following figure:

To insert a free comment, proceed as follows:

1 Click the free comment icon in the symbol palette (the bottom symbol). 

2 Then click where you want to place the symbol. The Free Comment box appears.

3 Type your text in the field, then click OK.

�
If an ORG diagram element contains many attributes, you may want to hide some or all of these to 
keep your diagram from becoming cluttered.

User-defined attributes can be hidden by deselecting the User attributes check box on the Text style 
card of the symbol style dialog. See also “How Can I Streamline My Diagrams by Making Some 
Texts Invisible?” on Page 367.

Predefined attribute keywords (such as Availability, Cost per hour) and the associated attributes also 
can be hidden. See “Hiding Attribute Keywords” on Page 368.
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If you want to start a new line of text in the Free Comment box, use Ctrl+Enter. In the following 
example, Ctrl+Enter was used after the words “of” and “available,” and after the semicolon:

Figure 2-13: Free Comment dialog

2.4.2 Changing the Position and Size of Diagram Elements

Keep these hints in mind when working with diagram elements:

• If you would like to reposition a symbol you have created, place your mouse pointer on it, 
then hold down your left mouse button so that the four-arrow cross increases in size. Then 
“drag” the symbol where you would like it. To test this, activate the Sales Department symbol, 
then, with your mouse pointer on it, hold down your left mouse button. Now drag the Sales 
Department to the right and upward and place it next to the empty group of symbols. Your 
diagram will now look something like this:
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• Usually, diagram elements will expand to fit the size of their contents. If you would like to 
resize /reshape a symbol, however, simply click the symbol once, then place your mouse 
pointer anywhere on the border of the symbol, wait until the horizontal or vertical arrows 
appear, then “drag” as needed. GRADE will readjust the text in the symbol, if necessary.

If you would like the symbols in the Sales Department to appear broader, activate each element 
in question and drag its border outward. The following figure shows the Sales Department tree 
with extended symbols:

Figure 2-14: Sales Department tree with changed layout

Setting a Default Width for Symbols

It is also possible to set a default width for symbols, to make sure that every new symbol you 
create will have the same width as the previous ones. Proceed as follows:

1 Click any symbol and set its borders to the desired width.

2 With this symbol still active, press the F4 key. (Alternatively, you can open the Options 
menu and activate the Set default width command.)

Any new box symbol will have the same width.

2.4.3 Editing and Deleting Diagram Elements

To edit a diagram element, proceed as follows:

1 Activate (click) the diagram element to be edited.
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2 Press the Enter (Return) key. (As an alternative, you can open the Edit menu and select 
the Symbol contents... command or click the diagram element with your right mouse 
button and then select Symbol contents...)

3 A dialog appears in which you can edit the contents of the element. This dialog depends 
on the type of symbol. Make the desired changes in this dialog.

4 Click the OK button to confirm the changes, or click Cancel to abandon the changes.

To delete a symbol, proceed as follows:

1 Activate the symbol to be deleted.

2 Press the Del key. Alternatively, you can open the Edit menu and select the Delete 
command.

To reverse a delete operation, proceed as follows:

Open the Edit menu and select the Undo delete command. (As an alternative, use the key 
combination Alt+Backspace.) In either case, the deleted symbol should reappear. The undo 
delete operation, however, will be successful only if you do it soon, before making other changes 
in the diagram layout.

Now you can use what you just learned to edit the empty symbols in your ORG diagram. These 
symbols currently appear like this:

Activate the top symbol, then press Enter (Return). The Organizational unit dialog should 
appear. In the Name field, enter SE. In the Alt.name field, enter System and its Environment. 
Click OK. (If you wish, you can activate the symbol and “drag” its borders outward to create 
more room for the text.)

If you delete a symbol in an ORG diagram, any subordinated subtree symbols will be deleted as 
well. To delete, for example, the tree shown in Figure 2-16, Page 56, click the Sales Department 
symbol in the diagram and press the Del key.
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Reference Symbol

This System and its Environment subtree will include an HVAPC symbol, representing the auto 
parts company. As you can see from Figure 2-1, Page 34, the HVAPC symbol in this subtree will 
be merely a reference to the main HVAPC symbol, which we will be creating later in the other 
subtree.

To create the reference symbol, proceed as follows:

1 Click the multicolored reference icon in the symbol palette. A dialog appears. This 
dialog, by default, displays a list of organizational unit symbols appearing in the model. 
(If you want to make reference to a different type of symbol, e.g., a position, you can 
click the corresponding radio button in the Change type field to view the names of the 
corresponding symbols.)

Figure 2-15: Creating a reference symbol

2 If the symbol to which you want to refer appears in the list, you can simply click it with 
your mouse button to select it. In this case, the symbol to which you want to refer 
(HVAPC) does not appear because it has not yet been created. Thus, you can simply 
place your cursor in the Name field and type HVAPC. 

3 Click OK.
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The subtree now looks something like this:

Now edit the unnamed organizational unit just beneath SE. Right-click the symbol, select 
Symbol contents... and enter the name Customer. Mark the External and Multiple check boxes 
(external because the customer is not an integral part of the system we are modeling, and 
multiple because there is more than one customer). Click OK.

Now edit the remaining organizational unit. Name it Supplier and mark the External and 
Multiple check boxes. The subtree you have been working on should now look like this:

2.4.4 Attaching, Detaching, Rearranging Symbols and Subtrees

Now that our Sales Department is complete, it’s time to place it under its parent diagram, the 
High Value Auto Parts Company. Proceed as follows:

1 Make sure that no symbol in the diagram is activated. (To deselect a symbol, simply click 
with your mouse on the blank field of the diagram.)

SE
System and Environment

HVAPC

SE
System and Environment

Customer

Supplier

HVAPC
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2 Create an organizational unit symbol with the name HVAPC and the alternate name 
High Value Auto Parts Company. “Grab” the Sales Department symbol with your mouse 
and drag it to a position under the HVAPC symbol. This part of your diagram should 
now look like the following figure:

Figure 2-16: High Value Auto Parts Company unit symbol and Sales Department tree

You now need to attach the Sales Department tree to the HVAPC symbol.

Attaching a Symbol or Tree to a Parent

To attach an existing symbol or tree to a parent symbol, proceed as follows:

1 Click the symbol to be attached (or top symbol in the tree to be attached) to mark it as 
the currently active symbol.

2 While holding down the left mouse button (the crossed arrows symbol should grow 
large), move the symbol to the desired parent symbol so that the upper left corner of the 
object overlaps the parent symbol.

3 Release the mouse button. (If the symbol now overlaps the parent symbol, try the 
operation again, overlapping the two symbols even more until a proper connection is 
established, as seen in the next figure.)
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The result should look like this:

Figure 2-17: HVAPC structure tree with Sales Department subtree attached

Detaching a Symbol or Subtree From a Parent

To detach a diagram symbol or subtree from its parent symbol, proceed as follows:

1 Click the symbol (or the symbol at the top of the subtree) to mark it as active.

2 Hold down the left mouse button so that the crossed arrows symbol increases in size. 
Now move the symbol/subtree to the desired (free) area and release the button. 

It is possible to move a diagram symbol or subtree from one parent symbol to another, using the 
combination of detaching and attaching the symbol or subtree.

The order of the branches also may be changed. Simply activate the symbol or subtree in 
question and move it to the desired position. Alternatively, you can detach the symbols/subtrees 
from the parent tree, then reattach them in the desired order. Generally, the one you attach last 
will be the one closest to the parent symbol.
Organizational Structure Modeling: ORG Diagrams 57 

• 
• 
• 
•
•
•



58 

• 
• 
• 
•
•
•

You can use the same detach/attach techniques to rearrange the elements in the SE subtree. 
Activate the HVAPC reference symbol, and then, holding down your left mouse button, drag 
the symbol upward so that it slightly overlaps the SE symbol, and let go. The subtree now looks 
like this:

Let us now resume work on the main subtree. Note that the High Value Auto Parts Company 
does not consist merely of a Sales Department! Activate the HVAPC symbol, then create under 
it the Manufacturing Operations and Finance Department organizational units. Your diagram 
now should look like this:

Figure 2-18: High Value Auto Parts Company with vertical layout

SE
System and Environment

HVAPC

Customer

Supplier
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At this point, you may notice that your diagram is growing vertically; that’s because the standard 
(default) layout style for ORG diagrams is Vertical. Since there are still more elements to be 
added to this diagram, and since you may not want a diagram that is very long and “thin,” read 
the next section to find out how to change the layout.

2.4.5 Diagram Layout: Horizontal vs. Vertical

As mentioned, the default layout style for ORG diagrams is Vertical. You can, however, easily 
change the layout and even combine Horizontal and Vertical styles as needed.

Let’s say you want the organizational units directly under the High Value Auto Parts Company to 
appear in a horizontal row. Activate the HVAPC symbol, then open the Layout menu and click 
Horizontal. (If the diagram now overlaps another one, “grab” the HVAPC symbol with your 
mouse and move it to a more convenient location.) The HVAPC tree should now resemble the 
following figure:

Figure 2-19: High Value Auto Parts Company with partially horizontal layout

A shortcut for changing the orientation of any tree/subtree to Horizontal or Vertical is as follows:

1 Click the top symbol of the tree/subtree with your right mouse button.

2 In the pop-up menu, select either Vertical or Horizontal.
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This feature allows you to mix and match vertical and horizontal layouts to control the breadth 
and depth of the ORG diagram. The following figure shows diagram trees with mixed vertical 
and horizontal layouts:

Figure 2-20: Vertical and horizontal layouts within a single diagram

If you are creating a new branch of a model, you can determine the layout early on, in the 
definition dialog. Proceed as follows:

1 Click the appropriate symbol in the symbol palette.

2 In the dialog that now appears, locate the Style of tree area. There, you can specify that 
you want the symbols in the new tree to be horizontal (rather than the default Vertical 
setting), and specify whether you want them centered under the parent symbol or 
branching out to the left or right.

3 Make any other necessary entries and click OK (or simply press Return).

If you decide at some point on a completely horizontal style or completely vertical style, open 
the Layout menu, then select Vertical all or Horizontal all.
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Use of the Layout Assistant

In ORG diagrams, you also have the option of using the layout assistant. It lets you design 
subtrees in which the child symbols of a single parent symbol can be arranged both vertically 
and horizontally, as seen here:

Figure 2-21: Using “forks” to achieve combined horizontal/vertical layout

To create this type of subtree, proceed as follows:

1 Create the top, or parent symbol, and make sure it is activated (framed in red).

2 Click on the fork icon, located near the bottom of the symbol palette, to create a fork. 
Click on the icon again to create a second one.

3 Activate one of the forks, then create the child symbols that are to be attached to it in 
the usual way.

4 Activate the other fork and do the same.

5 You can now assign a vertical layout to one of the forks by right-clicking on the given 
fork, then selecting Vertical in the pop-up menu.

Double-Sided Layout

When creating diagrams in vertical layout mode, you will notice that the child symbols 
automatically branch off to the right.

Parent Symbol

Child Symbol

Child Symbol

Child Symbol

Child Symbol Child Symbol Child Symbol
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You have the option of moving any of these child symbols so that they branch off to the left, 
thus creating a double-sided layout. Simply activate the symbol that is to be moved and then, 
holding down your left mouse button, move it just to the left of the connecting line.

Of course, the reverse technique can be used to move a symbol back to the right side.

Compacting

Another way to customize the appearance of your diagrams is by compacting. The compact 
attribute can be assigned to any diagram symbol. Then all the symbols under this symbol will 
be rearranged, if necessary, to minimize the space occupied.

To activate this feature, proceed as follows:

1 Click the symbol to mark it as currently active.

2 Open the Layout menu and select the Compact command. (As an alternative, click the 
symbol with your right mouse button, open the Symbol contents... menu and click the 
Compact check box in the dialog.)

To remove the Compact attribute from a symbol, proceed as follows:

1 Click the symbol to mark it as currently active.

2 Open the Layout menu and select the Remove compact command. (Alternatively, click the 
symbol with your right mouse button, open the Symbol contents... menu and remove the 
check mark from the Compact check box.)

It may well be that the diagram you have drawn is already compact in its layout; in that case, 
activating the compact option will not change anything.

2.4.6 Repositioning

GRADE allows you to change (and improve!) the layout of an entire diagram by issuing a single 
command. This is known as repositioning, and is available in ORG and other diagrams.

Do not move the symbol too far from its connecting line. If you do, you may detach it from the 
subtree.
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To optimize the layout of an ORG diagram, proceed as follows:

1 Open the diagram.

2 Open the Edit menu and activate the Reposition command. The elements in the ORG 
diagram will be rearranged in a more compact way; for example, if one symbol is far 
afield of all the others, it will be pulled in toward the group.

Depending on the type of diagram you are working with, there may be other repositioning 
possibilities.

2.4.7 Using a Grid

To make it even easier for you to create good-looking diagrams, GRADE lets you display a grid 
so that you can easily line up the edges of your symbols. In the following example, the grid was 
turned on so that the tops of the SE and HVAPC trees could be neatly lined up:

Figure 2-22: Diagram window with grid

To turn on the grid feature, proceed as follows:

1 Open the View menu, then click Show grid.

2 A grid will now appear in your diagram window, and a check mark will appear beside 
the Show grid command.
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To turn off the feature, do the same. The check mark and the grid will then disappear. By 
default, this feature is turned off. There is a separate show-grid setting for each diagram window, 
but this is not saved when the window is closed.

2.4.8 Collapsing/Expanding Subtrees

When generating larger ORG diagrams, it is frequently desirable to work with only a portion 
of the tree. For such situations, GRADE allows you to temporarily collapse subtrees that are 
currently not of interest.

To appreciate this feature more fully, we suggest that you first complete the High Value Auto 
Parts Company ORG diagram. All that’s left to do is add the positions and resources belonging 
to Manufacturing Operations and the Finance Department. Click Manufacturing Operations, then 
add the symbols under it, as seen in the following diagram. Then click the Finance Department 
and do the same. The diagram will now look like this:

Figure 2-23: High Value Auto Parts Company with subtrees

To collapse a subtree, proceed as follows:

1 Activate the top element of the subtree that you wish to collapse.

�
Note that this feature works not only in ORG diagrams, but in other types of diagrams as well.

SE
System and Its Environment

HVAPC

Customer

Supplier

HVAPC
High Value Auto Parts Company

Sales Department

Vice President Sales

Salesman Associate VP

Salesman
Instances: 12

Clerical staff
Instances: 3

PC
Instances: 10

Manufacturing
Operations

Manufacturing VP

Quality Tester
Instances: 5

Warehouse personnel
Instances: 5

Purchasing Officer
Instances: 2

Assembler
Instances: 5

Manufacturing
equipment

Finance Department

Finance VP

Secretary

PC
Instances: 2
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2 Open the Layout menu and select the Collapse/Expand command. (As an alternative, you 
can press the minus key on your keyboard, or click the minus button appearing on the 
symbol itself.)

You can recognize a subtree that is collapsed by the plus button appearing on its top symbol. 
Collapsing subtrees affects only the visual aspects of an ORG diagram; the content of the 
diagram remains unchanged. The following figure shows our diagram with two collapsed 
subtrees:

Figure 2-24: Tree with collapsed branches 

To make a collapsed subtree visible again, you have the following options:

• Activate the top symbol in the subtree, then open the Layout menu and select the 
Collapse/Expand command.

• Activate the top symbol in the subtree, then press the minus key.

• Activate the top symbol in the subtree, then click the + found in the lower left corner of that 
symbol.

If you want to expand only one level of the hierarchy, proceed as follows:

1 Activate the top element of the collapsed subtree in which you want to expand one level.
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2 Open the Layout menu and select the Expand one level command, or press the plus key. 
One more hierarchy level of this subtree is then revealed.

Use the Layout /Expand all command to expand all levels of the tree hierarchy.

2.4.9 Hiding/Displaying Text in Diagrams

Any of the textual items within an ORG element (e.g., the alternate name, the efficiency level, 
the number of instances) can be made visible or invisible in the diagram. By default, all textual 
items are visible. For more information about how to hide/display text in symbols, please see 
“How Can I Streamline My Diagrams by Making Some Texts Invisible?” on Page 367.

If you do decide to make text invisible in the diagram, this text can be retrieved and viewed by 
you at any time via the Show contents command. For more information about this, also see “How 
Can I Streamline My Diagrams by Making Some Texts Invisible?” on Page 367.

The hide/display/show contents feature is available in other types of diagrams, as well.

2.4.10 Copying, Pasting and Moving Diagram Elements

GRADE allows you to copy diagram elements and subtrees in an ORG diagram and then insert 
(“paste”) them elsewhere in the same diagram or into another ORG diagram. (Copying ORG 
diagram elements to another type of diagram, e.g., a BP diagram, is not allowed.)

Copying takes place with the help of a clipboard, a location where copied information is 
temporarily stored and from where it can be retrieved.

To copy any symbol in an ORG diagram, proceed as follows:

1 Activate the symbol by clicking it.

2 Press the key combination Ctrl+C or Ctrl+Ins. Alternatively, you can open the Edit 
menu and activate the Copy command or click the Copy button in the GRADE toolbar:

3 The active diagram element is copied to the clipboard.

�
Note that these guidelines for copying, cutting and pasting apply to other types of diagrams as well, 
not just to ORG diagrams!

Note also that you can select several items if you wish, and then perform the copy, cut and paste 
operations.
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If the element is to be moved instead of copied, the procedure is the same, but use the key 
combination Ctrl+X or Shift+Del. Alternatively, use the Cut instead of the Copy command in 
the Edit menu or click the Cut button in the GRADE toolbar:

In that case, the element is deleted from the diagram and copied to the clipboard.

To insert the clipboard contents in the same or another diagram of the same type, proceed as 
follows:

1 Open the diagram into which the clipboard contents are to be inserted.

2 Use the key combination Ctrl+V or Shift+Ins. Alternatively, open the Edit menu and 
select the Paste command or click the Paste button in the GRADE toolbar:

3 Click your mouse at the spot where the diagram element is to be inserted.

2.4.11 Activating Versus Selecting Diagram Elements

If you wish to copy/cut/paste/move more than one element at a time, you must select these 
items. In contrast to activation, which involves clicking an element with your left mouse button 
to give it a red frame, selection gives the element or group of elements a blue frame.

In a diagram, there can be either an active element or selected elements, but not both at the same 
time.

If you want to select several diagram elements, proceed as follows:

1 Hold down the Shift key (or Ctrl key).

2 Click all diagram elements to be selected, one after another.

�
To move a group of diagram elements from one part of a diagram to another, proceed as follows:

Select all the elements you want to move, then cut and paste as described above.

OR

Select all the elements you want to move, then position your mouse button on any selected element, 
hold down the left mouse key (so that the crossed arrows symbol appears), then “drag” the group to 
its new position.
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Selection operates as a toggle: You can exclude an already selected element by clicking that 
element again (while holding down Shift or Ctrl). To deselect all selected elements, simply click 
outside the selection area.

Another possibility for selecting a compact group of diagram elements is the following:

1 Move the mouse pointer to one side of the group to be selected.

2 Hold down the left mouse button.

3 Drag the mouse pointer around the diagram elements that you want to select so that a 
selection rectangle appears.

4 When the selection rectangle contains the desired elements, release the mouse button. 
The diagram elements within the rectangle are selected. Unwanted elements can be 
removed from the group individually by holding down Shift (or Ctrl) and clicking them.

In ORG diagrams, you also can select diagram elements by opening the Edit menu, clicking 
Select, then choosing any of the following:

You can perform several selections one after another; every subsequent selection adds elements 
to the set of the already selected elements.

2.4.12 Operations on Selected Elements in the ORG Diagram

In principle, the same operations can be carried out on several selected diagram elements as on 
a single, active diagram element. An exception is the command Edit/Symbol contents, which 
makes sense only for one currently active diagram element. But operations such as Cut, Copy, 

�
Note that the two selection methods described above apply to other GRADE diagrams, not just to 
ORG diagrams.

Keep in mind that in ORG diagrams, you can select an entire subtree by activating its top symbol.

Command Meaning

all Selects all diagram elements

boxes Selects all boxes

child list Selects all child symbols (branches) of the currently active symbol

free comments Selects only free comments

similar Selects all diagram elements similar (by their types) to the currently active one.

Table 2-2: Select commands
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Delete, moving elements, etc., also can be performed simultaneously on several diagram 
elements. For example, you can move several selected trees in a diagram at once (by “dragging” 
the entire selected group).

Since the selection remains after the operation has been performed, you can perform several 
operations on the selected diagram elements, one after another.

2.4.13 Unifying the Height and Width of Diagram Symbols

In some cases, you may want to resize elements so that they all have the same height and/or 
width.

Proceed as follows:

1 Select the diagram symbols you wish to unify in size. (They should all be framed in 
blue.)

2 Open the Style menu and select the Size... command. The Size dialog appears, as shown 
in the following figure:

Figure 2-25: Size dialog

3 Click the desired radio buttons in the Width and Height groups and click OK. The sizes 
of the selected diagram elements are changed according to your specifications.

�
This feature works in ORG diagrams, as well as in business process (BP), class (CL), package (PCK) 
and communicating object (CO) diagrams.
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2.4.14 Zooming to Enlarge or Reduce Diagrams

Zooming is used to enlarge or reduce the size of a diagram on the screen. It works with ORG 
diagrams, as well as with other types of GRADE diagrams.

’Camcorder-Style’ Zooming

Just as you might zoom in on a particular subject with a camcorder, so GRADE lets you zoom 
in on any part of a diagram.

With the diagram open, place your mouse cursor on some “zooming center.” Then press the 
period key (.) to enlarge the zoom factor (each time you press the key, you increase the zoom 
factor by an increment of 5%). Or use the comma key (,) to reduce the zoom factor by an 
increment of 5%.

Let us assume your diagram is currently set to a small zoom factor because you wanted to see it 
in its entirety. Now you decide to zoom in on a particular diagram element and its environment. 
Place your mouse cursor on that diagram element, and press the period key until you can see in 
detail everything that interests you.

Zooming via the Toolbar

Another option is to zoom via the toolbar. Proceed as follows. Click the arrow next to the zoom 
combo box to display the zoom options:

Now click the desired zoom factor in the list. If you select Wnd, the entire diagram image will 
be scaled to fit the current window. Or, you can select a particular area in your diagram (for 
example, by holding down Shift and clicking several diagram elements). Then select WndS, and 
only the selected area (marked in blue) will be scaled to fit the current window.

�
The actual keys used for zooming in and out may vary, depending on your keyboard layout (i.e., 
the language used).
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Zooming via the Zoom Command

Alternatively, you can open the View menu and select the Zoom... command. The following 
dialog is displayed:

Figure 2-26: Zoom dialog

Click any of the radio buttons for a preset zoom factor. Or, in the Custom field, enter any desired 
factor between 5% and 99%. Click OK.

2.4.15 Searching for Diagram Elements

If you have created a large diagram, it is useful to have a mechanism that allows you to quickly 
locate elements in it. 

To use GRADE’s search function, proceed as follows:

1 Open the Search menu and activate Find... or click the search icon in your GRADE 
toolbar:

�
The zoom feature can be used to a limited extent for resizing model trees, as well. Simply open the 
tree, click the zoom icon, and select the percentage needed. The Wnd and WndS options, however, 
are not available for use with model trees.

If you wish to zoom your diagram only for printing purposes, you can use the special Zoom for 
printing command or “drag” the page borders as necessary. For more information, see “Zooming the 
Diagram to Fit Your Paper Size” on Page 384 and “Moving Page Borders to Make Your Diagram Fit 
Paper Size” on Page 384.
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2 A Find dialog will open. Here, enter the name that you are searching for and specify any 
other special requests (e.g., you can make the search case sensitive, if you wish).

3 In this example, sales was entered. No other restrictions were put on the search, with the 
aim of locating all symbols having something to do with sales. The Find window then 
displays the matching elements that were retrieved:

Figure 2-27: Find dialog

4 To view the found elements in the diagram itself, click OK. You will then see one of the 
found elements framed in red. To view the additional ones, open the Search menu and 
select the Continue search... command. Or click the Repeat last search icon:

�
The search mechanism can be used in ORG as well as in other types of GRADE diagrams. It can 
also be used to locate diagrams in the model tree.
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2.4.16 Printing Diagrams and Models

�
The procedure for printing diagrams is essentially the same, no matter what type of diagrams 
(ORG, BP, etc.) you wish to print. Note that you can plot diagrams that are as large as several meters 
in length, or use your diagram as the basis for a poster-size business graphic.

For more information about printing, please see “How Can I Optimize the Printouts of My 
Models?” on Page 378.
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Chapter 3
Business Process Modeling: BP Diagrams

3.1 Business Modeling: Basic Concepts

In this chapter, we will continue working on the sample business model that we began in 
Chapter 2. Having laid the foundation of the model with our ORG (organizational) diagram, 
we can now proceed with the business process (BP) diagram, which is the centerpiece of business 
modeling. First, however, we need to familiarize ourselves with the purpose of the BP diagram 
and its major elements.

The main goal of BP modeling is to describe a business system’s behavior. This type of modeling 
is based on two fundamental concepts: tasks and events.

• A task, as defined by Webster’s dictionary, is a “piece of work.” Within the context of 
GRADE business modeling, we use the term “task” to refer to an activity performed by a 
business system. Tasks may be very large, for example, manufacturing within a multi-
national enterprise, or very small, like signing a document.

• Events represent things that can happen in a business system; more specifically, events link 
or initiate tasks. For example, when Dad has finished making his extra-special pancake 
breakfast, he yells: “Breakfast is ready!” That’s the event that initiates a new task; the family 
comes running to the kitchen.

BP diagrams are organized hierarchically; thus, the big, high-level tasks are described in terms 
of smaller tasks, events, timers, data stores, data objects and decisions. Timers are used to 
prompt tasks and events that are time dependent. For example, if the mail, which contains 
customer orders, is delivered every workday at 1:30 p.m., a timer could be set in the BP diagram 
to reflect this. A data store represents a persistent (long-term) store of data or goods; a data 
object refers to the temporary storage of a single unit of data or goods.

The graphical representation of a BP is similar to a flowchart. It contains task/timer symbols, 
which represent tasks or timers that are an integral part of the depicted business process; these 
symbols are framed in solid lines. The BP diagram may also contain reference symbols, framed 
in dashed lines; these represent tasks/timers that are related to the process being depicted, but 
are not formally part of it.

The symbols in BP diagrams are connected by event arrows, decision paths and access paths.
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All of these elements are described in more detail later in this chapter.

Each task in a business process diagram is represented by default as a light blue, rounded 
rectangle.

A task symbol contains the task name and possibly other attributes, such as the performer, the 
triggering condition that must be achieved before the task can occur, the duration, etc. The task 
symbol may also include an information attribute, which is an informal description of the task.

Types of Tasks

There are two types of tasks:

• ordinary tasks (also known as transformation tasks), such as assembling a telephone

• decision tasks (also known as branching tasks), such as deciding whether to fill a customer’s 
order for 100 telephones. Decision tasks have one or more named decision symbols attached 
to them. These decision symbols are represented by green hexagons. A decision path 
connects the task symbol to a decision symbol.

In the following figure, an ordinary task can be seen on the left: A factory worker assembles a 
telephone. A decision task can be seen on the right: An accountant decides whether the order is 
“OK” or “not OK.” (If the accountant determines that this particular customer never pays 
his/her bills, the order for 100 telephones might be rejected as “not OK”!)

Figure 3-1: Ordinary task and decision (branching) task

Types of Events

An event arrow indicates that an event has occurred; this event may initiate the next task. As you 
will see in the list below, the term “event” is used broadly in GRADE and also can be used to describe 
various types of flows. There are basically four categories of events:

• Events with the category “message” correspond to objects produced by one task and 
transmitted to another. This may be an informal object, such as a notice that something has 
been completed, or formal, such as an invoice, bill, report, etc., when the information is 
formally associated with the event via a corresponding data type (for more information about 
data types, see “Converting Business Models to System Models” on Page 262). Message 
events always have a name, which appears next to the arrow.
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• Material events represent the flow of materials. Material events always have a name, which 
appears next to the arrow.

• Control flows simply express the fact that one task is completed and the next task may start. 
Control flows are represented as arrows without a name.

• Timer events take place at a certain moment or are generated at specified intervals by an 
imaginary “timer,” which is represented as a small clock and connected to a task by an arrow. 
Each timer event has a name.

All named events are also automatically registered in the event table (ET) of the business model. 
You also can manually supplement the event table with more details about events.

The following figure shows examples of events as they are depicted in BP diagrams. From left to 
right, you can see a message event, a control flow and a timer event.

Figure 3-2: Examples of events

Specifying Task Details

A triggering condition may be associated with any task as one of its essential properties. A 
triggering condition specifies the combination of input events (or a single input event) necessary 
to start the task. This condition is often specified as a so-called Boolean formula; in other words, 
event names are combined with the words AND or OR. For example, if a task can be triggered 
only after a customer order and the payment have been received, the Boolean formula for the 
triggering condition would look like this: Order AND Payment. More advanced triggering 
conditions are also available.

The next important part of a task is its performer. Performer specification consists of one or 
more performer names (in the case of several names, they will be joined by AND and/or OR). 
(Instead of AND, you can use &, and instead of OR, you can use |). Performers may be 
organizational units, persons (positions) or equipment (resources). The performers are specified 
in the organization diagram (ORG diagram) of the business model.

In the task symbol, you can also specify the duration of the task, i.e., its required execution time. 
This may be defined simply as “1h” for one hour, “2d” for two days or “5m” for five minutes. 
(In more complicated cases, where the duration is variable, it may be defined as a formula. For 
more information about this, please see the Language Guide.)
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The following figure shows how a task can be specified. Here, the processing of the order takes 
place only if the triggering condition is met (an approved order has arrived and it is Friday 
morning). The performer is a secretary. The duration of the task is 15 minutes. 

Figure 3-3: Specified task

You can specify even more of the task’s formal and informal details in its task details diagram 
(TD); for more information, see the Language Guide.

In any description of a business model’s behavior, there may be tasks that affect the business 
system, but are not formally part of it: e.g., a customer creating an order. These are referred to 
as external tasks and are framed in dashed lines, as you can see in the following figure:

Figure 3-4: External task

A task reference is similar to an external task. It is not formally a part of the current BP diagram, 
but is part of the overall business model. A task reference represents a link to a related task 
located one or more levels above. Graphically, a task reference is represented by a light blue, 
rounded rectangle within a dashed rectangle. In the following figure, filling the order is a task 
described in the current diagram, but first, the manufactured auto parts were inspected and 
approved. 

Figure 3-5: A link from a referenced task (dashed frame) to a “normal” task

It is also possible to have an external reference; this represents a link to a related external task 
located one or more levels above. An external reference appears as a pink task in a dashed 
rectangle.
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BP diagrams also may include inline tasks, which represent simple activities. When creating an 
inline task, you typically fill in just the name of the operation.

Data Symbols

Two special symbols represent the use of data in a BP diagram:

• As mentioned earlier, a data store symbol indicates a persistent store of data or materials. A 
typical use of the data store is to represent a related database. For example, a Directory 
Assistance operator might access a database (data store) containing telephone numbers. In 
such cases, the contents of the data store can be described in detail in an entity-relationship 
(ER) diagram. On the other hand, data stores may simply represent a stock of goods. Data 
stores appear as green parallelograms and are connected to tasks by lines called access paths.

• A data object represents just one unit. It is a temporary store of information or materials. A 
data object is represented by a green rectangle. A task is connected to a data object via an 
access path.

To better understand the difference between a data store and data object, consider the following 
example. The mayor of New York has been kidnapped, and Agent 99 has been called upon to 
help solve the crime. During his first day on the case, Agent 99 analyzes the available 
information, making use of an anonymous tip and a database of known and suspected terrorists. 
The tip, which is later rejected as untrustworthy, is a single, temporary unit of information; it 
is represented in the following figure as a data object. The terrorist database, meanwhile, 
represents a persistent store of data and is thus represented as a data store.

Figure 3-6: Task linked to data store (left) and data object (right)

Note that inline tasks may not be used if you plan to simulate the model.
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Pulling It All Together

You are now familiar with the basic elements used by GRADE to represent business processes. 
To see how these elements work together, take a look at the following example. It illustrates the 
task of handling orders:

Figure 3-7: Example of a business process (BP diagram)

As you can see, the process starts with an external task (the customer creates an order). When 
the customer order arrives at the auto parts company, it is registered and the customer’s credit is 
checked. This credit check depends on the information in the customer database, which is 
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maintained by the Finance Department and which can be accessed by members of the Sales 
Department. If the customer has an acceptable credit rating, the order is filled and the product 
is sent along with an invoice. A customer with a poor credit rating receives a rejection letter.

3.2 Structure of the Business Process

The following figure represents the business-model tree as it will appear when we have created 
our BP diagram. As you can see, the BP information appears in the tree hierarchically. There is 
a main task, called Handling Orders, which is made up of a series of subtasks: checking customer 
credit, creating an order, etc.

Figure 3-8: Model tree Handling Orders

The diagram types appearing in this tree have already been introduced; if you have any 
questions, refer to “Appendix B: Glossary” on Page 443 for quick reference.

�
You may notice that there is a TD, or task details, diagram, corresponding to each task making up 
the business process. TD diagrams, which are generated automatically as you create new tasks in a 
BP diagram, are used to describe all properties of a task and its possible links to other tasks. If you 
prefer not to have TD diagrams generated automatically as you work, you can turn this feature off 
by opening the Options menu and selecting Settings... Then deselect the check box next to Auto BP-
>TD.
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3.3 Getting Started With Your BP Diagram

If you created the ORG diagram described in Chapter 2, you already have a business-model tree 
named Handling Orders; it contains an empty BP diagram, which you can simply fill out.

Assuming that you now have the Handling Orders business-model tree on your screen, you can 
open the BP diagram to start work by double-clicking it. A diagram window like the one 
pictured in Figure 3-9, Page 83, will open. A large part of business modeling takes place in this 
window.

�
If you did not create the model tree described in Chapter 2, go ahead and create a new model now. 
It should be named Handling Orders, and should be of the type business model. You will find 
complete instructions for this in “Creating a Model” on Page 37. It is strongly recommended that 
you create the ORG diagram before producing the BP diagram, since the performers in the BP 
diagram are transferred in from the ORG diagram.
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3.4 Business Process Diagram Window

The following figure presents the BP diagram window as it will appear at the start:

Figure 3-9: Business process diagram window

We will not be describing the screen elements from top to bottom here because most of these 
are the same as in the ORG diagram. For more information, take a look at that description in 
Section “ORG Diagram Window” on Page 39.
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The BP diagram does, however, have a menu bar that differs slightly from that of the ORG 
diagram. You will find an overview of the major BP menu functions in the following figure. The 
most important menu commands also will be discussed as we go along.

Figure 3-10: Major menu functions in the BP diagram window
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Note, also, that the BP window has a different symbol palette than does the ORG window. It is 
very important to familiarize yourself with these icons, since they provide a fast and easy way to 
create the elements in a BP diagram:

Symbol Name Function

Deselect Cancels a selection in the symbol palette. If you select an 
element in the symbol palette, then decide it was the 
wrong one, click this arrow to deselect your choice. 
(Note: In the case of many elements, a dialog window 
will open as soon as you select them. In that case, simply 
click Cancel, then select the symbol you want.)

Task Creates a task symbol

External task Creates an external task symbol

Timer Creates a timer symbol

Decision Creates a decision symbol

Data store Creates a data store symbol

Data object Creates a data object symbol

Task reference Creates a task reference symbol

External reference Creates an external task reference symbol

Timer reference Creates a timer reference symbol

Event or path Creates an event or path symbol. An event symbol 
indicates that an event has occurred. This may initiate 
the next task. In GRADE, “event” is used in a broad 
sense and may be a control flow, material flow, etc. An 
access path connects a task to a data store or data object. 
A decision path connects a task symbol to a decision 
symbol.

Inline task Creates an inline task, which is used to represent a 
simple activity.

Simulation show box Creates a show box symbol. Show boxes are used only 
during animation of a model; for more information, see 
the Simulation Guide.

Free comment Creates a comment symbol so that you can add a stand-
alone comment to your BP diagram.

Table 3-1: Symbols in the business process diagram
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�
If your symbol palette does not include all of the above symbols, you are probably working with an 
older model. To display the full symbol palette, activate the model tree, then open the Options menu 
and click Restore default stereotypes.

GRADE also lets you define your own stereotypes; for example, you might want to define a special 
task symbol having a particular color and shape to represent a particular type of task. If you wish, 
you can create an icon for this stereotype and add it to the BP diagram symbol palette. GRADE also 
lets you modify existing icons in this palette. For more information, see “Stereotype Table (STE)” 
on Page 317.
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3.5 Working With Business Process Diagrams

Let’s now start creating the symbols found in the sample diagram, Handling Orders, presented 
here:

Figure 3-11: Business process diagram Handling Orders
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3.5.1 Creating an External Task Symbol

Let’s model the system from top to bottom, starting with the Create Order external task symbol.

Normally, an external task symbol is created by clicking the corresponding icon in the symbol 
palette. (This icon, a red rectangle, appears near the top.) A dialog then opens in which you 
can fill in information about the external task, then click OK.

Because the diagram already contains an empty task symbol, however, we will use a different 
approach. We will turn this task symbol into an external task symbol. To do so, proceed as 
follows:

1 Click with your left mouse button on the task symbol to activate it (it now should be 
framed in red):

2 Hit Return (Enter) to open the Occurrence of Task dialog:

Figure 3-12: Occurrence of Task dialog

3 In the Name field, enter the name of the external task (Create Order).
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4 Just below the Name field, click in the External check box. This is necessary because we 
are changing the task symbol into an external task symbol.

5 Click the Performer tab:

Figure 3-13: Performer tab

6 Select the performer by clicking the down arrow next to the from ORG field. A list of 
performers from your ORG diagram will appear. (If you have not created an ORG 
diagram, you can fill in this field manually by simply typing in a name or names.) To 
select a performer from the list (in this case, Customer), click it, then click the left arrow 
button:

7 If your external task happens to have more than one performer, you would now click 
the AND or OR button. Then you would open the performer list, select a performer and 
click the left arrow button. Repeat as necessary.

8 When you have completed your entries, click the OK button. The external task symbol 
appears in the diagram:
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3.5.2 Creating a Task Symbol

The next element in our diagram is the task symbol Register Order.

To create it, proceed as follows:

1 Click with your left mouse button on the task icon in the symbol palette (it is light blue 
and appears near the top).

2 The Occurrence of Task dialog box appears:

Figure 3-14: Occurrence of Task dialog

3 Enter the name of the task (Register Order) in the Name field.

4 Click the Performer tab at the top of the dialog window. Next to the field named from 
ORG, click the downward arrow to reveal a list of possible performers. Select a performer 
by clicking the name (in this case, Clerical staff). (GRADE has automatically inserted an 
underscore between Clerical and staff where you had a blank space; do not let this bother 
you.) To confirm your choice, click the left arrow button next to the from ORG field. 
(You can also enter several performers in this way, as described in the previous section, 
or type in several performers.) 
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5 Click the OK button to close the dialog. Your diagram now contains two box symbols. 
GRADE automatically inserts an event arrow between them, indicating that the task 
Create Order is followed by the task Register Order:

Labeling Event Arrows

Now let’s add a label to the event arrow. Click the arrow to activate it, then press Return to 
display the Event dialog. Type New Order into the Name field, then press Return again to close 
the dialog. (Event arrows will be described more fully in “Creating an Event Arrow” on Page 95.)

Now make sure Register Order is activated, then create the next task, Check Customer Credit. 
Since this task has two performers, you will need to select Salesman Associated VP, then click the 
arrow button, then AND, then select Clerical staff, then click the arrow button, then on OK.

Then select the event arrow, press Return, give it the name Order, and press Return again.

3.5.3 Creating a Decision Symbol

The last box symbol created, Check Customer Credit, is a branching task that leads to the decision 
symbols Credit OK and Credit not OK.

�
Note that in BP diagrams, the Vertical layout option is set by default. This means that GRADE will 
automatically arrange your symbols in vertical columns and create appropriate connecting lines 
between them (the currently active symbol will be connected to the newly created symbol). This 
makes your work easier. For information about the various layout options for BP diagrams, see 
“Layout Styles” on Page 114.
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To create these decision symbols, proceed as follows (first making sure that Check Customer 
Credit is activated):

1 Click the decision icon (a green hexagon) in the symbol palette. The Decision dialog 
appears, as seen in the following figure:

Figure 3-15: Decision dialog

2 In the Name field, enter the name of the decision (Credit OK).

3 Click the OK button. A symbol like the following one appears (GRADE has 
automatically inserted the required decision path):

Before you create the next decision symbol (Credit not OK), activate the Check Customer Credit 
symbol again. This will ensure that Check Customer Credit will be linked by a decision path to 
Credit not OK.

Once you have created Credit not OK, make sure that it is activated, then create the Send 
Rejection task (do not forget to enter the performer for each created task). Then activate the 
event arrow and enter the event name Rejected Order. Then activate Send Rejection and create the 
Receive Rejection external task. Insert the event name Rejection Letter.

Now activate the Credit OK symbol and create the symbols leading down from it: Fill Order, 
Pack Product, Ship Product With Invoice and Receive Product and Invoice. Add the appropriate 
names to the event arrows.
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3.5.4 Specifying the Triggering Condition

You are now ready to create the other branch, showing how the invoice is prepared and sent. 
Note that the task symbol Prepare Invoice not only has a name and a performer, but also a 
triggering condition: Approved Order AND Weekday mornings. Thus, this task takes place only 
if an approved order has been received AND if it is morning. (The secretary always prepares 
invoices early in the day, then goes out for a three-martini lunch; no one expects her to do any 
work in the afternoon!) If the triggering condition had an OR rather than AND, the task could 
be started if either of the conditions were met.

Start by creating a task as usual: First make sure Pack Product is activated, then click the task icon 
in the symbol palette. In the Occurrence of Task dialog, fill out the task name (Prepare Invoice) 
and performer (Secretary), but do not yet click OK. 

To specify the triggering condition, proceed as follows:

1 Assuming that the Occurrence of Task dialog is still open, click the Trigger tab.

2 Note that there is a field marked from ET. Click the downward arrow next to it to reveal 
a list of events. Use your downward arrow key to move through this list and highlight 
one of the events that triggers the task (in this case, Approved Order), then confirm your 
selection by clicking the left arrow button:

3 You can select events from the from TD list as well, if you have a model that contains 
task descriptions.

4 To place an AND or an OR after the event, click the appropriate AND or OR button 
(in this case, AND).

5 You now want to select the next triggering event (in this case, Weekday mornings). Since 
this event has not yet been entered into the diagram, you cannot select it. Thus, simply 
type Weekday mornings after AND.
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6 If you have many events and wish to start a new line, click the nl button. As you fill in 
the triggering condition, the trigger tab will look something like the following figure:

Figure 3-16: Trigger tab of the Occurrence of Task dialog box

7 Click OK to complete the process.

Make sure Prepare Invoice is activated, then create Register Invoice. Add the appropriate event 
names (Approved Order and Invoice).
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3.5.5 Creating an Event Arrow

We now need to manually create an event arrow between Register Invoice and Ship Product With 
Invoice.

Proceed as follows:

1 Click the event/path icon (appears as a simple line in the symbol palette).

2 Move your mouse pointer (appears as a +) to the Register Invoice task symbol and hold 
down the left mouse button. (You start here because the Register Invoice symbol is the 
source, where the connection starts.)

3 Drag the mouse to the second task symbol, Ship Product With Invoice, and release the 
mouse button. This task symbol is the target, to which the connection is to be made. 
The Event dialog appears, as shown in the following figure:

Figure 3-17: Event dialog

4 In the Name field, enter the name of the event (Invoice). (Or select this event name by 
clicking the downward arrow next to the Name field, then clicking Invoice.)

5 Confirm the entry with the OK button.
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The event arrow, labeled with the desired name, appears in the diagram.

Event Table

The event Invoice has been registered automatically in the event table. To check this, proceed as 
follows:

1 Save your work by clicking the Save button in the toolbar:

2 Then click the Open event table button in the toolbar:

3 Now you will see the event table, including the event Invoice:

Figure 3-18: Event table

3.5.6 Creating a Timer Symbol

Your diagram now requires the timer symbol, which will be set for weekday mornings, 9 a.m.

To create this symbol, proceed as follows:

1 Click the timer symbol, near the top of the symbol palette.
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2 An editing window appears:

Figure 3-19: Timer window

3 Click either the + or the -- button as needed to reset the clock.

4 Click the OK button to leave the window.

It is possible that your newly created timer symbol is not near the Prepare Invoice symbol, where, 
ideally, it should be. In that case, click the timer symbol with your left mouse button, then hold 
down the button and drag the timer to a position directly above the Prepare Invoice symbol, to 
which it will be linked. Do not worry about a possible lack of space to insert the timer; GRADE 
will adjust the diagram as necessary.

Now create an event arrow between the timer symbol and Prepare Invoice and insert the name 
Weekday mornings.

�
Note that setting the timer as described above is sufficient for modeling purposes. If you want to 
simulate the model, however, you will need to define the time via the Event dialog or directly in the 
event table. For example, you could specify that the event Weekday mornings refers to something that 
is repeated Monday through Friday at 6:39, and your simulated model would behave accordingly 
(even if the clock in the diagram says 11:00).

For an example of an event table, please see “Event Table” on Page 96; for information about how 
to define times for simulation, please see the Language Guide.
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3.5.7 Creating a Data Store

Still missing from your diagram is the data store symbol entitled Customer Data. Since we want 
it to be linked to the Check Customer Credit symbol, click that symbol first.

Then proceed as follows to create the data store symbol:

1 Click the data store icon in the symbol palette (appears as a green parallelogram). The 
Data Store dialog box appears, as seen in the following figure:

Figure 3-20: Data Store dialog

2 In the Name field, enter Customer Data, then click OK. The data store symbol then 
appears in the diagram window:

3.5.8 Creating an Access Path

GRADE has automatically inserted an access path between the task Check Customer Credit and 
the data store symbol Customer Data. This indicates that members of the Sales Department have 
access to the customer data. You should be aware that various types of access can be specified:

• Read, which means that the given performer(s) can view but not modify or delete the 
information;

• Write, which means that the given performer(s) can input new information, but not view, 
modify or delete the existing information;
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• Read and write, which means that the given performer(s) can view, modify and delete the 
existing information, as well as add new information.

The type of access is indicated by the appearance of the access path. Read access is indicated by 
a circle at the performer’s end:

Write access is indicated by a circle at the data end:

Read and write access is indicated by a line without circles:

As you can see in Figure 3-11, Page 87, members of the Sales Department have only Read access 
to the customer database (a circle appears at the performer end of the access path).

To specify this Read access, proceed as follows:

1 Click the access path leading to Customer Data with your left mouse button to activate 
it.
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2 Press Return. The Access Path dialog appears, as seen in the following figure:

Figure 3-21: Access Path dialog

3 Specify Read access rights by clicking the appropriate radio button.

4 Click OK.

Our diagram requires one more access path, connecting the Register Invoice (performer Finance 
Department) to Customer Data. Because the Finance Department is responsible for preparing 
invoices, making sure that bills have been paid and keeping a record of customers who do not 
pay their bills, this department has Read and write access to the customer database. To create 
this new access path, proceed as follows:

1 Click the access path icon in the symbol palette (it appears as a line with a ball on the 
end).
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2 Use your mouse to drag a line from the Register Invoice symbol to the Customer Data 
symbol. The Access Path dialog appears, as seen in the following figure:

Figure 3-22: Access Path dialog

3 Because Read and write mode is the default setting (i.e., it is already marked), all you 
need to do is click the OK button.
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Custom-Shaping a Line

At this point, you may notice that this new access path crosses other lines and is not the clearest 
path that can be drawn:

Figure 3-23: BP diagram with access path crossing other lines
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As the Vertical layout style, which has been set by default, will not allow us to “grab” a line and 
reshape it as desired, we will use a different strategy: Make sure that the new access path is 
activated, then hit Del. The line has been deleted. Now click the arrow next to the layout combo 
box to reveal other layout styles and click Manual:

Now redraw the line by clicking the access icon, then dragging from the lower left part of Register 
Invoice to Customer Data. Drag a line with the desired shape, clicking your right mouse button 
to create right angles where you want them. When you have finished dragging and release the 
mouse button, the Access Path dialog will appear. Simply press Return. Here is how the lower 
part of the diagram appears with a redrawn access path:

Figure 3-24: BP diagram with redrawn access path

If you need to readjust your new line, make sure it is activated, then use your mouse pointer to 
drag as needed.
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For more information about drawing, shaping and renaming lines, see “Modifying Connecting 
Lines and their Texts” on Page 112. 

�
The Manual layout style should be used only when a diagram is just about ready. This style lets you 
put the finishing touches on your diagram by repositioning elements as needed. During the early 
and middle stages of modeling a system, it is better not to use Manual.
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As you are working in Manual style, which gives you more freedom to reposition diagram 
elements, you can now click event names and drag them to slightly different positions, if you 
believe this will improve the diagram’s appearance. Your finished product should look 
something like this:

Figure 3-25: Finished BP diagram

Congratulations on finishing your BP diagram! You are now familiar with the fundamental 
principles of GRADE business modeling.
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In the rest of this chapter, we will learn about BP symbols that did not occur in our example but 
that may be useful when you start modeling your own system. At the end of this chapter, you 
will find hints to help you work more efficiently with BP diagrams and achieve optimal results 
in terms of layout.

3.5.9 Creating a Timer Reference Symbol

You are already familiar with the timer symbol. Do not confuse it with the timer reference 
symbol, which looks similar, but appears in a box with dashed lines:

The difference between the two symbols is that the timer is an integral part of the current BP 
diagram and can be used in a simulation to start events; the timer reference is a link to a timer 
that occurs in the business model one or more levels above. The timer reference symbol itself 
has no spontaneous activity, unless the corresponding timer at another level generates an event.

A timer reference symbol is created in nearly the same way as a regular timer. Simply follow the 
steps in “Creating a Timer Symbol” on Page 96, but select the timer reference symbol from the 
symbol palette instead.

3.5.10 Creating a Decision Path 

In our example, decision paths (connecting task symbols to decision symbols) were created 
automatically by GRADE.

If you ever need to create one manually, proceed as follows:

1 Click the event/path icon in the symbol palette (appears as a simple line).

2 Position your mouse pointer (appears as a +) on the task, then hold down your left 
mouse button and drag over to the decision symbol. Release the mouse button.

3 No dialog window appears and no name is entered, but a line will be drawn.

3.5.11 Creating a Task Reference

As you may recall, a task reference is a symbol that is not formally part of the business process 
being described, but is part of the overall business model. A task reference represents a link to 
a related task located one or more levels above. The task reference symbol is a light blue, rounded 
rectangle in a square, dashed-line frame.
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To create a task reference symbol, proceed as follows:

1 Click the task reference icon in the symbol palette. The Task Reference dialog box 
appears:

Figure 3-26: Task Reference dialog

2 In some cases, the task that you want to make reference to may not yet exist in the 
business model. In that case, you can simply click OK or press Enter to create a task 
reference symbol with no content. You can enter the content later by activating the task, 
then hitting Enter to reveal the Task Reference dialog.

3 If, however, you already know what task or tasks you want to make reference to, you can 
select and enter them in the Names field. To do this, click the downward arrow next to 
the Select tasks field, then use your downward arrow key to browse through the list, then 
select the task you want by hitting Enter (or clicking it), then confirm your selection by 
clicking the left arrow button:

4 The task name will appear in the Names field. If you want to select more than one name, 
repeat the process. GRADE will automatically insert commas between the task names. 

5 If you wish, you can fill in the Comment field (use Ctrl+Enter to create a new line of text 
here).

6 When you are satisfied with your entries, click OK or press Enter. The task reference will 
appear in the diagram.
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3.5.12 Creating an External Task Reference

An external task reference differs from a task reference only in that the reference is to a task 
executed by an external performer. For example, your business model represents an airplane 
manufacturer, but you want to make an external task reference to a supplier who delivers the 
upholstered seats.

The creation of an external task reference is analogous to creating a regular task reference (except 
that you must select the external task reference icon in the symbol palette). You will find the 
instructions in “Creating a Task Reference” on Page 106.

3.5.13 Creating a Data Object

You will recall that a data object refers to the temporary storage of a single unit of data or goods.

To create a data object, proceed as follows:

1 Click the data object icon (a green rectangle) in the symbol palette. The Data Object 
dialog appears:

Figure 3-27: Data Object dialog

2 Enter the data object name and, if needed, the data-type name. At present, you need not 
worry about data types; they will be described in Section “Converting Business Models 
to System Models” on Page 262. You can pick a type or a name by using the Pick type or 
Pick name buttons. (If you pick a type in this way, be sure to click the left-arrow button 
in the Pick Data Type dialog window to confirm your choice.)

3 If you wish, enter a comment in the Comment field. (To create a new line of text, use 
Ctrl+Enter.)

4 Click the OK button or hit Enter to confirm your entries. The new data object appears.
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3.5.14 Creating a Free Comment

Sometimes you may want to insert additional comments or other information into your BP 
diagram, but cannot find an appropriate location. That’s the time to use a free comment.

Free comment symbols appear as rounded, gray rectangles and can be placed at any location in 
your diagram. Free comments are not affected by automatic diagram layout mechanisms.

To insert a free comment, proceed as follows:

1 Click the free comment icon (a yellow box) near the bottom of your symbol palette. 
Then click at the location where you wish to place the comment.

2 The Free Comment dialog box will appear:

Figure 3-28: Free Comment dialog box

3 In the large field, enter your text. (Use the key combination Ctrl+Enter to create a new 
line, if necessary.) Since your text may contain references to various symbols in the 
diagram, you can use the Pick name button to insert these names into your text.

4 When your comment is complete, click OK or press Enter.

Note that your comment symbol may also include a graphic. For more information about this, 
see “Additional Hints” on Page 336.

3.5.15 Creating an Inline Task

As mentioned, inline tasks are used to represent simple activities. When creating an inline task, 
you typically enter just the name of the operation (thus, these are called “nameless” tasks). The 
inline task will appear in the BP diagram, but will not have an associated task details (TD) 
diagram in which the task can be further refined.
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To create an inline task, proceed as follows:

1 Click the inline task symbol, which appears as a yellow rectangle near the bottom of the 
symbol palette.

2 In the Operation field, enter the name of the operation, e.g., Wait for order to arrive or 
Display loan application. Generally, no further entries are necessary.

3 Click OK.

3.5.16 Creating a Simulation Show Box

Show boxes are used only during the animation of a business model to display the current values 
of attributes (for more information about this, see the Simulation Guide). Otherwise, they have 
no effect on modeling or simulation.

To create a show box symbol in a BP diagram, proceed as follows:

1 Click the simulation show box symbol at the bottom of the symbol palette, then click 
at the position where you want to insert the show box.

2 The Show Box dialog appears, as seen here:

Figure 3-29: Show Box dialog

3 In the Title field, you may enter the name of the show box (any short text).

4 In the subsequent fields, you may enter the name of a business process, task and/or 
attribute by clicking the downward arrow next to the corresponding fields, then clicking 
the appropriate entry. (Note that there is no obligation to fill out any of the fields of the 
show box; what you fill in is up to you.)
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5 Click the OK button or press Enter. A shadowed, gray rectangle will appear in your 
diagram.

Now you have learned how to create all the symbols and connectors that may appear in a BP 
diagram.

3.5.17 Modifying the Elements in Your BP Diagram

The First Step in Editing: Activation

If you want to change the appearance or contents of symbols in your BP diagram, keep in mind 
that the symbol in question must first be activated. For more information about activating a 
single symbol or selecting an entire group of symbols, please see “Activating Versus Selecting 
Diagram Elements” on Page 67.

Changing the Positions and Sizes of Diagram Elements

For more information about changing the positions and sizes of symbols, please see “Changing 
the Position and Size of Diagram Elements” on Page 51. To set a standard width for symbols, 
refer to Page 52.

In BP diagrams, you will have maximum freedom to reposition symbols, lines and line texts if 
you activate the Manual, Oblique manual or Oblique semiauto layout styles; for more 
information, see “Layout Styles” on Page 114.

Copying Diagram Elements

Symbols in BP diagrams can be copied. You may want to copy a symbol and paste it elsewhere 
in the same BP diagram or a different BP diagram. (GRADE, however, will not permit pasting 
objects into dissimilar diagram types, e.g., a BP element into an ORG diagram.)

�
To hide the show boxes in a BP diagram, open the Options menu and select Show Show boxes. To 
make them visible again, do the same. (If a check mark appears beside this menu command, it 
means the boxes are visible.)
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Whether you are copying elements in an ORG diagram or a BP diagram, the process is 
essentially the same. For more information, see “Copying, Pasting and Moving Diagram 
Elements” on Page 66.

Editing and Deleting Diagram Elements

For information about this topic, please see “Editing and Deleting Diagram Elements” on Page 
52.

Making the Contents of Diagram Elements Invisible

When you create BP diagram symbols and enter text, this text, of course, is normally visible. If, 
however, you wish to make any text element invisible, this is possible. For more information 
about this, see “How Can I Streamline My Diagrams by Making Some Texts Invisible?” on Page 
367.

Modifying Connecting Lines and their Texts

The connecting lines in BP diagrams (event arrows, decision paths and access paths) can be 
modified in various ways.

If you wish to change the shape of an existing line, proceed as follows:

1 Activate the Automatic, Manual, Oblique semiauto or Oblique manual layout style. (For 
more information about this, see “Layout Styles” on Page 114.)

�
Note that you cannot copy an individual connector (e.g., an event arrow) in a BP diagram. You can, 
however, copy a connector along with the symbols attached to either end of it. To do this, you will 
need to first select all three elements. For more information about selecting several elements, please 
see “Activating Versus Selecting Diagram Elements” on Page 67.

�
In BP diagrams, there is an easy way to convert symbols from internal to external and vice versa. 
To make a task or a task reference external, simply activate the symbol, hit Return, and mark the 
External check box. Click OK.

To make an external task or an external task reference internal, follow the same procedure, but 
unmark the External check box. Click OK.

�
These techniques can be used in other GRADE diagrams, as well.
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2 Click the line to activate it, and make sure your mouse pointer stays somewhere along 
the line.

3 Hold down your left mouse button to drag the line as necessary, then release the mouse 
button.

If you wish to define the shape of a connection while drawing it, proceed as follows:

1 Make sure that the Automatic, Manual, Oblique semiauto or Oblique manual layout style 
is activated.

2 Click the appropriate line icon in the symbol palette, then move your mouse pointer 
(appears as a +) over to the box symbol from which the connection is to start. While 
holding down your left mouse button, start “dragging” to create the required shape.

3 At the points where you want to create angles, i.e., change the direction of the line, click 
with your right mouse button (while continuing to hold down the left mouse button).

4 Complete the process by dragging over to the box symbol where the line is to end, then 
releasing the mouse button.

You can redirect a line from one symbol to another while in any layout style. (Keep in mind, 
however, that GRADE will display an error message if you try to make a connection that violates 
GRADE guidelines.) Proceed as follows:

1 Click the line to activate it.

2 Move the mouse pointer (appears as a +) to the line end that is to be moved.

3 Press and hold down the left mouse button.

4 While continuing to hold down the mouse button, move the mouse pointer to the new 
symbol.

5 Release the mouse button.

To change text associated with a line, click the line with your left mouse button and hit Return. 
A dialog box appears. Change the text and click OK.

If you are working in Manual, Oblique semiauto or Oblique manual layout style, you can also 
activate the text, then press down your left mouse button and drag it to move it to another 
position.
Business Process Modeling: BP Diagrams 113 

• 
• 
• 
•
•
•



114 

• 
• 
• 
•
•
•

3.5.18 Layout Styles

Depending on the type of diagram you are creating, GRADE gives you various layout 
possibilities. The default for BP diagrams is the Vertical layout style, but you can freely switch 
from one style to another (this is described below). These styles fall into four categories:

• Automatic or Manual

• Vertical or Horizontal

• Oblique semiauto or Oblique manual

• Vertical lanes or Horizontal lanes. 

The most straightforward layouts belong to the first group. Each symbol is selected manually 
from the symbol palette and dragged to that specific location in the diagram where it should be 
inserted, much as in a simple graphics program. In Automatic style, GRADE ensures that no 
object overlaps another object, and optimizes path and symbol positioning when a new symbol 
is inserted or a symbol is moved. Manual layout is essentially the same, except that GRADE 
allows you to position each symbol element manually; GRADE will not reposition anything. 
This means that you can move an event name away from its event arrow or place one object on 
top of another. Manual layout is used to optimize a diagram in a very specific way, or to place 
symbols closer to each other than GRADE would normally allow.

The second group of layouts, Vertical and Horizontal, share one common attribute: They 
support a form of automatic “prompting.” In each case, you first select a symbol in the diagram 
to which the new symbol should be attached, then you select the desired icon from the symbol 
palette. GRADE will immediately open the editing window for the new symbol. GRADE 
automatically inserts the symbol, along with the appropriate connector, after the previously 
selected symbol. GRADE also repositions the diagram as necessary after you have completed 
editing the contents of any new symbol.

The Vertical layout style positions diagram elements sequentially from top to bottom. The 
Horizontal style will produce a diagram layout with the task execution sequence from left to 
right.

The third group of layout styles, Oblique semiauto and Oblique manual, can give your diagram 
a “jazzier” appearance. You may have noticed that the GRADE connector lines are usually 
straight, or straight with rounded right angles. The Oblique semiauto and Oblique manual layout 
styles, however, let you include slanted lines in your BP diagrams. See “How Can I Use Oblique 
Layouts to Jazz Up My Diagrams?” on Page 362.

The fourth group of layout styles, Vertical lanes and Horizontal lanes, result in a very practical 
layout that allows you to quickly identify what each performer is doing. The Vertical lanes style 
arranges tasks in separate columns for each performer, while the Horizontal lanes style creates a 
row for each performer. (If your diagram contains tasks that are carried out jointly by more than 
one performer, GRADE also creates a separate column/row for each performer combination.) 
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The assignment of tasks to the proper column or row occurs automatically. The following figure 
(Figure 3-30, Page 115) shows part of our Handling Orders BP diagram in the Vertical lanes 
layout style.

Figure 3-30: Business process diagram: Vertical lanes layout style

No matter which layout style you decide to use, the procedure for selecting this style is basically 
the same:

1 Open the diagram.

�
Note that this type of layout is very flexible. You can change the order of lanes, the color of lanes 
and the font used for lane headings. For more information, please see Section “How Can I Use 
Customized Lanes to Make My Diagrams Clearer?” on Page 365.
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2 Open the Style menu and select the Layout... command. The Layout dialog box appears:

Figure 3-31: Layout dialog

3 Click the desired layout style and click OK.

As noted earlier, you can also switch layout styles by clicking the down arrow next to the drop-
down list in the GRADE toolbar, then clicking the layout style you prefer:

The layout style is set individually for each diagram and is saved together with the diagram.

If you switch to a new layout style and find this has made little or no difference in the appearance 
of your diagram, try using the Reposition command described below.

Optimizing Layout

The Reposition command allows you to optimize the layout of your BP diagram. Open the Edit 
menu, then select Reposition, then specify the appropriate submenu (All, Paths, etc.).

Undoing a Layout Change

When switching between layout styles, it may happen that the diagram elements are 
repositioned in an undesirable way. If this happens, use the key combination Alt+Backspace to 
go back to the previous style (or open the Edit menu and select the Undo layout or Undo 
reposition command, whichever is available). If you wish to undo a layout change, make sure you 
take care of this right away, before other changes are made to the layout; otherwise, it will not 
be successful.
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3.5.19 Selecting Diagram Elements

The general principles of selecting diagram elements were already described; see “Activating 
Versus Selecting Diagram Elements” on Page 67.

If you are working in a BP diagram, you should know that the Edit menu also gives you the 
selection options described here:

You can perform several selections one after another; every subsequent selection adds to the set 
of the already selected elements.

3.5.20 Operations on Selected Elements in BP Diagrams

In principle, the same operations can be carried out on a group of selected diagram elements as 
on a single, activated element. An exception is the command Edit/Symbol contents, which makes 
sense only for one currently active diagram element. But operations such as Cut, Copy, Delete, 
etc., can be performed simultaneously on several elements.

Since the selection remains after the operation has been performed, you can perform several 
operations on the selected diagram elements, one after another.

3.5.21 Changing Sizes and Alignment of Selected Diagram Elements

GRADE also has a feature that allows you to specify a uniform size for two or more symbols 
used in your BP diagram.

Specifying Uniform Size

Let’s assume you have drawn a diagram in which the president of a company performs several 
tasks. To make these tasks stand out, you decide to make them all of uniform size.

Command Meaning

Select all selects all diagram elements

Select boxes selects all task symbols, decision symbols, timer symbols, data store symbols, data object 
symbols, task reference symbols

Select lines selects all connectors

Select free comments selects only free comments

Select similar selects all diagram elements similar (by type) to the currently active one

Table 3-2: Select commands
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Proceed as follows:

1 Select all the symbols to be unified in size.

2 Open the Style menu and activate the Equate sizes command.

(Another way of making the president’s tasks stand out would be to switch over to lane layout; 
that way, the president’s tasks would be grouped in a single row or column. For more 
information on this feature, available in BP diagrams, see “How Can I Use Customized Lanes 
to Make My Diagrams Clearer?” on Page 365.)

Specifying a Uniform Width or Height

If you want to specify only the same width for certain symbols or only the same height, you 
should use another GRADE feature, the Size dialog box. For more information on this, see 
“Unifying the Height and Width of Diagram Symbols” on Page 69.

Aligning Diagram Elements

You can also automatically realign the diagram elements so that, for example, symbols are 
rearranged as a perfectly centered column or so that all the top edges are aligned.

Proceed as follows:

1 Select the diagram symbols you wish to align.

2 Open the Style menu and select the Align... command. (If the Align... command appears 
gray, i.e., is deactivated, switch to another layout style in which this feature is available.) 
The Alignment dialog appears:

Figure 3-32: Alignment dialog

3 Mark the appropriate radio button in the Vertical or Horizontal group.
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4 Click OK or hit Return to confirm your choice.

3.5.22 Other Features

GRADE offers several additional features, most of which are used to adapt the symbol layout to 
personal tastes and/or specific requirements:

• To enlarge or reduce the size of an entire diagram, see “Zooming to Enlarge or Reduce 
Diagrams” on Page 70. 

• To search for particular diagram elements, see “Searching for Diagram Elements” on Page 71.

• To change the appearance of symbols or lines in your diagram, please see “How Can I 
Custom-Design Symbols Used in Diagrams?” on Page 349.

• GRADE has an advanced feature that allows you to identify the most time-consuming 
sequence of tasks in a business process. For more information, see “How Do I Pinpoint a 
Critical Path in a Business Process?” on Page 388.

• GRADE allows you to automatically convert your completed business model into a draft 
system model. Read about this in “Converting Business Models to System Models” on Page 
262.

• To make use of GRADE’s animation, simulation or statistics-gathering features, consult the 
Simulation Guide.

3.5.23 Printing

GRADE offers you many options for printing your diagrams. You can print in color or black-
and-white; you can “zoom” the diagram so that it neatly fits your paper size; you can specify 
what you want to appear in the frame of the printed diagram. These options are essentially the 
same no matter what type of diagram you are printing. For more information, see “How Can I 
Optimize the Printouts of My Models?” on Page 379.

�
Another way of aligning your symbols is to use a layout grid. For more information about this, 
please see “Using a Grid” on Page 63. Again, your freedom to reposition diagram elements will 
depend on the layout style you are using.
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Chapter 4
Object Modeling: CL Diagrams

4.1 Object Modeling: Basic Concepts

Now that you are aware of how ORG and BP diagrams can be used to model systems, it is time 
to introduce another way of tackling the same problem.

This is to use object modeling, which was conceived 20 years ago as a novel way of thinking 
about problems using models organized around real-world concepts. The fundamental building 
blocks of object modeling are objects, classes and associations.

Objects represent real-world entities with clearly defined boundaries; these entities are 
meaningful in terms of the problem at hand.

A class describes a group of objects with common properties (attributes), common behavior 
(operations), common relationships to other objects, and common semantics. Classes are 
connected via associations. An association documents a physical or conceptual connection 
between two or more classes. Classes and the associations between them make up an object 
model of a system.

Object models are represented with the help of class (CL) diagrams. A CL diagram is an ideal 
way of organizing your ideas about a system. If several people will be working on a model, a CL 
diagram provides an opportunity to create a first draft of the model and agree on terminology 
to be used. In fact, you can use a CL diagram to create your initial sketch of a system, then use 
a special feature of GRADE to export that CL diagram to a business model. (See “How Can I 
Use a CL Diagram as the Basis for a Business Model?” on Page 402.)

Object models can play a fundamental role in the process of understanding problems, 
communicating with application experts, modeling enterprises, and designing programs and 
databases.

A system-analysis and design technique based on object modeling was described by James 
Rumbaugh in his book “Object-Oriented Modeling and Design.” The approach he describes is 
now known as the Object Modeling Technique (OMT). (For those who want to learn more 
about object modeling, we recommend the first eight chapters of this book.)
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The UML (Unified Modeling Language) gives you additional constructs for creating object 
models. UML was developed by the pioneers of the object-modeling approach. There are several 
books and tutorials describing UML, including official documentation on the World Wide 
Web. Even if you are not familiar with UML and OMT, you can easily create object models by 
following the instructions in this chapter.

If you are familiar with UML, you may be interested to learn that the UML stereotype 
mechanism has been extended considerably in GRADE. Owing to stereotypes, GRADE allows 
you to perform not only object modeling, but also use-case modeling, dynamic modeling, and 
most other modeling techniques via class diagrams.

GRADE supports an object-modeling technique using UML notation. In accordance with this 
notation, the object model of a system is a package or several packages with class diagrams. A 
package diagram (PCK) can be thought of as a “folder” containing the various parts of an object 
model. A PCK diagram can contain zero or more CL diagrams and zero or more nested PCK 
diagrams. A GRADE model can contain several packages.

Programmers will be pleased to learn that GRADE class diagrams can be exported to Rational 
Rose for source-code generation. Rational Rose is a UML modeling tool of the Rational 
Software Corporation. Diagrams that are too large to be created easily in Rational Rose can be 
drawn in GRADE, then exported to Rose.

Unlike models using ORG and BP diagrams, object models cannot be used for simulation.

Since the centerpiece of object modeling is the CL diagram, we will start by presenting its 
elements.
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4.1.1 Class Diagram Elements

Here, we offer you a CL diagram representing a simplified object model of a bank:

Figure 4-1: Simplified class diagram of a bank

Based on this example, we will introduce the CL diagram elements and explain how they are 
created.

Classes

Classes may represent data, concepts, processes, organizational units, etc. By default, a class is 
represented in GRADE by a yellow rectangle that may have as many as three regions.

The figure below presents a few examples of the types of information that can be displayed in a 
class symbol:

Figure 4-2: Class symbols

As you can see, you have the option of creating a class with merely a class name (in this chapter, 
all class names in diagrams are in bold), or can add other types of information. The terminology 
used is explained below:
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• A class name should be defined for each class.

• Stereotype refers to a class type; in our example, <<Computer>> and <<Actor>> are 
stereotypes.

• A description can be an informal definition of a class.

• Properties reflect a special UML mechanism (see “Tags and Properties” on Page 211 and 
“Using Tags” on Page 175).

• Attributes may be of various types; for example, if your class represents a department, an 
attribute may be the number of employees in that department.

• Operation is a job, task or activity; e.g., if your class represents an accounting department, 
an operation might be the preparation of the monthly report.

In the CL diagram of a bank (Figure 4-1, Page 123), you will find 11 class symbols (Bank, Head 
Office, Central Computer, Cashier, etc.). As you can see in this diagram, the default yellow 
rectangle representing a class can be changed to another shape or color.

Objects

An object is represented by default in GRADE by a green rectangle and symbolizes an instance 
of a class. For example, an object might be a single invoice or order. If a class diagram contains 
both class and object symbols, only a dependency (this is explained below) can link the objects 
and classes. Objects are sometimes placed in a separate class diagram known as an object 
diagram.

Our bank diagram contains no object symbols.

Associations

Associations establish relationships among classes. Associations may be binary, involving two 
classes, or N-ary, involving three or more classes.

As you can see in the following figure, a binary association may have two association names or 
two roles. Examples of association names are belongs to and has (e.g., Account belongs to 
Customer), while examples of role names could be provider and recipient (e.g., Factory is a 
provider for Warehouse):

Figure 4-3: Binary associations
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Class3 Class4
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1
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In our bank diagram, all of the labeled lines represent binary associations (holds, has, concerns, 
etc.). As you can see, the use of only one association name is also possible. Associations may 
display cardinalities (multiplicities), showing how many objects are linked. In our example, an 
account belongs to just one customer (1), but one customer may have several accounts (1..*).

In the following table, you can see how cardinalities are represented in class diagrams: either 
using UML or crowfeet notation.

Table 4-1: Cardinalities

As noted, the formal representation of the binary association can be paraphrased using natural 
language sentences. For example, you can read the binary association just mentioned

in both directions:

An Account belongs to exactly one Customer.

A Customer has one or more Accounts.

The first sentence is obtained by reading the association from left to right using the association 
name belongs to and the cardinality. The second one is obtained by reading the association from 
the right source class Customer to the left target class Account using the association name has and 
the cardinality 1..*. (Be aware of GRADE’s automatic placement rule: If the subject of the 
association is on the left side, then the association name or role name is placed above the 

Crowfeet Notation UML Notation Meaning

Zero or one (0..1)

Exactly one (1)

Zero or more (*)

One or more (1..*)

Number ranging from M to N (M..N)

Exactly N (N)

Undefined cardinality ( )

Account Customer
belongs to

has1..*

1
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association line, and vice versa. Here, the subject of the association belongs to is Account; it is on 
the left; thus, the association name appears above the association line. You can remember this 
rule by thinking of the hands of a clock; just as they move clockwise, so associations are read in 
a clockwise manner.)

If needed, N-ary associations can be drawn. The following figure contains an N-ary association 
(you could also call it ternary, as it involves three classes):

An N-ary association also can be paraphrased using natural language. For example, the 
association in the figure below

could be paraphrased as:

A Customer delivers a Check to the Bank Branch Office.

Our bank diagram contains no N-ary associations.

Aggregations (Part Associations)

Aggregations represent an “is part of” relationship connecting a “part class” to a “container” or 
“assembly class.” For example, in a class diagram of an Information Systems Department, the 
employees, computers and building in which the department is located all could be connected 
to the department itself via an aggregation. In that case, the employees, computers and building 

Class 1 Class 2

Class 3

role 3

role 1

role 2

Customer

Bank Branch Office

Check
delivers

to
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each would be a part class, while the department would be an assembly class. As you can see in 
the graphical representation of this example, a small diamond points to the assembly class of the 
aggregation:

Figure 4-4: Aggregation (part association)

In our bank diagram, Head Office and Branch Office are connected to Bank via an aggregation 
diamond.

Generalizations (Subclass Associations)

A generalization represents an “is subclass of” relationship between a subclass and a superclass. 
For example, the managers, programmers and testers who work for the Information Systems 
Department may be considered subclasses of the employees’ superclass. Subclasses are 
considered to be refined versions of the superclass; the superclass is said to “generalize” the 
subclasses. As you can see in the following figure, an arrow points to the superclass:

Figure 4-5: Generalization

In our bank diagram, Withdrawal and Deposit are subclasses of Transaction and are connected 
to it via a generalization arrow.

BuildingComputerEmployee

Department

1..*1..* 1

TesterProgrammerManager

Employee
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Dependencies

It is also possible to establish dependencies for classes using dependency arrows. In the following 
figure, the Manufacturer depends upon the Supplier:

Figure 4-6: Dependency

Our bank diagram contains no dependencies.

Notes

A note symbol can be used to add comments to a class diagram or to attach informal text to 
concepts, as seen in the following figure:

Figure 4-7: Notes

The note symbol may be linked to a class, an association symbol, or another note via an 
anchorline.

Our bank diagram contains only one note symbol (explaining a condition for the withdrawal of 
money).

Supplier Manufacturer

Informal text

Informal text

Class 1

Class 2

Class 3
Chapter 4 



Anchorlines

There are two types of anchorlines:

Straight anchorlines connect note symbols to class, object or N-ary association symbols. An 
example can be seen in the following figure, where a note is attached to the Company class:

Figure 4-8: Straight anchorline

A slope anchorline can be used to connect boxes to lines, i.e., a class, object, N-ary relationship, 
or note to an association, subclass association, part association, dependency or straight 
anchorline symbol. 

In the following example, the account may belong either to a person or to a company. The OR 
keyword in the note is attached via slope anchorlines to the associations to express this exclusive 
(either/or) dependency:

Figure 4-9: Slope anchorlines

The bank example (Figure 4-1, Page 123) contains straight anchorlines linking the note symbol 
to relevant classes. In the following sections, you will learn how to create a CL diagram based 
on this example.
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4.2 Getting Started With Your Class Diagram

4.2.1 Creating a New Model

We will first create a new (empty) model. Proceed as follows:

1 With the GRADE REPOSITORY window open, click the New model icon:

2 The New Model window appears. Enter the model name (this time, Bank), then mark 
the Object model check box and remove the check mark next to Business model:

Figure 4-10: Creating a new object model

3 Click OK. GRADE creates a new object model:

Figure 4-11: Object-model tree
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Here, PCK represents a package diagram, which may be used to contain an overview of your 
object model. CLA is a class definition table, which will be filled in automatically with 
definitions of all classes belonging to the package. 

CL represents a class diagram, where your detailed modeling will be done.

As mentioned earlier, GLO and PIC represent the glossary and picture tables (for more 
information, see Page 337 and Page 331.)

The STE table will contain all defined stereotypes. (See also “Using Stereotypes” on Page 167.)

The TAG table will list all tags you define for your diagram elements. (See also “Using Tags” on 
Page 175.) The EXT table will contain any reusable external links. (See also Page 302.)

4.2.2 Creating a CL Diagram

Now that you know how to create an empty object model, let’s assume you want to create a CL 
diagram within it, i.e., within the Bank package.

Here is one way to do that:

1 Activate the package (PCK) by clicking it with your left mouse button.

2 Click the New diagram icon:

3 The Define window appears, as seen in the following figure.
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4 Click the CL radio button and enter the diagram name:

Figure 4-12: Defining a new CL diagram

5 Click Define. The new CL diagram appears in the model tree:

Figure 4-13: Model tree with new CL diagram
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4.3 Class Diagram Window

Before you actually start modeling, it’s a good idea to become familiar with the CL window.

In the model tree, double-click the CL Main icon. The class diagram window then appears:

Figure 4-14: Class diagram window

Since many of the elements in this window are the same as in the ORG diagram window, we 
will not be explaining all of them here. (If you have questions, you can refer back to Section 
“ORG Diagram Window” on Page 39.)
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Near the top of this window, a series of menus appears. Below, you will find an overview of the 
major menu functions:

Figure 4-15: Overview of CL diagram menu functions
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The CL symbol palette does differ considerably from that of the ORG diagram. The following 
table explains these symbols and their functions:

Table 4-2: CL symbol palette

Symbol Name Function

Deselect Cancels a selection in the symbol palette. If you select the 
wrong symbol, click this icon to cancel your selection.

Class Creates a class symbol.

Object Creates an object symbol. 

Association Creates a binary association between two classes or two 
objects or, alternatively, between a class or object and a fork 
rectangle.

 
Is subclass of (subclass association) Creates a generalization relationship (subclass association) 

between one class (the subclass) and another class (the 
superclass).

Is part of (part association) Creates an aggregation relationship (part association) 
between one class or object (the part) and another class or 
object (the container or assembly).

N-ary association Creates an N-ary association symbol.

Dependency Creates a dependency line connecting two class or object 
symbols.

Note Creates a note symbol.

Anchorline Creates a dashed line connecting a note symbol to a class, 
object, N-ary relationship symbol, fork rectangle or 
another note.

Slope anchorline Creates an oblique, dashed line connecting a box to a line, 
i.e., a class, object, N-ary relationship, or note to an 
association, subclass association, part association, 
dependency or anchorline. 

Abstract line Creates an abstract line whose meaning can be defined by 
the user.

Abstract fork Creates an abstract fork whose meaning can be defined by 
the user.

Free comment Creates a comment symbol.
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4.4 Working With CL Diagrams

The following sections are designed to give you hands-on experience working with a CL 
diagram.

Our initial Bank model consists of one CL diagram (by default, GRADE names it Main). 
Because this chapter discusses the creation of basic CL diagram elements, we will simplify our 
diagram for now to depict only the classes and relationships among them without any 
“decorations” (i.e., stereotypes, special fonts, shapes, pictures). Our pared-down version of the 
Bank diagram looks like this:

Figure 4-16: Pared-down Bank diagram

Again, this diagram has been kept simple for teaching purposes. When working on real projects, 
we recommend that you start by defining stereotypes, then apply them as you create diagram 
symbols.

�
GRADE also lets you modify the symbol palette. For more information, see “Stereotype Table 
(STE)” on Page 317, especially “Defining or Modifying an Icon in the Symbol Palette” on Page 320.
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Now we can start creating various types of symbols. The procedure differs somewhat depending 
on the symbol type.

4.4.1 Creating a Class Symbol

The diagram we will be drawing (Figure 4-16, Page 136) contains 11 class symbols (Bank, 
Branch Office, Head Office, Account, etc.).

To create, for example, the class symbol Account, proceed as follows:

1 Select the class icon by clicking it (the yellow rectangle) in the symbol palette.

�
If you have any questions about how to work with diagram symbols in general, e.g., how to edit, 
delete or copy them, please consult Chapter 2. The following sections in Chapter 2 may be of special 
interest:
“Editing and Deleting Diagram Elements” on Page 52;
“Repositioning” on Page 62;
“Using a Grid” on Page 63;
“Copying, Pasting and Moving Diagram Elements” on Page 66. 
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2 Click with your left mouse button at the location in the diagram where the new class 
symbol is to be placed. A window will open, as seen in the following figure:

Figure 4-17: Details of Class dialog: Main tab

3 By default, the Package field displays the name of the package containing the current 
class diagram; here, it is Bank. In many cases, you can simply leave this as is. In more 
complicated situations, you may want to choose a class from another package. In that 
case, click the down arrow next to the Package field to select the package, then click the 
down arrow next to the Name field to select a class name.

4 In the Name field, enter the name of the class: Account.
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5 Click the Attributes tab. Here, enter two attributes: Number and Balance. To make sure 
that Balance appears on a separate line, press Ctrl+Enter. The Attributes tab now should 
look like this:

Figure 4-18: Details of Class dialog: Attributes tab

6 Click OK or simply hit Return to close the dialog and insert the symbol in the diagram. 
The symbol appears:

Go ahead and create all the class symbols in our pared-down Bank diagram. (You need not create 
the note Withdrawal possible..., as we will learn about notes later.) If you need to reposition a 
symbol, click it to activate it, then hold down your left mouse button and drag where needed.

�
Another way of entering attributes is to click the Edit or New button, then make your entries. This 
is to ensure that the attributes appear in UML syntax. For more information about this, see “More 
About Defining Class Attributes” on Page 140.

To delete a line in the Attributes field, simply click the line in question, then click the Delete button.

Account
Number
Balance
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Here are a few more helpful hints for defining a class:

• In the Description field you can enter any useful information.

• You also can specify a stereotype for a class. See “Using Stereotypes” on Page 167.

• Properties and tags also may be specified. See “Tags and Properties” on Page 211.

• Operations can be entered similarly to attributes. If you want to define operations in UML 
syntax for export to Rational Rose, see “Defining Class Operations” on Page 145.

• The Pick name... button allows you to select a name that already exists elsewhere in the 
model.

• If your class is from another package and the class symbol displays this information (e.g., 
from Package A), you can hide the keyword from as well as the name of the package itself. See 
Page 370.

• To reshape a box symbol, activate it, position the left mouse pointer on the border to be 
changed, then hold down your left mouse button and drag it.

More About Defining Class Attributes

We have already discussed how to fill in the simple attributes needed for our example. This 
section describes the more sophisticated possibilities offered by GRADE for entering attributes.

If you plan to export your model to Rational Rose, the attributes must be entered in complete 
compliance with UML syntax. That means each attribute must be on a separate line (use 
Ctrl+Enter to create each new line). Thus, a simple sequence of attributes should appear as 
follows:

a1
a2
a3

To include informal information about any attribute (in UML this information is referred to as 
properties), add a space after the attribute name, then enter the additional information in 
braces, as follows:

a1 {information about a1}
a2 {information about a2}
a3 {information about a3}
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To import attributes from a stereotype, proceed as follows:

1 First, make sure you have selected a stereotype. A valid stereotype name should appear 
in the Stereotype field on the Main card of your Details of Class dialog. If none has been 
selected, click the down arrow next to the field and then click your selection. The Main 
card should appear something like this:

Figure 4-19: Stereotype selected
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2 Now click the Attributes tab, then on the left arrow button next to the words Copy from 
stereotype. Any attributes assigned to your selected stereotype now will appear in the 
main field of the Attributes card:

Figure 4-20: Attributes copied from stereotype

To delete any attribute, simply position your cursor on that line, then click the Delete button.
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To make sure that your attributes are entered in UML syntax, use the Edit or New buttons on 
the Attributes card. To edit an attribute that already appears in the card’s main field, simply 
position your cursor on that attribute, then click Edit. To create a new attribute, click New. In 
either case, the Attribute dialog will appear:

Figure 4-21: Dialog for entering attributes in UML syntax
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The following table explains how to fill out this dialog:

Table 4-3: Elements of Attribute dialog

To help you better understand the definition of attributes, let us assume we are modeling a bank 
and that one of the classes is named Account. For this class we define an attribute named Balance 
and give it the type Currency. Assuming that some minimum deposit is required for opening the 
bank account, we assign 10 as the initial value. We specify Private visibility to indicate that 
access to this information is available only to the Account class (e.g., its operations).

Once we have filled out the Attribute dialog as described above, we click OK. The Attributes card 
will now appear, and in its main field, we see the attribute specified in UML notation:

- Balance: Currency = 10

Dialog Element Function/Description

Name Enter the name of the attribute directly or use the Pick name button. In the Name field, 
you may optionally add information in square brackets, e.g., array[1..99]. The name 
may contain blanks, and the general name syntax rules are relaxed here; e.g., the name 
may start with a digit.

Type Filling in a type is optional. You can type it in directly or use the Pick type or Pick name 
button. You also may add information in square brackets or parentheses, e.g., string[32] 
or (Yes, No, Cancel).

Initial value Here, you can assign an initial, or default, value for the attribute. Enter any text, which 
may contain blanks, commas, etc. Note, however, that if this text contains blanks or 
special characters (commas, semicolons, braces), it must be enclosed by single or double 
quotation marks. You may enter the value directly or via the Pick name button. 

Visibility Click any radio button in this field to specify visibility. Public indicates that the attribute 
is visible to all classes; Protected means visibility to subclasses of the given class; Private 
means that the attribute is visible only to the given class; None means visibility has not 
been specified (this is the setting generally used for simple modeling). (Note that this 
setting does not affect the physical visibility of attributes in the model; even if you select 
Private for all attributes, they still will be displayed in the model itself.) The exact 
meaning of visibility is related to UML and code generation.

Kind This field is deactivated.

Stereotype This field is for selecting a stereotype.

Properties This field is for indicating properties. Here, you should not use manual line breaks or 
braces: { }.

Pick tag Here, you can pick a tag by clicking the downward arrow, then making your selection, 
then clicking the left arrow icon.

and value Here, you can assign a value for your tag.
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Here, the - represents Private visibility (+ = Public, # = Protected). That is followed by the 
attribute name, type, and initial value.

In other words, the attribute syntax is as follows; v stands for visibility, and the type, initial value 
and comment (property) are all optional:

v name: type = initial_value {comment}

Defining Class Operations

As mentioned earlier, classes can be assigned operations; for example, if you have a class named 
Customer you might assign it operations such as Withdraw_money, Deposit_money and 
Transfer_money.

To do this, define the class as usual, but before closing the Details of Class window, click the 
Operations tab:

Figure 4-22: Card for entering class operations

Here, you can type in operations (using the Pick name... button if you wish). If the name of an 
operation consists of more than one word, type in the words separated by blanks; GRADE will 
automatically replace the blanks with underscores, but in the class symbol the name will again 
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contain blanks if the appropriate option is turned on. (Use the Underscores visible option 
described on Page 393.) To remind you that this is an operation and not an attribute, empty 
parentheses are appended automatically to the operation name in the class symbol, as you will 
see when you reopen the diagram (there may be parameters inside the parentheses). Here is an 
example of a class with operations:

Figure 4-23: Class with operations

For simple modeling, class operations typically are not specified, or merely operation names are 
entered; operations are given in more detail if the diagram is to be used for software design and 
exported to Rational Rose (see Chapter 6).

As with class attributes, class operations must be defined in complete compliance with UML 
syntax if the model is to be exported to Rational Rose. That means each operation must appear 
on a separate line (to obtain a line break, press Ctrl+Enter). To delete any operation, position 
your cursor on the corresponding line and click Delete.

Customer
name
address
Withdraw money()
Deposit money()
Transfer money()
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To make sure that your operations are entered in UML syntax, use the Edit or New button on 
the Operations card. To edit an operation that already appears in the card’s main field, simply 
position your cursor on that operation, then click Edit. To create a new operation, click New. In 
either case, the Operation dialog will appear:

Figure 4-24: Dialog for defining class operations
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The following table will help you fill out the Operation dialog:

Table 4-4: Elements of the Operation dialog

To help you understand how an operation can be defined, let us return to the example 
mentioned earlier, involving the class named Customer and the operation named 
Transfer_money. During the definition of class Customer we click the Operations tab, then click 
New to define a new operation.

Dialog Element Function/Description

Name Enter the name of the operation directly or use the Pick name button. In the Name field, 
you may optionally add information in square brackets, e.g., array[1..99].

Parameters This is a factor that further defines the operation; for example, if your operation is 
named Withdrawal, one parameter might be Amount. To ensure that the parameters 
appear in UML syntax, use the New or Edit button. To edit a parameter, position your 
cursor on it and click Edit; to create a new parameter, click New. Fill out the Operation 
Parameter dialog (for details, see table on Page 150). Then click OK.

Value type Filling in a value type is optional. You can type it in directly or use the Pick type or Pick 
name button. You also may add information in square brackets or parentheses, e.g., 
string[32] or (Yes, No, Cancel).

Visibility Click any radio button in this field to specify visibility. The meaning of visibility as 
defined here is similar to that used for attributes; see Page 144.

Stereotype This field is for selecting a stereotype.

Properties This field is for indicating properties. Here, you should not use manual line breaks or 
braces: { }.
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We name the new operation Transfer_money. We now click the New button next to the 
Parameters field to open the Operation Parameter dialog:

Figure 4-25: Dialog for defining parameters of operations

In the Operation Parameter dialog, we enter the name of a parameter (Amount), the type 
(Currency), and the initial value, 0. By clicking OK, we return to the Operation card. We decide 
to enter a second parameter, indicating the account to which the money is to be transferred. 
Next to the Parameters field we click New, then name the parameter Receiver account and give it 
the type String to indicate that this account can be designated by a string of characters. We click 
OK. In the Visibility field, we click Public, then on OK. In the Operations field, our entered 
information appears automatically in UML syntax:

+ Transfer money(Amount: Currency = 0, Receiver account: String)

Here again, the + represents Public visibility (# = Protected, - = Private). 
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The following table will help you fill out the Operation Parameter dialog:

Table 4-5: Elements of Operation Parameter dialog

4.4.2 Creating an Object Symbol

Our sample diagram does not include any object symbols (object symbols usually appear in a 
separate diagram). You should know that creating an object symbol is very similar to creating a 
class symbol. Keep in mind, however, that an object symbol represents an instance of a class. 
Thus, in the Main tab you enter not only the object symbol name, but also select the class to 
which this object belongs.

To select the class, proceed as follows:

1 Click the down arrow to the right of the Class name field.

2 Use your downward arrow cursor key to move through the list and select a class.

3 Press Return to confirm your selection of a class.

4 Click OK or press Return to insert the object symbol into the diagram.

Dialog Element Function/Description

Name Enter the name of the parameter directly or use the Pick name button. In the Name field, 
you may optionally add information in square brackets, e.g., array[1..99]. 

Type Filling in a type is optional. You can type it in directly or use the Pick type or Pick name 
button. You also may add information in square brackets or parentheses, e.g., string[32] 
or (Yes, No, Cancel).

Initial value Here, you can assign an initial, or default, value for the parameter. Enter any text, which 
may contain blanks, commas, etc. This text must be enclosed by single or double 
quotation marks if it contains blanks, commas, semicolons, or braces. You may enter the 
value directly or via the Pick name button. 

Visibility This field is deactivated.

Kind Click one of the radio buttons to specify access rights. Here, in means that it is an input 
parameter, which may not be modified by the operation; out means that it is an output 
parameter; inout refers to an input parameter that can be modified; none means access 
has not been specified. 

Stereotype This field is deactivated.

Properties This field is deactivated.

Pick tag Here, you can pick a tag by clicking the downward arrow, then making your selection, 
then clicking the left arrow icon.

and value Here, you can assign a value for your tag.
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4.4.3 Creating a Binary Association

Associations represent connections between two classes. For example, there should be a binary 
association between the classes Bank and Account in the sample diagram:

In natural language, this relation can be read as follows:

Bank holds one or more Accounts

As explained on Page 125, cardinality can be represented either in UML notation, as seen above 
(1 and 1..*) or in crowfeet notation. For this example, let’s use UML. (To make sure that option 
has been set, open the Options menu, then select Notation and UML. To set either type of 
notation as the default, open the Options menu, then select Settings..., then mark the Crowfeet 
notation option for crowfeet or unmark it for UML.)

Assuming that you have created the two class symbols Bank and Account, you can go ahead and 
create the binary association that joins them.

Proceed as follows:

1 Select the association symbol (a simple line) from the symbol palette.

2 Move the mouse pointer to the Bank symbol, then press and hold down the left mouse 
button and drag it over to the Account symbol. (Here, Bank can be considered the source 
symbol, and Account the target symbol.)

Bank
Name
Address

Account
Number
Balance

holds

1

1..*
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3 The Binary Association dialog appears, as shown in the following figure:

Figure 4-26: Dialog for defining binary associations
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4 Here, you can make additional entries concerning this connection. 
Since the Bank holds the account, enter the role name holds into the role name field 
under the label Bank. Set the cardinality of the association to 1..* by selecting the 
appropriate value from the cardinality combo box. Make sure the second cardinality is 
set to 1. The window now looks like this:

Figure 4-27: Specifying cardinality

5 To make sure you have the correct cardinality settings, try reading the dialog as natural 
sentences. In this case:

Bank holds one or more Account(s)

Account (is associated with) one Bank 

6 Confirm your entries by clicking OK.

The association then appears with the desired association name and cardinalities:

Bank
Name
Address

Account
Number
Balance

holds

1

1..*
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Here are a few additional hints for creating binary associations:

• You also have the option of specifying a user-defined cardinality. For example, you can type 
1..4 in the Cardinality field.

• If you decide to use “crowfeet” notation in your diagram, the Binary Association dialog will 
have a somewhat different appearance. In this case, you should mark the appropriate radio 
buttons to specify cardinality:

Figure 4-28: Binary Association dialog for crowfeet notation

• For more information about the fields Properties and Pick tag, see “Using Tags” on Page 175. 
More information about stereotypes appears in “Using Stereotypes” on Page 167.

• While creating a diagram, you may want to reposition the box symbols or connecting lines. 
See “Repositioning a Box Symbol” on Page 181 and “Modifying Connecting Lines” on Page 
181.

4.4.4 Creating an Aggregation (Part Association)

Our sample Bank diagram (Figure 4-16, Page 136) contains one aggregation, which involves the 
Bank, Branch Office and Head Office. As you will recall, an aggregation is a relationship between 
a part class and a so-called container or assembly class. In our example, the Branch Office and 
Head Office are parts of the Bank (assembly) class.
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Let us assume you already have created these three class symbols. To create a part association, 
proceed as follows:

1 Select the part association symbol (having a diamond at one end) from the symbol 
palette.

2 Move your mouse pointer to the Branch Office symbol, then press and hold down the 
left mouse button. Move the mouse pointer to the Bank symbol and release the mouse 
button.

3 The Aggregation dialog appears, as seen in the following figure:

Figure 4-29: Dialog for defining an aggregation

4 You will note in our sample diagram that there can be one or more bank branch offices. 
Thus, select a cardinality of 1..* to indicate this.

5 Click OK or simply press Enter to close the dialog and insert the aggregation symbol in 
the diagram. The aggregation path then appears:

The assembly class Bank now has one part class, Branch Office. A gray rectangle appears on the 
aggregation path. 

We now want to connect the part class Head Office to the gray rectangle. Proceed as follows:

1 Click the association icon, which appears as a simple line (not the part association icon!).

Bank
Name
Address

Branch Office
Number
Address

Head Office
1..*
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2 Move your mouse to Head Office, hold down the left mouse button, and then drag over 
to the gray rectangle.

3 The Aggregation window opens. Here, select a cardinality of 1 to indicate that there is 
only one head office of the bank. The window then should look like this:

Figure 4-30: Dialog for defining an aggregation

4 Click OK to confirm your entry. An association connection will be established, and the 
assembly class Bank will now have its two parts. The desired aggregation has been 
constructed:

The gray rectangle can be reshaped and repositioned almost like any other box. So, for example, 
you can reshape the gray rectangle and reposition branch lines and the fork line (the one with 
the diamond) to form a proper “fork.”

Bank
Name
Address

Branch Office
Number
Address

Head Office
1..*
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Proceed as follows:

1 Click the gray rectangle to activate it, then “drag” its left and right borders outward:

2 Reposition the symbols and branch lines as desired:

Bank
Name
Address

Branch Office
Number
Address

Head Office
1..*

Bank
Name
Address

Branch Office
Number
Address

Head Office

1..*

�
In a more complicated case, involving more branches, try to connect all branches to the gray 
rectangle from underneath. Once you have finished drawing all branches, reposition the class 
symbols and branch lines to obtain the desired appearance.

In this example, you selected cardinalities from a predefined list. Note that it’s also possible to type 
an arbitrary value in the Cardinality field. And it’s possible to assign names to the branches and root 
part. These names can be entered into the role name field (the central field) of the Aggregation 
dialog.
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4.4.5 Creating a Generalization (Subclass Association)

Creating a generalization is similar to creating an aggregation. In our example, only one 
generalization is needed. Withdrawal and Deposit both are types of transactions and thus can be 
attached to Transaction as subclasses of it.

Assuming that the three classes already appear in your diagram, create the generalization as 
follows:

1 Click the subclass association icon, then move your mouse pointer to Withdrawal.

2 Holding down your left mouse button, drag your mouse pointer to Transaction, then let 
go. The Generalization dialog will appear, as seen in the following figure:

Figure 4-31: Dialog for defining generalization

3 You need not enter anything here (unless you wish to give this branch a special role 
name). Click OK; the generalization line will appear.

4 Now select the association icon. Move your mouse pointer to Deposit, hold down your 
left mouse button and drag over to the gray rectangle. Let go.

5 Another Generalization window will appear. You need not enter anything; simply click 
OK. A new connection will appear.
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Now the superclass Transaction has two subclasses, Withdrawal and Deposit. Your diagram 
fragment should look something like this:

Figure 4-32: Sample generalization

Again, you can adjust the shape of the generalization by clicking the gray rectangle and the lines 
and dragging as necessary.

Now you should be able to create most of the elements in our sample CL diagram (with the 
exception of the note and the anchorlines). Your diagram should look something like this:

Figure 4-33: Pared-down CL example, lacking the note symbol and anchorlines

While drawing, do not forget to save your diagram from time to time. A fast way of doing this 
is to press Ctrl+S.

Transaction
Kind
Date
Amount

Deposit

Withdrawal

Cashier
Deposit

Withdrawal

Transaction
Kind
Date
Amount

Customer
Name
Address

Account
Number
Balance

Central
Computer

Bank
Name
Address

Head
Office

Branch Office
Number
Address

PC

initiates1

*

concerns

1

1

owns1
1..*

uses

1..*

1

communicates with

1..*

1

owns

1

11..*

1

performs

1

*

has1..*

1
holds

1

1..*
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4.4.6 Creating a Note Symbol

The note symbol is for comments or other information. Notes can be attached to box symbols 
and lines. In our sample diagram (Figure 4-16, Page 136) you will see only one note, which 
appears as a white sheet of paper.

To create a note symbol, proceed as follows:

1 Select the note icon (looks like a sheet of paper) from the symbol palette.

2 Click with your mouse at the location where you want to insert the note.

3 A Note dialog will appear:

Figure 4-34: Note dialog box 

4 In the field, enter your text (use Ctrl+Enter to create a new line).

5 Click OK or press Return to confirm your entry. The note symbol appears:

4.4.7 Creating an Anchorline

The only elements now missing from our simple diagram are the anchorlines connecting the 
note to other elements.

To create them, proceed as follows:

1 Click the anchorline icon (dashed line with right angle), then drag your mouse from the 
Account to the note and let go.

2 An Anchorline dialog appears. Since you do not want to make any entries, click OK. An 
anchorline appears in the diagram. 

Withdrawal possible
if "amount" <= "balance"
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3 Create the same type of line between the note and Transaction and between the note and 
Withdrawal. (Hint: To create an anchorline with a right angle, drag your mouse from 
one symbol to another, clicking your right mouse button wherever you want the angle 
to appear.)

Congratulations! Your simple CL diagram is now complete.

In the following sections, we will introduce the other elements that can be included in CL 
diagrams and provide a few additional tips for working with these diagrams. 

4.4.8 Creating a Slope Anchorline

As you may recall, slope anchorlines are used to connect boxes to lines.

To create a slope anchorline, proceed as follows:

1 Click the slope anchorline icon (appears as an oblique line) in the symbol palette.

2 Move your mouse pointer to the box where the slope anchorline is to start, then hold 
down your left mouse button and drag over to the line to which the anchorline is to 
connect. The slope anchorline appears.

4.4.9 Creating a Free Comment

A free comment is similar to a note in the sense that it also can contain arbitrary text. Entering 
a free comment is analogous to entering a note; follow the instructions in Section “Creating a 
Note Symbol” on Page 160. A simple free comment symbol looks like this:

A free comment differs from a note in the following ways:

• In contrast to notes, which appear as “sheets of paper,” free comments are by default gray, 
rectangular diagram symbols with rounded corners. They can be placed at any location in 
the diagram and are not connected by lines to other diagram elements.

• Free comments are not affected by automatic diagram layout mechanisms and can be moved 
independently of other diagram symbols.

• One more thing, and this is very important: The free comment is the only symbol in a CL 
diagram that can contain another diagram symbol. In other words, once you have created a 
free comment symbol, you can expand it and use it as background, against which other 

This tool is
the best one
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symbols are placed. This way, your free comment functions as a frame, possibly with a 
heading, as seen in the following figure (here, the free comment frames the organizational 
structure of a bank):

Figure 4-35: Free comment symbol used as a frame

The desired text style and color can be set for a free comment by using the various Style options. 
To learn more about changing the style of box symbols and connectors, see “How Can I 
Custom-Design Symbols Used in Diagrams?” on Page 349. For information about using a free 
comment as background, see “Additional Hints” on Page 336.

ORGANIZATIONAL STRUCTURE OF BANK

Branch Office
Number
Address
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<<Computer>>

Withdrawal possible
if "amount" <= "balance"
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4.4.10 Creating an N-ary Association

As mentioned earlier, associations may be binary (involving two classes) or N-ary (involving 
three or more classes). An example of an N-ary association can be seen in the following figure:

Figure 4-36: Example of N-ary association

Let’s assume you have already drawn the three classes (Customer, Check and Bank Branch Office). 
To connect them via an N-ary association, proceed as follows:

1 Select the N-ary association symbol (having a green diamond in the middle) from the 
symbol palette.

2 Click your mouse pointer at the location in the diagram where you want to position the 
symbol. 

3 The N-ary Association dialog appears:

Figure 4-37: N-ary Association dialog

4 Fill in the name of the N-ary association: Transfer of Check. (Filling in a name or 
comment here is optional.)

5 Click OK or press Return to confirm your actions. The N-ary association symbol 
appears:

6 Using the (binary!) association symbol, connect each class involved in the desired 
association to the N-ary association symbol. As you create these lines, another N-ary 
Association dialog will appear.

Transfer of CheckCustomer

Check

Bank Branch Office
recipient

essential

provider

Transfer of Check
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7 Enter a role name in the central field, as seen in the figure below. (Optionally, you could 
also specify cardinality.)

Figure 4-38: N-ary Association dialog: Filling in a role

8 Press Return to close the dialog.

4.4.11 Creating a Dependency

To create a dependency (dashed arrow indicating that one class is dependent on another), 
proceed as follows:

1 Click the dependency symbol in the symbol palette.

2 Holding down your left mouse button, create a connecting line between the two 
symbols, ending with the one that is dependent on the other (in this example, the line 
was drawn from Customer to Bank). The Dependency dialog appears:

Figure 4-39: Dependency dialog
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3 Click OK or press Return.

A dependency line now appears in the diagram:

4.4.12 Creating an Abstract Line and Abstract Fork

Abstract lines and abstract forks give you more freedom in designing your CL diagrams, as the 
meaning of these symbols can be defined by you.

To create an abstract line (used to connect boxes to boxes or boxes to N-ary symbols), proceed 
as follows:

1 Click the abstract line icon in your symbol palette.

2 While holding down your left mouse button, drag your mouse between the elements to 
be connected.

3 The Abstract Line dialog appears:

Figure 4-40: Abstract Line dialog

4 Enter any text(s).

5 Click OK to confirm your entries.

Bank Customer
Object Modeling: CL Diagrams 165 

• 
• 
• 
•
•
•



166 

• 
• 
• 
•
•
•

 Here, you will see an example of an abstract fork:

To enter an abstract fork, proceed as follows:

1 Click the abstract fork icon in the symbol palette.

2 Using your mouse, drag a line between the symbols to be connected.

3 An Abstract fork dialog appears, as seen in the following figure:

Figure 4-41: Abstract fork dialog

4 Enter a remark, if you wish, then click OK.

5 A line with a gray association rectangle will appear:

6 Now connect the other class by drawing a binary association between the Invoice box 
and the gray rectangle.

Customer

InvoiceReport

Customer

InvoiceReport
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7 Optionally, you can activate the fork’s root part (the line between the gray rectangle and 
Customer), press the right mouse button, and select Symbol contents... The following 
dialog box will appear. Enter a role name: here, receives:

Figure 4-42: Naming the root part of an abstract fork

4.5 Using Stereotypes

In GRADE, stereotypes can be used to distinguish a particular diagram element or an entire 
group of diagram elements of a particular type. Note that stereotypes can be defined in different 
ways, depending on the circumstances. In some cases, you may want to define a stereotype name 
and give it a distinctive symbol style; in other cases, you may want to use just a stereotype name, 
which appears in the diagram symbol; in yet other cases, you may want to define just a 
stereotype name and attributes.

The use of stereotypes in general will be discussed in more detail in “Stereotype Table (STE)” 
on Page 317. Here, we will discuss the use of stereotypes in class diagrams.

4.5.1 The Role of Stereotypes in UML

Stereotypes are one of the most powerful mechanisms introduced by UML. Stereotypes allow 
us to define a new kind of model element based on an existing model element. Thus, a 
stereotype is “just like” an existing element (class, association), with additional semantics not 
present in the former.

For example, we might define two class stereotypes: Actor and Computer. Each stereotype can be 
assigned a specific shape, picture, color, etc., as shown in the complete Bank diagram (Figure 4-
1, Page 123). This is a way of making our CL diagram more expressive and easier to grasp at 
first glance.
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We can do much more, however, with the stereotype mechanism. For example, we can define 
the class stereotypes Function and Actor and the association stereotypes control flow and performs. 
Three of these stereotypes are used in the following figure:

Figure 4-43: GRADE diagram with three stereotypes

Check-in Agent
<<Actor>>

Registration
Duration
Frequency

<<Function>><<performs>>
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In the previous figure, you can see the style associated with each stereotype. The styles are 
displayed in accordance with the model’s stereotype table, a fragment of which is shown below:

Figure 4-44: Fragment of stereotype table

The stereotype Function has two defined attributes: Duration and Frequency. That means that if 
you define a class with the stereotype Function, you can also take over these attributes. This way 
of handling shapes and attributes is a supplemental feature offered by GRADE, in addition to 
the usual UML features.
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By using the stereotypes listed in Figure 4-44 we can draw CL diagrams like the following one: 

Figure 4-45: The use of stereotypes in representing a business process

As you can see, this type of class diagram actually represents a business process in a way similar 
to traditional data flow or business process diagrams.

Thus, by integrating stereotypes into our class diagram, we can turn it into a diagram type that 
is convenient for our present purposes.

When you open the STE table of a new model, you will see the stereotypes that have been 
predefined by GRADE. To define a new stereotype, follow the instructions in the next section.

Defining a Stereotype for a Class

Assume we want to define the stereotype Actor.

Proceed as follows:

1 In the model-tree window double-click the STE icon:

Figure 4-46: Model tree with STE table activated

2 A window with a stereotype table appears, containing predefined stereotypes for various 
diagram types.

Check-in Agent
<<Actor>>

Assigning Boarding
Number

<<Function>>

Assigning Seat
<<Function>>

Printing Bag Tags
<<Function>>

<<performs>>

<<performs>>

<<performs>>

<<control flow>>

<<control flow>>
Chapter 4 



3 Click the New row icon:

4 The Stereotype Table Entry dialog appears:

Figure 4-47: Dialog window for defining a stereotype

5 Because the Actor stereotype is to be defined for classes, the CL entry in the Diagram 
type field and the Class entry in the Base type field can remain as they are. In cases where 
a stereotype is to be defined for a different diagram element (e.g., an object or 
association), you would simply click the down arrow next to the Base type field to reveal 
a list of diagram elements, then click the desired one.

6 Enter a name for the stereotype: in this case, Actor.

7 Any comment text can be entered in the Description field.
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8 Click the Style button. A style-setting dialog like the following one appears:

Figure 4-48: Dialog for setting stereotype style

9 If the font for the name is not yet set to bold, set it now as follows: On the Text style card, 
click the gray Change font button in the Name row. Click Bold in the Font style list, then 
OK.

10In the Color area, click the Background button, select a shade of pink, then click OK.

11In the Picture area, click the Select... button, then click ACTOR_S and OK. (If a list of 
pictures does not appear, you are probably working with an older model. In that case, 
after clicking Select..., click New picture, Select file and select a picture file. Then click 
OK, OK and OK.)

12The picture will appear by default at the right edge of the class symbol; to ensure that 
the class symbol’s name and stereotype name do not overlap this picture, click the left 
radio buttons of the Alignment column in the Stereotype and Name rows, as shown below:
Chapter 4 



13Click OK and OK. A new line appears in the STE table:

Figure 4-49: Stereotype entered

Define the stereotype Computer in the same way.

�
In the previous example, we made use of only a few of the style options available. For a more 
complete list of style options, see “Symbol Style Dialog” on Page 352.

When creating a box symbol (class or object) in a CL diagram, you also have the option of creating 
a new stereotype “on the fly.” Start creating the diagram element as usual, clicking the appropriate 
icon in the symbol palette, then clicking at the location in the diagram where the element is to 
appear. In the dialog, click Stereotype... to display the Stereotype Table Entry dialog. Make your 
entries, then click OK.

Stereotypes also may include attributes. Information about attributes can be found in “More About 
Defining Class Attributes” on Page 140.
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Applying a Stereotype

To apply a stereotype to a new element in a CL diagram, create the element as usual, and in the 
dialog window, select the appropriate stereotype from the combo box (click the down arrow, 
then on the name of the stereotype):

Figure 4-50: Selecting a stereotype

Then click OK.

To apply a stereotype to an existing element in a CL diagram, click it with your right mouse 
button, then click Symbol contents... Then select the appropriate stereotype from the combo box, 
as described above.

There are also alternative ways of applying stereotypes:

• Right-click the corresponding diagram symbol, then click Symbol stereotype... In the dialog, 
select the stereotype, then click Apply.

• Define a special icon for the stereotype in the symbol palette, then use this icon to create a 
new diagram element. This is described in “Defining a Stereotype” on Page 318 and in 
“Defining or Modifying an Icon in the Symbol Palette” on Page 320.
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Stereotypes for the Bank Model

Once you have defined the stereotypes Actor and Computer in the bank model, you can apply 
them to the class symbols Cashier, Central Computer and PC. As you can see in Figure 4-1, Page 
123, Cashier should be assigned the stereotype Actor, while the other two symbols should be 
assigned the stereotype Computer.

To improve the appearance of the other Bank symbols, set the class names bold for all of them. 
(Hint: Select all these classes, move your mouse pointer outside the selection rectangle, then 
right-click your mouse button and click Symbol style... On the Text style card, in the Name row, 
mark the check box next to the Change font button, then click the button and change the font 
to bold, then click OK and OK.)

Congratulations! If you have followed instructions, your Bank diagram now should be 
complete.

4.6 Using Tags

You will recall that tags can be defined for use in CL diagram elements. For example, if your 
model contains many symbols representing bank accounts, it might be useful to define a tag 
named Balance; that way, you can quickly add the word Balance (followed by an amount) to any 
symbol.

Making Entries in the TAG Table

Tags are stored in the TAG table, which is global for the entire model.

To make an entry in the TAG table, proceed as follows:

1 In the model-tree window, open the TAG table by double-clicking it. A number of tags 
are defined by default:

Figure 4-51: Table for defining tags
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2 Click the yellow icon to create a new line. A dialog appears:

Figure 4-52: Dialog for defining a tag

3 Enter a name for the tag (type it in and/or use the Pick name button). This name must 
be unique among tags in the model. Because our model deals with banking, let’s enter 
Balance.

4 Click the down arrow next to the Base type field and select the type of diagram element 
to which the tag will be applied (e.g., Class, Object). Let’s select Class.

5 In the Value set field, enter any comment text. (Use Ctrl+Enter to create a new line, if 
necessary, and the Pick name button, if you wish.) If your tag is Balance, you might write: 
Any value; must be in U.S. dollars.

6 In the Description field, you may enter any comment text. (Use Ctrl+Enter to create a 
new line, if necessary, and the Pick name button, if desired, to select names.)
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7 Once you have made all necessary entries, click the OK button. Your tag now appears in 
the table:

Figure 4-53: Entry appears in TAG

To edit a row in the table, click the row in question with your right mouse button and select 
Edit row... from the pop-up menu. The Tag Table Entry dialog appears; it can be filled out as 
described above.

Adding a Tag to a Diagram Element

To add a tag to a new diagram element, proceed as follows:

1 Start creating the element as usual.

2 In the dialog box, click the down arrow next to the Pick tag field. Then click the required 
tag and the left arrow icon:
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3 Your tag name now appears in the Properties field. Add a value after the equal sign. Your 
dialog window should now look like the following figure.

Figure 4-54: Specifying a tag

4 Make any other necessary entries, then click OK.

To add a tag to an existing diagram element, simply activate the element, press Return, select a 
tag and fill in the value, as described above, then click OK.

4.7 Using a CL Diagram to Build a Business Model

Once you have created a CL diagram, you can use it as the basis for creating a business model 
(that is, to create the ORG and DD, or data definition, diagrams in a business model). For more 
information on this, please see “How Can I Use a CL Diagram as the Basis for a Business 
Model?” on Page 402.
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4.8 Creating a Different View of a CL Diagram

In the case of a large CL diagram, it may be convenient to define part of it as a separate “view.” 
Thus, you can inspect that part of the diagram separately, without being distracted by other 
elements.

For more information about this, please see “How Can I Create a Special View of a CL Diagram 
to Let Me Focus on What Interests Me?” on Page 377.

4.9 Exporting a CL Diagram in Rational Rose Format

Thanks to a new feature of GRADE, you can now export your CL diagrams in Rational Rose 
format. For more information, see “Preparing GRADE Diagrams for Export to Rational Rose” 
on Page 212 and “Exporting Diagrams in Rational Rose” on Page 217.

4.10 Modifying the Elements in your CL Diagram

The First Step in Editing: Activation

If you want to change the appearance or contents of any symbol in your CL diagram, keep in 
mind that the symbol in question first must be activated. For more information about activating 
a single symbol or selecting an entire group of symbols, please see “Activating Versus Selecting 
Diagram Elements” on Page 67.

One way of selecting elements in a CL diagram is to open the Edit menu, then click the 
appropriate command. The available commands are listed below:

You can perform several selections one after another; every subsequent selection adds to the set 
of the already selected elements.

Command Meaning

Select all selects all diagram elements

Select boxes selects class, object and N-ary association symbols, as well as forks and notes

Select lines selects all connectors (but not the boxes within them)

Select free comments selects only free comments

Select similar selects all diagram elements similar (by their types) to the currently active one

Table 4-6: Select commands
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Operations on Selected Elements in CL Diagrams

In principle, the same operations can be carried out on a group of selected diagram elements as 
on a single, activated element. An exception is the command Edit/Symbol contents, which makes 
sense only for one currently active diagram element. Operations such as Cut, Copy, Delete, etc., 
can be performed simultaneously on several elements.

Since the selection remains after the operation has been performed, you can perform several 
operations on the selected diagram elements, one after another.

Changing the Contents

To change the contents of an activated symbol, click your right mouse button and select Symbol 
contents... A dialog box will appear (like those described earlier in this chapter). Change the 
contents of any field in this dialog box, then click OK or press Return. 

Changing Sizes and Alignment of Selected Diagram Elements

In CL diagrams, there are quick and easy ways of changing the height or width of symbols and 
aligning these elements to give your diagram a neat appearance.

These functions are analogous to those that can be performed in BP diagrams. For more 
information, please see “Changing Sizes and Alignment of Selected Diagram Elements” on Page 
117.

If you want more freedom to reposition symbols, lines and line texts, select the Manual, Oblique 
semiauto or Oblique manual layout style. In the GRADE toolbar, click the downward arrow next 
to the layout list, then click the style:

Copying, Pasting and Moving Diagram Elements

Symbols in CL diagrams can be copied. You may want to copy a symbol and paste it elsewhere 
in the same CL diagram or even into a different CL diagram. (GRADE, however, will not 
permit pasting objects into dissimilar diagram types, e.g., a CL element into a BP diagram.)
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Whether you are copying elements in a CL or ORG diagram, the process is essentially the same. 
For more information, see “Copying, Pasting and Moving Diagram Elements” on Page 66.

Editing and Deleting Diagram Elements

For information about this, please see “Editing and Deleting Diagram Elements” on Page 52. 
To edit other aspects of symbol appearance, see “How Can I Custom-Design Symbols Used in 
Diagrams?” on Page 349.

Making the Contents of Diagram Elements Invisible

When you create CL diagram symbols and enter text, this text, of course, is normally visible. If, 
however, you wish to hide any text element, this is possible. For more information about this, 
see “How Can I Streamline My Diagrams by Making Some Texts Invisible?” on Page 367.

If your CL diagram contains long class descriptions, it is recommended that you make these 
invisible. These can easily be viewed by activating the symbol in question, then opening the 
Options menu and clicking Show contents.

Repositioning a Box Symbol

If you would like to reposition a box symbol, place your mouse pointer on it so that the four-
arrow cross appears, then hold down your left mouse button and “drag” the symbol where you 
would like it. 

Modifying Connecting Lines

There are many possibilities for modifying connecting lines in CL diagrams. For maximum 
freedom, set the Manual, Oblique semiauto or Oblique manual style. (See “Layout Styles” on 
Page 182.)

You can modify a binary association by editing its route; reconnecting it to different symbols; 
or by deleting it, then redrawing the path altogether.

To edit the route of a binary association, proceed as follows:

1 Click the line with your left mouse button to activate it.

�
Note that you cannot copy an individual connector (e.g., an association) in a CL diagram. You can, 
however, copy a connector along with the symbols attached to either end of it. To do this, you will 
need to first select all these elements. For more information about selecting several elements, please 
see “Activating Versus Selecting Diagram Elements” on Page 67.
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2 Move your mouse pointer to any part of the line, hold down your left mouse button and 
drag the line as necessary. Let go of the mouse button.

3 Repeat this as often as necessary to achieve the desired shape.

If you have an association defined in a diagram and would like to reconnect its end to a different 
symbol, proceed as follows:

1 Click the line with your left mouse button to activate it.

2 Move your mouse pointer to the endpoint that is to be changed.

3 Press and hold down the left mouse button. The mouse pointer changes to a small cross.

4 While holding down the mouse button, drag the association endpoint to the new 
symbol to which it is to be attached.

5 Release the mouse button.

You also have the option of drawing the association manually, i.e., shaping it as you draw. 
Proceed as follows:

1 Click the association icon.

2 Place your mouse pointer on the symbol where the line is to start.

3 Holding down the left mouse button, drag the line as needed, clicking your right mouse 
button at the points where you want to create a right angle.

4 Once you have reached the target symbol, release the mouse.

Other types of lines in CL diagrams can be altered in a similar way.

Note that you also can define stereotypes for lines and apply these stereotypes as required. See 
“Defining a Stereotype for a Class” on Page 170.

4.11 Layout Styles

GRADE offers four layout styles for CL diagrams:

• Automatic. This style is aimed at “keeping order” in your diagrams; it will not allow you to 
overlap two symbols or draw lines across the faces of symbols. In our example we have used 
this style only.

• Manual. This style gives you more freedom; if you wish, you can overlap two symbols or draw 
lines across the faces of symbols. Usually this style is used for the final arrangement of 
symbols in a diagram.

• Oblique semiauto. This style allows you to create a diagram with oblique lines, but will not 
allow you to overlap symbols.
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• Oblique manual. This style allows you to create a diagram with oblique lines and will allow 
you to overlap symbols.

As noted, the default layout style in CL diagrams is Automatic.

This section describes how to switch from one layout style to another. For more information 
about the oblique styles, please consult “How Can I Use Oblique Layouts to Jazz Up My 
Diagrams?” on Page 362. When you use the Oblique semiauto feature, GRADE detects 
“clusters” in your CL diagram, i.e., elements that seem to belong together, and helps rearrange 
the elements to make the groupings more evident.

To switch from one style to another, proceed as follows:

1 Open the diagram for which you want to change the layout style.

2 Locate the layout combo box in the middle of your GRADE toolbar:

3 Click with your mouse on the black, downward arrow to reveal a list of the layout styles 
available:

4 Click with your mouse on the layout style you require.

The new layout style will be saved together with the diagram.

Undoing a Layout Change

If you do not like the new layout, open the Edit menu and select Undo layout. This Undo option 
must be used immediately, before any other change is made to the diagram layout.

�
Note that when you switch to an oblique layout, you may not immediately see any effect of this 
change. Open the Edit menu and select Reposition, then All or Paths to see how the new layout 
affects the diagram. All new lines that you draw, of course, can be drawn obliquely, if so desired.
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Optimizing Layout

GRADE has a special command that allows you to optimize the layout of your CL diagram: 
Open the Edit menu and select Reposition. Then, depending on what you want to reposition, 
select Paths or All. You also can reposition your diagram to make it more vertical or horizontal 
by selecting the corresponding option.

4.12 Other Features

GRADE offers these additional possibilities for CL diagrams:

• To enlarge or reduce the size of an entire diagram, see “Zooming to Enlarge or Reduce 
Diagrams” on Page 70. 

• To search for particular diagram elements, see “Searching for Diagram Elements” on Page 71.

• To change the appearance of symbols or lines in your diagram, please see “How Can I 
Custom-Design Symbols Used in Diagrams?” on Page 349.

• If you are interested in exporting CL diagrams, please see “How Can I Export Diagrams and 
Models?” on Page 418 and “Exporting Diagrams in Rational Rose” on Page 217.

• If you want to turn your CL diagram into a talking presentation, see “Presentation Diagrams 
(PRE)” on Page 285.

4.13 Printing

The options used for printing your diagrams are essentially the same no matter what type of 
diagram you are printing. For more information, see “How Can I Optimize the Printouts of My 
Models?” on Page 379.
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Chapter 5
Object Modeling: PCK and CLA Diagrams

5.1 What is a Package?

A package is the main facility in UML for structuring and grouping things. In object modeling, 
the classical functional decomposition of a system is impossible; your only alternative is to group 
the classes constituting the system model into a set of packages.

UML stipulates that a package can contain

• classes

• class diagrams

• other packages.

Classes are contained in class diagrams, which, in turn, are contained in packages. Thus, 
packages form a strict hierarchical structure. Strictly speaking, each class or class diagram should 
belong to a package. But a class diagram can contain classes from several packages.

In GRADE, the package concept manifests itself in three ways:

• in the model tree

• in PCK diagrams

• in class definition tables for packages.

5.1.1 Packages and the Model Tree

An object model can consist of several packages and class diagrams structured in levels. (In 
GRADE, a package may also contain additional diagram types; more about this later.) Each 
class diagram, in turn, can contain many classes and other elements. The object-model tree 
helps us arrange all parts of the model in an order that reflects their hierarchy. GRADE uses a 
model tree somewhat resembling that of the Microsoft Explorer. A similar approach is taken in 
UML.
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The model tree, as shown in the following figure, displays the hierarchy of packages in the 
model. The tree also reflects the positions of class diagrams in this hierarchy. This example is 
from the Check In model delivered with the GRADE installation.

Figure 5-1: Example of model tree with packages

The uppermost package, Check-In, contains the packages Activities, Database, Domain Objects 
Conceptual and Domain Objects Ready for C++, and each package, in turn, contains one or more 
class diagrams (Registration, etc.). The model tree provides the best overview of the packages and 
class diagrams of the model and supports navigation (via double-click) to any of these objects.

Thus far in this manual, we mainly have used GRADE’s default model-tree style, with diagram 
type acronyms (CL, PCK, etc.). GRADE, however, also offers an alternative model-tree style, 
which makes use of icons.

In UML, objects also are depicted as icons (e.g., the model tree in Rational Rose’s browser 
window). UML notation specifies certain standard symbols, e.g., a package is represented by a 
folder-shaped icon:

 Package

This icon is also used in GRADE.
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The icons for other tree elements differ for various tools. The following icons were introduced 
for the GRADE model tree:

 Model (in the REPOSITORY window)

 Class diagram

 Class definition table

 Glossary

 Stereotype table

 Picture table

 Tag table

External link table

Traditionally, in UML tools each class is reflected as an icon in the model tree. In many cases, 
such a model tree is so large that it may be hard to find the major elements, such as class 
diagrams. In GRADE, classes are collected in class definition tables, thus reducing the size of 
the model tree.

When depicted in icon style, the model in Figure 5-1, Page 186, looks like this:

Figure 5-2: Model tree with icons
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To switch from one model-tree presentation style to another, proceed as follows:

1 Open the Options menu.

2 Select Settings...

3 Mark or unmark the Use diagram icons check box.

A single model can contain several top packages; in that case, the only items shared by them are 
the glossary, stereotype, picture, tag and external link tables (GLO, STE, PIC, TAG, EXT). For 
the sake of brevity, in this and some subsequent sections we will use the name “PCK tree” for 
the model-tree fragment under one top package. The current GRADE version has this 
restriction: All package names within a PCK tree must be unique. GRADE will not 
automatically rename your package to make it unique; instead, it will display an error message.

Semantic Independence of PCK Trees

Each PCK tree represents one special aspect of modeling, usually semantically independent of 
other PCK trees. In the UML standard, only one PCK tree is provided for each model. In 
GRADE, there may be several PCK trees in a model, and GRADE maintains correct semantics 
within each separate tree. For example, when you enter a class symbol, GRADE prompts you 
only with package names from the current PCK tree. Another consequence of the PCK trees’ 
independence can be seen when you move a CL diagram from one place to another in the model 
tree (see “Moving Packages and Class Diagrams” on Page 194). 

5.1.2 What is a Package Diagram?

GRADE’s PCK diagrams can contain both the traditional UML elements described earlier and 
additional elements, as shown in the following figure.

Here, package symbols (resembling folders) are used to represent a university’s major 
departments. Each of these packages can contain subordinate packages, classes, etc. Class 
diagram symbols (green trapezoids) are used to represent the university’s sports and IT facilities. 
The diagram also includes non-UML elements: an ORG diagram symbol (pink trapezoid), 
representing the Student Council; a BP diagram symbol (blue trapezoid), representing the 
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admissions process; and a DD diagram symbol (yellow trapezoid), representing the structure of 
an admissions application. This package diagram shows just one hierarchy level in the model 
tree, the direct components of a package.

Figure 5-3: Example of a package diagram

Package diagrams are in many ways similar to class diagrams; in fact, you might think of a 
package diagram as a “stereotype” of a class diagram. The same note and comment symbols, and 
a similar set of connectors, are available in both types of diagrams. The only relationship with 
predefined UML semantics that can be established between packages is a dependency. If 
package A depends upon package B, it means that a class in A somehow uses a class in B (e.g., 
as a type for an attribute). Packages also can be joined with an abstract line, which does not have 
predefined semantics.

When working in a package diagram, you can double-click any box symbol to navigate to the 
relevant diagram. The package diagram is the best place to introduce a new package or class 
diagram (as described in “Working With Package Diagrams” on Page 198).

Administrative Offices

Institute of
Technology

College of Liberal Arts

Student Council Admissions Process

Structure of
Admissions
Application

Sports Facilities

IT Facilities
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5.1.3 What is a Class Definition Table?

The class definition table (CLA) of a package contains the list of classes defined in that package, 
as shown in the following example:

Figure 5-4: Example of a class definition table

Keep in mind that each entry in this table is a class definition, while a class symbol in a diagram 
is a reference to this definition. Therefore, everything you modify in a class symbol in a diagram 
automatically appears in the corresponding class definition table entry as well. This fact also 
ensures that all class symbol occurrences that reference the same definition are identical. 

If a class diagram contains (references) a class from a package other than the “native” package of 
this diagram, an explicit from <package name> qualifier appears in the class symbol:

Airline
from Activities
Airline name
Airline ID
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By double-clicking the class name in a class symbol, you can navigate from the class diagram to 
the class definition table; the relevant table entry will be activated. To return to the diagram, 
click the Back icon:

If the class also has an entry in the glossary table (as described in “Glossary Table (GLO)” on 
Page 337), you will be asked which table to navigate to.

5.2 When Are Packages Necessary?

A newly created model, by default, has one top-level package automatically named after the 
model itself. This package contains one class diagram named Main (a name popular in object 
modeling). You can add any number of class diagrams and classes to this package. For creating 
a set of overview diagrams whose purpose is to make a system comprehensible, this may be 
completely sufficient. (You also can add ORG, BP or DD diagrams to a PCK, either by using 
the “drag and drop” method in the model tree or by creating the corresponding diagram 
symbols in the PCK itself.)

When creating informal overview diagrams, you may find it necessary to place a class diagram 
outside the package; in the model tree, this would appear as an independent, or “free,” class 
diagram, not attached to the others. This may be a good strategy if you want to use a class two 
or more times, but with different descriptions, e.g., customer (internal) and customer (external), 
where (internal) and (external) appear in the Description field. Of course, you could take a more 
formal approach to solving this problem by using subclasses, but this may be inconvenient if 
you are simply creating an informal overview class diagram. Placing a class outside a package 
disables any formal checking of class consistency; in that case, you can use GRADE as a pure 
“drawing machine.” However, the stereotypes defined in the model are still available, even in a 
“free” class diagram.

The real business of using packages starts when you need to partition a larger model. Typically, 
this occurs when you use GRADE for IT-system design. For example, a standard three-tier 
architecture could be conveniently modeled via packages named Presentation, Domain Objects, 
and Database. In large projects, a deeper package structuring involving many hierarchy levels is 
necessary.

There also may be a more formal reason for introducing new packages, since a class within a 
package can have only one definition (to be found in the corresponding class definition table); 
all class symbol occurrences within diagrams of the package have identical elements: attributes, 
descriptions, etc. A class is identified by its name, and the GRADE class definition dialog offers 
you a drop-down list for selecting a “copy” of an existing class. If you need a class with the same 
name, but, for example, different attributes, you would need to introduce another package and 
Object Modeling: PCK and CLA Diagrams 191 

• 
• 
• 
•
•
•



192 

• 
• 
• 
•
•
•

place the modified definition there (for more information, see “Modifying Package References 
in Classes” on Page 203). This could be the case with the Database package, where attributes 
must be “normalized” according to the relational database standards.

5.3 Working With the Model Tree

5.3.1 Creating a Package

A GRADE object model typically has a top-level PCK diagram, as seen here:

Figure 5-5: Initial model tree

Let us assume that you want to create another top-level PCK named Use Cases. Proceed as 
follows:

1 In the model tree, click the New diagram icon:

2 The Define window appears.
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3 In the Object model field, mark PACKAGE. In the Parent diagram combo box, select 
FREE. Then enter the diagram name; here, Use Cases:

Figure 5-6: Defining a new, top-level PCK package

4 Click Define.

The model tree with a new PCK appears:

Figure 5-7: Model tree with a new package 

Now let us assume you want to create a new package under an existing one. To create a new 
Activities package under the existing Airport, you can proceed as described above, but in the 
Define dialog select Package Airport as the parent diagram. In such cases, however, we 
recommend an alternative method of creating packages; see “Creating a Package Symbol” on 
Page 198.
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5.3.2 Creating a Class Diagram

One way of creating a class diagram under the existing package was described in “Creating a 
CL Diagram” on Page 131. An alternative way will be described in “Creating a Class Diagram 
Symbol” on Page 198.

In a model tree we also can create a “free” class diagram, which is not under any package. 
Assume you want to create a free class diagram named Check-in overview.

Start by clicking the New diagram icon:

In the Define dialog, mark the CL radio button, enter the diagram name, select FREE and click 
Define. A free CL diagram is added to the model tree:

Figure 5-8: Model tree with a free CL diagram

5.3.3 Moving Packages and Class Diagrams

When, in the model tree, one package or class diagram B is positioned under another package 
A (and connected by a line) we say that B is attached to A. In the model tree, we can easily detach 
any such diagram and reposition it.

Let as assume we are working with the model tree shown in Figure 5-8, Page 194.

To detach the Main diagram from its parent, position the cursor on the diagram symbol, press 
and hold down the left mouse button, then move the cursor (we call this “moving Grady” 
because the GRADE mascot, Grady, appears) to a free area. Then release the button and answer 
the confirmation question with Yes. 

To attach a diagram under a new parent, position the cursor on the diagram symbol, press and 
hold down the left mouse button, then move the cursor (“Grady”) to the desired parent. Then 
release the button and answer the confirmation question with Yes.

The contents of package subtrees do not change during these detach/attach operations.

Now a special note about the repositioning of CL diagrams in the model tree. Remember that 
separate PCK trees are semantically independent parts of the model (see also “Semantic 
Independence of PCK Trees” on Page 188). When moving a CL diagram from one place to 
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another within one PCK tree, GRADE automatically supports consistency of all references from 
packages to classes and vice versa. For example, let us assume that a Bank package and a Market 
package are under a single, top package. Further assume that a CL diagram is detached from the 
Bank package and attached to the Market package. In that case, class definitions remain in the 
CLA for Bank and the notation from Bank will appear in all the CL diagram symbols, as seen in 
the example below: 

When moving a CL diagram to another PCK tree, this notation does not appear. GRADE 
allows you to decide which will be the proper “local” package for newly appearing classes. You 
must manually insert this package name into the class symbols (as a result, new classes will 
appear in the relevant class tables). Only after this operation will the PCK tree again become 
semantically consistent. You will encounter the same situation if you attach a free CL diagram 
to a PCK tree. 

5.3.4 Performing Other Operations in the Model Tree

See “Deleting, Duplicating and Renaming Diagrams in the Model Tree” on Page 26 and 
“Collapsing/Expanding Model Trees” on Page 27.

Branch
office

from Bank
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5.4 Package Diagrams

5.4.1 Package Diagram Window

To open a package diagram, double-click its symbol in the model tree. A package window 
similar to the following one appears:

Figure 5-9: Package window

The PCK window is very similar to that of CL diagrams.
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The PCK symbol palette, however, differs somewhat:

Table 5-1: Symbol palette of PCK diagram

Symbol Name Function

Deselect Cancels a selection in the symbol palette. If you have 
selected any symbol, then decide it is the wrong one, click 
this icon to cancel your selection.

Package Creates a package symbol and adds a PCK diagram to the 

model tree under the current PCK diagram.

Class diagram Creates a class diagram symbol and adds a CL diagram to 
the model tree under the current PCK diagram.

BP diagram Creates a business-process diagram symbol and adds a BP 
diagram to the model tree under the current PCK diagram.

ORG diagram Creates an organization/resource structure diagram symbol 
and adds an ORG diagram to the model tree under the 
current PCK diagram.

DD diagram Creates a data-definition diagram symbol and adds a DD 
diagram to the model tree under the current PCK diagram.

Dependency in PCK Creates a dashed arrow connecting two boxes.

Note in PCK Creates a note symbol (Ctrl+Enter may be used to create a 
new line).

Anchorline in PCK Creates a dashed line connecting a note to a box.

Slope anchorline in PCK Creates an oblique, dashed line connecting a box to a line.

Abstract line in PCK Creates a line between boxes (i.e., class diagrams, packages 
and notes). You can define the meaning of this line 
according to your needs.

Free comment Creates a comment symbol (use Ctrl+Enter to create a new 
line).

�
If your symbol palette does not include all of the above symbols, you are probably working with an 
older model. To display the full symbol palette, activate the model tree, then open the Options menu 
and click Restore default stereotypes.

You can alter the symbol palette, modifying the existing icons and adding new ones. For more 
information, see “Stereotype Table (STE)” on Page 317.
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5.4.2 Working With Package Diagrams

Creating a Package Symbol

Proceed as follows:

1 With the PCK diagram open, click the package symbol (a yellow, irregular box) in the 
symbol palette, then click with your left mouse button at the location where you want 
to insert the symbol.

2 The Package dialog appears:

Figure 5-10: Package dialog

3 Enter a name for the package. (You can type it in, and/or click the Pick name button.)

4 Enter any comment text into the Description field, if desired. (Type it in and/or use the 
Pick name button; use Ctrl+Enter to create a new line.)

5 Click OK. The symbol appears in the diagram, and a corresponding (empty) PCK 
diagram is created in the model tree under the current PCK diagram.

Creating a Class Diagram Symbol

Proceed as follows:

1 With the PCK diagram open, click the class diagram symbol (a green trapezoid) in the 
symbol palette.
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2 Click with your left mouse button at the location where the symbol is to be inserted. 
The Class Diagram dialog appears:

Figure 5-11: Dialog for creating a class diagram symbol

3 Enter the name of the class diagram (type it in directly or use the Pick name button).

4 If desired, fill in the Description field with any comment text. (Type it in directly and/or 
use the Pick name button; use Ctrl+Enter to create a new line of text.)

5 Click OK. The symbol appears in the diagram, and the corresponding (empty) CL 
diagram is created in the model tree under the current PCK diagram.

Other Operations in Package Diagrams

The creation of other boxes is done analogously. For tips on creating the remaining symbols 
(dependencies, notes, etc.) see “Working With CL Diagrams” on Page 136.

All diagram-modifying operations (such as editing diagrams, changing layout style, etc.) in PCK 
diagrams are very similar to those in CL diagrams. See Chapter 4 for details.

�
Please note that pasting a class-diagram symbol into a PCK diagram results in the appearance 
of a new CL in the model tree, under this PCK. This CL will be empty. If you want to really 
copy and paste a CL diagram with its contents, proceed as follows:

1 Duplicate the CL diagram as a “free” diagram (as described on Page 26).

2 Attach this CL diagram under the desired PCK diagram.
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5.5 Working With the Class Definition Table (CLA)

As mentioned, class definition tables appear next to PCK diagrams in the model tree. Each CLA 
contains definitions of all classes belonging to that package. 

To open a CLA table, double-click its icon in the model tree. Or, if you are currently viewing a 
PCK diagram, simply click the class definition button:

The corresponding CLA table will open. See the example in Figure 5-4, Page 190.

For the most part, this table will be filled in automatically. When you create a new class in a CL 
diagram, then save and close this diagram, a new class definition appears in the CLA table. If 
you create a new class in a CL diagram and specify a “foreign” package for it (i.e., a package other 
than that in which the CL diagram appears), then the class definition will appear in the class 
definition table of the specified package.

When you modify a class in a CL diagram, then save and close this diagram, this modification 
will appear automatically in the CLA table. The changes also will appear in all occurrences of 
this class anywhere in the relevant CL diagrams (the changes will become visible when you 
reopen the corresponding diagrams).

Attributes, operations and properties of a class are transferred to the relevant class table entry 
strictly according to UML syntax. If you violate this syntax, for example, enter a comma in the 
attribute’s Initial value field without using quotes, the “violating” text is simply deleted without 
any message. In the class definition table, you can see this automatic “filtering” as soon as you 
complete the class modification. In the class symbol in the diagram itself, however, you will see 
the results of such “filtering” only after you have saved, closed and reopened the class diagram. 
No syntax check occurs for a “free” class diagram.

You also can fill in the CLA table manually by defining new classes and modifying existing ones 
directly in this table.

To store a class definition in the CLA table, proceed as follows:

1 Open the CLA table by double-clicking it.

�
If you change the name of a class in a CL diagram, GRADE does not consider this a modification; 
rather, it will be considered a new class definition. This new class definition will appear in the CLA 
table, along with the old one. If you would like to discard the old class definition, you can activate 
that line in the CLA table, then press Del, then confirm your decision with Yes.
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2 Click the yellow icon in the upper left part of the window to create a new row. The Class 
Definition dialog appears:

Figure 5-12: Class Definition dialog

Note that this dialog box is very similar to that used for creating a new class symbol in CL 
diagrams (Figure 4-17, Page 138). The only difference is that the Class Definition dialog box 
does not contain a Package field.

3 In the Name field, enter a class name that is unique for that package.

4 Optionally, you can fill out any other fields (Stereotype, Description, etc.).

5 Click OK.

To edit a row in a CLA table, click the given row with your right mouse button, then click the 
Edit row... command and proceed as in Steps 3-5 above.
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The table below provides additional hints for filling in the Class Definition dialog:

Table 5-2: Elements of the Class Definition window

As mentioned earlier, you can delete a class definition from a CLA. However, you cannot 
successfully remove a “used” class from the CLA, i.e., a class that actually appears in a CL 
diagram. Once you close and save the diagram in question, the used class will reappear in the 
CLA.

For easy copying of similar class definitions from one CLA to another you can use the 
Copy/Cut/Paste commands. The Search command also can be used in CLAs.

Dialog Element Function/Description

Name Enter the name directly or use the Pick name button.

Stereotype If you wish to enter a stereotype, select the name from the available list of stereotypes, 
enter a stereotype name directly, or use the Pick name button.

Properties If you use tags, enter each tag name here, followed by an equal sign and a value. Enter 
each tag on a new line, using the key combination Ctrl+Enter. 

Pick tag If you wish to use a particular tag, select one from the combo box here, then click the 
arrow push button next to the Pick tag field. The tag name, followed by an equal sign, 
will appear in the Properties field. Enter the desired tag value after the equal sign. (For 
more information about tags, see “Using Tags” on Page 175.)

and value Here, you can pick a value for the selected tag.

Description This can be any comment text. The key combination Ctrl+Enter may be used to obtain 
a new line.

Stereotype... Click this button to open the Stereotype Table Entry dialog. Here, you can modify the 
current stereotype or define a new one (see also “Defining a Stereotype for a Class” on 
Page 170).

Attributes card Here, you can enter one or more rows, each containing a class attribute description in 
UML syntax. This process is analogous to that used when defining attributes for class 
symbols; see “More About Defining Class Attributes” on Page 140. 

Operations card Here, you can enter one or more rows, each containing an operation description in 
UML syntax. This process is analogous to that used when defining operations for class 
symbols; see “Defining Class Operations” on Page 145.
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5.6 Modifying Package References in Classes

If you want to transfer a class from one package to another, select this class symbol in the CL 
diagram, activate the Symbol contents... command, then, in the dialog window, change the 
contents of the Package field. The class definition row will appear in the CLA for the specified 
package. However, this operation does not remove the class definition from the previous CLA 
table. It must be deleted explicitly.

�
Do not use Cut/Paste in a CLA for changing class package references. It will not produce the desired 
result.
Object Modeling: PCK and CLA Diagrams 203 

• 
• 
• 
•
•
•



204 

• 
• 
• 
•
•
•

Chapter 5 



6

Chapter 6
Object Modeling: UML and Software Design

This chapter is intended mainly for those planning to use GRADE object models professionally 
for IT-system design.

6.1 GRADE Class Diagrams and UML

GRADE class diagrams are in complete compliance with the UML standard, version 1.3. All 
features of UML packages, classes, class attributes and operations, associations, generalizations, 
dependencies, objects and notes are implemented in GRADE class diagrams. As regards the 
UML standard for classes, the only missing concepts in GRADE are parameterized classes and 
instantiated classes; class utilities and interfaces can be obtained using appropriate stereotypes. 
GRADE also offers convenient extensions to UML: the alternative crowfeet notation for 
cardinalities, powerful graphical stereotypes and views for class diagrams. These features do not 
conflict with UML principles.

The package semantics in GRADE also is completely consistent with the UML standard.

6.2 GRADE and Other UML Diagram Types

In addition to class diagrams, UML supports other diagram types. Although GRADE object 
models formally support only class diagrams, some of the other UML diagram types can be 
adequately represented in GRADE via stereotyped class diagrams.

The emphasis in GRADE object models is on the early stages of IT-system development. This 
development usually starts with an informal overview class diagram of the system under 
investigation. GRADE is highly effective for this type of modeling. The next step, in accordance 
with UML methodology, is to identify use cases. In UML, these are defined in use-case 
diagrams.
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6.2.1 Representing Use-Case Diagrams in GRADE

Use-case diagram information can be represented adequately in GRADE via class diagrams 
using stereotypes. You can find a modeled use-case diagram and the relevant stereotypes in the 
Check-In example included in the GRADE installation. The following figure shows the diagram 
Check-in Use Cases from this example. The main symbols in this diagram are actors and use 
cases, represented by the corresponding class stereotypes in typical use-case diagram notation 
(stick man = actor, ellipse = use case). The associations between actors and use cases are assigned 
the stereotype communicate (the stereotype name is not visible in the diagram). A larger use case 
may include smaller ones; in our example, the larger Check-In use case includes the smaller use 
cases Registration and Boarding. A corresponding stereotype represents this (this time the 
stereotype name is visible: <<include>>). Similarly, a use case may extend another one. Use cases 
also may have subtypes, which are shown in the standard way (in our example, Registration for 
Flight is a subtype of Registration).

The stereotypes defined in the stereotype table of the example support all possible relations 
between use cases in accordance with UML notation (version 1.3).

If you model use cases in a similar way, you can copy the stereotypes from the stereotype table 
of the Check-in example into the stereotype table of your model.

Figure 6-1: Modeled use-case diagram

Check-in
Agent

Passenger
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Registration
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Registration
on Waiting
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Passenger
Registration Seat

Assignment
Baggage

Registration

Check-in
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<<include>>

<<include>>

<<include>>

<<include>>
<<include>>
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6.2.2 Refining Use Cases via Modeled Activity Diagrams

In accordance with the UML methodology, each use case is typically refined by a sequence 
diagram, describing the scenario in reasonable detail: messages received, activities performed, 
the system components performing these activities, etc.

UML standards also allow an alternative way of representing the same use-case scenarios: via 
activity diagrams. In many cases, activity diagrams are even more readable; their lesser 
popularity is due to the fact that many widely used UML tools began to support this diagram 
type only recently.

Sequence diagrams have a different graphical structure than class diagrams; therefore, these 
cannot be adequately represented by GRADE. On the other hand, activity diagrams can be 
created easily in GRADE using the appropriate class and association stereotypes.

In the Check-In example, you can find one class diagram that models activities: Registration in 
the Activities package. This diagram provides some refinement of the main use case, Registration. 
Figure 6-2 shows a fragment of this modeled activity diagram.

Because the names in the use case and the modeled activity diagram coincide, you can use 
GRADE’s navigation facilities to go from the use case to its refining activities. (Note that there 
is no possibility in GRADE of attaching a class diagram under a class in the model tree.)

Elements of Activity Diagrams

The main element of an activity diagram is the activity (or action state). This stereotype is in 
the shape of a rounded rectangle; its color in our example is light blue. An activity typically 
contains only its name, but attributes defining, e.g., the performer of the activity could be added 
as well.

Activities following each other are linked via control flow, which is a stereotype of a dependency 
(represented by a solid line instead of a dashed one). The starting point of the diagram is shown 
by an unnamed class having the start stereotype (black dot). Thus, the first activity to be 
performed in the scenario is Verify Passenger and Flight Data. Control flows branch at decision 
symbols (these are classes with the stereotype DecisionMerge). The outgoing flows should be 
marked with distinct labels (called guard conditions); in this example, the labels OK and 
overbooking are used. A decision symbol also can be used to merge several flows.

A feature not available in standard activity diagrams is an explicit representation of activity 
decomposition. This is done in GRADE by using the standard aggregation symbol (more 
precisely, its composition option).

In addition to activities, UML activity diagrams may contain objects. You can see an example 
of an activity diagram in the Automatic Teller Machine sample model (the Top-Level Activity 
Diagram), where objects are used in strong adherence to UML syntax. Our modeled activity 
diagrams may contain both objects and classes; the activity diagram example from the Check-In 
model contains only classes. Classes are linked to activities via object flow lines; this type of line 
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also is a stereotype of a dependency and depicts an input or output relationship. Thus, Flight 
Coupon is input for Verify Passenger and Flight Data; Seat is output by Select Seat. An activity also 
may update a class (or object); in that case, arrowheads should be attached to both ends (using 
the mechanism for changing symbol styles). The most important types of associations between 
classes in activity diagrams are shown in the following figure:

Figure 6-2: A modeled activity diagram
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Because of the need to show associations and aggregations between the objects participating in 
activities, class symbols are used instead of objects in the Registration activity diagram. 

The following list summarizes the stereotypes used for modeled use-case and activity diagrams:

Figure 6-3: Stereotypes for use-case and activity diagrams

communicate Binary
association

extend Binary
association

include Binary
association

Activity Class

Activity synchronization Class

Actor Class

DecisionMerge Class

document Class

Process Class

Start Class

Use case Class

Control flow Dependency

Object flow Dependency

Base type: Binary association

Stereotype name: Base type: Style: Attributes: Description:

Base type: Class

Stereotype name: Base type: Style: Attributes: Description:

Base type: Dependency

Stereotype name: Base type: Style: Attributes: Description:
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6.2.3 Describing System Dynamics Via Modeled State Diagrams

State diagrams in UML are frequently used for high-level descriptions of system behavior. This 
type of diagram also can be modeled quite successfully via class diagrams with stereotypes. 

We show here a modeled state diagram example from the Automatic Teller Machine model, 
which comes with the GRADE installation. The ATM State Diagram for Class ATM is a typical, 
high-level description of ATM behavior. The stereotypes used for modeling a state diagram are 
<<state>>, <<start>>, <<end>>, and <<transition>>. The state symbol is the most complicated; 
in addition to a name, it may contain an action description list. Each action consists of its timing 
specification (entry, do) and the proper action. The action may be a simple action, defined by its 
name, or a send-event action identified by the keyword send.

Figure 6-4: State-diagram example

Collaboration diagrams, in the simplest cases, also can be modeled via class diagrams with 
stereotypes. Since collaboration diagrams are mainly used at late design stages as a vehicle for 
extending the class-operation list, we give no example here. This type of diagram consists of 
objects or classes in the role of symbols. The stereotype <<object link>>, defined on the basis of 
an association, could be used for defining object links, with an arrow icon showing the message 
direction.
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The other UML diagram types cannot be represented as adequately via class-diagram 
stereotypes. Moreover, these diagram types are used mainly in later stages of IT-system 
development, where the use of GRADE is generally less effective.

6.3 Tags and Properties

In addition to stereotypes, properties and tags (tagged values) are an important extension 
mechanism in the UML language. Properties can be assigned to classes, attributes, operations, 
associations, association ends, aggregations, generalizations and dependencies. All of these 
possibilities are also supported by GRADE. A property is a comma-delimited sequence of 
tagged values, where a tagged value is a pair

tag=value

In GRADE diagrams, properties appear in braces.

Here is an example of an attribute property:

Flight_ID{ColumnType=varchar,Length=9,NullsOK=false}

If the value is the Boolean value true, it may be omitted; i.e., only the tag is present in the 
property:

Airline_ID{PrimaryKey,NullsOK=false}

In GRADE, tags are defined in a tag table, which, like the stereotype table, is global for the 
entire model. The following figure shows an example of a tag table:

Figure 6-5: Tag table in GRADE

If the tag table presents values for a tag, you should choose a value from that list.

ColumnType Attribute varchar,
int

is navigable Binary association false

Length Attribute

NullsOK Attribute false,
true

persistence Class Persistent,
Transient

PrimaryKey Attribute

Unique Attribute

Tag name: Base type: Value set: Description:
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You can define your tags in the tag table and then use them to express the class properties defined 
within the framework of your project. Working with the tag table in GRADE is the same as 
working with other tables (stereotypes, etc.) and therefore is not described in detail here.

The most typical use of tags and properties in UML is for controlling system implementation 
language-dependent features in UML tools (especially code generation). Since GRADE itself 
does not perform code generation, it was designed to work in tandem with another UML tool 
that does: Rational Rose from the Rational Software Company. Therefore, a predefined tag table 
is used in GRADE. This table complies with the basic usage of tags for two purposes in Rational 
Rose:

• DDL generation for relational databases

• C++ class header generation.

Actually, the table seen in Figure 6-5 is this predefined table. It can be modified, but usually 
there is no need for this.

6.4 Preparing GRADE Diagrams for Export to Rational Rose

There are two design steps for which it is reasonable to start with a GRADE object model and 
then continue in Rational Rose: the formal definition of a database structure via a class diagram 
and the preparation of a class diagram for C++ header generation. Both of these operations can 
be completed only in Rational Rose. GRADE is used for designing these two diagrams because 
of its excellent drawing and layout capabilities. Database diagrams, in particular, tend to be large 
and indivisible, but these can be handled easily with GRADE, since one of the application's 
special features is the view mechanism for class diagrams (typically found only in entity-
relationship tools). The view mechanism allows you to create a separate view diagram 
containing only the specified parts of a larger diagram. Thus, by making use of GRADE's view 
and layout features, you can design databases of realistic size (several hundred classes). These 
database designs then can be exported to Rose, merely for DDL generation for the desired 
database server.

Class diagrams meant for export to Rational Rose should be created in strong adherence to 
UML syntax: always enter class attributes and operations using the New or Edit boxes (see 
Page 143 and Page 147).
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6.4.1 Preparing a Diagram for Database DDL Generation

Diagram requirements for DDL generation depend to a great degree on the mapping used by 
the code-generation tools. In the case of DDL generation by Rational Rose for typical relational 
database servers, these requirements are quite simple:

• Association cardinalities must be either one-to-one or one-to-many to permit the use of 
foreign keys.

• Generalizations and aggregations should be avoided, since only partial support for them is 
ensured.

All other settings are specified via tags from the default tag table:

• All classes used for database definition must have the tag persistence, with the value Persistent. 
This is essential to ensure that DDL generation from the corresponding classes in Rational 
Rose will be enabled (see Figure 6-6).

• The tag is_navigable is assigned to association ends to indicate whether the association is 
navigable in the given direction. It must be set to the value false for association ends where 
foreign keys must not be generated. In particular, it must be set to false for association ends 
with “many” cardinality. It should be noted that Rational Rose generates foreign keys 
everywhere by default, except where this is blocked by the setting is_navigable=false (see Fig. 
Figure 6-6).

• For class attributes serving as primary keys, the tag PrimaryKey must be set (with only the 
default value true; therefore, the value is not shown explicitly). For composite primary keys, 
several attributes must have this tag.

• The default column type for an attribute is varchar, but it can be reset using the tag 
ColumnType (with values equal to valid SQL column data types).

• The column length can be set by the Length tag, which must have an integer value. 
Otherwise, the Rational Rose default length is used.

• The non-null property for a column can be set by the tag NullsOK=false (default is true). If 
a foreign key always must be non-null, the only way to ensure this is to mark the 
corresponding primary key as non-null.

• The value uniqueness property can be set via the tag Unique (with the default value true, not 
shown explicitly).
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Figure 6-6: Diagram prepared for DDL generation

Airline
{persistence =
Persistent}

Airline name
Airline ID{
PrimaryKey }

Aircraft
{persistence =
Persistent}

Reg ID{ PrimaryKey }
Date manufactured
Date acquired
Flight hours

Flight Coupon
{persistence =
Persistent}

Booking status
Class
Advance seat
number

Coupon ID{
PrimaryKey }

Issue date

Equipment Type and Version
{persistence = Persistent}
Type name{ PrimaryKey }
Version{ PrimaryKey }
Modification

Flight Leg
{persistence = Persistent}
Flight ID{ PrimaryKey }
Flight date{ PrimaryKey }
Origin{ PrimaryKey }
Destination
Check-in status

Flight
{persistence =
Persistent}

Flight ID{
PrimaryKey }

Flight date{
PrimaryKey }

Origin
Destination

Boarding Pass
{persistence = Persistent}
Boarding number{ PrimaryKey }
Boarding status
Seat number

Passenger
{persistence = Persistent}
Last name{ PrimaryKey }
First name{ PrimaryKey }
Bonus type
Status
Cabin baggage weight
Checked baggage weight

performed on
{is navigable=false}

*

1

to
{is navigable=false} *

1
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{is navigable=false}

1..*1

provided by
{is navigable=false}

1..*

1
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{is navigable=false}

1..*

1

for
{is navigable=false}

1

1..*

consists of

{is navigable
=false}

1

1..*

for
{is navigable
=false}

1..*

1

for
{is navigable=false} *

1
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You can set tags by first selecting the appropriate tag in the Pick tag combo box and then 
selecting the appropriate value in the and value combo box (as shown in the following figure). 
After that, click the gray arrow, and the complete tagged value is added to the property. Numeric 
values must be entered directly into the Properties field; the trailing comma must be removed.

Figure 6-7: Setting tags and values

No other processing of the diagram is required. A fragment of a prepared diagram can be seen 
in Figure 6-6.

6.4.2 Preparing a Diagram for C++ Header Generation

Another design step that can be started in GRADE but completed in Rational Rose is the 
generation of a skeleton for the implementation language code. Here, we consider header 
generation for C++, but for other languages supported by Rational Rose (Visual Basic, Java), the 
situation is similar. The rationale for initiating this task in GRADE is the same: GRADE has 
better diagram-drawing capabilities.

Again, the requirements for preparing a diagram for C++ code generation depend on the 
mapping used. When generation is performed in Rational Rose, C++ data are generated for 

• classes

• attributes
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• associations

• operations.

Each class attribute becomes a data member (together with the supporting methods) of the 
corresponding class in C++; therefore, a valid C++ data type must be assigned to it. Of course, 
user-defined data types also are permitted.

If an association is navigable in a given direction, a data member is generated for the “source” 
class of this direction. If the cardinality is one, a pointer to the “target” class is generated; for 
multiple cardinality, a collection is generated. In any case, the member name is the role name at 
the target end (if present) or the default name the_<target_class_name>.

The main reason for setting tags is to eliminate unnecessary data members from associations, 
especially those of the collection type. Again, this is done by setting the tag is_navigable=false at 
the corresponding association end (e.g., for the owner association at the Aircraft end). Of course, 
a number of tags influencing code generation can be set in Rational Rose, but typically the 
default values (as imported from GRADE) are acceptable. Consequently, additional tags are not 
provided in GRADE.

The other reason for setting tags is to support the generation of meaningful member names in 
C++ code; therefore, the true “role style” should be used, with “substantivized” role names such 
as owner, holder, etc. (By substantivized we mean turning a verb, such as owns, into a noun, such 
as owner.)

The following figure shows a diagram prepared for C++ code generation. Based on this example, 
you can expect that the Aircraft class will have a data member

Airline * owner
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Figure 6-8: Diagram prepared for C++ code generation

6.5 Exporting Diagrams in Rational Rose

You can export a package together with all its contents (classes, class diagrams, subordinate 
packages) in Rational Rose. (This feature is available only if you are working with Windows 95, 
Windows 98 or Windows NT.) You cannot export a single CL diagram (not even a “free” one, 
i.e., one that is not attached to the rest of the model tree). The reason is that Rose requires class 
definitions as called for by UML requirements, and these definitions are present only in a 
package (in its class definition table). The exported package is converted to the so-called Petal 
code (*.ptl file), which can be imported by Rational Rose.

To export a package, proceed as follows:

1 With the model tree open, activate the package by clicking it.

2 Open the Tools menu and execute the Export in Rose PTL... command.

3 In the dialog window that appears, select a file name and folder for the diagram to be 
exported.

Airline
Airline_name:char[20]
Airline_ID:char[3]

Flight_Leg
Flight_ID:char[7]
Flight_date:Date
Origin:char[3]
Destination:char[3]
Check_in_status:char[3]

Equipment_Type_and
_Version

Type_name:char[20]
Version:char[20]
Modification:char[20]

Aircraft
Reg_ID:char[10]
Date_manufactured:Date
Date_acquired:Date
Flight_hours:int

Flight
Flight_ID:char[7]
Flight_date:Date
Origin:char[3]
Destination:char[3]

provider

{is_navigable=false}

1..*

1

type

{is_navigable=false}1..*

1

1..*

owner

{is_navigable=false} 1..*1
*

1
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4 Click OK.

6.6 Importing Diagrams Into Rational Rose

This section provides a few helpful hints regarding import into Rational Rose. For more detailed 
information, consult the manual “Rational Rose 98. Using Rational Rose” published by the 
Rational Software Corporation, 1998.

The ptl file generated by GRADE must be imported into Rational Rose. Do not simply open 
this file in Rose, as this will result in error messages.

During the importation process, a new Rose model is created. The package exported from 
GRADE, together with its entire substructure, is placed under the default top package Logical 
View in Rose. The obtained hierarchy of packages, classes and class diagrams is the same as in 
GRADE. Package diagrams themselves are represented as class diagrams in Rose. But only 
subordinate packages are visible in them; there are no class diagram symbols in Rose class 
diagrams. Consequently, package diagrams containing only class diagram symbols become 
empty when imported. Dependencies in GRADE package diagrams are mapped to package 
dependencies in Rose.

The import of class diagrams occurs in a straightforward way, with the complete correspondence 
of standard UML elements in GRADE and Rational Rose. 

During the import of class symbols, both properties and descriptions are mapped to the 
corresponding documentation fields in Rose. If the properties contain a valid tag list (as defined 
in “Tags and Properties” on Page 211 and “Preparing GRADE Diagrams for Export to Rational 
Rose” on Page 212), they are, in addition, mapped to the corresponding Rose tag settings. 
Objects are ignored; there is no object symbol in Rational Rose. Free comments are converted 
to Rose text boxes. For associations, the mapping is also straightforward; again, properties of 
elements are converted to the corresponding documentation (and to the Rose tag setting, if 
applicable). N-ary associations are absent in Rose and therefore ignored. 

Generally speaking, the diagram layout is preserved during export/import. However, the 
diagram layout obtained in Rose may tend to be less readable due to differences in layout 
principles. The main problems are texts at lines (e.g., association roles). Rose frequently 
repositions these. For export, avoid oblique line style; oblique lines (more precisely, their last or 
sole segments) in Rose always are directed toward the connected symbol’s center, which results 
in a completely different positioning of connection points. 

�
During export, the error messages E5031 or E5032 may appear. Both may be displayed in situations 
when a class in a diagram has an incorrect package reference, either empty or pointing to a package 
that does not exist in the package tree. Both may be caused only by an incorrect manual move of a 
diagram between package trees. Correct the relevant package fields manually (see “Moving Packages 
and Class Diagrams” on Page 194).
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One more issue is texts consisting of several lines in GRADE (class names, role names, etc.). 
Rose always uses one line per text, so you have to reshape the text or symbol in Rose manually. 
GRADE’s generalization and aggregation forks also can result in a different layout when the 
diagram is exported to Rose. Rose does not use forks for aggregations, and generalization forks 
are restricted in shape. Therefore, exported forks generally appear as overlapping lines in Rose. 
Note also that GRADE visibility settings for class texts are not exported to Rose: If, for example, 
in GRADE the stereotype name is set to invisible for a class symbol and this reduces the symbol’s 
size, after export to Rose this stereotype name becomes visible and the class symbol occupies 
more space. If you want to preserve layout as much as possible, avoid invisible texts in GRADE. 
Abstract lines and abstract forks are ignored at export altogether. Class diagram views are also 
ignored during export.

If your exported model contains a diagram ready for DDL generation, you can go directly to 
the generation; no additional diagram processing is required in Rose. But the following hints 
may be helpful:

• In options, set the selected database server type as default.

• In options, set the generated column type to a valid SQL value, e.g., INT.

• Set the default length of VARCHAR columns to a reasonable value >1.

• Select diagram classes for generation in such an order that “definitions” come first and 
“references” (via expected foreign keys) afterward. Do not use simply Select All.

Again, for more information on these topics, see the Rational Rose documentation. 

The application of C++ code generated for appropriate imported diagrams is even simpler; no 
additional activities are required.

The supported versions of Rational Rose are Rational Rose 98 and 98i.
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Chapter 7
System Modeling

7.1 System Modeling: Basic Concepts

As GRADE is a very flexible tool, it provides you with various possibilities for modeling your 
system. Each approach has a different focus and different advantages:

• Business models (based on ORG and BP diagrams) are very useful if your main focus is on 
processes: work flow, procedures, the overall structure of operations.

• Object models (based on CL diagrams) are very useful for creating an initial outline of a 
system, for reflecting the static state of a system and for IT-system design.

• System models, which we will introduce in this chapter, focus more on the components of a 
system and how they interact; you can fully describe and analyze the function of each 
component and its interfaces to other components.

System modeling is based on the premise that complex systems can be modeled effectively using 
the three fundamental building blocks of sociotechnological systems:

• active objects

• passive objects

• processes.

In a GRADE system model, these building blocks are interlinked and can be represented 
hierarchically. Each building block has its own type of diagram(s).

Active objects are bounded parts of the physical world that are capable of performing a process, 
i.e., receiving inputs, acting upon them and producing outputs for other active objects. Typical 
examples are companies, departments within companies, information systems, machines, as 
well as any combination of these.

Passive objects are objects that are created, sent, received or otherwise worked upon by an active 
object. Some examples of passive objects are documents, pure information, materials and 
consumable resources.
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A process is a series of tasks triggered by an event and performed to produce a result. Typical 
examples of processes are tracking the maintenance of airplanes, handling orders and invoices, 
processing tax returns, etc.

These fundamental building blocks are represented in the following types of diagrams:

• Communicating objects (CO) diagrams, which represent active objects and communication 
paths between them;

• Data definition (DD) and entity-relationship (ER) diagrams, which represent passive 
objects;

• Process diagrams (PD), which represent processes.

The relationships between these three fundamental building blocks are shown in the following 
figure:

Figure 7-1: Relationships between the building blocks of system models

�
In the following sections, we will provide an overview of the diagrams used in system modeling. 
The creation of these diagrams is analogous to that described in earlier chapters; thus, we will not 
be presenting full details here. If you do need additional hints, please consult the online helps, i.e., 
click the Help menu, then Contents, then scroll down to the bottom of the window and click any of 
the topics under Structure and Software Modeling.

Because data definition diagrams (DD) also can be used with other types of modeling, they are 
described in the chapter on general-use diagrams; see “Data Definition Diagrams (DD)” on Page 
271.
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7.2 Communicating Objects (CO) Diagrams

CO diagrams are used to describe the static structure of a system. In CO diagrams, you can see 
how a communicating object is broken down into subobjects; you can also view the 
communication among these objects and subobjects.

CO diagrams have two major components:

• Communicating objects, also known as active objects. These depict real, physically bounded 
entities that perform some activity.

• Communication paths. These paths, which join two communicating objects (active objects), 
signify communication in the specified direction, i.e., the exchange of passive objects 
between the active objects. When passive objects are transferred in this way, they are referred 
to as transfer objects. The contents of this communication are depicted in transfer object 
(TO) tables. (These are described in Section “Transfer Object (TO) Tables” on Page 232.)

Each active object can be further defined in a subordinated CO diagram bearing its name.

�
Be aware of this special GRADE feature: Using an existing business model (with valid BP and ORG 
diagrams), GRADE can create a basic system model automatically! For more details about this, 
please consult “Converting Business Models to System Models” on Page 262.

The reverse is also true: GRADE can take a system model and generate a draft business model 
from it automatically. For more details, see “Converting System Models to Business Models” on 
Page 264.

�
Note that system modeling was designed to enable specification of models to the level of detail 
required for prototyping and code generation based on the graphical GRADE/4GL language. 
(Prototyping means “running” the system model, analogous to the simulation of business models.) 
This formal modeling is beyond the scope of this document; only a subset of GRADE features used 
for specifying systems is described here. The typical user most likely will not use many of the formal 
language features available. In addition to “normal” data processing and interprocess 
communication statements, GRADE/4GL also contains sophisticated constructs for database 
manipulation, screen input/output (screen forms) and reports. See also the GRADE online help.

�
A word on terminology: As you will have noted, communicating objects are the same as active 
objects. To avoid confusion, we will simply refer to these as active objects from this point on.
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A typical active object might look like this:

Figure 7-2: Active object High Value Auto Parts Company

The active object may be connected to another active object via an arrow, which indicates the 
direction of flow for specified information or materials. For instance, the root (highest-level) 
CO diagram for the High Value Auto Parts Company model used in previous chapters might be 
represented as follows:

Figure 7-3: CO diagram High Value Auto Parts Company and Environment
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Customer and Supplier constitute the environment of the closed system to be modeled. The 
arrows are the communication paths, indicating the transfer of passive objects (information, 
materials, etc.) between the active objects. The internal structure of the High Value Auto Parts 
Company can be depicted in subordinate diagrams, as seen in the following figure. Note that 
the dashed arrows represent communication paths to active objects on a higher level. 

Figure 7-4: CO diagram of departments within High Value Auto Parts Company

A CO symbol can also be refined by a subordinate process diagram (PD). For more information 
about this, please see “Process Diagrams (PD)” on Page 240. An active object in a CO diagram 
may be refined by both a subordinate CO and a PD; in that case, however, only one refinement 
can be active (visible) at a time.

If you have a subordinate diagram open and want to navigate to the corresponding “parent” 
diagram, simply click the following icon:

The parent diagram will be opened and the corresponding parent symbol will be activated.
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7.2.1 CO Diagram Window

Because the CO diagram window is very similar to the ORG diagram window, it will not be 
discussed in detail here. (If you have questions, refer back to “ORG Diagram Window” on Page 
39.)

The one major difference between the ORG and CO windows is the symbol palette, which is 
described in the following table:

Table 7-1: Symbol palette of the CO diagram

The creation of CO symbols and connectors is analogous to that already described for other 
types of diagrams. The techniques used for editing symbols, etc., are also similar; for more 
information, consult Chapter 2.

In the following sections, you will find special hints for creating the symbols and connectors in 
CO diagrams, as well as information about the channels via which transfer objects are 
transported.

Symbol Name Function

Deselect Cancels a selection in the symbol palette. If you select an 
element in the symbol palette, then decide it was the wrong 
one, click this arrow to deselect your choice. 

Active object Creates an active object.

Communication path Creates a communication path.

Database Creates a database symbol (the structure of the database 
itself will be represented in an ER diagram).

Access path Creates an access path from an active object to a database; 
when creating this path, you can specify the rights for 
accessing the database: read, write, or read and write.

Activation path Creates an activation path, used for prototyping purposes; 
any activated object can activate other objects via an 
activation path. If you are creating an informal model, you 
can use this arrow in a different way, e.g., to represent a 
dependency between two active objects.

Free comment Creates a free comment symbol (analogous to the free 
comment symbols in other diagrams).
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7.2.2 Creating Active Objects

During the creation of an active object, the following dialog appears:

Figure 7-5: Dialog for defining active objects
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If you have questions about any part of this dialog, consult the following table:

Dialog Element Meaning

Name Any GRADE identifier (by “identifier” we mean a name that is valid for GRADE; see 
also “Rules for the Selection of Names in GRADE” on Page 29). You may type in or 
pick a name via the Pick name button.

Alt. name Alternative name

Type This field is deactivated.

Comment Arbitrary text, which will appear in the symbol. Use Ctrl+Enter to create a new line 
within this field.

Task Mark this check box to indicate that this is an active object for which an executable 
program is to be created. (This is relevant only for code generation and will not be 
discussed further here.)

Autoactivated Mark this check box to indicate that this active object is to be started automatically 
during test runs of the diagram (used in conjunction with prototyping).

Array Mark this check box to indicate that the active object is an arbitrarily chosen example 
of a set of identical objects (for purposes of analysis or modeling), such as the customers 
of a bank. Objects identified as an array are represented in the diagram as two 
overlapping rectangles. Identification as an array has no further functional significance. 
It is merely a kind of graphical comment.

“Visible” box For purposes of picking a name, this box will determine the range from which you can 
choose. To get the broadest possible range use All; to narrow the range, click Subtree or 
Visible (for an explanation of visibility, see the Glossary).

Table 7-2: Elements of the Active Object dialog
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7.2.3 Creating a Database Symbol

When you create a database symbol, the following dialog will appear:

Figure 7-6: Dialog for definition of database symbol

The fields seen in this dialog are analogous to those used for defining an active object (see 
“Creating Active Objects” on Page 227). In the Entity-relationship model field, however, you can 
enter the name of an ER model that describes the database. If this model exists, simply click the 
down arrow next to the field, then select it (the selection range will be determined by what you 
have specified in the Names box). If the ER model has the same name as the database itself, this 
field may remain empty. The symbol will display the name of the ER model:
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7.2.4 Creating Connection Paths

In CO diagrams, you can also create communication, access, and activation paths. The 
procedure is similar to the creation of connectors in other diagrams: Click the appropriate type 
of connector in the symbol palette, place your arrow pointer on one symbol, then “drag” over 
to the other. In the case of communication and access paths, GRADE gives the path a default 
name, which you can change. In the case of access paths, you can click a radio button to specify 
the access rights. Below, we describe how the different types of paths are used.

Internal Versus External Communication Paths

If you connect two symbols that are visible in the diagram, an internal path will be created; if 
one end of your connector appears to be “hanging in mid-air,” it is an external path. It 
represents a communication path that is continued in the CO diagram at the next highest level. 
(Thus, external communication paths are not permitted in the top diagram.) External 
communication paths can be refined in TO tables, just as internal communication paths are. As 
you can see in the figure below, external communication paths appear as dashed lines. When 
you create such a path, GRADE by default will place an X in the name to indicate the external 
link (e.g., you could read the name of the path in the top right part of the diagram as “Sales 
Department to external”):

Access Paths

An internal access path is used to connect an active object to a database. When creating an 
internal access path, be aware that you can determine the access rights by marking one of three 
radio buttons: Read, Write or Read and write. When the path appears in the diagram, a circle at 

�
As mentioned, GRADE suggests path names in CO diagrams. You have the option of specifying 
the length of these suggested names; see the explanation of the setting Default path names in CO, 
on Page 391.
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the active object end means that the object has the right to read the database; a circle at the 
database end means that the object can “write” in the database; circles at both ends indicate read 
and write access, as seen here:

Just as communication paths are described in TO tables, access paths can be described in access 
tables (also known as ATs; for more information, see “Access Tables (AT)” on Page 254).

An external access path is used to link an active object in a CO diagram to a database in a CO 
diagram on the next higher level. (A database located in a CO diagram on a lower level cannot 
be accessed because it lies outside the visibility area of the active object concerned; for more 
about visibility, see the Glossary.) One end of the symbol for the external access path is 
connected to an object, while the other end is open. Creating an external access path is basically 
the same as creating an internal one, but you will be asked to fill out a field named Database 
reference to indicate the database to be accessed (simply click the down arrow and make your 
selection). External access paths also can be further defined in an AT. 

Activation Paths

As mentioned, activation paths are used for prototyping purposes. This topic will not be further 
discussed here, since prototyping is not part of the standard GRADE Modeler package. If you 
are interested in this feature, please contact INFOLOGISTIK GmbH to purchase GRADE-P.

If you are creating an informal model, you can use the activation path in a different way, to 
represent a dependency between two active objects, with the arrow pointing to the active object 
that is dependent on the other. Activation paths do not have names.

7.2.5 Channels

We have mentioned the fact that communication paths indicate communication between active 
objects; channels are used to describe this communication. A communication path can be 
divided into several channels, with each channel transporting a specified type of transfer object 
in a specified direction (from sending object to receiving object). A channel can connect any two 
active objects in a model, regardless of the distance between them in the model hierarchy.

Instructions for defining a channel can be found in Section “Creating a Channel From a CO 
Diagram” on Page 234 and in “Defining a Channel Via the Global TO Table” on Page 236. 
Basically, this involves specifying the sender, the receiver, and the transfer object. This 
information then appears automatically in all relevant transfer object (TO) tables.
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The point at which an active object is connected to a channel is known as a plug; transfer objects 
are sent to/sent from this point. GRADE generates plugs automatically. You might need to 
create them manually only in rare, complex cases.

If you double-click a communication path, you will see all channels on that path. If there are 
several communication paths linking the same two active objects, clicking any of these paths will 
display the same channel(s).

7.2.6 Other Operations in CO Diagrams

There are, of course, many other operations that can be performed in CO diagrams, such as 
deleting, copying, and moving elements; creating a free comment; modifying symbol contents; 
changing the zoom coefficient; selecting a different layout style. These operations are analogous 
to those in ORG and BP diagrams; for more information, consult Chapter 2 and Chapter 3.

7.3 Transfer Object (TO) Tables

As mentioned, when you create a channel for any given transfer object, this channel information 
will be reflected automatically in all relevant TO tables.

A new CO model initially has no entries in its global TO table, which looks something like this:

Figure 7-7: Empty TO table

�
Note that you can specify the columns to be displayed according to your needs. To do this, simply 
open the Options menu, then select Column settings... By marking/unmarking the check boxes in 
the Visible column, you can determine what is shown. In the following figures, you will see examples 
of transfer object tables in which some columns are hidden.
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The following figure is a fragment of a global TO table based on our High Value Auto Parts 
Company example. Here, you can see how a TO table appears when channels have been 
defined:

Figure 7-8: Filled-in TO table

If you are interested in seeing only a certain portion of the information in the global TO table, 
you can open the related input or output TO tables, which are created automatically. The 
following input TO table shows items that may be received by a customer: the product and 
invoice or a rejection letter.

Figure 7-9: Input TO table

If you need to modify a channel, you can carry out this change in the global TO table; the 
change then will be reflected in the input and output TO tables, as well.
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7.3.1 Opening TO Tables

To open the global TO table, which contains a full list of the model’s transfer objects, display 
the model tree. Then open the Model menu and select the Show all transfer objects command.

To open a particular input or output transfer object table, display the model tree, then click 
one of the TO icons to the right of the corresponding name (for example, to the right of the 
name Customer). The TO icon on the far right contains the output transfer objects; that next to 
it is for input transfer objects.

If you want to examine the transfer objects passed between two active objects in a diagram, 
open the diagram, then double-click the communication path between the two active objects.

Now that you know what channels are, the obvious question arises: How are these channels 
defined and, if necessary, changed? This is discussed in the following sections.

7.3.2 Creating a Channel

There are basically two methods for creating a channel.

Creating a Channel From a CO Diagram

Let’s first assume you have a CO diagram open in which the sending and/or receiving object is 
displayed.

Proceed as follows:

1 Locate the communication path linking the two active objects. If there is not yet a 
communication path in the required direction, define one by clicking the 
communication path icon (appears as a plain arrow) in the symbol palette, then 
dragging your mouse pointer from the sending object to the receiving object and letting 
go. If the two active objects are found in separate diagrams, you can start drawing your 
communication path from the sending object, then let it “hang” in mid-air; GRADE 
will create an external communication path represented by a dashed line. (You will 
specify the receiving object later, in Step 6.)
Chapter 7 



2 Now double-click the communication path. The corresponding TO table will be 
displayed. In the example here, you see a TO table for the display of objects transferred 
between Customer and Clerical Staff:

Figure 7-10: Empty TO table

3 To create a new row in the table, click the yellow New row icon seen to the left. (As an 
alternative, open the Edit menu and select Insert row... or simply hit the Ins key.)

4 A dialog will open:

Figure 7-11: Transfer Object Table Entry dialog

5 Type the name of the transfer object (or a data type, more about this later) into the 
Transfer object field (e.g., New Order). If your model already contains transfer objects, 
you can pick one of these by using the Pick TO button (if you select a user-defined type, 
be sure to confirm your choice by clicking the left arrow icon).
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6 Make sure the correct sender and receiver appear in their corresponding fields. If not, 
click the downward arrow next to these fields and select the appropriate name.

7 Fill in any other necessary information, e.g., if you wish, you can fill in a channel name. 
If you fill in a channel name and leave the Receiving plug field empty, the sending plug, 
receiving plug and channel all will have the same name. (The transmission mode, at the 
bottom of the window, is set to ASYN, asynchronous, by default and can be left as is for 
our purposes.)

8 Click OK. The new line appears in the TO table, as seen here:

Figure 7-12: Defining a channel

In rare cases, you may want to define plugs. As you may recall, a plug is the connecting point 
between an active object and a channel. The advantage of defining a plug is that you can 
characterize its function; i.e., give the plug from which the new order is sent the name New 
Order Sent, and give the other plug the name New Order Received. To define plugs, follow the 
instructions for defining a channel given above, but in the Channel/sending plug field, enter a 
name for the sending plug, and in the Receiving plug field, enter a name for the receiving plug. 
When you have made all your entries, click OK.

The newly defined channel now appears in all relevant model tables. Any missing 
communication paths will be drawn in automatically by GRADE. (For example, if the sending 
and receiving objects appear in different diagrams, and you have drawn only an external 
communication path from the sender in its diagram, GRADE will create a corresponding 
external communications path to the receiver in its diagram.)

The GRADE Modeler allows you to define several communication paths in the same direction 
between the same two active objects. All of these definitions open the same TO table.

Defining a Channel Via the Global TO Table

To define a channel via the global TO table, proceed as follows:

1 Open the model tree.

2 Click Model, then on Show all transfer objects.
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3 A global TO table will appear:

Figure 7-13: Global TO table

4 Click the yellow New row icon to create a new row.

5 Follow Steps 4-8 in the instructions given above (Page 235).

7.3.3 Deleting a Channel

To delete a channel, proceed as follows:

1 Open a diagram in which the communication path containing the channel to be deleted 
is visible.

2 Double-click the corresponding communication path to display the TO table.

3 Click the row to be deleted, the press the Del key (or select Delete from the Edit menu). 
Click Yes when asked whether you really want to delete.

The channel is deleted from all relevant TO tables. (Any plugs assigned to this channel are also 
deleted, unless they are also linked to another channel.)

Another way of deleting is to open the global TO table, select the appropriate row, press Del, 
then confirm with Yes.

7.3.4 Modifying a Channel

To modify a channel, proceed as follows:

1 Open a diagram in which the communication path containing the channel you want to 
edit is visible.
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2 Double-click the corresponding communication path to display the TO table.

3 Click the corresponding row with your right mouse button to reveal a pop-up menu, 
then select the Edit row... command.

4 Make your changes.

5 Click the OK button.

Another way of modifying a channel is to open the global TO table, then follow Steps 3-5 above.

Editing a channel is equivalent to deleting the old channel and creating a new one. 
Consequently, existing plugs are deleted unless they are linked to another channel.

When you edit a channel, you also can connect other active objects to this channel by changing 
the entries in the Sender and Receiver fields. Although this is generally not a good thing to do, it 
can make sense in certain situations (for example, when the object is refined).

7.3.5 Refining Channels

If you have refined the structuring of an active object in your model (e.g., split one object into 
two parts), you may also have to redirect the channels in the diagram so that they are attached 
to the corresponding new active objects (also called refinement objects).

Example:

If active object A, which has three input channels (P, Q and R), is refined to form the subobjects 
A1 and A2, you must redirect all three of active object A’s input channels either to object A1 or 
object A2.

Proceed as follows:

1 Open the CO diagram containing the refined active object.

2 Create new communication paths as necessary to and from newly created active objects.

3 Double-click the relevant “old” communication paths to display their TO tables. 
Change the senders and receivers as necessary to ensure that the corresponding transfer 
objects are sent/received by the new active objects in the diagram.

7.3.6 Redirecting Channels

If an active object in a CO diagram is deleted, all the channels for which this active object is the 
sender or receiver are automatically redirected to the parent object of the deleted object. (By 
parent object we mean the object appearing one level higher in the CO diagram; it is the object 
that contains the child object.)
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If you want to redirect some of these channels differently (for example, to the adjacent active 
object rather than to the parent object), proceed as follows:

1 Open the CO diagram containing the active object you want to delete.

2 Double-click a communication path that connects to the active object to be deleted.

3 Click with your right mouse button on a row to be edited, then activate the Edit row... 
command.

4 If the active object to be deleted appears in the Sender field, click the downward arrow 
next to this field and select the adjacent object instead. If the active object to be deleted 
appears in the Receiver field, do likewise.

5 Click OK.

6 Repeat this process (Steps 2 through 5) as necessary.

7 Adjust the communication paths as needed to account for the fact that an active object 
will be deleted: Click a communication path to activate it, then hold down the left 
mouse button and drag the end that is attached to the active object to be deleted over to 
the adjacent object. Repeat as necessary.

8 If desired, rename the redirected communication paths (GRADE will not rename them 
automatically!). Click with your right mouse button on the name, then activate the 
Symbol contents... command. Change the name and click OK.

7.3.7 GRADE’s Automatic Management of Channels

When standard operations are executed in the model tree, GRADE manages/adjusts all 
channels automatically, as far as possible:

• When the model tree is restructured (an active object is moved to a different point in the 
model tree), all channels are modified automatically. 

• When an entire subtree is moved, all channels that connect this subtree to other parts of the 
model are modified automatically. The channels within the subtree remain as they are.

• When a subtree is duplicated and exported/imported, only the channels within the subtree 
are retained, but the plugs are duplicated, which makes it easy to connect the duplicated or 
imported subtree to the other parts of the model.

• When a single diagram is duplicated and exported/imported, the channels and plugs are not 
duplicated with it.

When a model of significant complexity is built, the advantages of using CO diagrams become 
apparent, since GRADE automatically maintains the consistency of the entire network, 
ensuring that no information goes astray.
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7.4 Process Diagrams (PD)

While CO diagrams describe the static object structure, a process diagram (PD) describes the 
dynamic behavior of an active object in the model.

You may wonder at first why process diagrams are necessary and whether they are really different 
from the business process (BP) diagrams introduced earlier. The difference lies mainly in the 
point of view: BP diagrams are created from the perspective of the process; PDs are created from 
the perspective of the performers (active objects).

This section actually deals with the most important subset of PD diagrams, formally known as 
PD process diagrams. We will refer to them hereinafter simply as PDs. (GRADE also offers 
various related diagrams. For example, PD procedure and SD procedure diagrams can be used 
to reflect the details of a process. In addition, there are SD module and PD macro diagrams. All 
of these are topics for advanced users and will not be further discussed here.)

Now let’s get back to our major topic of interest: PD process diagrams. These are usually linked 
to CO diagrams; for any active object described in a CO, there can be a PD. When you create 
a new CO diagram, an associated PD, having the same name, will be created automatically; at 
this point, the CO diagram will be in the foreground and the PD will be hidden behind it. 
Together, the CO diagram and the PD can provide a full description of an object.

A PD diagram is displayed by “toggling” (switching) between the CO and PD. With the model 
tree open, simply click with your left mouse button on the small T to the left of the CO or PD 
symbol. Only the diagram that is in the foreground can be opened and edited. 

To open and edit a PD diagram, proceed as follows:

1 Click the small T button to the left of the corresponding CO symbol. (Alternatively, 
press Ctrl+T or open the Diagram menu and activate the Toggle CO<->PD command.)

2 The PD diagram now will be brought to the foreground. You can double-click it to open 
and modify it.

To bring the CO back into the foreground, close the PD diagram, then use any of the methods 
described in Step 1, above.

PD diagrams can be used in two modes:

• an informal mode, in which the user simply uses the PD editor to “flowchart” a process (you 
will see these informal types of diagrams in the following examples), and

�
Note that the initial contents of a PD are not generated by simply toggling and opening it. Rather, 
you should open the PD, then open the Edit menu and select the Generate draft contents command.
Chapter 7 



• a formal mode, in which the user implements a syntax prompter to actually program the 
behavior of the active object in question.

The most common use of the PD is to specify software processes. It also can be used very 
effectively to specify manual processes, showing where in the manual process interaction with a 
computer take place and what processing the computer performs as a result of the user 
interaction.

PDs have a sophisticated structure in which different operations are represented by different 
graphical symbols. A wide variety of symbols are available for use. Here, we will introduce some 
of the more frequently used symbols.

Start and Stop Symbols

PDs begin with a start symbol, which may or may not contain text:

The stop symbol, which has no exits, looks like this, and marks the end of activity for the given 
process:

Send and Receive Symbols

This is an example of the send symbol, used to represent the sending of messages (the term 
messages is used broadly and may include material goods). In this example, you see the channel 
name on top and the message sent below:

This receive symbol is set up analogously:
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Procedure

The following symbol makes reference to a procedure, which is part of a process. Typical 
procedures would be registering a received application, preparing an answer to a customer 
request, paying an invoice, etc.:

Decision

As you can see in the following example, the outcome of a decision leads to two different results:

The following figure shows the same decision symbol in its broader context. Here, you can see 
that if the decision results in FALSE, the process will be stopped (stop symbol); if the decision 
results in TRUE, the process loops back and may be repeated.

Similar to the decision symbol is the case symbol, which is used for multiple branching. It looks 
like this:
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A case is like a decision, but is more generic, having 1..N outputs. When a case symbol occurs, 
an “expression” is calculated (expressions are an advanced topic that will not be discussed in 
detail here). Depending on the result of this calculation, one of the branches leading from the 
case symbol will be executed. The following figure shows a case symbol in a broader context:

Loop

A loop as used in GRADE permits the repetition of an operation or sequence of commands. 
The loop symbol looks like this:

When creating a loop, you will need to select the type. An “endless” loop means the operation 
or sequence will be repeated continually, without checking what is known as the termination 
condition. A “while” loop means that the termination condition will be checked at the start of 
the loop (i.e., the decision whether to go ahead with the operation will be made first, and the 
operation, if approved, will be carried out then). In a “repeat” loop, the decision whether to 
repeat the operation/sequence will be made at the end. (There is also a special loop symbol; see 
Page 250.) For examples of loops “in action,” see Figure 7-14, Page 246, and Figure 7-15, Page 
247.

Selective Wait

When the process arrives at a selective wait symbol, the system “decides” what to do next. This 
symbol allows the execution of only that branch for which the start signal indicated at the 
beginning of the branch has been received. Whenever the process reaches this point, only one 
branch can be executed. If no start signal is received, the process waits until one arrives.
System Modeling 243 

• 
• 
• 
•
•
•



244 

• 
• 
• 
•
•
•

The appearance of the selective wait symbol differs, depending on whether it contains text. If 
not, it resembles a ball with a cross; if it does, it is oblong. In either case, the meaning of this 
symbol is the same:

The selective wait can be viewed in context in the following diagram. When the process arrives 
at the selective wait symbol, either the invoice is sent and paid or the product is sent and used 
or the process waits for conditions to be right:

Parallel Control

The parallel control symbol, which allows all branches leading from it to be executed, looks like 
this:
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In this example, the parallel control allows the product and invoice to be prepared at the same 
time:

7.4.1 Sample PD Diagrams

Now that you are familiar with some of the basic elements used in PD diagrams, you can see 
how they interact in the following examples.

In the first diagram, you can view the transactions between a customer and the High Value Auto 
Parts Company. The customer sends an order (Customer to HVAPC - Order). Let’s assume the 
customer then receives the product and uses it (Use Product), but still has no invoice. In that 
case, the system determines that the process is incomplete (Incomplete - True). The process then 
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loops back, and this time the company send the customer an invoice. Customer pays it (Pay 
Invoice). The system determines that the process is no longer incomplete (Incomplete - False). 
The process then reaches the end (stop symbol):

Figure 7-14: PD of Customer
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In the following figure, we see the process from the point of view of a different performer, the 
active object HVAPC. Here, the customer order is received (Customer to HVAPC - Order), then 
the system arrives at a parallel control, which allows both of the ensuing branches to be executed: 
The product and invoice are prepared and sent to the customer. This process can be repeated.

Figure 7-15: PD of HVAPC

To see how the same situation is reflected in the corresponding CO diagrams, take a look at the 
following figures. In the first one, you see a CO diagram simply representing the two active 
objects with communication paths between them:

Figure 7-16: Simple CO diagram

�
Note that the previous diagrams were, in a sense, “freely drawn”; these types of diagrams are not to 
be used in conjunction with GRADE prototyping.
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The following CO diagram shows more complexity and includes the next-level processes:

Figure 7-17: CO diagram showing next-level processes

The final example in this series is a global TO table based on the previous figures; it lists transfer 
objects passed between the company and the customer and vice versa:

Figure 7-18: TO table

7.4.2 PD Diagram Window

The PD diagram window is similar to others in GRADE (for a general introduction to the 
various elements, see “ORG Diagram Window” on Page 39).

The PD symbol palette offers a wide variety of options for creating diagrams. To help you make 
sense of these many symbols, we will be presenting the most important and frequently used ones 
in the following four tables. The symbols are grouped according to function.
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The first group contains symbols used for starting/stopping processes and procedures. The start 
symbol, which was already introduced, automatically appears in new PDs and thus is not 
presented as a choice in the symbol palette, whereas the stop and end symbols are.

Table 7-3: Stop and end symbols in the PD symbol palette

The next group of symbols can be described as operational:

Table 7-4: Operational function symbols in the PD symbol palette

The next group can be referred to as interprocess communication symbols, used to depict the 
sending/receiving of messages (the term messages is used broadly and can refer to materials as 
well as information):

Table 7-5: Interprocess communication symbols in the PD symbol palette

Symbol Name Function

Stop Creates a stop symbol, representing the termination of a process.

End Creates an end symbol, representing the termination of a procedure.

Symbol Name Function

Assign Creates an assign symbol, which can informally describe a process step 
or formally assign the value of an expression to a variable (e.g., Total 
Price := Amount * Item_Price).

Procedure Creates a procedure symbol, representing part of a process (e.g., paying 
an invoice).

Symbol Name Function

Send Creates a send symbol, representing the transmission of a message.

Send and wait Creates a send and wait symbol, used to represent the synchronous 
transmission of messages, i.e., the message is sent when the receiver is 
ready to receive it.

Receive Creates a receive symbol, representing the reception of an incoming 
message.
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And finally, we introduce the flow-control group of symbols.

Table 7-6: Flow-control symbols in the PD symbol palette

The symbol palette also includes the free comment symbol, which can be used as in other 
diagrams.

7.4.3 Working With PD Diagrams

Note that there are two basic ways of defining PD symbols: with or without the use of the 
automatic syntax prompter. The syntax prompter is useful if you want to create a formal model 
that might be used for prototyping or code generation; these advanced topics will not be 
discussed further here. For informal modeling, it is usually easier to work without the syntax 
prompter. To deactivate it, open the Options menu and select Settings... In the General tab, 
unmark the Syntax prompter check box.

Symbol Name Function

Decision Creates a decision symbol, which may have two possible outputs: TRUE 
or FALSE.

Case Creates a case symbol, similar to the decision symbol, but more generic, 
with 1..N outputs.

Loop Creates a loop symbol, which permits the repetition of an operation or 
sequence of commands; loop types may be “endless,” “while,” or 
“repeat,” as described earlier.

(Special) loop Creates a special loop symbol in which a decision forms the head of the 
loop.

Parallel control Creates a parallel control symbol, which permits the parallel execution 
of several branches of a process, with synchronization at the end; in other 
words, the branches usually merge, and execution is continued to the 
next symbol after all branches have reached the merge point.

Selective wait Creates a selective wait symbol, reflecting a wait for one or more 
incoming events; once the event or events have arrived, the 
corresponding branch will be executed.

Continue Creates a continue symbol, used at the end of a control routine to 
continue event processing. (A control routine is a fragment of a PD 
diagram; control routines are activated by events triggered by the user.)

Exit Creates an exit symbol, used to exit a control routine.

Incoming label Creates an incoming label, i.e., a label for an incoming connector.

Outgoing label Creates an outgoing label, i.e., a label for an outgoing connector.
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When you open a new PD diagram, all you see is a start symbol:

Any new symbol that you create will be attached to the activated symbol automatically or will 
be added to the active control flow branch.

To create a symbol, click the corresponding icon in the symbol palette. If you have chosen a 
symbol that is not allowed at this position in the diagram (for example, a stop symbol followed 
by a stop symbol), GRADE issues a corresponding error message: Cannot insert this symbol after 
current symbol.

To insert an additional branch in multiple branches, click with your left mouse button on one 
of the gray arrows between the already existing branches.

Defining/Editing Symbols Without the Syntax Prompter

To enter the contents of a new symbol without the prompter, simply click the appropriate 
symbol in the symbol palette, and a definition window will appear in which you can make your 
entries. (In some cases, a Status list will be displayed; if you click Formal, your entered text will 
be interpreted as formal syntax and this will be taken into account during syntax analysis. If the 
Informal option is selected, the text will not be analyzed.) Make your entries and click OK.

To edit the contents of a symbol without the syntax prompter, click it with your right mouse 
button, then select Symbol contents... Edit the contents and click OK.

Defining Symbols Using the Syntax Prompter

If the syntax prompter is activated, an automatic syntax prompter window will appear as soon 
as you click a valid symbol in the symbol palette. The appearance of the window depends on 
the type of symbol you are creating. Here is an example of an automatic syntax prompter 
window:

Figure 7-19: Automatic syntax prompter window
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The left part of the automatic syntax prompter window contains buttons, check boxes, and 
possibly a selection list. These elements are described in the following table:

The right-hand part of the window contains a kind of dynamic form, in which all syntactic 
options and variants are listed (depending on whether the Pattern is visible check box is marked). 
The names of referenced components can be inserted at certain points on this form.

The following separators are used to identify variants and options:

Table 7-8: Separators used in the automatic syntax prompter window

Dialog Element Function

Save/Close Ends editing of the symbol contents and saves all changes

Cancel Ends editing of the symbol contents without saving changes

Pattern is visible If this box is checked, all possible syntax options of the associated clause appear in 
the text area on the right-hand side of the window. If the box is not checked, only 
those syntax options and variants appear that have already been selected or 
completed.

Name prompting If this box is checked, all names that are appropriate for the selected input field are 
shown.

Comment Click here to insert a comment in the symbol

Short f. (Short form) If this box is checked, the syntax in the diagram symbol is abbreviated. For example, 
instead of the keyword VIA FORM, only VIA is shown. This can be especially 
useful with lengthy clauses to save space in the diagram. In the syntax prompter 
window, however, the full-length syntax is always shown.

Table 7-7: Elements of automatic syntax prompter window

Separator Function

{...!...} Only one of the alternatives given may be selected.

{...!...}* One or more of the alternatives given may be selected. Alternatives also may be used in a clause 
more than once.

[...] Optional language element

<<...>> Input field. The type to be entered appears between the angle brackets. Data may be entered 
directly or via selection lists.
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To improve readability, elements in the right-hand window area are highlighted in different 
colors.

Table 7-9: Colors used in automatic syntax prompter window

Various operations can be performed via the mouse in the syntax prompter window. These are 
described below:

Table 7-10: Use of the mouse in the syntax prompter window

7.4.4 Other Operations in PD Diagrams

The operations that can be performed in PD diagrams are somewhat similar to those in other 
diagrams. You can cut, copy, paste and delete diagram elements by activating them, then 
pressing Ctrl+X, Ctrl+C, Ctrl+V and Del, respectively. (Note that when you activate a single 
element, additional lines and/or symbols that are linked to it may be affected.)

Color Meaning

Text colors:

Light red Marks selected elements or entered field contents.

Dark red Marks non-selected elements and input fields with no entry.

Green Marks non-selected optional elements.

White Marks names of extensions that may be opened by clicking.

Yellow Marks text in the active input field.

Background colors:

Gray Marks inactive input fields and extension names.

Black Marks active input field.

Operation Function

Single-click left Select an option or cancel a selection.

Single-click right Display a selection list.

Double-click left Within fields: delete an element, a comment, or the contents of a field.
Outside fields: save.

�
The following information is only for those using a non-U.S.-English version of the MS 
Windows keyboard driver. After entering the circumflex character ̂  in an expression, you must 
press the space bar before entering the next character.
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As regards layout, note that the locations and dimensions of symbols are set automatically by 
GRADE. You do have the choice between Normal and Compact layout; Compact makes the 
maximum use of the space available by bringing the elements closer together. In some cases, you 
can reposition a branch by activating a symbol in it, then opening the Style menu and activating 
Branch alignment, then selecting Left, Centered or Right.

Symbols can be activated by clicking them with the left mouse button. To edit the contents of 
an activated symbol or branch, simply press Return and the corresponding window will appear.

Changing the zoom coefficient and some other functions are analogous to those described for 
BP and ORG diagrams; for more information, consult Chapter 2 and Chapter 3.

7.5 Access Tables (AT)

As mentioned earlier, access paths may be described in access tables (ATs). When creating an 
access path, you specify an active object’s access rights to an entire database (read, write or read 
and write); in the access table, you describe the access rights possessed by an active object for 
the individual entities in the database. The following types of access rights can be defined in the 
access table:

• R: Read access rights

• A: Add, i.e., the right to add new instances to an entity

• U: Update, i.e., the right to update entity instances

• D: Delete, i.e., the right to delete entity instances

• G: General, i.e., all access rights.

Here, you see an example of an access table:

Figure 7-20: Access table

Each line in an AT describes the access rights to one entity and contains:

• the entity name, which should appear in the corresponding entity-relationship model (see 
“Entity-Relationship (ER) Diagrams” on Page 255);

• one or more access codes R, A, U, D (with no repetitions) or the code G for all access rights;

• a comment (optional).
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The parent of the access table is the CO diagram containing the relevant access path.

To change the contents of any row in the AT, click the corresponding row with your right mouse 
button, then activate Edit row... The Access Table Entry dialog appears. Make your changes and 
click OK.

To create a new row in an AT, click the yellow icon on the left side of the AT window, fill out 
the Access Table Entry dialog and click OK.

7.6 Entity-Relationship (ER) Diagrams

Entity-relationship (ER) diagrams represent relationships among entities as well as database or 
data-store structures. To help you better understand this type of modeling, we will first 
introduce the various elements that may appear in ER diagrams.

Entity

The term entity as used in ER diagrams actually refers to an entity type; it is a data group having 
a specific structure. For example, an entity type might be Customer Order, which could represent 
any number of actual orders.

An entity symbol can include the following:

• Entity name.

• An entity type, e.g., Type: Invoice. This type is taken from a DD diagram (see “Data 
Definition Diagrams (DD)” on Page 271). (If you set All in the Entity definition box, you 
can use a type from any DD diagram in the model tree; by setting Visible or Subtree, you will 
limit the range of types from which to choose.) If the entity name matches the type name, 
there is no need to indicate a type.

• A primary key (PK). If you think of the contents of the entity as a series of rows in a table, 
the primary key is the field containing the unique identifier for each row. For example, in the 
entity Invoice, there is a row for every invoice, and the field Invoice Number could serve as the 
primary key, which uniquely identifies a given invoice. In that case, the Invoice entity symbol 
would look like this:

• An index list. Here, you can enter a field or fields that can be used when indexing an entity. 
In the symbol, this information would appear as Index: Customer Number.

• A maximum number of instances of the entity. For example, if the Order entity is marked 
Max: 1000000000, you know that there may be up to 1,000,000,000 orders!
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An entity type also may be nested in another entity type; for example, the entity Order might 
include a nested entity Item; here, the name of the item ordered is a component of the order:

Relationship

An ER diagram can also contain connecting lines known as relationships, which reflect the 
interdependencies among the entity types. Each relationship must include one or more role 
names. For example, in a relationship between Customer and Order, a role name could be 
“places” or “is placed by,” as seen in the following figure, resulting in the phrases Customer places 
order and Order is placed by customer. Also note that relationships in ER diagrams must be 
marked for cardinality, analogous to the associations in CL diagrams (to refresh your memory, 
see Page 125). In the following diagram, the cardinality indicates that there is one customer and 
zero or more orders.

In addition, a foreign key (FK) may be indicated. This is the field that helps an entity uniquely 
identify a “foreign” entity. For example, if a company receives an order from Customer, this order 
is likely to include a field called Customer Number, which also would be the customer’s primary 
key. Thus, for the entity Order, the foreign key could be Customer Number. In the diagram, this 
is illustrated by the text FK Customer Number appearing below the connecting line. (Note that 
a foreign key can be entered only if one side of the relationship has the cardinality 0..1 or 1..1.)

Single-Nested Entity

You can also create a special type of nested entity known as a single-nested entity (1-nested 
entity). It reflects a situation in which one entity is a subset of another. For example, the entity 
Customer might contain a single-nested entity New Customer, as seen below; this reflects the fact 
that the pool of customers includes a new one:
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ER diagrams are very similar in appearance to the CL diagrams discussed in Chapter 4. ER 
diagrams can be used in a manner similar to CL diagrams, that is, to describe the static structure 
of a system and the relationships between its different parts in an informal manner. (In fact, 
GRADE has a feature that allows you to convert your ER diagram to a CL diagram; see “How 
Can I Convert an ER Model to a CL Diagram?” on Page 385.)

Sometimes, a reference to an ER diagram may be included in a CO diagram. The following 
figure is a fragment of our earlier diagram showing the structure of the auto parts company; 
here, a reference to a database accessed by the Finance Department has been added. Behind this 
database symbol, one would find an ER diagram showing the content and structure of this 
database.

Figure 7-21: CO with database symbol

And now a word about terminology: The database structures contained in ER diagrams are also 
known as ER models. An ER diagram can contain only one ER model; both the diagram and 
the model have the same name.

7.6.1 ER Diagram Window

The ER diagram window is similar to others in GRADE (for a general introduction to the 
various elements, see “ORG Diagram Window” on Page 39).
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Of course, the symbol palette differs from other types of diagram windows:

Table 7-11: Symbol palette of ER diagram

7.6.2 Defining an Entity

Proceed as follows:

1 Click the Entity symbol in the symbol palette.

2 Click at the location in the diagram where the entity symbol is to be placed. The Entity 
dialog appears:

Figure 7-22: Entity dialog

3 Enter the name of the entity in the Name field.

Symbol Name Function

Deselect Deselects a symbol; if you click the wrong symbol in the symbol palette 
by mistake, click here to revoke your selection.

Entity Creates an entity.

Relationship Creates a relationship between two entities.

Single-nested entity Creates a single-nested entity.

Free comment Creates a free comment symbol (analogous to the free comment symbols 
in other diagrams).
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4 Normally, the entity and its data type have the same name. If that is not to be the case, 
you must specify the type separately. First select the range of available types by clicking 
the down arrow under the Names box and then clicking All, Visible or Subtree. (All will 
give you the largest range of choices, but Visible usually makes more sense; for more 
about visibility, see the Glossary.) Then click the down arrow to the right of the Datatype 
list field and make your choice (or simply type in a name).

5 Now define the entity’s primary key. Click the Pick PK button. The Pick Primary Keys 
dialog appears. Click one (or more) field names, then click OK. The selected names are 
transferred to the Primary key field of the Entity dialog. (Alternatively, you can enter the 
names directly in the Primary key field.)

6 If you wish to enter indices, click the Indices button. The Specify Entity Indices dialog 
appears. Click the Pick Field button. The Pick Index Fields dialog appears.

7 Click one or more fields to be used as index markers. Then click OK.

8 If desired, you can also add or delete indices in the Specify Entity Indices dialog. The 
procedure is analogous to the definition of array index ranges (for details, see Page 280). 
Once you have entered all desired indices, click OK to close the Specify Entity Indices 
dialog.

9 If desired, enter the maximum number of possible instances of the defined entity in the 
Maximum number of instances input field.

10Enter any desired comments in the Comment field.

11Click OK to close the entity definition dialog.

7.6.3 Defining a Nested Entity

To define a nested entity (subordinate entity), click the entity symbol in the symbol palette, then 
move your mouse pointer to the diagram and click the entity symbol (superordinate entity) that 
is to contain the new, nested entry. 

Defining a nested entry is analogous to creating a normal entity (see “Defining an Entity” on 
Page 258). In addition, you must enter the name of the field of the superordinate entity to which 
the subordinate entity refers. (For example, if your nested entity is Item, you might enter Item 
Number.) To do this, click the Pick PK button, click the appropriate field name in the list, and 
confirm with OK. (Or type in a name.)

If you enter a maximum number of instances, this refers to the maximum number of instances 
of the subordinate entity per instance of the superordinate entity.
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7.6.4 Defining a Single-Nested Entity

Proceed as follows:

1 Click the single-nested entity symbol in the symbol palette.

2 Place the mouse pointer inside the associated superordinate entity (the one that is to 
contain the nested entity) and click once. The Single-Nested Entity dialog appears.

3 This dialog is a subset of the Entity dialog discussed earlier. The meaning of the fields is 
the same as for normal entities; the fields can be filled out analogously (for more 
information, see “Defining an Entity” on Page 258). Note that, in this case, the 
maximum number of instances means the maximum number of instances of the single-
nested entity per instance of the superordinate entity.

7.6.5 Defining a Relationship

You can define a relationship via the symbol palette or via the entity list.

To define a relationship via the symbol palette, proceed as follows:

1 Click the relationship symbol in the symbol palette.

2 Place the mouse pointer on one of the two entity symbols to be joined by the 
relationship.

3 Press and hold down the left mouse button while moving the mouse pointer to the 
partner entity symbol. Then release the mouse button.

4 The Relationship dialog appears. Enter one or both role names (for example, is sent by, is 
received by).

5 Specify the cardinalities for each side of the relationship by marking the appropriate 
radio buttons. (For more about cardinalities, see Page 125.)

6 If it makes sense to define a foreign key (the term Foreign key will appear in black letters 
rather than gray), click the Pick button. The Pick Foreign Keys dialog appears.

�
If you are uncertain about the difference between a regular nested entity and a single-nested entity, 
consider the following example. If an entity is a hamburger, a nested entity within it could be a slice 
of pickle. This is an “is part of” relationship. If an entity is all hamburgers prepared at the company 
picnic, a single-nested entity within the group could be the hamburgers prepared by George, who 
is famous for his super-deluxe creations with bacon, cheese and tomato. This is an “is subclass of,” 
single-nested relationship.
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7 Click one (or more) names, then click OK. The selected names are transferred to the 
Foreign key field of the Relationship dialog. (As an alternative, you may type names 
directly into the Foreign key field.)

8 Click OK to close the definition.

If an ER diagram is very large, it may become difficult to draw the connection between desired 
entity symbols with the mouse.

In that case, you may want to define relationships via the entity list. Proceed as follows:

1 Open the Options menu and select the Define relationships via entity list command.

2 GRADE switches to an alternative definition mode.

3 Click the relationship symbol in the symbol palette.

4 A dialog named Relationship appears.

5 For both of the fields marked Entity name, click the down arrows and select the desired 
name.

6 Continue defining the relationship in the usual manner (as described above).

7.6.6 Changing an Entity or Relationship Definition

Proceed as follows:

1 Open the entity symbol or the connection, respectively, by activating it and pressing 
Return.

2 The associated definition window appears.

3 Make the needed changes.

4 Click OK to close the definition window.

7.6.7 Other Operations in ER Diagrams

There are, of course, many other operations that can be performed in ER diagrams, such as 
copying elements, modifying symbol contents, defining a free comment, changing the zoom 
coefficient, selecting a different layout style. These operations are analogous to those that can be 
performed in ORG and BP diagrams; for more information, consult Chapter 2 and Chapter 3.
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7.6.8 Generating Database Initialization Scripts

To generate database initialization scripts for a particular database in your model, see “How Do 
I Generate Database Initialization Scripts for DB2, Microsoft SQL Server, INFORMIX-
Online, Oracle7 and SQLBase?” on Page 400.

7.7 Converting Business Models to System Models

Essentially, business models (using ORG and BP diagrams) and system models (using CO 
diagrams, etc.) can be used as different views of a single sociotechnological system. As a result, 
GRADE provides the capability to convert some elements of the business model into a system 
model. For example, the user can automatically generate a CO hierarchy, TO tables and 
preliminary PDs from BP and ORG diagrams. During the conversion process, the events found 
in BP diagrams are converted to transfer objects and the draft contents of PDs are created; 
incoming events then correspond to receive symbols and outgoing events correspond to send 
symbols. Meanwhile, the organizational units in ORG diagrams become active objects in CO 
diagrams.

To carry out this type of conversion, proceed as follows:

1 Open a model tree containing business diagrams (BP and ORG).

2 Activate the BM icon of the business model by clicking it once with your left mouse 
button.

3 Open the BM Tools menu and activate the Build system model command.

4 An independent tree containing CO and related diagrams will appear under the selected 
model tree.
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To illustrate this feature, we used the GRADE model Order and created a system model out of 
it. The new system model subtree looks like this:

Figure 7-23: System model created automatically from business model

In case you are not familiar with the VT icon in the previous figure, it represents a variable table, 
used in model simulation. For more information, see the Simulation Guide.

Here are two tips to keep in mind when converting business models to system models:

Before you start the conversion, make sure your ORG diagram does not use the same name for 
different symbols! For example, if both the Sales Department and Finance Department have a 
subunit named Secretary, you could rename those subunits Finance Secretary and Sales Secretary.

Note that a conversion is best carried out when your business model is relatively complete and 
you want to create the framework for a new system model.
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7.8 Converting System Models to Business Models

Once you have completed a system model, you can use it to generate a draft business model.

Proceed as follows:

1 Activate the top CO symbol of your system model by clicking it.

2 Open the BM Tools menu and activate Build business model.

The generation of the new model takes place in three steps:

1 A new BM symbol (with the corresponding ORG and other symbols) is created in the 
model window.

2 The CO diagram tree is scanned, and each active object in the CO tree is converted to 
an organizational unit and represented in the ORG diagram.

3 All communication channels connecting the tree objects are scanned. Each channel is 
converted into a message event and an entry is generated for the event in the ET table.

7.9 Changing the Focus of a System Model

To see your system model from a different point of view, see “How Can I Rearrange My System 
Model to Focus Attention on a Particular Object?” on Page 398.
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Chapter 8
Component Modeling

8.1 Introduction

In addition to the three traditional types of modeling, GRADE now supports component 
modeling. It makes use of various types of diagrams (PCK, CL, BP, etc.) described earlier in this 
manual.

Component modeling is particularly useful for planning state-of-the-art business systems that 
rely heavily on self-service mechanisms. For example, in today’s banking industry, customers 
may check their account balance or apply for a loan online.

Component modeling is a technique for the component-based development (CBD) of systems 
and for high-level design specification. The basic model for CBD is similar to the one described 
in “Business Component Factory” by P. Herzum and O. Sims (Wiley, 2000).

8.2 Elements of the Component Model

The basic unit for the analysis and design of systems is the business component. A business 
component corresponds to an autonomous business concept or business process and is meant 
to be implemented via a set of software components, with the goal of reuse. Typical examples of 
business components are Customer, Account, and Order.

The main constituents of a business component are business component methods (BCMs), 
which describe the actions that the business component can perform (or which can be 
performed on it). Thus, a business component is a set of actions (BCMs) related to a single 
business concept. In addition to BCMs, a business component is typically characterized by data.

A component model represents a system in terms of subsystems, which are named applications. 
Typical applications in the banking industry would be Customer Management, Account 
Management, and Online Banking. 
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Each application, in turn, consists of business processes. A business process is a meaningful 
activity performed by a customer in online mode (this may be followed by off-line interaction), 
or a group of activities for reaching some goal in the enterprise itself. An example of a business 
process is Open New Account. 

When creating a component model, it is recommended that one first construct an object model 
(using CL and PCK diagrams) to provide a general overview of the system. (See Chapter 4 and 
Chapter 5.) Business processes themselves are represented by BP diagrams (see Chapter 3), 
while the data structures involved can be depicted in DD diagrams (see “Data Definition 
Diagrams (DD)” on Page 271).
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The typical structure of a component model is illustrated in the following example:

Figure 8-1: Component model tree

The top PCK diagram, Banking, contains three packages with predefined names:

• Application Repository

GLO STE PIC TAG EXT

BankingPCK CLA

Application RepositoryPCK CLA

Account managementPCK CLA

Check depositionBP TD AT PD

Open New AccountBP TD AT PD

Online bankingPCK CLA

Online Banking ConceptsCL

Open New AccountBP TD AT PD

Application by mailBP TD AT PD

Application through phoneBP TD AT PD

Backoffice processing of applicationBP TD AT PD

Online applicationBP TD AT PD

Use online bankingBP TD AT PD

Backoffice processingBP TD AT PD

Customer needs realtime helpBP TD AT PD

Online banking suiteBP TD AT PD

Account informationBP TD AT PD

Checking HistoryBP TD AT PD

TransferBP TD AT PD

Bill payment centerBP TD AT PD

Selection page banking showBP TD AT PD

Special servicesBP TD AT PD

Business Component RepositoryPCK CLA

AccountPCK CLA

Account implementationCL

Account dataDD

CreateBP TD AT PD

DeleteBP TD AT PD

ShowMenuBP TD AT PD

ShowSummaryBP TD AT PD

F23GSF

billPCK CLA

Bill dataDD

CreateBP TD AT PD

CustomerPCK CLA

CreateBP TD AT PD

LoginBP TD AT PD

Selection page banking showBP TD AT PD

Data RepositoryPCK CLA
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• Business Component Repository

• Data Repository.

These names are created automatically during the generation of a new, empty component 
model. They must not be changed, as navigation within the model depends on them.

The Application Repository PCK diagram contains applications, such as Account Management 
and Online Banking. Each application, in turn, contains BP diagrams representing business 
processes, such as Open New Account.

The Business Component Repository consists of a package for each business component, e.g., 
Account and Customer. In addition, data structures relevant to each business component can be 
shown in DD diagrams, while BP diagrams are used for informal explanations of business 
component methods.

The Data Repository may consist of CL, DD and ER diagrams describing data structures.

8.3 Working With a Component Model

To create a component model, click the New model icon in the toolbar. Enter a name for the 
model, make sure the Component model check box is marked, then click OK.

To create an application, proceed as follows:

1 Double-click the PCK diagram Application Repository. 

2 Select the package icon in the symbol palette, then click in the diagram area. The 
Package dialog appears.

3 Enter the application name and (if needed), a description.

4 Click OK. A new package symbol appears in the diagram.

5 Double-click the new symbol. The application (PCK) diagram is opened.

To create a business component, proceed as follows:

1 Double-click the Business Component Repository PCK diagram.

2 Select the package icon in the symbol palette and click in the diagram area. The Package 
dialog appears.

3 Enter the component name and (if needed) description.

4 Click OK. A new package symbol appears in the diagram.

5 Double-click the new symbol. The component (PCK) diagram is opened. 
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To add a new method to a business component, proceed as follows:

1 Double-click the desired component (PCK) diagram.

2 Select the BP diagram icon in the symbol palette and click in the diagram area. The BP 
Diagram dialog appears.

3 Enter a method name and (if needed) description.

4 Click OK. A new method (BP diagram) symbol appears in the diagram.

5 Double-click the new symbol. The method (BP) diagram is opened. 

To reference (call) business component methods from BP diagrams, use inline task symbols. 
Proceed as follows:

1 Create a new inline task symbol (or open an existing one). (See “Creating an Inline Task” 
on Page 109.)

2 Select the desired component name in the Component list. (This list contains names of 
components from the Business Component Repository.)

3 Select the desired method name in the Method list, and click the left-arrow icon next to 
it. The method name appears in the Operation field. 

4 Click on the Performer tab. 

5 Select the component name from the from BC list, and click on the left-arrow icon. The 
component name appears in the Performer field.

�
Note that diagrams using inline tasks are not simulatable. 
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Chapter 9
General-Use Diagrams

This chapter presents GRADE diagrams that can be used in conjunction with all types of 
modeling. The following diagram types are covered:

• DD, or data definition diagrams, for defining data structures;

• PRE, or presentation diagrams, used to turn a model into an audiovisual presentation;

• EXT, or external link diagrams, used to create external links from a diagram to an Internet 
address, a document, the glossary, an executable program, etc.;

• STE, or the stereotype table, used to define stereotypes for a model and to modify symbol 
palettes;

• GSF, or graphical screen form diagrams, used to prototype the graphical user interface of a 
software application;

• PIC, or the picture table, used to store pictures for the enhancement of diagrams;

• GLO, or the glossary, used to store definitions of terms used in a model;

• CMT, or comment diagrams, used to add comments to a model;

• TAB, or custom tables, that can be added to the model as free diagrams or can be associated 
with other GRADE diagrams.

9.1 Data Definition Diagrams (DD)

As noted, data definition diagrams are used to describe data structures. For example, if your 
model includes employee records, all of which basically have the same data structure (name, 
employee number, address, etc.), this structure can be represented in a DD.

A DD can be used informally, simply to identify documents or materials, or formally to specify 
a data type. (A data type has a certain value range, a predefined structure and a specific set of 
permissible operations.)

In the context of system modeling, CO diagrams show who or what takes part in a system; TO 
tables show what objects are exchanged; and data definition diagrams serve to specify the 
structure of data transmitted over a communication path. A data definition diagram is often 
associated with a specific CO diagram and can contain definitions of one or more types of data.
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Rather than present highly technical definitions of data types here, we will now introduce the 
data types used in GRADE modeling by way of graphical examples.

Atomic

The atomic data type is also known as a “simple” or “non-structured” data type; it defines a 
single value. The following figure illustrates the structure of an atomic data type:

In the following example of an atomic data type, the attributes of a password are specified. The 
password consists of a string (of characters). The number of characters in the password can range 
from 3 to 30.

Set

A set is an unordered collection of elements of the specified data type. The structure of a set is 
as follows:

In this example of a set, the resumes simply belong to the group. There is no special order.

�
In the following figures, some terms (such as STRING, INTEGER, FLOAT) may be unfamiliar to 
you. These are GRADE’s predefined data types, which are used mainly in models intended for 
simulation. For purposes of basic modeling, you need not concern yourself with them; more 
information about them can be found in the online help.
Chapter 9 



Record

A record represents a collection of components of various data types that are structured and 
grouped together by means of field names. The structure of a record data type is as follows:

In the following example, the record type name is Invoice, the field names are Product, Quantity 
and Total Cost, and the field types are STRING, etc. In terms of content, this example shows 
that an invoice includes the name of a product (represented as a string of characters), the 
quantity bought (an integer ranging from 1 to 150), and the total cost to be paid by the 
customer (FLOAT; this is a GRADE predefined data type representing a value range).

Array

An array represents an ordered collection of data objects; each data object may be uniquely 
“referenced” via an index list, which contains one or more index ranges. The structure of an 
array data type is as follows:
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In our example, employees at a large corporation handed in 78 suggestions over the last year for 
improving company efficiency. These suggestions were received by management and assigned 
serial numbers. Here, they are represented as an array data type, indexed from 1 to 78.

List

Lists are ordered collections of elements of some type. The structure of a list is as follows:

In the example here, management wanted to see a complete list of company travel expenses for 
1998. The accounting department generated a list showing expenses for each month.

Variant Record

GRADE supports variant records for purely historical reasons, such as migrating old data. The 
use of variant records for creating new models should be avoided.

Subtypes (Nested Data Types)

GRADE also lets you create subtypes of all the data types described above, e.g., subatomic, 
subarray, subset, sublist, subrecord. These subtypes are also known as nested data types.
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To better understand this, take a look at the following example. Let’s say you have created this 
record data type for company employees:

Note that the definition of Address is incomplete, since an address normally consists of a series 
of records: street address, city, state, postal code. Thus, you decide to create a subrecord within 
your record data type. In that case, your data type, including nested data type, will look like this:
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9.1.1 DD Diagram Window

The DD diagram window is similar to others in GRADE (for a general introduction to the 
various elements, see “ORG Diagram Window” on Page 39).

The symbol palette sets the DD diagram window apart from the others:

Table 9-1: Symbol palette of DD diagram

9.1.2 Defining an Atomic Data Type

To define an atomic data type, take the following steps:

1 Open a DD diagram by clicking the DD symbol twice (or follow the instructions given 
in Section “How Can I Create a Diagram?” on Page 429, for creating a new diagram).

Symbol Name Function

Atomic Creates an atomic data type.

Set Creates a set data type.

Record Creates a record data type.

Array Creates an array data type.

List Creates a list data type.

Variant record Creates a variant record data type.

, etc. Subtypes All symbols marked with a broken line are subtypes of the corresponding 
symbols above; here, you see the subatomic data type; these are used to create 
nested data types (a type within a type).

Free comment Creates a free comment symbol (analogous to the free comment symbols in 
other diagrams).
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2 Click the upper left symbol in the symbol palette (atomic data type). The Atomic 
Datatype dialog appears.

Figure 9-1: Atomic Datatype dialog

3 In the Name field, enter a name for the data type.

4 Click the Pick type button. The Pick Datatype and Attributes dialog appears. Under the 
box marked Names, you can determine the range of names offered: All; Visible, for only 
those “visible” from the diagram; or Subtree for those in the given subtree.

5 To select a user-defined data type, click the appropriate selection in the box marked User 
defined. To select a standard GRADE data type, click the appropriate selection in the 
box marked Basic, then select any attributes that might be needed from the box marked 
Attributes. (Some data types do not have attributes; some have several; you may pick 0, 
1 or more attributes.)

6 Click OK.

7 If parameters (such as RANGE:(min..max)) are to be assigned to some of the selected 
type attributes, these parameter values may be inserted directly into the Type field of the 
dialog (for example, RANGE:(1..99)).

8 If the data type required for a reference has not yet been defined in the model, the name 
of this type also may be entered directly into the Type field of the dialog.

9 Complete the type definition by clicking OK.

The definition appears in the diagram.
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9.1.3 Defining a Set Data Type

Proceed as follows:

1 Click the symbol for the Set type in the symbol palette.

2 The Set Datatype dialog appears.

3 Enter the name of the new set type in the appropriate input field.

4 Define the data type for the new element, as described on Page 277, starting with Step 4.

5 Click OK. The type definition now appears in the diagram.

9.1.4 Defining a Record Data Type

Proceed as follows:

1 Click the symbol for the Record data type in the symbol palette.

2 The Record Datatype dialog appears.

3 Enter a name for the record type.

4 If you want all record fields to have a uniform width, regardless of their contents, mark 
the Justify fields option (this will give your diagram a neater appearance).

5 Click OK. The dialog closes, and the symbol appears in the diagram. To begin with, the 
record has two fields without name or type and looks something like this:

Defining a Record Field

Let’s assume you have created a record data type as shown in the previous figure. Now you want 
to fill out the blank boxes (record fields) on the right.

Proceed as follows:

1 Activate a record field, then press Enter. The Record Field dialog appears.

2 Fill in the fields; this is analogous to defining the fields for an atomic data type, as 
described on Page 277.

3 Click OK.
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Adding/Deleting a Record Field

To add a new field to a record type definition, you will need to make use of one of the small, 
gray rectangles in the record field symbol:

1 Click with your left mouse button on the gray rectangle after which a new record field 
is to be inserted.

2 The Record Field dialog appears. You can either fill it out or leave it empty.

3 Click OK. The new record field will be inserted.

To delete a field, activate it, then press Del.

9.1.5 Defining an Array Data Type

Proceed as follows:

1 Click the symbol for the Array type in the symbol palette.

2 The Array Datatype dialog appears.

3 Enter a name for the array type into the corresponding input field.

4 Specify the data type; this is analogous to the specification of atomic data types (see 
Page 277, starting with Step 4).

5 Enter an index range for each array dimension; this is described below.

6 Click the OK button.

Specifying Array Dimensions

For each array type, one or more index ranges may be specified, one index range for each array 
“dimension.” To help you understand what is meant by a dimension of an array, imagine a U.S. 
city in which there are numbered streets intersected by numbered avenues. In this situation, you 
could define one dimension as being 6th Street through 47th Street (index 6..47); another 
dimension could be defined as 12th Avenue through 28th Avenue (12..28).
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Here are a few hints to help you specify these index ranges.

• Make sure the Array Datatype dialog is open (either activate the corresponding array data type 
symbol in your diagram and press Return, or click the Array symbol in the symbol palette):

Figure 9-2: Array Datatype dialog

• In the Index area, type in the starting and ending numbers of the index range, then click the 
Ins button. If you make a mistake, click Del. The ranges are numbered automatically, starting 
with 1 (the number of the currently shown index range is indicated next to the word Index). 
Once you click Ins, GRADE automatically clears your index fields and displays the next 
sequence number (1 will be followed by 2, etc.).

• Once index ranges have been defined, you can inspect them by clicking the up and down 
arrows in the Index area. To delete a range, simply press Del; to change a range, type in new 
values and press Ins.

• To jump directly to a given index range, click the All button. It opens a window displaying 
all index ranges. Select one by clicking the desired range in the list, then click OK. 
Alternatively, you may double-click the appropriate list entry.

• To insert a new index range, switch to the index range after which the new range is to be 
inserted, and click the Ins button. To make an insertion at the beginning of the list (before 
Index 1), you may flip through the list of index ranges by clicking the up arrow to a position 
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before the first entry (in a way, Index 0). This index position is indicated in the Index area by 
three dots (Index:...). Make your entries and press Return. The list will be renumbered 
automatically (your new entry will have the sequence number 1).

9.1.6 Defining a List Data Type

Proceed as follows:

1 Click the symbol for the List type in the symbol palette.

2 The List Datatype dialog appears.

3 Enter the name of the new list type in the appropriate input field.

4 Define the data type for the new element, as described on Page 277, starting with Step 4.

9.1.7 Defining a Variant Record Data Type

As mentioned earlier, GRADE supports variant records purely for historical reasons, such as for 
migrating old data. We do not recommend the use of variant record data types when creating 
new models.
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9.1.8 Defining Subtypes (Nested Data Types)

To help you recall what is meant by a nested data type, we again present the example in which 
Address is a subrecord nested within the Employee record:

Figure 9-3: Nested data type

To create a nested data type, proceed as follows:

1 Let us assume you have a record data type in which one record field has been left empty 
because you want to create a nested data type there.

2 Activate this record field, then click one of the nested data types (e.g., subrecord) from 
the symbol palette.

3 A type definition dialog appears. Define the type here in the usual manner.

4 Click OK. The new type definition now appears nested in the record type definition.
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A nested definition can provide greater clarity when a specific data type is used in the model 
solely as part of a particular compound data type. For frequently used data types, a free, rather 
than nested, definition is preferred.

9.1.9 Defining a Free Comment

This procedure is analogous to that used in other types of diagrams; for more information, see 
“Free Comments” on Page 50.

9.1.10 Repositioning Diagram Contents

In most diagrams, the positions of elements have meaning; in a BP diagram, for example, the 
tasks are logically positioned to reflect work flow. In DD diagrams, by contrast, the relative 
positions of the data definitions do not have meaning; you can place them where you please.

By default, DD diagrams have a vertical orientation; new elements are positioned automatically 
to form single column.

GRADE, however, offers you the possibility of rearranging data-type definitions in up to nine 
columns and to choose a sort order as well.

�
You can also use a “drag and drop” method to create a nested data type.

Assuming your model contains a data type that is to serve as the “parent” and another that can be 
nested within it, simply activate the data type that is to be nested, hold down your left mouse 
button, and drag it over to the “parent” symbol. The top left corner of the data type to be nested 
should overlap the “parent” symbol. If you have overlapped two compatible data types, GRADE 
will “join” them automatically.
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Proceed as follows:

1 Open the Edit menu and select the Reposition... command. The Optimize dialog appears:

Figure 9-4: Optimize dialog

2 Enter the number of columns desired (up to 9).

3 Mark a radio button to specify whether the data definitions should be sorted and, if so, 
by what criterion (size, name, type).

4 Click the OK button to confirm your entries.

The arrangement of data-type definitions changes according to your specifications.

9.1.11 Opening Your DD Diagram as a Table

Thanks to one of the newer features of GRADE, you can now open your DD diagram in tabular 
form and work with it as a table. See “How Can I Open a DD Diagram as a Table?” on Page 396.

9.1.12 Other Operations in DD Diagrams

There are, of course, many other operations that can be performed in DD diagrams, such as 
deleting, copying, and moving elements; modifying symbol contents; changing the zoom 
coefficient; selecting a different layout style. These operations are analogous to those that can be 
performed in ORG and BP diagrams; for more information, consult Chapter 2 and Chapter 3.
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9.2 Presentation Diagrams (PRE)

You can turn your models into audiovisual presentations by taking advantage of GRADE’s 
presentation feature. It permits you to assign spoken text to a diagram, to an entire set of 
diagrams – or even to a complete model. When the presentation is played back, your recorded 
text is heard and the relevant part of the model is displayed on the screen.

The main goal of GRADE presentations is to help your audience more easily understand your 
models. Of course, if your model is very small and simple, it may not require additional 
explanation. But if your model is more complex, a presentation with an informal narrative and 
a “guided tour” will help your audience more fully understand the concepts you are 
communicating.

The presentation facility imitates a human lecturer. Just as a lecturer could stand in front of an 
audience and use a pointer to draw attention to the part of the diagram he/she is talking about, 
so GRADE presentations use a pointer to draw attention to parts of the model in any desired 
sequence.

The pointer used in GRADE presentations is the so-called presentation cursor, containing the 
Grady icon: 

A GRADE presentation consists of slides in a specific sequence. A slide normally corresponds 
to one or several spoken sentences, which are recorded as a single audio file. Each slide is 
assigned to one diagram of the model and typically explains a fragment of that diagram. 

In addition, the slide has an attached home symbol in the diagram: any symbol or line in it 
(class, note, association, etc.). The home symbol is displayed as activated during the playback of 
the slide. But the presentation cursor can be freely moved around the diagram during this 
playback, thus pointing to any element in the diagram. It should be noted that the cursor can 
point not only to a diagram element (symbol or line), but also to any location in the diagram 
area. This capability is very important in conjunction with the GRADE feature allowing a 
diagram symbol (typically, a large one) to contain a picture covering its area (see “Additional 
Hints” on Page 336). Thus, in your presentation you can include spoken comments, e.g., on a 
problem statement, using any picture, as you would do, for example, when preparing a 
Microsoft PowerPoint presentation. This extended explanation becomes a natural part of your 
recorded presentation. In addition to diagrams, a slide can be associated with a table entry, e.g., 
in a glossary or stereotype table.

�
Thanks to a new feature of GRADE, you can use GIF (Graphics Interchange Format) pictures in 
your diagrams. That means you can “jazz up” your presentation with screen shots and photographs. 
Simply assign a GIF picture file to the corresponding diagram element, as described in “Inserting a 
Picture” on Page 333.
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Each presentation in GRADE is a diagram of the special presentation type, with the acronym 
PRE or icon  in the model tree. There can be any number of presentations in a model. Thus, 
a presentation is an “official” part of a model, more precisely, of its documentation.

Hard- and Software Requirements for Presentations

To record and play back GRADE talking presentations, your system should fulfill the following 
requirements:

• Windows 2000, Windows NT, Windows 98, or Windows 95 operating system with 
multimedia support installed

• a sound card

• a microphone

• speakers or headphones.

9.2.1 Playing Back a Presentation

Let us consider a case in which a GRADE presentation has already been created. The GRADE 
installation package includes the Automatic Teller Machine model, which includes two 
presentation diagrams. These can be seen in the model tree below:

Figure 9-5: Presentation diagrams in model tree
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Double-click either presentation diagram. A dialog like the following one appears:

Figure 9-6: Dialog for playing back presentations

The Playback of Presentation dialog contains all necessary options for controlling the playback 
process. In the background, you will see the diagram with which the presentation starts.

Now click the Play button, and the playback of the presentation starts (if you should encounter 
problems, please read the note on Page 288). You hear the narrator’s recorded voice, and along 
with it the presentation cursor moves from one diagram element to another, pointing to 
elements mentioned in the given sentence. You can stop the presentation by clicking the Stop 
button. If the playback control box covers an important part of a diagram, move it aside (by 
“dragging” it with your mouse).

�
Note: By double-clicking an ordinary diagram, you open it. Double-clicking a PRE diagram, 
however, prepares it for playback.
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There are also alternative ways to initiate the playback dialog. You can click the right mouse 
button on a presentation diagram in the model tree and then select Play back/Design... from the 
displayed pop-up menu, or you can activate the presentation diagram in the model tree and 
select Play back/Design... from the Diagram menu.

Since a presentation is a diagram in GRADE, you also can view or edit it as a diagram. You will 
very seldom need to do this, however, because the diagram is generated automatically during the 
recording of the presentation. For more information on how and when to open a presentation 
as a diagram, see “Working With Presentations as Diagrams” on Page 300. 

�
The sample presentation diagrams included in the GRADE installation package contain sound 
files compressed with the Microsoft GSM audio compressor. This compressor must be 
installed to play back the sample presentations. To check the sound 
compressors/decompressors available to you, proceed as follows (these steps may vary slightly, 
depending on your operating system):

• Open the Control Panel.

• Open the Multimedia applet.

• Click the Devices tab.

• The installed codecs are listed under Audio compression codecs. This list should contain the 
Microsoft GSM 6.10 Audio CODEC or an equivalent one. (Note that this codec is 
included in your Windows installation package, but may not actually have been installed; 
in that case, install it according to the instructions given by your operating system’s user 
manual or online help.) 

The availability of this compressor is important only for the sample presentations; to create 
and play back your own talking presentations, you may use any audio format that meets your 
requirements for sound quality.
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The following table explains the meaning of all elements of the Playback of Presentation dialog:

Table 9-2: Elements of the Playback of Presentation dialog

During the playback of a diagram, the zoom factor saved with the diagram in your model is used 
(and not the zoom factor used by the author of the presentation during the recording). To 
optimize the display of diagrams on your computer screen, open each diagram visible in the 
presentation, set the desired zoom factor for each and save each diagram. (See “Zooming to 
Enlarge or Reduce Diagrams” on Page 70 for instructions.)

Element Function

Indicates time (in seconds) since the last activation of the Play button.

Indicates the current slide’s sequential number and name (the name of the symbol with 
which the slide is associated). This field will always contain a sequential number; a name is 
optional.

Opens an online help window.

Switches to the Design of Presentation dialog. See next section.

 
Closes the dialog and the diagram last displayed by it.

Moves the current presentation position to this symbol (to the slide for which this symbol 
is the home symbol). Before pressing this button, you must click the desired symbol in the 
diagram. If the selected symbol is not a home symbol for any of the slides, a corresponding 
message is displayed.

Moves the current position to the start of the presentation.

Moves the current position to the previous slide.

Moves the current position to the next slide.

Moves the current position to the end of the presentation.

Initiates the playback of the presentation from the current position. 

Stops the playback. The current position is the last slide played. (Note that the Play and 
Stop buttons appear alternately at the same position.)
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This is all you generally need to know about playing back presentations. If, however, you run 
into problems, consult the following list:

Table 9-3: Troubleshooting list for playing back presentations

Problem Solution

The presentation starts; the cursor 
moves, but you hear nothing.

Check your sound system. Make sure that the speaker is turned on and 
plugged into the sound card, that the volume controls are appropriately set, 
etc. (The best way to test your sound system as a whole is to double-click in 
the Windows Explorer on any .wav file; there must be some in your Windows 
folder. You should hear a sound.)

The following error message is 
displayed:
“E10002 Appropriate sound 
compression codec possibly not 
installed. See help topic “Presentations: 
Making your Model Talk” 

The appropriate sound compression codec (compressor/decompressor) 
apparently is not installed in your Windows system. By default, the Microsoft 
GSM 6.10 audio codec is used in GRADE. This codec is installed by default 
in Windows 98, but in older Windows 95 systems it may not be installed 
(though it is always present on your Windows CD). You can check the list of 
the installed codecs in the Control Panel’s Multimedia/Advanced tab by 
expanding the Audio Compression Codecs item. 

If the GSM 6.10 codec is not on the list, you should install it. The installation 
data are available on your Windows 95 CD. To install:

Select Control Panel/Add/Remove Programs.
Click the Windows Setup tab.
Highlight the Multimedia component, then click Details.
Check the box next to the Audio Compression component.
Click OK, insert the Windows installation CD if required.

If you are trying to play a presentation in a model not from the GRADE 
installation, then another codec may have been used during the recording of 
the presentation. Consult the model’s designer for the right one.

In some cases, the requested codec may be installed, but turned off. Check the 
list of installed codecs as described above, select the required codec, then click 
Properties. Make sure that Use this audio codec is on.

(Note: The processes described above will differ slightly, depending on your 
operating system.)

Error message E11084: Invalid path 
“...” appears

This message should never occur for installation examples, but may appear for 
other models after model copying. Your model’s sound-file folder is not 
located where expected. To solve this problem, the path specification must be 
manually adapted to the new location by editing the START symbol; see 
“Working With Presentations as Diagrams” on Page 300.
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9.2.2 Creating a Presentation

Let us assume you want to create a new presentation using the Automatic Teller Machine model 
from the installation package.

You start creating a presentation in the model-tree window by activating the top diagram of a 
subtree (e.g., a PCK, BM or CO diagram), then selecting New presentation... in the pop-up 
menu. (Alternatively, select New presentation... in the Diagram menu.)

The Create Presentation box appears:

Figure 9-7: Preparing a new presentation

Here, enter the name of the new presentation. Let’s call it Explanation of System. Then click OK.

After that, the Folder for presentation box appears:

Figure 9-8: Selecting a folder for a new presentation

Here, select a folder for storing the sound files of your presentation slides. By default, the folder 
is created inside the folder containing all model files. We recommend this default path, because 
this ensures the relocatability of the model (you can copy it to another GRADE repository 
without modifications). GRADE always selects for you a new, “unused” folder name. For the 
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first presentation in a model, the name vav is offered, for the next one, the name vav1, and so 
on. Normally, you can simply click OK in this box; you need not select a special folder name 
because you will not explicitly use it, and, what is more important, by relying on the default you 
will ensure that no two presentations use the same folder for sound files (if they do, a filename 
clash may occur). Of course, you can choose “readable” folder names that have meaning for you, 
if you wish. In some cases, it may be useful to remember the name of the presentation folder, 
since sound files tend to be large and you may need to “measure” their size.

You can determine the sound folder’s name for an existing presentation by opening the 
presentation as a diagram and looking at the START symbol’s last text line. (For more details, 
see “Working With Presentations as Diagrams” on Page 300.)

After clicking OK for the Folder name, the Design of Presentation dialog box appears:

Figure 9-9: Preparing to design a presentation

This box is the main tool for creating and modifying a presentation. To start building this 
presentation, create the first slide. Proceed as follows:

1 Open the diagram with which the slide will be associated (in our case, it could be the 
Second Class Diagram). If necessary, move the design dialog box aside.

2 Activate a symbol in this diagram (e.g., the class symbol Transaction).

3 Click the Add button.

START
D=0,S=0,P=0
\vav
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The presentation cursor appears at the selected home symbol of the slide: 

In addition, the sequence number, 1, and the slide name, Transaction, appear in the upper field 
of the Design dialog box.

Before you start recording for the first time, be sure that your microphone is on and the 
recording level is adjusted accordingly. If you do not use other multimedia authoring 
applications, the following is important for you. If your computer has a sound card, your 
Windows system always has an “elementary” recording tool. You can start it, for example, via 
Start/Programs/Accessories/Multimedia/SoundRecorder. It can be operated by controls very similar 
to those of an ordinary tape recorder. Record a couple of words and then play them back to 
check the recording level. If nothing is recorded, the microphone is “logically off.” Double-click 
the speaker icon in the task bar to get the Volume control box, select Options/Properties, check 
Recording and click OK. The Recording Gain Control box appears. Here, check Select for the 
microphone and adjust the level. There may be additional recording level controls, e.g., in 
Control Panel/Multimedia.

Now let us record the text for this first slide, a single sentence: “You see that transactions in a 
banking system can be classified as cashier transactions or remote transactions.” To record the 
sound for a slide, click the Record button and start speaking (you may have to wait just a fraction 
of a second, until the field for counting seconds turns white). When finished, immediately click 
the Stop button. To hear the results, click the Play button. If not satisfied with the results, repeat 
the recording.

During playback you saw that the presentation cursor was at a fixed place, in the upper left 
corner of the Transaction class symbol. But it would be more natural to have three different 
positions for the cursor during the sentence: first at Transaction, then at Cashier transaction and, 
finally, at Remote transaction.
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This is done by introducing several intervals, each of them having a fixed cursor position in 
GRADE (by default, a recorded slide consists of a single interval). First, plan the intervals so 
that they will be synchronized with the recording. Let us assume you split the sentence into three 
intervals:

1 “You see that transactions in a banking system can be classified as

2 cashier transactions

3 or remote transactions.”

This type of “markup” identifies the points in our speech where we want to start a new interval. 
The first interval always starts at the beginning of the speech. Now play the recorded sentence 
once more and at moments where the speech “crosses” the markup points 2 and 3, click the Split 
button. Be sure to do this at precisely the right moments.

When you finish, you will see that the Interval field of the dialog has changed and now contains 
something like this:

The actual numeric values will vary; the number after the first t refers to the length of the given 
interval and the one after the second t, to the total duration of the slide (all values given in 
seconds). The 3... of 3 indicates that the playback stopped with the third interval, which is the 
third of three for this slide.

You can move the current position to the next or previous interval via the 

and 

buttons in the Interval area. Thus, click the  button to move to the second interval and drag 
the presentation cursor manually to Cashier transaction, the right location for interval 2. Then 
click the  button in the Interval area and position the cursor on Remote transaction for 
interval 3. Then play the slide once more and check the synchronization of speech and cursor 
movements.

Alternatively, with interval 3 as the current one, you could click the Play interval button and 
check whether you hear “… or remote transactions.” You can improve the synchronization via 
the
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buttons, which move the left or right end of the current interval in the given direction (in time), 
in increments of 0.2 seconds, until you hear the right words for the interval. (For details, see 
Page 298.) Do the same for other intervals until the results are satisfactory. Now the first slide 
is ready.

If the spoken text is longer, you may need more intervals for a slide. But the techniques remain 
the same: Either you plan the intervals in the written text, with interval number “markups” at 
appropriate points, and then adjust real intervals to this plan, or you just speak, then play and 
split intervals as needed. (If you have quick reactions, you may be able to split intervals “online,” 
as you speak. Then play back the recording interval by interval, and for each interval decide 
where to place the cursor.) The cursor need not be at the upper left corner of a symbol; it can 
be placed anywhere in the diagram and may point to a symbol, line, text outside or inside the 
symbol, etc. You can select four different presentation pointer positions (by selecting any of the 
four cursor buttons at the bottom of the Design of Presentation dialog) or make it invisible (by 
clicking the button in the middle).

Now add the second slide. It will be associated with the First Class Diagram, with Cashier 
transaction as its home symbol. Go back to the model-tree window, e.g., by clicking this icon in 
the toolbar:

Now open the First Class Diagram, activate the Cashier transaction class in it and click Add. The 
presentation cursor appears again. The spoken sentence for this slide could be as follows, divided 
as shown into four intervals:

1 “If we look at the initial ATM class diagram, we see that without a generalization symbol

2 a cashier transaction

3 and remote transaction

4 are completely different concepts.”

For this slide, the presentation cursor could be invisible for intervals 1 and 4, but point to 
Cashier transaction during interval 2 and Remote transaction during interval 3.

Each slide should correspond to a unit of text, with the number of intervals ranging from 1 to 
10 (not more than 15, because then the intervals become extremely difficult to synchronize and 
correct). It is easier for you to make more slides than more intervals. Remember that a sound 
recording of 1 second requires 2KB on your hard disk (with a default audio compression factor 
of 5).
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A slide’s home symbol can be selected from any diagram. Moreover, you can select a model table 
(e.g., GLO, STE, TAG, CLA) as a home symbol. To do this, open the model table, activate an 
entry in it and click Add. The only limitation in this case is that no visible presentation cursor 
is available for tables; during the playback of this slide, the table is shown with the “home entry” 
activated. This also means that intervals make no sense for “table slides,” because intervals differ 
only in terms of presentation cursor position.

We conclude this section with a formal description of all the elements of the Design of 
Presentation dialog.
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Element Function

Indicates time (in seconds) since the last activation of the Record or Play button.

Indicates the current slide’s sequential number and name (the name of the symbol with 
which the slide is associated). This field always contains a sequential number; a name 
is optional.

Opens an online help topic for this dialog.

Switches to the Playback of Presentation dialog, allowing you to play back the 
presentation.

 
Closes the dialog and the diagram last displayed by it.

Slide Group

Adds a new slide after the current one. Moves the current position to the new slide.

Adds a new slide before the current one. Moves the current position to the new slide.

Deletes the current slide.

Moves the current presentation position to this symbol (to a slide for which this 
symbol is the home symbol). Before pressing this button, you must click the desired 
symbol in the diagram. If the selected symbol is not a home symbol for any slide, a 
corresponding message is displayed. 

Moves the current position to the start of the presentation.

Moves the current position to the previous slide.

Moves the current position to the next slide.

Moves the current position to the end of the presentation.

Opens the standard Select audio format dialog. Allows you to select a recording quality 
appropriate for the computers of your potential audience (see also “Technical Tips for 
Recording” on Page 300).
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Starts recording the audio file of the current slide. IMPORTANT: Start speaking very 
soon after activating this button; you may have to wait just a fraction of a second, until 
the second-counter field turns white.

 Stops the current recording. (Note: This button appears alternately with Record.)

Initiates playback of the current slide. Stops when the playback is completed.

Stops playback of the current slide. (This button appears alternately with Play.)

Before clicking this button, you must activate Play or Record. Once the playback or 
recording is under way, click Split to divide the slide/interval into two intervals.

Interval Group

Indicates the active slide’s current interval and duration (in seconds and hundredths of 
seconds). The formulation 1...of 3 means that the current interval is the first in a set 
of three for that slide. The number following the first t is the length of the interval, 
while the number after the second t is the total length of the recording for that slide.

Undoes a split, merging the current interval and the next one.

Undoes a split, merging the current interval and all intervals following it up to the end 
of the current slide. 

Increases (by 0.2 sec) the duration of the current interval. The duration of the left (i.e., 
the previous) interval is decreased accordingly.

Decreases (by 0.2 sec) the duration of the current interval. The duration of the left 
(i.e., the previous) interval is increased accordingly.

Decreases (by 0.2 sec) the duration of the current interval. The duration of the right 
(i.e., the next) interval is increased accordingly.

Increases (by 0.2 sec) the duration of the current interval. The duration of the right 
(i.e., the next) interval is decreased accordingly.

Moves the current position to the first interval of the current slide.

Moves the current position to the previous interval.

Element Function
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Table 9-4: Elements of the Design of Presentation dialog

Once you have created a presentation, you may decide that certain corrections or improvements 
are required. Most of these can be carried out just as you did when creating the presentation, via 
the Design of Presentation dialog box. Here are some helpful hints:

• If you discover a defect in the recording, you must rerecord the given slide, using the same 
procedure as for an initial recording. If there were intervals, you then need to repeat the 
process of splitting the slide into intervals.

• Changing a slide’s home symbol is not particularly easy, but you can “reuse” a slide’s sound 
file in another slide (see “Working With Presentations as Diagrams” on Page 300).

• The presentation cursor position for an interval of a slide can be modified whenever this 
interval is the current one. “Grab” the presentation cursor with your mouse pointer and drag 
it to the required position.

• Any unnecessary slide can be deleted (make it the current one and click Delete).

• A new slide can be inserted after or before the current one (using the Add or Before buttons, 
respectively).

• The order of slides in the presentation can be changed by editing the presentation diagram 
(see “Working With Presentations as Diagrams” on Page 300).

Moves the current position to the next interval.

Moves the current position to the last interval of the current slide.

Starts playing back the current interval. Stops when the interval’s duration has elapsed.

 Stops current playback. (This button appears alternately with Play interval.)

Click any of these buttons to change the appearance of the presentation cursor of the 
current slide/interval. Use the blank button to hide the presentation cursor.

Element Function
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• You can insert a “silence period” (pause) after a slide by extending the last interval of the slide 
to the right via the  button. But you cannot “cut off” the last word by moving the right 
end to the left; the whole sound file will be played in any case.

9.2.3 Technical Tips for Recording

Sound recording, like all multimedia operations, requires much disk space. Therefore, an audio 
compression technique is implemented by means of codecs (compressor/decompressor). As 
noted, GRADE by default uses the Microsoft GSM 6.10 codec, which comes with the Windows 
operating system (see the troubleshooting table, Page 290, for installation tips). This codec has 
a compression factor of about 5. The sound is recorded at an 11 kHz sampling rate, equivalent 
to a high-quality telephone transmission and completely sufficient for recording speech. The 
resulting space requirements are 2 KB/second (more precisely, 1 minute requires about 130 KB).

If your system has a better codec installed, you can use it instead. By clicking the Format... 
button you get the same Select audio format dialog as you would have in Control 
Panel/Multimedia. Select a coding method and parameters as needed. But be aware that your 
presentation’s potential listeners must have the same codec installed on their computers.

9.2.4 Working With Presentations as Diagrams

Though normally not necessary, you may open a presentation as a diagram. (To do this, right-
click the diagram, then select Edit as diagram from the pop-up menu or, alternatively, activate 
the diagram and select Edit as diagram from the Diagram menu.)

This diagram consists of slide symbols that are connected in a particular order by abstract lines 
(arrows).

The chain’s start symbol is special. It has the fixed name START and its sound file text (the last 
line of the symbol) contains the folder name for the whole presentation:

IMPORTANT NOTE: For many presentation modification operations, it is necessary to mark a 
slide as the current one. Do this by using the arrow buttons for next ( ), previous ( ), 
beginning ( ) or end ( ), which let you move through the presentation. As an alternative, 
click a symbol that should be the home symbol for the desired slide, then on the 

button. Check the correctness of your choice by playing the beginning of the slide or 
by looking at the slide name in the box. If the slide has no name, its sequential number may be 
of help.

START
D=0,S=0,P=0
\vav
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If the folder name is in the form \name, it is a relocatable folder (always a direct subfolder of the 
model folder). Otherwise, the folder name defines the absolute path of the folder in your system. 
When such a model is copied, this path specification must be manually adapted to the new 
location by editing the START symbol.

All other slide symbols have the same structure:

The name (in the first line) is present if the home symbol of the slide has a name. Following 
that, the home symbol identity, sound-file length (P=…), interval lengths (T=...) and relative 
cursor positions for each interval are coded. The lengths are in hundredths of a second. The last 
line of a slide symbol is the sound file name (generated automatically):

vavnnn.vav

You can edit all these data by right-clicking the symbol, then selecting Symbol contents... from 
the pop-up menu. The need for this is very rare, however. The only item you might edit, on 
occasion, is the Sound file name. By editing this field, you can reuse an existing sound file (be 
sure to copy all sound file names, to avoid name clashes). In addition, if the slide name is empty 
(i.e., an unnamed home symbol such as a free comment has been used), you can manually add 
the slide name of your choice. Do not use an overly long name.

Another useful operation that can be performed in this diagram is the reordering of the slide 
chain. The abstract lines used to connect the slides can be detached and reattached just as in a 
class diagram (see Page 182). In this way, you can rearrange the slides in any order. Be sure, 
however, that after the modification you again have a chain, not several branches (the slides that 
do not appear in the main chain, connected to the START symbol, will be missing from the 
presentation). For better readability, you can reposition the chain (Edit/Reposition/Vertical, or 
Horizontal).

The sequential number is not a permanent part of a slide. It is assigned automatically during 
playback/design, so you need not update the number when reordering slides.

Any other changes in the presentation should be made via the Design of Presentation box.

9.2.5 Copying Models With Presentations

Currently, the possibilities for copying models with presentations are limited. These models 
cannot be exported in EI format (more precisely, they cannot be imported) (see also “Exporting 
and Importing Diagrams, Models in Export/Import Format” on Page 421). 

ATM
D=100009,S=101,P=489,Q=0,R
=16640,X=0,Y=0,T=6,I=407,O=7,X=0,Y
=0,T=148,I=407,O=145,X=0,Y=0,T
=335,I=407,O=0
vav104.vav
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Thus, the only way to copy such a model is via the Backup copy facility (see also “How Can I 
Make Backup Copies of Models?” on Page 372). When you create a backup copy in the 
repository window via Create backup copy in the pop-up menu (or via Model/Create backup copy), 
the sound-file folders together with all included sound files are also copied to the destination 
folder. 

When you need to restore a model, you create an empty model and activate it in the repository 
window. Then restore its contents from a backup copy by right-clicking the model and selecting 
Restore from backup copy in the pop-up menu (or open the Model menu and select Restore from 
backup copy). During this you are asked for a confirmation. Sound folders in the copy are also 
copied to the new model, so you obtain a ready-to-play model. The only problem may occur 
for non-relocatable sound folders (with full path specifications). Then you have to edit the 
START symbol manually (see “Working With Presentations as Diagrams” on Page 300) in the 
presentation diagram.

The same restore-from-backup method is used when you download models from the Web. 
Assuming the model is available as a ZIP file, you download it, unzip it in a temporary folder, 
and then use the restore-from-backup method, with the source of the restore operation being 
this temporary folder. Thus, you obtain a ready-to-play model.

9.3 External Link Diagrams (EXT)

Thanks to one of GRADE’s newer features, you can create external links in diagrams. That 
means linking a diagram symbol

• to an Internet address (e.g., Web site),

• a file (e.g., a Microsoft Word or Excel document, a help file, an audio or video file),

• a corresponding entry in the model’s glossary,

• an executable program, or

• another GRADE diagram.

Once the link has been established, you can click it to open the corresponding Web site, file, 
etc. These external links can be used both when viewing the diagram in GRADE and after the 
export of the diagram in HTML format. (To open an external link in GRADE, double-click it. 
To open an external link in HTML, a single click is sufficient.)

Such links can be very practical. For example, if you are creating a model in which various 
companies are represented, you can link each company’s symbol to its Web site. If you are 
creating a quality-assurance model, you can link each procedure represented in a diagram to a 
Word document providing detailed instructions for that procedure. If you have a model that 
makes use of complex terminology, you can link any symbol to its explanation in the model 
glossary.
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There are various ways of defining links:

• An explicit link is defined by inserting a corresponding text into the diagram element itself 
(or into a table that is part of your GRADE model).

• An iconized link is defined by activating a diagram element (a symbol or line), then filling 
out the External Link dialog. In your diagram, the link will be represented by a small icon 
(e.g., a picture representing a Word document or a Web browser) that will be attached to a 
diagram element. The icon can appear against the background of the diagram element or be 
adjacent to it. When you move the diagram element, the icon moves with it.

• A reusable link is defined in an external link table (EXT), which is global for the model. This 
link is referenced by name and can be attached in the form of an icon to diagram elements 
(box symbols or lines) as needed.

In the following sections, you will see examples showing how the various techniques are applied.

9.3.1 Defining a Link to an Internet Address

An Explicit Link to an Internet Address

To create an explicit link to an Internet address (e.g., a Web site or an e-mail address), proceed 
as follows:

1 Activate the diagram element that is to contain the link. (If the link is to appear in a 
table, open the table and activate the corresponding row.)

2 Click your right mouse button to open a pop-up menu and select Symbol contents… (If 
you are working in a table, click your right mouse button, then Edit row…)

When defining external links, do not use folder- or filenames exceeding 8 characters or names 
containing blanks.

�
Exactly what happens when you open any external link depends on your operating system’s settings 
for that file type. If you wish to change these settings, please consult your operating system’s manual 
or online help.
General-Use Diagrams 303 

• 
• 
• 
•
•
•



304 

• 
• 
• 
•
•
•

3 In the Description or Comment field, enter a URL (Internet address) enclosed by triple 
angle brackets: <<<SampleURL>>>. For example, to link your diagram element to the 
INFOLOGISTIK Web site, you would enter <<<www.infologistik.com>>>. To link 
your diagram element to an INFOLOGISTIK e-mail address, you would enter 
<<<mailto:info@infologistik.com>>>.

4 Press Return or click OK to close the dialog window.

An Iconized Link to an Internet Address

Let us assume you are working on a model of a consortium and would like to create links 
between all the companies in the model and their Web sites.

Proceed as follows:

1 Activate a diagram element (box symbol or line) that is to be linked. Here, we will be 
activating a class symbol representing a particular company (the company logo was first 
saved as a GIF file, then added to the symbol as described in “Inserting a Picture” on 
Page 333):

Figure 9-10: Activating the diagram element to be linked

�
In some cases, there may be no Description or Comment field available, but you can enter the 
Internet address (or other external-link information) into a text field (for example, in the text field 
of a free comment or note). If none of these fields is available, use the iconized link method 
described in “An Iconized Link to an Internet Address” on Page 304.

�
In some cases, it does not make sense to attach an explicit link to a line. Let’s assume you want to 
assign a link to a communication path of a CO diagram. You can do so, but when you double-click 
the link, a TO table will appear! In such cases, you should use the iconized link method described 
in “An Iconized Link to an Internet Address” on Page 304.
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2 Click your right mouse button to open the pop-up menu, then select New external 
link… The External Link dialog appears:

Figure 9-11: Dialog for defining external links

3 If you happen to know the name of the icon to be used as a link, you can simply type it 
into the Icon name field. If you want to select an icon or define a new one, as in our case, 
click the Select icon button. A dialog like the following one appears:

Figure 9-12: Dialog for selecting pictures
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4 If the Pictures available list contains the name of a picture that you want to use, you can 
simply click it, then on OK. In our case, however, we want to define a new icon by 
clicking New picture, then Select file. The Select Picture dialog appears:

Figure 9-13: Dialog for selecting a picture

5 You can now browse the folders in the Folder list to select the image (a file having the 
extension .gif, .wmf or .bmp) to be used for the link. (For more information, see the 
Glossary definitions GIF, WMF and BMP.) In this case, let us assume we have created a 
GIF image to be used for the iconized link. (You can create your own GIF files using 
graphics programs such as Microsoft PhotoDraw or PowerPoint, Adobe PhotoShop or 
Macromedia Fireworks. And you can create your own WMF files by using GRADE’s 
bitmap editor, which is described in “Defining or Modifying an Icon in the Symbol 
Palette” on Page 320.) Click the down arrow next to the List files of type box, then on 
GIF Files. As we browse the folders and select various files, we see a preview of each 
image. This is how the dialog looks once the final selection has been made:

Figure 9-14: Icon preview shown
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6 Then click OK, OK and OK.

7 In the URL/File/Executable field, enter the URL (in this case, www.infologistik.com). No 
angle brackets are necessary. If you want to make sure you have entered the correct URL, 
click the Test button, check the contents of the browser window, then close it. (To create 
a link to an e-mail address, simply enter the address without brackets, e.g., 
mailto:info@infologistik.com.) The External Link window now should look like this:

Figure 9-15: Filled-out External Link dialog

8 Then click OK. You will now see the diagram with the new icon. If you wish to move 
this icon, position your mouse pointer on it (the pointer becomes a hand), then hold 
down your left mouse button and drag it to a new position, as done here:

Figure 9-16: Icon positioned in upper left corner of symbol
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9 To test your new link, simply double-click the icon.

A Reusable Link to an Internet Address

To create a reusable link to an Internet address, proceed as follows:

1 With the model-tree window open, double-click the EXT icon (found in the top row). 
An EXT table appears:

Figure 9-17: EXT table

2 Click the yellow New row icon to create a new row in this table. The External Link Table 
Entry dialog appears:

Figure 9-18: External Link Table Entry dialog

3 In the Link name box, enter a name that is unique among the links stored in the model, 
e.g.,
To Company Web Site

�
Not all pictures are suitable for use as icons, as some become distorted when reduced to icon size. 
You may need to experiment to arrive at the right icons for your diagram.
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4 In the Icon name box, type in the name of an icon or select one by using the Select icon 
button. (If necessary, define a new icon by following the instructions in Steps 3-6, 
starting on Page 305.)

5 In the URL/File/Executable field, enter the Internet address (e.g., www.infologistik.com or 
mailto:info@infologistik.com). No angle brackets are necessary. (If you want to make sure 
you have entered the correct URL, click the Test button. Then check the contents of the 
browser window and close it.) Then click OK. The new link appears in the EXT table:

Figure 9-19: EXT table with new link

To make use of the link just created, see “Assigning a Reusable Link to Any Diagram Element” 
on Page 309.

9.3.2 Assigning a Reusable Link to Any Diagram Element

To assign a reusable link to a diagram element (box symbol or line), proceed as follows:

1 Open the diagram and right-click the diagram element.

2 In the pop-up menu, select New external link… The External Link dialog appears.

3 Click the down arrow next to the Link name field, then select the name of a link. Then 
click OK.

9.3.3 Editing a Row in an EXT Table

To edit a row in the EXT table, click the row in question with your right mouse button, then 
select Edit row… from the pop-up menu. In the External Link Table Entry dialog, make your 
entries as needed, then click OK.

�
If you receive an error message when trying to open a link to the Internet, it may be that you are 
not currently connected to the Internet. Establish the connection, then open the link.
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9.3.4 Defining a Link to a File

To define an explicit link to a file, proceed as described in “An Explicit Link to an Internet 
Address” on Page 303. The only difference is Step 3. Instead of defining a URL, enter the path 
to the desired document in angle brackets, e.g.,

<<<c:\Products\GRADE\Prices.doc>>>

To define an iconized link to a file, proceed as described in “An Iconized Link to an Internet 
Address” on Page 304. The only difference is Step 7. Rather than entering a URL into the 
URL/File/Executable field, simply enter the path to the desired document (without angle 
brackets), e.g.,

c:\Finances\Revenue\Rev1999.xls

To create a reusable link to a file, proceed as described in “A Reusable Link to an Internet 
Address” on Page 308. The only difference is in Step 5. Instead of entering a URL in the 
URL/File/Executable field, simply enter the path to the desired document (without angle 
brackets), e.g.,

c:\QA\GRADE\V4011\Test.doc

Do not forget the filename extension, e.g., .doc, .txt, etc.

�
If your external link is to a large HTML file, you can use a “bookmark” to jump to a particular 
location in that file. Let us assume you want to create an explicit link to jump to the letter P in a 
GRADE dictionary that has been exported in HTML. The dictionary already contains the 
bookmark letter_P, marking where the entries with the letter P begin.

If you are using the Microsoft Internet Explorer, you would enter something like this:
<<<iexplore.exe C:\GRADE4\REPOSIT\MODEL1\HTML\Dict.htm#letter_P>>>

If you are using the Netscape browser, you would enter something like this:
<<<netscape.exe C:\GRADE4\REPOSIT\MODEL1\HTML\Dict.htm#letter_P>>>
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9.3.5 Defining a Link to the Glossary

To define an explicit link to an entry in the model’s GLO table, proceed as described in “An 
Explicit Link to an Internet Address” on Page 303. The only difference is Step 3. Instead of 
defining a URL, enter GLO followed by a space and the name of the relevant item in the glossary 
in angle brackets. If the name of the glossary entry contains a space, replace it with an 
underscore. For example:

<<<GLO Remote_Transaction>>>

To define an iconized link to an entry in the model’s GLO table, proceed as described in “An 
Iconized Link to an Internet Address” on Page 304. The only difference is Step 7. Rather than 
entering a URL into the URL/File/Executable field, simply enter

GLO

And in the Parameter string field, enter the name of the glossary entry, e.g., 

Remote transaction

�
If you do not enter the full path to a file, the GRADE external link interpreter comes into play. 
When the link is opened in GRADE, the model’s path will be added automatically. Thus, if you 
have entered only REVENUE.XLS, GRADE will interpret it as 
C:\GRADE4\REPOSIT\MODEL\REVENUE.XLS (assuming C:\GRADE4 is the installation folder 
and REPOSIT and MODEL represent the repository and model names, respectively). If your file is 
located in this folder, GRADE will find it there.

If a link having an incomplete path is opened in a Web browser, the path to the model’s HTML 
files will be added. Thus, if you have entered only budget.xls, the browser will interpret it as, e.g., 
www.infologistik.com\examples\model1\budget.xls.
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To better understand how a glossary link could be helpful, consider the following example. You 
are creating a model entitled ATM Future, a modified version of the Automatic Teller Machine 
model delivered with the installation. Looking at the diagram below, you decide to create an 
iconized link from the class Remote transaction to its definition in the model’s glossary.

Figure 9-20: CL diagram without external links

First create the Remote transaction glossary definition in the GLO table, as described in 
“Creating a Glossary Entry” on Page 337. Then proceed as follows:

1 Click the Remote transaction symbol with your right mouse button to open a pop-up 
menu. There, select New external link...
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2 Now click Select icon to open the Select Picture dialog. Use your downward arrow cursor 
key to move through the list of available pictures. Select IC_DETLS, as shown here:

Figure 9-21: Selecting a picture to be used as an icon

3 Then click OK, OK and OK.

4 In the URL/File/Executable field, enter GLO to indicate that the link will be to the 
glossary table.
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5 In the Parameter string field, enter the name of the glossary entry, in this case, Remote 
transaction. The External Link dialog now should look like this:

Figure 9-22: A filled-out External Link dialog

6 Click OK. The class symbol Remote transaction now contains the newly defined icon:

7 Because you do not want the icon to cover the name of the symbol, click the icon once 
with your left mouse button to “grab” it (a hand will appear), then, holding down the 
button, move the icon to a more convenient location either on or near the symbol:

8 To test your link, double-click the icon. The GLO table appears with the Remote 
transaction entry activated:

Figure 9-23: Linked definition is activated in glossary
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To create a reusable link to an entry in the model’s GLO table, proceed as described in “A 
Reusable Link to an Internet Address” on Page 308. The only difference is in Step 5. Rather 
than entering a URL into the URL/File/Executable field, simply enter

GLO

And in the Parameter string field enter the name of the glossary entry, e.g., 

Remote transaction

9.3.6 Defining a Link to an Executable Program

To define an explicit link to an executable program, proceed as described in “An Explicit Link 
to an Internet Address” on Page 303. The only difference is Step 3. Instead of defining a URL, 
enter the path to the executable program in angle brackets, e.g.,

<<<c:\Programs\HySnapDX\hsdx.exe>>>

To define an iconized link to an executable program, proceed as described in “An Iconized Link 
to an Internet Address” on Page 304. The only difference is Step 7. Rather than entering a URL 
into the URL/File/Executable field, simply enter the path to the executable program (without 
angle brackets), e.g.,

c:\Programs\HySnapDX\hsdx.exe

To create a reusable link to an executable program, proceed as described in “A Reusable Link to 
an Internet Address” on Page 308. The only difference is in Step 5. Instead of entering a URL 
in the URL/File/Executable field, simply enter the path to the executable program (without angle 
brackets), e.g.,

c:\Programs\HySnapDX\hsdx.exe

�
As an alternative to typing out the path name, you can use the Browse button to select the path.

If you do not enter the full path to an executable program, the GRADE external link interpreter 
comes into play. When the link is opened in GRADE, the model’s path will be added automatically. 
Thus, if you have entered only PROGRAM.EXE, GRADE will interpret it as 
C:\GRADE4\REPOSIT\MODEL\PROGRAM.EXE (assuming C:\GRADE4 is the installation 
folder and REPOSIT and MODEL represent the repository and model names, respectively). If your 
executable file is located in this folder, GRADE will find it there.

If a link having an incomplete path is opened in a Web browser, the path to the model’s HTML 
files will be added. Thus, if you have entered only program.exe, the browser will interpret it as, e.g., 
www.infologistik.com\examples\model1\program.exe.
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9.3.7 Defining a Link to Another Diagram

Defining an external link from a GRADE diagram element to another diagram is simple. The 
basic principle is to enter a diagram-type code followed by a space and the diagram name. The 
allowed diagram-type codes are listed below:

• ASF (alphanumeric screen form)

• ATR (attribute table)

• BP (business process diagram)

• CL (class diagram)

• CO (communicating objects diagram)

• DD (data definition diagram)

• DGR (can be used for any type of diagram)

• ER (entity-relationship diagram)

• GLO (glossary table)

• GSF (graphical screen form)

• ORG (organizational/resource diagram)

• PCK (package diagram)

�
When defining an iconized link or a reusable link to an executable program, you can also enter a 
parameter in the Parameter string field of the External Link dialog. 

For DLL/OCX function calls use the following syntax (for 16-bit and 32-bit DLLs, respectively):

URL/File/Executable: rundll.exe
Parameter string: c:\ppp\library.dll,function

URL/File/Executable: rundll32.exe
Parameter string: c:\ppp\library.dll,function

Note that links containing an executable program and parameter are fully supported only during 
GRADE sessions. They are not fully supported after export in HTML because Web browsers 
generally do not transmit parameters to applications they are starting. For this reason, when 
exporting a diagram in HTML, GRADE drops the initial part of the link text, i.e., 
<<<c:\ppp\program.exe parameter>>> becomes simply <<<parameter>>>. An external link to an 
executable program and parameter will work after export in HTML if the parameter names a file 
that can be started automatically via its filename extension. For example, the parameter 
Test1999.doc can be used to open a Microsoft Word document.
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• PD (process diagram)

• PRE (presentation)

• SD (specification diagram)

• TAB (custom table diagram)

• TD (task details diagram)

• VIEW (view diagram)

• VT (variable table).

To define an explicit link to a GRADE diagram, proceed as described in “An Explicit Link to 
an Internet Address” on Page 303. The only difference is Step 3. Instead of defining a URL, 
enter the diagram-type code followed by a space and the diagram name. All this information 
must be enclosed in triple angle brackets. Thus, an external link to a class diagram named Bank 
Accounts would look like this:

<<<CL Bank_Accounts>>>

To define an iconized link to a GRADE diagram, proceed as described in “An Iconized Link to 
an Internet Address” on Page 304. The only difference is Step 7. Rather than entering a URL 
into the URL/File/Executable field, simply enter the diagram-type code, e.g., CL, and in the 
Parameter string field, enter the diagram name, e.g.,

Bank Accounts

To create a reusable link to a GRADE diagram, proceed as described in “A Reusable Link to an 
Internet Address” on Page 308. The only difference is in Step 5. Instead of entering a URL in 
the URL/File/Executable field, simply enter the diagram-type code, e.g., CL, and in the 
Parameter string field, enter the diagram name, e.g.,

Bank Accounts

9.4 Stereotype Table (STE)

As you may recall, stereotypes can be used to distinguish a particular diagram element or an 
entire group of diagram elements of a particular type. Note that stereotypes can be defined in 
many different ways, depending on the circumstances. Just a few examples are presented below.

In some cases, you may want to define just a stereotype name, as shown in this class symbol:

Bank Central
Computer

<<Computer>>
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In other cases, you may want to define attributes as well, as shown in this class symbol:

In still other cases, you may want to define a stereotype with a particular style, as shown in this 
resource symbol:

A brief introduction to stereotypes as they are used in CL diagrams was presented in “Using 
Stereotypes” on Page 167. This section provides more general information about stereotypes. In 
addition to CL diagrams, stereotypes can be used in the following diagram types:

• package (PCK) diagrams 

• business process (BP) diagrams 

• task details (TD) diagrams 

• organization/resource structure (ORG) diagrams.

Defining a Stereotype

To define a new stereotype, follow the instructions below:

1 Double-click the STE icon in the model tree.

Standard Workstation
Pentium II
32 MB RAM

<<Computer>>

Administrator
Workstation
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2 Click the yellow New row icon to open the Stereotype Table Entry dialog:

Figure 9-24: Dialog for defining a stereotype

3 Enter a name for the stereotype in the Name field. (Each stereotype in the model must 
have a unique name.)

4 To select the type of diagram element to which the stereotype will apply, select the 
diagram type first from the Diagram type combo box, then the diagram element from 
the Base type combo box.

5 Optionally, you may add a description in the Description field (using Ctrl+Enter to create 
a new line).

6 Click the Style button to define the style of the stereotype; you can define the box shape, 
the color, the fonts used, etc. The principles of defining style are explained in Section 
“Symbol Style Dialog” on Page 352. Click OK.

7 Optionally, you can define an icon in the symbol palette for the stereotype. For more 
information, see “Defining or Modifying an Icon in the Symbol Palette” on Page 320. 
Do not forget to insert a number in the -th in symbol palette field to indicate the icon’s 
position in the symbol palette.

8 Once you have made all of your entries, click OK to close the dialog.

Modifying a Stereotype

Proceed as follows:

1 Right-click the stereotype to be changed in the STE table.

2 Click Edit row...
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3 Make any desired changes, following Steps 3-7 above (Section “Defining a Stereotype”).

4 The changes you have made will not be automically applied to the relevant diagram 
elements. If you want to apply these changes now to all diagram elements with this 
stereotype throughout the model, click the Apply to all button. If you do not want to 
apply the changes now, simply click OK.

Applying Stereotypes

To apply a stereotype to an activated symbol or selected group of symbols, click your right 
mouse button and select Symbol stereotype... In the dialog, make sure the correct stereotype is 
selected, then click Apply.

There are also alternative ways of applying stereotypes:

• In CL diagrams, you have this option: Right-click a diagram element, then click Symbol 
contents... Locate the Stereotype field, then click on the down arrow next to it. Select the 
desired stereotype and click OK.

• Define a special icon for the stereotype in the symbol palette, then use this icon to create a 
new diagram element. This is described in “Defining a Stereotype” on Page 318 and in 
“Defining or Modifying an Icon in the Symbol Palette” on Page 320.

If you want to make sure all stereotypes are applied to all diagram elements in the model having 
this stereotype specified, proceed as follows:

1 Activate the model tree (click in it).

2 Open the Options menu and select Apply all stereotypes.

Restore Modified Stereotypes

By opening the Options menu of the model window and selecting Restore default stereotypes, you 
can restore the default GRADE stereotypes in the STE table. This command does not delete 
stereotypes. It inserts default stereotypes that are missing from the STE table and overwrites the 
modified ones. (Close and reopen the STE table to see the changes.)

Defining or Modifying an Icon in the Symbol Palette

During the process of creating/modifying a stereotype, you can define/modify an icon for it in 
the symbol palette.
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Proceed as follows:

1 With the Stereotype Table Entry dialog open, click the Icon button. A dialog similar to 
the following one appears:

Figure 9-25: Dialog for defining an icon for the symbol palette

2 If the current stereotype already has an icon assigned to it, this icon appears in the Edit 
picture field; if no icon has been assigned, the red frame will be empty. To modify the 
existing icon or draw a new one, use the “paintbrush” method: click in the Color palette 
field to select a color, then click at the appropriate location in the red frame to create a 
square having that color. Repeat as necessary. As an alternative, you can hold down your 
left mouse button and “drag” the color across a larger area. To define a new color in the 
color palette, click on any square in the palette, then click on Change color. Select a color 
and click OK. To restore the palette (and the corresponding colors in the frame), click 
Restore colors. 

3 You also can “borrow” an icon by loading a bitmap (a BMP format picture). Click Load from 
file, select the file, then click OK. Or, if you have a bitmap saved in the model’s PIC table, 
click Load from PIC.

4 To resize the icon, “grab” the red frame, holding down your left mouse button, and drag as 
needed.

5 When finished, click OK to close the Bitmap Editor dialog.
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6 To make certain that your new icon will appear in the symbol palette, take one additional 
step. In the Stereotype Table Entry dialog, enter a number in the box marked -th in symbol 
palette. This will determine the position of the icon in the palette; 0 means it will not appear. 
If you select a number that is already taken (check the STE table for a list of numbers already 
in use), the icon also will not appear. Click OK.

9.4.1 Managing Stereotypes

GRADE provides a quick and easy way of managing stereotypes via the Symbol Stereotype dialog. 
It lets you:

• view a list of all available stereotypes for the currently activated diagram element

• apply a stereotype to a diagram element or group of elements

• remove a stereotype from a diagram element or group of elements

• define a new stereotype.

Proceed as follows: Activate a single diagram element or select a group of elements. Then click 
your right mouse button and select Symbol stereotype... (As an alternative, you can select this 
command from the Style menu.) Your options are explained in the following table:

Table 9-5: Elements of the stereotype-selection dialog

�
The -th in symbol palette field will be disabled until you have both defined a stereotype style and 
created an icon.

You also can use this icon editor as a general-purpose small bitmap editor, for example, to create 
external link icons for GRADE diagrams. Create the desired bitmap, click the Save as file button, 
and save the icon, for example, in the PIC folder.

Dialog Element Meaning

Stereotypes available
combo box

Displays the list of stereotypes available for the activated/selected symbol(s). By selecting 
another stereotype in this list and clicking OK, you will replace the current stereotype. 
To actually apply the stereotype and change the symbol’s appearance, use the Apply 
command (see below).

Remove button To remove a stereotype from the activated/selected symbol(s), click Remove, then OK. 
This revokes the assignment of the stereotype, but does not change the appearance of 
the symbol. To change its appearance you can, for example, apply a different stereotype.

Apply button Click this button to apply the highlighted stereotype to the activated/selected symbol(s). 

New button Opens the Stereotype Table Entry dialog, allowing you to define a new stereotype.
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9.5 Graphical Screen Form Diagrams (GSF)

Let’s assume you are building a new business and have modeled the business processes in a 
GRADE diagram. To execute one of these processes, employees will require a new software 
application. You can model a prototype of this application’s graphical user interface using 
GRADE’s graphical screen form (GSF) diagrams. The example below shows a very simple 
dialog box that was modeled using GRADE; you can also use GRADE to model very complex 
interfaces.

Figure 9-26: Dialog prototype created with GRADE

There are four types of graphical screen forms that can be prototyped in GSF diagrams. To help 
you better understand what is meant by these forms, we will explain them in the context of 
GRADE.

• A window. In GRADE, a typical window would be a model-tree window. One of the window 
forms must be marked as the main window, which corresponds to the GRADE main 
window; it is the one opened at the start of the application and closed at termination.

• A subwindow, which is displayed within a parent window and which is not movable. In a 
GRADE diagram window, the symbol palette would be considered a subwindow.

• A dialog. A screen form for dialog with the user. When you define a diagram element in 
GRADE, you normally fill out a dialog.

• A menu. An example of a menu in GRADE is the menu bar (Diagram, Edit, Style, etc.), 
including the items within each submenu (Save, Print..., etc.).

There are four subtypes of GSF diagrams, each corresponding to one of the screen forms 
mentioned above: GSF window, subwindow, dialog and menu.
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9.5.1 Creating a GSF Window, Subwindow or Dialog

When you use a GSF window, subwindow or dialog diagram to create a prototype, the following 
symbol palette will be displayed:

Table 9-6: GSF symbol palette for creating windows, subwindows and dialogs

Defining the Main Window of the Application

One of the screen forms used in an application must be marked as the main window, which is 
opened at the start of the application and closes upon termination of the application.

Symbol Name Function

Deselect Deselects a previously selected symbol in the symbol palette.

Text Creates text.

Field Creates a field.

Vertical scroll bar Creates a vertical scroll bar for scrolling up and down.

Horizontal scroll bar Creates a horizontal scroll bar for scrolling from side to side.

List box Creates a list box (a selection list).

Combo box Creates a combo box. The field at the top will show the currently 
selected/entered item. (A Simple combo box is one in which an open list is 
displayed below this field; a Drop-down combo box is one in which the list 
can be opened via mouse click and an entry can be selected or typed in; a 
Drop-down list combo box is similar, but entries cannot be typed in.)

Radio button group Creates a radio button group with round selection buttons.

Radio button Creates an individual radio button for insertion in a radio button group.

Check box group Creates a group of check boxes.

Check box Creates an individual check box for insertion in a check box group.

Bitmap Opens a dialog for inserting a bitmap image.

Frame Creates a frame.

Drawing area (Not currently available for use.)

Button Creates a command button.

Field array (Not currently available for use.)

Subwindow Creates a subwindow.

Free comment Creates a free comment, analogous to those used in other diagram types.
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To define the main window of your application, proceed as follows:

1 In the model tree, right-click the desired parent diagram (a diagram with which the new 
one is to be associated) and select New diagram... from the pop-up menu. The Define 
dialog appears.

2 Enter a name for the window, click the GSF WINDOW radio button, then click Define 
& Open. A new GSF window diagram is created and its window is opened.

3 Right-click the frame of the inner window, then select Symbol contents... from the pop-
up menu. The Window form dialog appears.

4 Mark the Main window check box.

5 Specify other attributes of the main window (such as the title) and click OK.

6 Right-click the inner frame again, select the Size... command from the pop-up menu, 
and specify the size.

7 If needed, specify the colors and fonts by right-clicking the inner frame and selecting the 
Colors or Font command from the pop-up menu.

8 If needed, insert dialog elements such as radio buttons, lists, etc., in the window: With 
the inner frame activated, click the appropriate symbol in the symbol palette, then click 
at the location where the element is to be entered. Make any necessary entries in the 
dialog, then click OK. (For more information about inserting dialog elements, see 
Section “Defining Text” on Page 326 and the following sections.)

9 Save and close the diagram.

Defining Other Windows

To define other windows, proceed as described in “Defining the Main Window of the 
Application” on Page 324, except that the Main window check box must be switched off.

�
When defining a main window, you also have the option of defining its start window. When the 
user starts the application, a start window appears for a few seconds and displays, for example, the 
company or product logo. Only then does the main window appear.

To define a start window, enter its name and the number of seconds it is to be displayed in the 
Window form dialog of the main window. The start window itself must be prepared as a separate 
GSF window diagram.
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Defining a Subwindow

Proceed as follows:

1 In the model tree, right-click the desired parent diagram and select New diagram... from 
the pop-up menu. The Define dialog appears.

2 Enter the name of the subwindow. Click the GSF SUBWINDOW radio button, then the 
Define & Open button. A new GSF subwindow diagram is created and its window is 
opened.

3 Right-click the frame of the inner window, then select Symbol contents... from the pop-
up menu. The Subwindow form dialog appears. Specify attributes of the subwindow and 
click OK.

4 Then proceed according to the instructions starting on Page 325, Steps 6-9.

Defining a Dialog

Proceed as follows:

1 In the model tree, right-click the desired parent diagram and select New diagram... from 
the pop-up menu. The Define dialog appears.

2 Enter the name of the dialog. Click the GSF DIALOG radio button, then click the 
Define & Open button. A new GSF dialog diagram is created and its window is opened.

3 Right-click the frame of the inner window, then select Symbol contents from the pop-up 
menu. The Dialog form definition dialog appears. Specify the attributes of the dialog 
form and click OK.

4 Then proceed according to the instructions starting on Page 325, Steps 6-9.

The following sections describe how to enter various elements in a window, subwindow or 
dialog.

Defining Text

You can enter text in a predefined rectangle with a specified alignment.

�
When defining elements in GSF diagrams, you can enter the internally used name of an element in 
the Name field (e.g., a button used to confirm entries and close a window might be given the name 
Approval). The actual text that is to appear on the screen is entered in the Title, Value or Default field 
(e.g., an Approval button might be given the title OK, Yes or Next). For basic modeling, it is usually 
sufficient to fill out only the Title/Value/Default field. If you are creating a formal model (one that 
is to be analyzed, simulated, etc.), however, you should fill out the Name field as well.
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Proceed as follows:

1 Select the text symbol in the symbol palette by clicking it. Move the mouse cursor to the 
location where you wish to insert the text and click once more. The Text dialog appears.

2 Enter the text into the Value field, specify the alignment by marking the appropriate 
radio button and click OK. The text rectangle appears in the form.

3 Adjust the text area’s size and position by “dragging” the entire rectangle or its borders.

4 If desired, right-click the text box, then select Colors or Font to change the text’s 
appearance.

Defining a Field

In the context of a GSF window, subwindow or dialog, a field is a rectangular box that can be 
used for text input and modification.

To insert a field, proceed as follows:

1 Select the field symbol in the symbol palette by clicking it. Move the mouse cursor to 
the location where you wish to insert the field and click once more. The Field dialog 
appears.

2 Make any necessary entries, then click OK. The field rectangle appears in the form. (To 
enter field contents, see “Defining Text” on Page 326.)

3 Adjust the field’s size and position by “dragging” the entire field or its borders.

4 If desired, right-click the field and select Colors to change the colors used.

Defining Buttons

A button is an element for the visual display of a command. It may have a changeable title 
displayed on it. (In GRADE dialogs, the most frequently encountered button is OK.)

To insert a button, proceed as follows:

1 Select the button symbol in the symbol palette by clicking it. Move the mouse cursor to 
the location where you wish to place the button and click once more. The Button dialog 
appears.

2 Select or enter the button title (the text that will appear on the button) and any other 
necessary information and click OK. The button appears in the form.

3 Adjust the button’s size and position by dragging the entire button or its borders.

4 If desired, right-click the button, then select Font to change the typeface used.
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Defining Radio Buttons

A radio button group is used for selection from a fixed set of possible items. The item titles 
appear on the application screen, and after the selection is made the new item is passed to the 
application program. Some of the items may be disabled (not available for selection).

To insert radio buttons, you first will need to insert a radio button group, then insert the desired 
number of radio buttons.

Proceed as follows:

1 Select the radio button group symbol in the symbol palette by clicking it. Move the 
mouse cursor to the location where you wish to insert the group and click once more. 
The Radio Button Group dialog appears.

2 Make any necessary entries, then click OK. The group symbol (containing two radio 
buttons) appears in the form.

3 Adjust the group symbol’s size and position by dragging the entire symbol, its borders, 
or elements within it.

4 Complete the definitions of the two radio buttons already inserted: Right-click either of 
the radio button circles, then select Symbol contents... from the pop-up menu. The Radio 
Button dialog appears.

5 Make any necessary entries and click OK.

6 Adjust the radio button’s size and position.

To add another radio button to the group, proceed as follows:

1 Select the radio button symbol in the symbol palette by clicking it. Move the mouse 
cursor to the location where (within the group symbol frame) you wish to place the radio 
button and click once more. The Radio Button dialog appears.

2 Make any necessary entries, then click OK.

3 Adjust the radio button’s size and position.

Inserting Pictures (Bitmaps)

GRADE allows you to enhance your window, subwindow or dialog with pictures, which must 
be available as bitmaps in BMP format.

To insert a bitmap, proceed as follows:

1 Select the bitmap symbol in the symbol palette by clicking it. Move the mouse cursor to 
the location where you wish to place the picture and click once more. The Bitmap dialog 
appears.
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2 Select or enter a name for the bitmap (this is optional).

3 Position your cursor in any one of the File name fields, depending on how many colors 
your bitmap has. (If you are not sure about the number of colors, view your bitmap’s 
attributes using a bitmap editor.)

4 Click the Browse button, then select your bitmap and click OK.

5 Click OK again, and the picture appears in the form.

6 Adjust the picture size and position. The picture is always scaled to the full size of its 
rectangle.

9.5.2 Defining a GSF Menu

You can use the GSF MENU diagram to define a menu bar. Here, we will refer to each item 
displayed in the menu bar as a submenu. Each item within the drop-down submenu will be 
referred to as a menu item. The lines that may separate groups of menu items will be referred 
to as separators. These elements can be created via the symbol palette:

Figure 9-27: Symbols in the GSF MENU symbol palette

To create a menu, proceed as follows:

1 In the model tree, right-click the desired parent diagram and select New diagram... from 
the pop-up menu. The Define dialog appears.

2 Enter the menu name, click the GSF MENU radio button and click the Define & Open 
button. A new GSF MENU diagram is created and its window is opened.

3 Right-click the SUBMENU line and select Symbol contents... from the pop-up menu. 
The Submenu dialog appears.

�
Only the BMP file name of the picture (the selected path included) is stored with the diagram 
contents. When reopening the diagram, GRADE will search for all the picture files involved.

The export to EIF function exports only the BMP file name of the picture (including the selected 
path).

Symbol Name Function

Menu item Creates a menu item.

Submenu Creates a submenu.

Separator Creates a separator.
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4 In the Title field, enter the name of the submenu as it is to appear on the user interface. 
If you enter an ampersand (&) in front of any character, that character will be 
underlined, and it can be used as a shortcut to open the menu; for example, if your 
submenu is titled File, you can press Alt+F to open this submenu. Specify any other 
attributes, then click OK. 

5 To define the items in this submenu, right-click the ITEM line just beneath it, then click 
Symbol contents... The Item dialog is displayed. Make an entry in the Title field and add 
any other required information. Then click OK.

6 To enter a separator, activate the ITEM line beneath which the separator is to appear, 
then click the separator symbol in the symbol palette.

7 To enter a new menu item, click the line beneath which the new item is to appear, then 
click the menu item symbol in the symbol palette. Enter a title and any other necessary 
information, then click OK.

8 To enter a new submenu, activate the final line of the previous submenu (the one that 
will appear to the left of the new submenu), then click the submenu symbol in the 
symbol palette. Fill in a title and any other necessary information, then click OK. 

9 To see the results of your work, click any submenu in the Test Menu window.

10Save and close the diagram.

To modify a menu element: right-click the element and select Symbol contents... from the pop-
up menu. The corresponding dialog appears. Modify the attributes of the element and click OK.

To delete a menu element: click the element and press Del. By deleting a submenu, you also 
delete all its items and all nested submenus. 
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9.6 Picture Table (PIC)

The PIC icon appears in the top row of the GRADE model tree:

Figure 9-28: Model tree with PIC icon

It represents a picture table with graphics that can be used to enhance GRADE diagrams. These 
pictures may be in various formats, with the file extension .wmf (for a Microsoft Windows 
metafile), the extension .gif (Graphics Interchange Format) or .bmp (bitmap). (See also the Glossary 
definitions of WMF, GIF and BMP.) The possibility of using GIF pictures is one of GRADE’s 
newer features; it means you can enhance your diagrams with photographs or screen shots that 
have been stored as GIF files.

The pictures stored in the PIC table are simply referenced by name (not filename) and can easily 
be called up for use in diagrams. The PIC table is global for the GRADE model.

By default, the PIC table contains dozens of pictures that come with the GRADE installation. 
To view the pictures stored in the PIC table, double-click the PIC table to open it. Then right-click 
any line and select Edit row... A preview of the picture is shown in the lower right corner of the dialog 
box.

Storing a Picture

GRADE gives you the option of supplementing the PIC table with additional pictures, as well. 
For example, you might want to add WMF clip-art images from your Microsoft Windows 
Office package or from other sources, or create GIF files using graphics programs such as 
Microsoft PhotoDraw or PowerPoint, Adobe PhotoShop or Macromedia Fireworks. 

Proceed as follows:

1 Open the picture table by double-clicking the PIC icon in the model tree.

�
Note: If you are working with an older GRADE model, you may find that its PIC table is empty. 
You still have the option, however, of “loading” standard GRADE pictures into this table. With the 
PIC table open, click the yellow New row button. Then click Select file and select a picture file. 
Then click OK and OK.
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2 Click the yellow icon to the left to open the Picture Table Entry dialog:

Figure 9-29: Dialog box for entering graphics in PIC table

3 In the Name field, enter a picture name that is unique among pictures stored in the 
model. (Type it in and/or use the Pick name button to select a name.)

4 In the Description field, you may optionally enter a description of the picture or other 
comment. (To create a new line, press Ctrl+Enter. If you wish, you can pick names using 
the Pick name button.)

5 Click Select file to open the Select Picture dialog. Here, you can click on the folders 
displayed in the Folders list to browse to the desired file.

6 Once you have selected the desired file, click OK and OK.

Editing a Row in the Picture Table

To edit a row in the picture table, proceed as follows:

1 Click the row in question with your right mouse button.

2 Select Edit row... from the pop-up menu. The Picture Table Entry dialog appears.

3 To make your changes, follow the guidelines in Steps 3-6 above.

Only the name of the picture is saved with the diagram; the picture itself is stored in the PIC 
table. When you reopen the diagram, GRADE will search for the picture in the PIC table. Thus, 
if you export a diagram by itself, the pictures in this diagram will not be exported.
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Inserting a Picture

Assume you want to insert a picture into a diagram element, i.e., a box symbol or line. Proceed 
as follows:

1 Right-click the diagram element, then select Symbol style...

2 In the Picture part of the dialog, click the Select... button. A Select Picture dialog, similar 
to the following one, appears. Here, you can click any available picture, then click OK 
and OK to insert it. That’s all. If you want to insert a new picture, which is not in the 
PIC table and does not appear in the Select Picture list, proceed with Step 3.

Figure 9-30: Select Picture dialog
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3 Click New picture. The Picture Table Entry dialog box appears:

Figure 9-31: Picture Table Entry dialog

4 Click Select file. You now can browse the folders in the Folders list to select any .wmf, .gif 
or .bmp file. A preview of the selected picture file will appear in the lower right corner of 
the window:

Figure 9-32: Selecting a picture
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5 Click OK, OK, OK and OK. The picture appears in the symbol:

Modifying the Appearance of Pictures

By default, pictures appear in Iconized mode, as seen in the previous figure. Section “Placement 
of Text and Appearance of Pictures” on Page 355 explains how to reposition a picture within 
the symbol area or modify its size by dragging. You can also change the appearance of a picture 
as follows. Click the diagram element where the picture appears with your right mouse button, 
then select Symbol style... In the Picture group, mark any of the following options:

• Hidden
To make the picture invisible.

• Maximized
To make the picture occupy the full area of the symbol. (If you use the Maximized picture 
option, we recommend selecting a picture and symbol with the same shape. In most cases, 
the picture’s shape will be rectangular, so you should select a rectangular symbol, as well. If 
the shapes differ, the following occurs: The picture shape dominates, but some relics of the 
symbol shape and background are retained.)

• Max. with title
To ensure that the name of the symbol is displayed above the picture.

• Max. on back.
To ensure that all visible, specified elements (e.g., the name of the symbol) are displayed 
against the picture’s background.

If a picture has been added to a line, only the Iconized or Hidden options are available.

Removing a Picture

To remove a picture from a diagram element, proceed as follows:

1 Right-click the corresponding diagram element, then select the Symbol style... command.

2 A dialog appears. In the Picture area, click the Remove button.
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3 Click OK.

Additional Hints

If you want a picture that can be moved freely anywhere in the diagram, insert it in a free 
comment symbol, then move that symbol where needed. To remove the picture, simply activate 
the symbol and press Del.

A free comment symbol combined with a picture also can be used as background. Simply create 
a free comment symbol. Then activate it and drag its edges until it is large enough to serve as 
background. To change its color or add a picture, click the free comment with your right mouse 
button and in the pop-up menu, select Symbol style... Here, you can change the style as described 
in “How Can I Custom-Design Symbols Used in Diagrams?” on Page 349 and add a picture as 
described earlier in this section. Other diagram symbols can then be arranged against this 
background, as shown in the following figure:

Figure 9-33: Using a free comment with picture as background
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9.7 Glossary Table (GLO)

You may have noticed the GLO icon, which appears at the top of model trees:

Figure 9-34: Model tree with GLO icon

The GLO symbol represents a table that can contain glossary entries, i.e., names that appear in 
a model, along with their descriptions. This type of table, which is global for the entire GRADE 
model, can help make a complicated model easier to understand.

Customizing the Glossary Table

By default, an empty glossary table looks like this:

Figure 9-35: Glossary table without entries

Generally, terms used in the model are entered in the Name column, while definitions are 
entered in the Description field. Before you start creating a glossary, you may want to consider 
whether you want to change the names of these two columns and, possibly, add additional 
columns. 

To make any changes, first open the GLO table. Then open the Options menu and select 
Column settings... Under Title, you can modify any of the column headings or type in new 
column headings in the rows numbered 4 through 8. Before you close this window, make sure 
you have marked the Visible check box for all column headings that should appear on the screen. 
Then click OK.

Creating a Glossary Entry

You can create your own glossary entries.

�
Thanks to one of the newer features of GRADE, you can create a link from any diagram element 
to its explanation in the glossary. See “Defining a Link to the Glossary” on Page 311.

Name: Description:
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Proceed as follows:

1 Open the glossary by double-clicking the GLO symbol in the model tree.

2 Click the yellow icon appearing to the left to insert a new row.

3 A Glossary Entry dialog box will appear (if you have changed any of the column headings, 
the new names will appear at left):

Figure 9-36: Dialog for creating glossary entries

4 In the Name field, provide a name that is unique among the glossary names used in the 
model. You can type in the name directly or use the Pick name button to make your 
choice easier. Confirm with Pick or click Cancel to exit the box.

5 In the Description field, provide a definition/explanation/comment concerning your 
glossary entry. Use Ctrl+Enter if you need to create a new line. You can pick, rather than 
type, names if you wish.

6 Optionally, you can add a type (enter it directly or use the Pick name button) in the Type 
field or a picture name in the Picture field (use the Select picture button to make an entry 
here). The fields marked 4, 5, 6, 7, and 8 represent supplementary columns, which can 
be used as the need arises. You can define headings for these columns as described in 
“Customizing the Glossary Table” on Page 337 and make any corresponding entries for 
each column now.

7 Click OK to confirm your new glossary entry or Cancel to terminate the process.
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Editing a Glossary Entry

To edit a row in the glossary, proceed as follows:

1 Click the row in question with your right mouse button.

2 Select Edit row... from the pop-up menu. The Glossary Entry dialog appears.

3 Change the entries, following the instructions presented in Steps 4-7 above.

9.8 Comment Diagrams (CMT)

You may have noticed that model trees contain symbols that look like sheets of paper. In the 
following model tree, you can see them in the second, third, fourth, fifth and sixth rows. These 
are comment (CMT) symbols.

Figure 9-37: Model tree with five comment symbols

As a rule, each comment is associated with exactly one diagram and appears in the model-tree 
window next to the associated diagram. An empty comment is created automatically together 
with the associated diagram.

GRADE supports two types of comments:

• Simple, textual comments that can be entered and edited using GRADE’s built-in text editor.

• Comments created with an external tool such as Microsoft Windows Notepad, Word, Excel, 
Paint, etc.

A CMT diagram may contain either text or a reference to an external comment file, but not 
both at the same time.

The same basic operations may be performed with a comment diagram as with other diagram 
types.
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Internal Comments

This type of comment is created when you open a CMT diagram (e.g., by double-clicking it) 
and simply type text into the comment window that appears. GRADE’s comment editor 
supports the basic techniques characteristic of Windows text processing.

In addition, comment texts may be exported and imported. To do this, proceed as follows:

1 With the comment open, open the Edit menu and select the Export in text format or 
Import from text file... command.

2 If you want to export the text and have selected the option to clipboard, the text will be 
saved on your clipboard (a storage site); then you can use Ctrl+V to insert this text 
elsewhere. For example, you can insert it into another comment, into a GRADE symbol 
(open Symbol contents... first) or into another type of file.

3 If you are exporting to a file or importing from a file, a dialog window appears in which 
you can select a folder and filename. (When importing, keep in mind that you must 
select a text file, not any other kind! If you want to import from a document that is not 
in the form of a text file, you should open it and save it as a text file first.)

4 Click OK. The active comment text is exported to the specified file, or the specified file 
is imported into the active comment.

External Comments

An external comment can be created using any Microsoft Windows program that stores each 
document in a separate file and that allows the filename to be transferred as a parameter in the 
command line when the program is started. Examples include Windows accessory programs 
such as Notepad and Paint, as well as larger programs such as Word and Excel.

To open an external-comment diagram, simply double-click the comment symbol. The external 
program (Word, Paint, etc.) will be started and the associated comment file will be opened. You 
can make entries in this file as needed, then save and close it.

Since external editors are not an integral part of GRADE, there are a number of operations 
requiring special handling of external CMT diagrams:

• External CMT diagrams are not automatically printed when Print and All diagrams have 
been selected. They must be printed separately.

• When closing a model, open external CMT diagrams are not closed automatically. They 
must be closed manually.

• When exporting a model in EI (Export/Import) format, external CMT diagrams are not 
included and must be copied separately.
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Registering an External Editor in GRADE

To use an external editor as the comment diagram editor in GRADE, you need to register the 
editor in the GRADE configuration file and prepare a template file for this editor type.

To register a new external editor, proceed as follows:

1 Open an empty CMT diagram (appears as a blank sheet of paper) or one that has been 
created with GRADE’s internal text editor.

2 In the External menu, select External editor... The Select External Comment Editor dialog 
appears:

Figure 9-38: Dialog for selecting an external comment editor

This dialog contains a list of any already configured external editors and a number of buttons. 
The following table explains these buttons:

Button Meaning

Properties... Displays the External Comment Editor Properties dialog for the currently selected external 
editor

New... Displays an empty External Comment Editor Properties dialog to allow the properties of 
a not yet configured external editor to be entered. When this dialog is closed, the 
specified external editor will be added to the GRADE configuration.

Remove Removes the selected external editor from the GRADE configuration 

OK Terminates the Select External Comment Editor dialog, saving changes 

Cancel Terminates the Select External Comment Editor dialog without saving changes

Table 9-7: Meaning of buttons in the Select External Comment Editor dialog
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3 Click New... to enter the properties of the new external editor. The External Comment 
Editor Properties dialog appears:

Figure 9-39: External Comment Editor Properties dialog

The following table explains the fields that now appear:

1 Fill out the fields as needed. (Note that you can use the Browse button to fill out the 
Command line field; simply click Browse, then find the folder.)

2 Click OK and OK.

3 Now take the next step, described below.

Creating a Template File for an External Editor

For each external editor that you wish to use, a template file must be prepared in the GRADE 
directory (e.g., C:\Grade4\Bam). A template file is simply a document file of the relevant 
external editor. This file may be empty or may contain (project-specific) data.

Field Meaning

Description Name of the external editor, having up to 8 characters, e.g., Winword. This name will 
be used as the editor reference in CMT diagrams. The editor will appear in the pick list 
under this name. This name also will be used for the template file. 

Command line The command line for starting the external editor. Normally, you should enter the full 
path to the executable file here (e.g., C:\MSOFFICE\WINWORD\WINWORD.EXE). 
If the editor .exe file is on the operating system search path, you need enter only the 
program name. 

Filename extension This is the extension in the names of document files created with your chosen editor 
(e.g., doc or txt). The extension may have a maximum of three characters. The template 
filename will be built from the editor name (Description field) and the extension 
(Filename extension field), for example, WINWORD.DOC or NOTEPAD.TXT.

Table 9-8: Explanation of fields in the External Comment Properties Editor dialog
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You can create the template file using the external editor itself:

1 Start the editor (e.g., Word for Windows).

2 Create a new document (it may be left empty), and initiate the process of saving it.

3 You will need to select a filename. For the first part of the filename, use what you entered 
in the Description field in the External Comment Editor Properties dialog (e.g., 
WINWORD).

4 For the file extension, use what you entered in the External Comment Editor Properties 
dialog Filename extension field (e.g., doc).

5 Save the file to the BAM directory in GRADE (e.g., C:\Grade4\Bam).

When an external editor is linked to a CMT diagram, the template file of this editor is 
duplicated and stored in the model directory with the name 
<Diagram_number>.<File_extension>. Each time the CMT diagram is opened, this name is 
passed as a command-line parameter to the external editor.

Specifying an External Editor

Assuming that you have already registered one or more external editors in your model (and 
created the associated template files), you can assign an external editor to a comment diagram 
that does not have one.

Proceed as follows:

1 Open the comment diagram in question.

2 Open the External menu. If you see the editor type (e.g., EXCEL) that you desire in that 
menu, simply click it. The comment will be linked to that editor; when you open the 
comment, the editor will be started automatically.

3 If the editor type you want is not in the menu, click External editor..., then click the 
downward arrow to view a list of available editors.

4 Click the editor you want, then click OK.

5 Now click the External menu again. The editor you want (e.g., WINWORD) should 
appear in the list. Select it. This comment will now be linked to that editor.

If you assign an external editor to a comment diagram that already has text in it (created with 
GRADE’s internal text editor), the text created by the internal text editor will be lost. To save it, 
highlight it and press Ctrl+C; you can then use Ctrl+V to paste it elsewhere.
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Changing External Editors

To specify a different editor for a given CMT diagram, you must first delete the link existing to 
the current editor.

To do so, proceed as follows:

1 Activate the CMT diagram symbol in the model-tree window.

2 Open the Diagram menu, then select Delete and Diagram. Confirm with Yes that you 
want to delete the diagram. The link with the current external editor will be deleted (the 
diagram symbol in the model tree becomes blank again).

3 Then follow the instructions in “Specifying an External Editor” on Page 343.

Copying a Model With CMTs Created by an External Editor

Proceed as follows:

1 Create a backup copy of the model by activating the model in the REPOSITORY 
window, then clicking your right mouse button and selecting Create backup copy... (or 
open the Model menu and select Create backup copy...). Make sure the path is correct, 
then click OK.

2 With the REPOSITORY window open, create a new model by clicking the New model 
icon:

3 In the window that is displayed, fill in a name and click OK.

4 With the REPOSITORY window open, activate the new (empty) model, then press your 
right mouse button and select Restore from backup copy... (or open the Model menu and 
select Restore from backup copy...).

5 Select the backup copy and click OK and OK, then confirm that you want any previous 
contents of the new model to be replaced.

When transferring the backup copy to another computer, be sure that the external editors 
involved are registered in both systems with an identical Description field in the External 
Comment Editor Properties dialog, as seen in Figure 9-39, Page 342.
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9.9 Custom Tables (TAB)

You can create your own custom tables (TAB diagrams) for a GRADE model. For example, if 
you are modeling a university, you might want to create custom tables for specialized 
information, such as department budgets and numbers of students.

For each table, you can define up to nine columns and specify the name of each column. Within 
a single model, you can define various custom tables, each with a different number of columns 
and different names for the columns, if you wish.

TAB diagrams may appear in the model tree as free diagrams or as “children” of a particular 
“parent” diagram. The following tree contains both options:

Figure 9-40: Model tree with one free TAB diagram and two “child” TAB diagrams

Creating a TAB Diagram

If you wish to create a custom table as a child diagram, first activate any diagram in the subtree 
where the new TAB diagram is to appear. (For example, to add a TAB diagram to the CO 
subtree in our previous example, activate either CO, ER or DD.) If you wish to create a custom 
table as a free diagram, it does not matter which diagram is activated in the model tree.

Now proceed as follows:

1 With the model tree displayed, click the New diagram icon:

2 In the Define dialog, mark the TAB radio button.
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3 In the Name field, enter a name for the table.

4 If the diagram is to be free, click the down arrow in the Parent diagram field to select the 
FREE option.

5 Click Define.

Setting up Columns

Proceed as follows:

1 Double-click the TAB diagram to open it.

2 Open the Options menu and select Column settings... The Table Column Settings dialog 
appears.

3 Enter the names of the planned columns in the fields beneath Title. (You can type right 
over the numbers if you do not want them to appear.)

4 Ensure that the columns you have defined will be visible by marking the appropriate 
check boxes in the Visible column. If you specify two columns, for example, your dialog 
should look something like this:

Figure 9-41: Setting up columns for a user-defined table
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5 Click OK and the table with the specified columns will appear.

Cloning a Table

Cloning a custom table is easy:

1 Open the table that is to be cloned.

2 Open the Diagram menu and select Save as free. A copy of the table, with the same name, 
column settings and content, will appear as a free TAB diagram in the model tree.

Of course, the normal Save command is still available. If you have altered the contents of a table 
and want to simply save it before closing, use Diagram--Save or Ctrl+S.

Referencing the Table in Other Diagrams

To create an explicit link between a diagram element and a custom table, proceed as follows:

1 Right-click the diagram element and select Symbol contents...

2 In any text field of the dialog (e.g., a Description or Comment field or the main field of 
a free comment), enter <<<TAB table_name>>>. For example, a custom table with the 
name Budgets would be entered as follows: <<<TAB Budgets>>>. (If the table name 
contains spaces, do not forget to replace these with underscores.)

3 Click OK. By double-clicking the explicit link in the diagram element, you open the 
corresponding table.

As an alternative, you can create an iconized or reusable external link to the table, as described 
in “Defining a Link to Another Diagram” on Page 316. (In the URL/File/Executable field, enter 
TAB and in the Parameter string field, enter the table name.)

Editing a Row in a TAB Table

To edit a row in your table, right-click the row in question, then select Edit row... from the pop-
up menu. Make your entries in the Table Entry dialog and click OK.

�
To adjust the width of columns in your table, place your mouse pointer on the column borders and 
drag them. As an alternative, you can set the column widths when defining the table by making 
entries in the Width column of the Table Column Settings dialog.
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Chapter 10
Tips and Tricks

This chapter presents additional tips, from basic to advanced.

10.1 How Can I Custom-Design Symbols Used in Diagrams?

GRADE provides several possibilities for changing the style of symbols (including both box 
symbols and connecting lines):

• To change the style of a single, activated symbol or several selected ones, click your right 
mouse button and select Symbol style... (or select Symbol style from the Style menu). Fill out 
the dialog, then click OK. (Hint: When changing the style of several selected elements, make 
sure you place your mouse pointer outside the selection rectangle before right-clicking the 
mouse button.)

• You can also change the style of one or more symbols by applying a stereotype, or by 
modifying an existing stereotype and then applying it, as described in “Defining a 
Stereotype” on Page 318, “Modifying a Stereotype” on Page 319, and “Applying Stereotypes” 
on Page 320.

• You can change the default style of symbols by opening the Options menu, selecting 
Settings... and then clicking the Diagrams tab and Symbol style... Then select the diagram type 
in which a symbol is to be changed, the symbol type, and click Change style... (Or, to change 
the style of free comments, simply click Change FC Style...) When finished, click OK to close 
any open dialogs. The modifications will not apply to the symbols already in diagrams, but 
only to all newly created symbols.

�
If any terms in this chapter are unfamiliar to you, consult the Glossary, Page 443.
349 

• 
• 
• 
•
•
•



350 

• 
• 
• 
•
•
•

In all cases, the style changes are made in a dialog for defining styles. This symbol style dialog 
differs somewhat, depending on the symbol type and other circumstances, but generally looks 
like this:

Figure 10-1: Dialog for changing style
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If you have selected two or more diagram elements and then activated Symbol style..., the dialog 
for setting style will contain additional check boxes, as shown in the following figure. Only the 
style aspects with a check mark will be transferred to the symbols; thus, click the appropriate 
check box before setting any style option:

Figure 10-2: Style-setting dialog with check boxes

The procedure for defining/modifying style via these dialogs is basically the same, no matter 
whether you are modifying the style of activated/selected elements, of a stereotype, or a default 
style.

The following sections provide instructions for changing style. In all cases, it is assumed that 
you have opened the symbol style dialog, as described at the beginning of this section.
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10.1.1 Symbol Style Dialog

Changing the Box Style of Symbols

Proceed as follows:

1 Click the Box style tab:

Figure 10-3: Changing the style of a box symbol

2 Click the downward arrow next to the Box shape list, then click the shape you require.

3 To achieve a different effect, select one or more of the additional options:

• Shadow to make the symbol “cast a shadow”

• Array to create the illusion of one symbol on top of another

• 3D for a three-dimensional look

• On front to ensure that the given symbol cannot be overlapped by another (e.g., use this to 
ensure that the free comment symbol will always be visible and not hidden by other symbols)

• No shape for a symbol without borders and without a fill color (this can be used if you want 
only the text of the symbol to be visible)

• No border to hide the border (fill color still is visible)

• No background to hide the fill color.
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Changing the Color of Symbols and Diagram Backgrounds

In the Color area, click the appropriate button to change the following colors:

• Line to change the border of a box symbol or, if the symbol is a line, to change its color

• Text to change the color of all texts belonging to the diagram element

• Background to change the symbol’s fill color or, if the symbol is a line, to change the fill color 
of shapes at the line ends

• Diagram to change the color of the diagram’s background.

In each case, a dialog for selecting a color appears. You can select a basic color or define a custom 
color.

Changing Borders and Lines

In the Pen style area, you have the following options:

• Bold to change the width of a box symbol’s frame (or, in the case of a line, to change its width)

• Dash to make a border or line dashed and to set the length of the dashes

• Gap to regulate the size of gaps in a border or connecting line.

Simply click the + or - buttons as needed.

Text Style

The Text style card includes the following options:

• Visible. Remove the check mark here to hide the given text (see also “How Can I Streamline 
My Diagrams by Making Some Texts Invisible?” on Page 367).

• Alignment. Click the left, center, or right radio button to align the text accordingly.

• Underline. Mark this check box to display the corresponding text underlined.

• Change font. Click this button to open a dialog for changing the font of the corresponding 
text.

Picture

• Select... Click here to open the Select Picture dialog, which allows you to select a picture that 
is saved in the PIC table or to define a new picture (for details, see “Inserting a Picture” on 
Page 333).

• Remove. Deletes a picture.

• Hidden, Iconized, etc. These buttons are used to alter the appearance of pictures. For details, 
see “Modifying the Appearance of Pictures” on Page 335.
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Hints for Changing the Style of Lines

GRADE lets you change the style of a single, activated line in your diagram, two or more 
selected lines, the default style of a line and line stereotypes. (In rare cases, line style cannot be 
changed; e.g., in ORG and DD diagrams, you cannot activate an individual line, nor change its 
style.)

The procedure for changing the style of lines is basically the same as that for changing the style 
of box symbols. Instead of the Box style card, however, GRADE offers the Line style card, where 
you can specify line ends, as shown here:

Figure 10-4: Dialog for changing line ends

Keep in mind that by changing the start or end of a line, you could change its meaning. Changing 
the appearance of lines may be useful for presentations, but could be a hindrance in the everyday 
use of GRADE as a modeling tool. (For more information about the significance of line endings, 
see Page 125.)

It is possible to transfer the style of one line to another without altering line ends. To do this, use 
the copy/edit/set style mechanism described in “Placement of Text and Appearance of Pictures” 
on Page 355. Make sure that you leave the check boxes next to Shape at start and Shape at end 
unmarked.
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10.1.2 Placement of Text and Appearance of Pictures

In some cases, the placement of elements within a symbol may cause problems. For example, 
the text and a picture overlap.

GRADE lets you reposition text and pictures as follows:

1 Activate the symbol you wish to modify by clicking it.

2 Open the Style menu and activate the Symbol appearance menu item (alternatively, press 
F6 or click your right mouse button and select the command from the pop-up menu).

3 The symbol texts and the inserted picture (if any) are now marked with red rectangles. 
You can now use your mouse pointer to “grab” the border of the text area and modify it 
(for example, you can push all text down to the bottom of the symbol).

4 You also can “grab” a picture and move it elsewhere, or double-click a picture to toggle 
between display modes.

5 To leave symbol appearance mode, open the Style menu and activate the Symbol 
appearance menu item again (alternatively, press F6 or click your right mouse button and 
select the command from the pop-up menu).

10.1.3 Transferring a Style to Another Symbol

In most types of GRADE diagrams, you can transfer the style of one symbol to another.

Proceed as follows:

1 Activate the symbol with the style to be transferred.

2 Open the Style menu and activate the Copy style command. If you want to transfer the 
style exactly as is, skip to Step 6.
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3 If there is any aspect of the copied style that you wish to change or do not wish to 
transfer, open the Style menu and activate the Edit style... command. The dialog for 
setting style now contains numerous check boxes, as seen in the following figure:

Figure 10-5: Dialog for editing style

4 By default, all relevant boxes are checked and all aspects of style will be transferred. By 
removing the check mark next to any style option, you ensure that this particular aspect 
of style will not be transferred to the new symbol. Let’s assume the symbol whose style 
Chapter 10 



you are copying is a line, and that you want all aspects of style to be transferred except 
for the line ends. In that case, click the Line style tab, then remove the check marks next 
to the Shape at start and Shape at end fields, as seen here:

Figure 10-6: Removing check marks to ensure that some aspects of style will not be transferred

5 If you wish, you can also change any other style setting (in that case, the corresponding 
check box should be marked). Then click OK.

6 Activate the symbol to which you want to transfer this style. (As an alternative, you can 
select an entire group of symbols to which you want to transfer this style by holding 
down the Shift key, then clicking each member in the group.)

7 Open the Style menu and activate the Set style command.

10.2 How Can I Change Other Defaults for Diagrams?

The previous section described the many possibilities offered by GRADE for changing symbol 
style, including the modification of default settings for symbols. This section shows you how to 
change other default settings. For example, you can change the default font used in the model 
tree, the default background color used for a particular type of diagram, or the default setup of 
a particular type of table.
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To make these types of changes, proceed as follows:

1 Open the Options menu and activate the Settings... command.

2 The User Settings dialog box will open. To change the look of your models, click the 
Diagrams tab. As you can see, it offers a great many options for altering the look of your 
GRADE models:

Figure 10-7: Dialog for modifying the default style of diagrams
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3 The first button on the left, Symbol style..., was discussed on Page 349. It can be used to 
alter the default style of box symbols and connecting lines. Now click Diagram style... 
and the following window will appear:

Figure 10-8: Diagram Style window

4 Now click the appropriate check box to specify the item to be changed (e.g., Model Tree) 
and the aspect to be changed (Change background, Change layout, Change font). In the 
following figure, the placement of the check mark shows that the background of the 
model tree is to be changed:

5 Now click the push button to the left of the check mark. For example, if you want to 
change the background for all model trees, you would click the button seen below:

6 In the dialog that appears, click the desired color, then click OK.
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7 Now let’s change the default layout style of BP diagrams to Horizontal lanes. In the 
Diagram Style box, mark the appropriate check box for changing the layout of a business 
process diagram:

Figure 10-9: Preparing to change default layout style

8 Now click the button just to the left of the new checkmark. The Layout dialog appears:

Figure 10-10: Selecting a new default layout style
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9 Here, click Horizontal lanes, then OK and OK again. Now all new BP diagrams will 
appear in Horizontal lanes layout style. (To change the background or layout of an individual 
diagram, open the Style menu and select Diagram background... or Layout...)

10Now let us assume you want to modify the page setup. On the Diagrams card, click Page 
setup... The following window opens:

Figure 10-11: Page Setup window

11Make your choices here and click OK. (For explanations of the options in the Page Setup 
window, see “Special Tips for Printing” on Page 382 and “Printing a Single Diagram” 
on Page 379.)

12Now that we are back at the Diagrams card of the User Settings window, note the area 
named Fonts. Click System font... to change the font used in GRADE as the default for 
all other default fonts (this is useful, for example, if you want to work in Russian using 
the Cyrillic alphabet). Click Keywords... to change the font for keywords in GRADE 
diagrams; e.g., in an ER diagram, keywords include GRADE-specific terms like Type 
and PK. Click Print headings... to change the font used for the printing of diagram 
frames, and Status bar... to change the font for the GRADE status bar. Click the Lane 
headings... button to change the font for the lane headings in BP diagrams.
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13At the bottom of the Diagrams card, you will see the Table column settings area. Here, 
you can click an appropriate button to select your table type, then make the desired 
changes and click OK; to revert back to the default table settings, click Set default. Click 
OK again to close the User Settings window.

10.3 How Can I Use Oblique Layouts to Jazz Up My Diagrams?

As you draw GRADE diagrams, the lines connecting symbols normally will be horizontal, 
vertical and/or form right angles with rounded corners. We will refer to these types of lines as 
orthogonal. If you prefer to include oblique (slanted) lines in your diagrams to give them a more 
dynamic appearance, GRADE allows this in some types of diagrams. The following two oblique 
layouts are available.

• Oblique manual: Gives you the freedom to draw oblique lines, draw lines across the faces of 
other diagram elements, and even overlap box symbols.

• Oblique semiauto: Gives you all the freedom offered by the Oblique manual style, but does 
not allow you to overlap box symbols.

To switch to an oblique layout, proceed as follows:

1 Open the diagram in which you want oblique lines.

2 In the GRADE toolbar, click the downward arrow next to the layout combo box:

3 Now click Oblique semiauto or Oblique manual, if available.

4 If your diagram layout was set to any of the usual (orthogonal) styles, and you switch to 
an oblique style, the diagram’s appearance does not change. To replace all orthogonal 
lines by oblique ones as far as possible, open the Edit menu and select Reposition, then 
All. To replace only certain lines, select those lines (be sure to select the lines, not the 
objects). Then open the Edit menu and activate Reposition, then Paths.

�
To custom-design a table “from scratch,” specifying your own column names, see “Custom Tables 
(TAB)” on Page 345.
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To help you understand what an oblique layout can do for your diagrams, we now present 
“before” and “after” pictures. The diagram below was created in Automatic layout style:

Figure 10-12: Example of Automatic layout style

Here, the diagram elements are rearranged in Oblique semiauto style:

Figure 10-13: Diagram with oblique lines

�
When working in CL and PCK diagrams using the Oblique semiauto layout style, you can use the 
Reposition - All command to identify “clusters.” See “Detection of Clusters” on Page 364.
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10.4 How Can I Let GRADE Automatically Optimize the 
Layout of My Diagrams?

You can often give your diagrams a neater appearance by using the Reposition command.

Proceed as follows:

1 Open the Edit menu and select Reposition.

2 Select a reposition option:

• All to reposition the entire diagram

• Paths to reposition only the paths while leaving the boxes in their positions (you also can 
select a number of paths and then reposition only them)

• Vertical for a vertical layout

• Horizontal for a horizontal one.

Detection of Clusters

GRADE allows for the detection of “clusters” in large CL and PCK diagrams; i.e., the system 
finds elements that seem to belong to a common group and rearranges them to optimize the 
diagram layout.

To implement this feature, proceed as follows:

1 Open the diagram that is to be rearranged.

2 Click the downward arrow of the layout combo box in the GRADE toolbar:

3 Click Oblique semiauto.

4 Then open the Edit menu, and select Reposition and All.
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10.5 How Can I Use Customized Lanes to Make My Diagrams 
Clearer?

As mentioned briefly in Chapter 3, GRADE can rearrange your BP diagrams automatically to 
create performer lanes; a separate horizontal or vertical lane is then created for each performer 
(a performer might be a department, a particular employee, etc.). This makes it easier to identify 
at a glance all the tasks executed by any given performer. (For example, you might discover that 
the secretary is juggling 34 jobs at the same time!) The following figure shows an example of a 
BP diagram arranged in horizontal lanes:

Figure 10-14: BP diagram with performer lanes

Creating Performer Lanes

GRADE automatically generates performer lanes when you take the following steps:

1 Open a BP diagram (it should contain tasks and performers).

2 Click the black arrow next to the layout combo box in the GRADE toolbar to reveal a 
list of the layout styles available:

3 Click either Vertical lanes or Horizontal lanes, depending on the type of layout you want.
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4 The diagram will display performer lanes. The layout style can be set individually for 
each diagram and is saved together with the diagram.

Below, we describe some of the special options that can be used for altering the look of these 
lanes:

Changing Lane Sequence

Proceed as follows:

1 Move the mouse pointer to the title of the lane to be moved (let’s call it Lane A).

2 Once your pointer is correctly positioned on top of the lane, a GRADE symbol will 
appear.

3 Press and hold down the left mouse button, then drag over to the title of another lane 
(let’s call it Lane B).

4 Release the button. Lane A is inserted at the indicated position (before or after Lane B).

Changing Lane Color

The default colors of the lanes in BP diagrams are white and gray. To change the color of all gray 
lanes in a particular BP diagram, proceed as follows:

1 Open the diagram.

2 Open the Style menu and activate the Lane color... command. The Microsoft Windows 
standard Color dialog appears.

3 Click the desired color (or create a custom color) and click OK. The lane color is 
changed. The lane color setting affects only the currently open diagram and is saved 
when you save the diagram.

Changing Lane Heading Fonts in BP Diagrams

One of the newer features of GRADE lets you change the heading font of the lanes in BP 
diagrams.

Proceed as follows:

1 Open the Options menu and activate the Settings... command.

2 The User Settings dialog appears.

3 Click the Diagrams tab, then click the Lane headings... button. A font dialog appears.

4 Select the font options to be changed.

5 Click OK.
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6 You now return to the User Settings dialog, where you click OK again. Any change in the 
lane heading font setting affects all BP diagrams and is saved with the user configuration 
file.

10.6 How Can I Streamline My Diagrams by Making Some 
Texts Invisible?

As you create GRADE diagrams, you may fill your symbols with quite a bit of text. In some 
cases, it may be preferable not to have all of this text appear on the screen or in the printed 
version of the diagram. You may want to hide text for security or privacy reasons, or to give your 
diagrams a more streamlined look.

You can make any entered text invisible, including the name of a symbol.

To do this, proceed as follows:

1 Click the diagram element that is to have invisible text.

2 Open the Style menu and select Symbol style... A dialog resembling the following one 
appears (the actual contents of this dialog will differ, depending on the symbol that you 
have selected):

Figure 10-15: Preparing to hide text
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3 In the column marked Visible, you can select or deselect any check box to make that text 
item visible or hidden. (In some cases, multiple check boxes will appear. See the 
following note and “Hiding Attribute Keywords” on Page 368.)

4 Click OK or simply press Return to confirm the new settings.

Hiding Attribute Keywords

One of GRADE’s newer features allows you to hide attribute keywords, as well. To better 
understand how this can change the look of your diagram, consider the following figure. In the 
diagram element on the left, the attribute keywords (such as Competency) are displayed. In the 
diagram element on the right, they have been hidden:

This feature is available in ORG, CL and TD diagrams.

To hide attribute keywords, proceed as follows:

1 Right-click the given diagram element and select Symbol style...

�
To perform the operation on several elements at once, select the relevant diagram elements. Then 
right-click and select Symbol style... On the Text style card, locate the row in which you want to hide 
text. (Here, let’s assume you want to hide the stereotype.) In the given row, mark the far-right check 
box in the Visible column, then deselect the check box on the left, as shown below, then click OK.

Secretary
Competency: English, French, Spanish
Availability: "*.*.(MON-FRI) (09:00-18:00)"
Cost per hour: 5

Secretary
English, French, Spanish
"*.*.(MON-FRI) (09:00-18:00)"
5
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2 A symbol style dialog will be displayed (its appearance will differ somewhat, depending 
on the diagram element):

Figure 10-16: Hiding attribute keywords

3 On the Text style card, locate the attribute(s) for which you want to hide the keyword (in 
this case, let’s use the keywords Competency, Availability and Cost per hour). Then click 
on the corresponding check marks on the right side of the Visible column to deselect the 
check boxes, as shown here:
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4 Click OK. The diagram element will now appear without the attribute keyword(s).

In CL diagrams, you can use an analogous technique to hide the package from which a class 
originated (e.g., from Package A). To hide the package keyword (from), deselect the check box 
on the right, as shown here:

To hide the keyword and the name of the package, deselect both check boxes.

Show Contents Command

Even if you have made the contents of a symbol invisible, they can be viewed by you at any time.

To show all contents of a symbol, proceed as follows:

1 Activate the symbol in question.

2 Open the Options menu and select the Show contents command.

�
To hide both the attribute keyword and the attribute itself, deselect both check boxes in the Visible 
column of the given row:

To hide attribute keywords for more than one diagram element at once, select all of the diagram 
elements, then right-click and select Symbol style... In the dialog, first mark the check box on the far 
right side of the Visible column in the given row, then deselect the corresponding check box(es) in 
the middle column:
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3 A small window with the entire text of the currently active symbol will appear:

Figure 10-17: Window displaying symbol’s contents

To hide the contents box, click the X in its upper right corner or open the Options menu and 
select Show contents, or click the symbol with your right mouse button and select Show contents 
in the pop-up menu.

10.7 Can a Whole Team Work on a GRADE Model, Then Merge 
the Results?

The answer is yes!

GRADE makes it possible for individuals working at single-user workstations to develop models 
concurrently, with the results being brought together at a later stage.

Keeping Track of Diagram Status

To help you maintain an overview of who is working on what and how far the work has 
progressed, the following attributes are assigned to each diagram:

• Design status (Not Started, In Work, Approved, Final),

• Designer name (this person is allowed to modify the diagram, and these are exclusive rights 
when a manager has been specified),

• Manager name (the person who not only is allowed to modify the diagram, but also can 
change its designer and design status).

To view the current values of these attributes, proceed as follows:

1 Open the model tree, then click with your right mouse button on the diagram symbol.

2 Select Information... from the pop-up menu. The Diagram Information dialog is 
displayed.
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3 Click the Configuration tab to view the information regarding the status of this diagram.

4 The attribute values (for the particular diagram, or for the entire subtree) can be changed 
via this dialog box; enter your changes, then click OK.

By default, each newly created diagram has Not Started status, but after the first save operation 
the status is changed to In Work. Also by default, the current modeler is designated as the 
designer (the designer name is obtained by combining the prefix User_ and the corresponding 
username). The design status and designer name do not affect your work with a diagram, as long 
as a manager is not specified.

If a manager is specified:

• only this manager can change the design status, designer name and manager name of the 
diagram;

• only the specified designer and the manager can modify the diagram contents (all other users 
can only open the diagram in view mode);

• if the design status is set to Approved or Final, then the diagram contents cannot be modified 
at all, except by the manager.

By controlling these diagram attributes, you can distribute the modeling tasks among your team 
members, who will be able to work with those parts of the model assigned to them, even at 
remote locations and independent of access to network facilities.

Merging Business Models

Let us assume you have distributed copies of your business model (BM tree) among your team 
members, and from this point on, the model is developed in parallel by several people. After 
some time, you will need to merge their work into a common model.

Normally, each team member will develop, according to your instructions, one or more subtrees 
of the BM tree; i.e., he/she will refine only the task (or tasks) assigned. As a side effect, you may 
need to add new events to the event table (ET) and new competencies to the competency table 
(CMP).

That means that the common model will need to be altered as follows:

• by replacing some task symbols with subtrees developed by a team member

• by adding to the common model’s ET and CMP the new events and competencies 
introduced by a team member.

Proceed as follows:

1 Make sure you have access to a backup copy of the model created by your team member.
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2 Create a temporary model by opening the REPOSITORY window, then clicking the 
New model icon:

(For more information about repositories and creating new models, see “Starting a GRADE 
Session” on Page 16 and “Creating a New Model and Opening an Existing One” on Page 19.)

3 With this new, temporary model activated, click your right mouse button, then activate 
Restore from backup copy.... Then select the backup copy provided by your team member 
and click OK.

4 A message appears to warn you that old model contents will be lost. Click OK.

5 A message indicating that the model has been recovered appears. Click OK.

6 In your temporary model, select a subtree created by the team member, then open the 
Model menu and select Copy to clipbox and Subtree.

7 Then open the common model and use the Model - Paste from clipbox command to paste 
in the subtree developed by the team member. Repeat this if necessary.

8 Move the new subtrees to their appropriate places in your model tree: You can “grab” a 
subtree by clicking it with your left mouse button to activate it; then use your mouse 
pointer to drag that subtree over to the icon of the subtree of which it is to be a part. 
Release the mouse button and click OK to confirm this step.

9 Open the ET of the temporary model, and choose Edit - Select all and Edit - Copy.

10Now open the ET of your common model and select Edit - Paste.

11During the pasting process you will receive warning messages “Duplicate object name 
xxxxxx. Modify?” Reply No if you know that event xxxxxx was not introduced by this 
particular team member. Then the duplicate event will be ignored. Reply Yes if you 
know that the event xxxxxx was introduced by this particular team member, but an event 
having the name xxxxxx is already present in your model because it was introduced by 
some other team member. If you reply Yes, the event will be inserted into your ET under 
a somewhat modified name. After the pasting process is completed, you can examine all 
events having modified names and decide how to resolve possible inconsistencies.

12Repeat the same with the CMP table of the temporary model.

10.8 How Can I Compare Two Versions of a Model?

Let’s assume you have a team working on a GRADE modeling project. Two team members have 
taken the same, basic model and modified it. You now want to see how the two models differ.
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Proceed as follows:

1 Close all open models.

2 In the REPOSITORY window, select the two models to be compared (for example, by 
holding down the Ctrl key and clicking each of them). The models now will be framed 
in blue.

3 Open the Model menu and select Compare two models (to compare model objects and 
diagrams). Alternatively, select Compare two models (objects) to compare model objects 
only: class definitions, stereotypes, tags, pictures, glossary entries.

GRADE compares the times when the various parts of the models were updated, then presents 
a corresponding message. In the displayed dictionary windows, the changes are highlighted in 
blue.

10.9 When Should I Use the Model Information Window?

If you need to obtain quick information about any model, such as the total number of diagrams, 
the last time it was saved, etc., use the Model Information window.

Proceed as follows:

1 Open the corresponding model tree, or open the REPOSITORY window and activate 
the model.
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2 Open the Model menu and activate the Information... command. The Model Information 
window appears:

Figure 10-18: Window providing information about a model

Among other information, you will see the path of the model’s folder. It contains all files 
connected with the model.

10.10 How Can I Make Backup Copies of Models?

GRADE’s backup mechanisms make it possible to copy a model from one repository to another; 
to duplicate a model, keeping a copy in the same repository; etc.

Copying and Duplicating Models

To create a backup copy of a model, proceed as follows.

1 Make sure the model is closed.

2 In the REPOSITORY window, activate the model by clicking it.
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3 Open the Model menu and select the Create backup copy... command. (Alternatively, 
click the model with your right mouse button, then select Create backup copy... in the 
pop-up menu.)

4 In the dialog window Create backup copy of model, enter the name and path of the 
subdirectory (folder) in which the model is to be saved (you may be able to use the 
defaults presented by GRADE). Click OK.

5 If the model was copied successfully, the message Model copy created appears. Confirm 
this message with OK.

Restoring a Model From a Backup Copy

To restore a model from its backup copy, proceed as follows.

1 Make sure that the model whose contents are to be restored is closed.

2 In the REPOSITORY window, activate the model to be restored by clicking it with your 
left mouse button.
If the desired model is not available, create a new one as described in “Creating a New 
Model and Opening an Existing One” on Page 19.

3 Open the Model menu and select Restore from backup copy...
(Alternatively, click the model with your right mouse button, then select Restore from 
backup copy... from the pop-up menu.)

4 The Restore model from backup copy dialog appears. Here, enter the name and path of the 
subdirectory (folder) in which the backup copy of the desired model is stored. (You can 
use your mouse to browse through the presented list and select the backup copy.) 
Confirm by clicking OK.

5 A message appears warning that the old model contents will be lost. Confirm this 
message by clicking OK.

6 After the model has been restored, the message Model recovered appears. Click OK.
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10.11 How Can I Create a Special View of a CL Diagram to Let 
Me Focus on What Interests Me?

In the case of a large CL diagram, it is sometimes convenient to define a part of it as a separate 
“view.” That way, you can inspect that part of the diagram without being distracted by other 
elements. Views are represented in the model tree as CL diagrams marked View. Each view is 
subordinated to its parent diagram. Nested views (“views of views”) are not supported.

Consistency of views and their parent diagrams is maintained by GRADE automatically, to a 
certain extent. If you delete lines, objects or comments in the parent (mother) diagram that are 
also reflected in the view, they will disappear from the view (once you save your changes in the 
parent diagram). If you add lines or objects to the parent diagram, however, they will not 
automatically appear in the view. If you add a comment to a symbol in the parent diagram that 
also appears in the view diagram, the new comment will appear in the view version.

If you add a symbol, line or comment to a view diagram, it will appear in the parent diagram 
(after you save the changes in the view diagram). If you delete a symbol, line or comment from 
a view diagram, these changes will not automatically be reflected in the parent diagram.

Creating Views

Here is one way of generating a new view diagram:

1 Open the parent diagram (a CL diagram).

2 Select (hold down the Ctrl key and click) boxes and lines you wish to include in the view 
diagram.
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3 Click the Views... icon in the GRADE toolbar:

(Or open the Edit menu and select Views...) The Views... dialog appears:

Figure 10-19: Dialog for defining a view of a CL diagram

4 Click the New... button, enter the name of the new view diagram and click OK.

5 Click the Minimum button (under Transfer to view). The dialog closes and the desired 
view diagram appears in the model tree.

If the parent diagram is very large and you find it inconvenient to manually select all the 
elements to appear in the view, try this method:

1 With the CL diagram open, but with no objects or lines selected, click the Views... icon.

2 Click the New... button, enter the name of the new view diagram and click OK.

3 Select (hold down the Ctrl key and click) one or more class names in the mother diagram 
class list.

4 Click the right arrow button. The selected names appear in the central list.
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5 If necessary, repeat the operation. And, if necessary, select (hold down the Ctrl key and 
click) the undesired names in the central list and delete them by clicking the left arrow 
button (located in the lower half of the Views... dialog).

6 Now you can click one of the three Transfer buttons: Minimum to transfer only the 
selected classes into the view diagram, Medium to transfer only the selected classes and 
possibly connected lines, or Maximum to transfer the selected classes and all lines and 
classes leading to it.

7 The dialog is closed and the desired view diagram appears in the model tree.

A mixed technique can be used as well: select boxes and/or lines in the mother diagram, then 
enter the Views... dialog, add more classes, then click one of the transfer buttons.

Updating Views

To add boxes and/or lines to an existing view diagram, follow the instructions for creating a 
view, above (you can use either of the approaches described), but instead of clicking the New... 
button, select the view name from the list.

To delete boxes and/or lines from an existing view diagram, open the diagram, select and delete 
(press the Del key) the elements that are no longer required, and save.

Deleting Views

To delete a view from the model tree, activate it, press Del, then confirm your choice by clicking 
Yes.

10.12 How Can I Optimize the Printouts of My Models?

GRADE offers you a wide variety of possibilities for optimizing the appearance of your printed 
models. For example, there is a fast method for zooming your model so that it fits your selected 
page size, and you can plot models to create printouts several meters in length or create posters 
for use in business presentations. Printing instructions, from basic to advanced, are presented in 
the following sections.

Printing a Single Diagram

To print a single diagram, proceed as follows:

1 Open the diagram that you wish to print.
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2 Open the Diagram menu and select the Print... command. As an alternative, you can 
press Ctrl+P or click the Print diagram icon:

3 The Print dialog appears:

Figure 10-20: Dialog for selecting printing options

4 In the Printing mode area, click the appropriate radio button:
Normal to print the document in the size currently set up, possibly across several pages.
Wallpaper to print the diagram in the size currently set up, possibly across several pages, 
which can be fitted together afterward. The pages will contain overlaps and alignment 
marks to allow them to be precisely fitted together.
Zoomed to one page to reduce (never enlarge!) the diagram to one printed page.
Zoomed to two pages to reduce (never enlarge!) the diagram to two printed pages.

5 In the Color option area, also click the appropriate radio button:
Color with background if you want both the diagram elements and the background to be 
printed in color. The color-print option also must be turned on in your Windows 
printer driver.
Color without background if you want only the diagram elements to be printed in color. 
The diagram background remains white. The color-print option also must be turned on 
in your Windows printer driver.
B/W without background if you want all diagram elements to be printed in black and 
white on a white background.

6 In the Frame Options area, you can indicate whether you want to print your diagrams 
with or without the GRADE standard page frame, and you can switch on/switch off any 
of the elements that might appear in the frame. 
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7 If you are not sure that the correct printer has been selected, click the Printer... button. 
In the Select Printer window, you can specify the printer to be used (click the downward 
arrow to see a list of available printers).

8 If you want to be sure the right paper size, etc., have been selected, click the Properties... 
button. Make your selections and click OK. Click OK again to confirm your printer 
choice.

9 Click OK again to open the Select Pages dialog. Pages selected for printing are marked 
with an X. You can use the appropriate buttons to select or deselect all pages. Or simply 
click an individual page to select/deselect it for printing.

10Once you have selected the pages, click OK to start the printing process. You can 
interrupt printing at any time by clicking the Cancel button.

Printing All Diagrams of a Model

Proceed as follows:

1 Open the window displaying the model tree.

2 Choose Print/All diagrams... from the Model menu.

3 Then follow the instructions for printing a single diagram, starting with Step 3 
(Page 380).

Printing a Model Tree

Proceed as follows:

1 Open the window displaying the model tree.

2 Choose Print/Model tree... from the Model menu.

3 Then follow the instructions for printing a single diagram, starting with Step 3 
(Page 380). 

Printing All Diagrams of a Model Subtree

Proceed as follows:

1 With the model tree displayed, activate the root diagram of the subtree whose diagrams 
are to be printed.

2 Open the Diagram menu and select Print, then Subtree...

3 Then proceed as in Step 3, Page 380 (if you wish to print all diagrams of the subtree, 
there is no need to select certain pages).
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Special Tips for Printing

There are even more possibilities for specifying how your documents will be printed.

With the model window active, choose Page setup... from the Model menu, and the Page Setup 
dialog will appear:

Figure 10-21: Page Setup dialog

Here, you can select

• The paper size

• The paper orientation: Portrait for a “normal,” vertical page, or Landscape for a horizontal 
page.

• Margins

• Units of measurement

• Frame options, etc.

�
Note that the settings specified in Page setup... will supersede standard Windows printer settings.
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If you open the Model or Diagram menu and select Print options..., the Print dialog will open. 
Here, select Printer..., then Properties... A window similar to the following one will appear:

Figure 10-22: Window for selecting printing properties

This dialog box offers choices such as the following:

• Paper size

• Paper source

• Number of copies

• Orientation

• Color appearance.
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You also have the option of displaying/not displaying page borders, which appear as light green, 
dashed lines. These lines let you see how much of your diagram will fit on a printed page. To 
display the page borders of a diagram, proceed as follows:

1 Open the diagram, then open the View menu and select Show page borders. The page 
borders will now be visible:

Figure 10-23: Diagram with page borders displayed (dashed lines)

2 When this option is activated, a checkmark will appear next to Show page borders. To 
turn off this feature and hide the diagram’s page borders, select Show page borders from 
the View menu once again.

To display the page borders of a model, proceed as follows:

1 Open the model, then open the Model menu and select Show page borders.

2 When this option is activated, a check mark will appear next to Show page borders. To 
turn off this feature, activate the same command again.
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Moving Page Borders to Make Your Diagram Fit Paper Size

To quickly adjust your diagram to fit your paper size, proceed as follows:

1 Open the diagram.

2 Open the Diagram menu and click Print preview.

3 The light green borders you now see represent the page borders.

4 You can now position your mouse pointer on any border, hold down the left mouse 
button, and drag the border so that the symbols you want on a given printed page fit on 
that page. Repeat this as necessary.

Zooming the Diagram to Fit Your Paper Size

Another method for making your diagrams fit your paper size is to use the zoom for printing 
option; it enlarges or reduces a diagram for printing, independent of the size of the image on 
the screen. To change the printed image size, take these preliminary steps:

1 Verify that the page borders are visible. Turn on the page borders, as described above, if 
necessary.

2 Using the zoom option, select an appropriate scale for the screen, so that the entire 
diagram is visible. (For more information about the zoom option, please see “Zooming 
to Enlarge or Reduce Diagrams” on Page 70.)

You can now determine, by means of the page borders, how many pages the printed image 
would occupy with the current print settings. To change the scale for printing, proceed as 
follows:

1 Open the View menu and select the Zoom for printing... command. The Zoom for 
Printing dialog appears:

Figure 10-24: Zoom for Printing dialog
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2 Select one of the predefined values, or enter your own custom value, and click OK.

What you now see on the screen will give you an idea of how the printed image will look. If the 
entire image fits within the light green borders, that means it will also fit on a printed page. The 
zoom scale can be set for each diagram individually and is saved when the diagram window is 
closed.

To test the image of a diagram to be printed, open the Diagram menu and select Print preview. 
(Or, if you are printing a model tree, open the Model menu and select Print preview.)

Creating Poster-Size or Larger Business Graphics

The flexibility of replacing the standard GRADE symbols with clip art and colors for special 
effects, along with the technique for hiding superfluous details, permits you to produce striking, 
poster-size business graphics; you can take what initially was a spartan-looking diagram and 
create a poster without compromising the diagram’s integrity.

For information about inserting clip art, see “Inserting a Picture” on Page 333. For information 
about changing the color of a symbol, see “Changing the Color of Symbols and Diagram 
Backgrounds” on Page 353. To learn about hiding non-essential text in a diagram, see “How 
Can I Streamline My Diagrams by Making Some Texts Invisible?” on Page 367.

If you are planning to print a large poster or a long diagram, use a plotter and select a custom 
paper size. Proceed as follows: 
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1 Open the diagram or model tree, then select Diagram, Page Setup..., or Model, Page 
Setup... A dialog appears.

Figure 10-25: Dialog for setting page format

2 In the Paper size area, click the downward arrow to reveal a list of options, as seen in the 
previous figure.

3 Click Custom size.

4 Just below Custom size, you will see fields for entering the paper height and width. If you 
are printing a long diagram on a plotter, set Height to fit the height of the plotter paper 
roll; Width can be a much larger figure.

5 Click OK to confirm your choice.
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10.13 How Can I Convert an ER Model to a CL Diagram?

If you have first built an entity-relationship model (i.e., ER diagram), some of the information 
contained therein can be used to create a class (CL) diagram.

Proceed as follows:

1 With the model tree open, activate the desired ER symbol by clicking it.

2 Open the Tools menu and select Build CL from ER.

The procedure is executed in two phases:

1 A new CL symbol having the name of the ER symbol is created in the model window.

2 The ER diagram is scanned and this information is filled into the CL diagram as follows:

• Each entity symbol is converted into a class symbol.

• Each relationship symbol is converted into an association symbol.

• If entity E11 is “nested” within entity E1, then in the CL diagram the E11 is_part_of E1 
association is created.

• If entity E11 is “1-nested” within entity E1, then in the CL diagram the E11 is_subclass_of 
E1 association is created.

10.14 How Do I Pinpoint a Critical Path in a Business Process?

This feature allows you to find for a particular business process (i.e., a BP subtree in your 
business model) the most time-consuming sequence of tasks (the so-called time-critical path). 
Of course, a precondition for running this check is that you have entered task durations in your 
BP!

Proceed as follows:

1 Click the BP symbol representing the top level of the desired business process in the 
model tree.

2 In the BM tools menu, select the Find critical path command.

3 After the preparation phase is completed, press OK to continue, or Cancel to stop.

�
If you are not sure what is meant by an “is_part_of” association, please see “Aggregations (Part 
Associations)” on Page 126. For more information about “is_subclass_of” associations, see Section 
“Generalizations (Subclass Associations)” on Page 127.
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If you clicked on OK, the second phase will be completed automatically. One or more BPs are 
then marked as selected (i.e., highlighted in blue) in the model tree. The critical path found is 
located in these marked diagrams.

To examine the path, proceed as follows:

1 Open the BP diagram representing the top level of the business process (for example, by 
double-clicking it).

2 Open the Options menu and select the Show critical path command. The critical path 
(i.e., the task boxes and event arrows belonging to it) is represented in blue.

3 A double-click a task symbol highlighted in blue will open the next level BP diagram, 
allowing you to examine the critical path in detail.

�
The critical path information is saved with the model’s contents. You can examine this information 
during upcoming GRADE Modeler sessions; simply open the top-level BP diagram of the desired 
business process and select the Show critical path command from the Options menu.
Tips and Tricks 389 

• 
• 
• 
•
•
•



390 

• 
• 
• 
•
•
•

10.15 How Can I Modify the User Settings According to My 
Needs?

GRADE now gives you even more flexibility in terms of user settings so that you can set up the 
application according to your needs and preferences.

For example, a new feature allows you to alter the look of model trees. You are probably 
accustomed to seeing rectangles with short names denoting the various diagram types (PCK, 
CL, etc.), as seen here:

Figure 10-26: Conventional model tree
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If you rather would have the diagram types identified by icons (pictures), you can switch on the 
Use diagram icons feature to get the following look:

Figure 10-27: Model tree with diagram icons

The rest of this section explains the procedure for modifying user settings and lists the options 
available to you.
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Changing User Settings

Open the Options menu and activate the Settings... command. The User Settings dialog appears:

Figure 10-28: User Settings dialog

The options we are interested in appear on the General card. (The Diagrams card is for 
customizing the appearance of the GRADE diagrams themselves; these options are described in 
“How Can I Change Other Defaults for Diagrams?” on Page 357.)

Assuming that the General card is displayed, you can modify the user settings by simply selecting 
or deselecting the appropriate radio buttons/check boxes, or filling in the one available field, 
then clicking OK. The settings are saved with the user configuration; i.e., they will remain active 
for all of your GRADE sessions until you change them.
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User Settings

The following table explains the user settings that can be modified via the General card:

Dialog Element Function

Toolbar By default, the GRADE toolbar (which contains buttons for saving, copying, pasting, 
etc.) is positioned horizontally near the top of your screen. This option allows you to 
reposition the toolbar (Vertical right, Vertical left) or conceal it (Hidden).

Prompt names During the modeling process, GRADE may prompt you, providing a list of names 
from which to choose. This option lets you set the range of names offered. Visible lets 
you select only those names that are “visible” from the current position in the model 
tree, in accordance with GRADE’s visibility concept (see Glossary). All lets you 
choose from names throughout the model. Subtree limits you to names in the active 
subtree.

Message level This option is relevant only if you plan to perform syntax analysis of your model. All 
means all syntax analyzer messages will be visible. Errors means only error messages 
will be displayed. None means no messages will be visible.

Syntax Use this option to switch among the three modes of syntax analysis and consistency 
checking used in business modeling. Use Simulatable syntax when analyzing models 
for simulation (you also may find it helpful to keep this option switched on while you 
are creating a simulatable model). The Semiformal mode, which gives you somewhat 
more freedom, should be used only if you definitely do not plan to use your model 
for simulation. Switch to WorkParty syntax only when analyzing models to be 
exported to WorkParty (a Siemens Nixdorf workflow tool).

Crowfeet notation If this box is checked, any new CL diagram created will automatically make use of 
crowfeet notation to indicate cardinality (see also Page 125). If the box is not checked, 
any new CL diagram will automatically make use of UML notation. (To change the 
notation in an existing CL diagram, simply open the Options menu, then select 
Notation, then the notation type.)

Auto edit This option will affect the way you create diagram symbols. If you turn this option 
off, you can create diagram symbols without being offered a definition dialog. This 
is useful if you want to create many diagram elements quickly, without filling in 
content. If this option is on, a definition dialog will appear.

Underscores visible When names used in models contain spaces, GRADE replaces these spaces with 
underscores automatically. This option determines whether underscores will be 
visible in your diagrams and in printouts. Turn this option on if you want underscores 
to be displayed.

Enhanced dialog graphics By default, the dialog windows in GRADE contain GRADE-specific enhanced 
graphics; for example, the OK button is marked by a thumbs-up picture. If you prefer 
not to display these special graphics, turn this option off.

Hide diagram status GRADE model trees may contain small cubes whose colors indicate diagram status. 
You can see whether a diagram has been approved, whether it contains errors, etc., as 
described in “Working With a Model” on Page 21. If you prefer not to see the status 
cubes, turn this option on.
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Table 10-1: Explanation of options in the User Settings dialog

New License

If, for any reason, you need to replace your current GRADE license with a new one, click the 
New license button at the bottom of the User Settings dialog. Enter the new license number, then 
click Yes.

Use diagram icons As mentioned earlier, turn this option on to see diagrams represented by icons in the 
model tree; turn it off to see diagrams represented by short names (CL, BP, VT, etc.).

Reduce model tree If you turn this option on, the model tree will be reduced and certain empty diagrams 
will be hidden. If the option is off, you will be able to see all elements in the model 
tree.

Syntax prompter This option lets you turn the automatic syntax prompter on or off. The syntax 
prompter is useful if you are creating a PD diagram to be used for prototyping or code 
generation. If you are not creating such a diagram, you may find it easier to work with 
the syntax prompter turned off. (For more information, see “Working With PD 
Diagrams” on Page 250.)

Auto BP->TD This option lets you toggle between the two modes of working in BP diagrams: a) 
automatic transfer of information from BP to TD diagrams and b) no transfer of 
information from BP to TD diagrams. By turning this option off, you will ensure that 
a TD diagram is not generated automatically for each task you create in a BP diagram.

Default path names in CO When you create paths in CO diagrams, GRADE suggests a path name (e.g., the 
suggested name for a path from a customer to clerical staff would be Customer Clerical 
Staff). You can specify the length of this suggested path name by entering any integer 
from 3 to 31 in the Maximum length field. For example, if you enter 7, the suggested 
name for the customer to clerical staff path would be Cus Cle. If you switch on Use 
alt.names, GRADE will create path names based on the alternative names of the 
source and target object (when no alternative name is available, the regular name will 
be used).

Dialog Element Function

�
If you try to start a GRADE application whose license has expired, the New License window will 
appear automatically.
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10.16 What Special Keys and Key Combinations Can Be Used?

GRADE offers numerous special keys and key combinations that can be used as shortcuts. 
These are listed according to function in the following sections:

• Shortcuts for Activating/Selecting Diagram Elements

• Shortcuts for Drawing/Modifying Diagrams

• Shortcuts for Navigating the Model Tree

• Miscellaneous Shortcuts.

Shortcuts for Activating/Selecting Diagram Elements

Esc can be used to deactivate/deselect diagram elements.

�
Shortcuts for working with tables are described in “What Other Operations Can Be Performed 
With GRADE Tables?” on Page 428. 

If you happen to be using a workstation that lacks a mouse or if you simply prefer keeping 
your hands on the keyboard, the following sections are particularly pertinent for you. Keep in 
mind, however, that the most convenient way of working with GRADE is with a mouse; in 
fact, there are certain operations that cannot be performed without one. 

Key/Key Combination Function

Ctrl+A Select all elements in a diagram

Tab Activate an element in the next group of diagram elements (see the note 
following this table on what constitutes a group)

Arrow keys
(up, down, right, left)

Activate another diagram element within the given group

Home Activate the first element within a group

End Activate the last element within a group

Ctrl+arrow keys In DD diagrams: activate another data type (use arrow keys alone to move 
through a single data type)

Table 10-2: Keys/key combinations for activating/selecting diagram elements

�
The term “group” has a different meaning, depending on diagram type. For example, the following 
groups exist in CO diagrams: boxes, connectors and free comments. Thus, pressing Tab in a CO 
diagram will let you activate boxes, connectors and free comments, alternately.
Tips and Tricks 395 

• 
• 
• 
•
•
•



396 

• 
• 
• 
•
•
•

Shortcuts for Drawing/Modifying Diagrams

As the previous table indicates, there are possibilities for executing commands without using the 
mouse. To execute a command in the symbol’s or diagram’s pop-up menu, proceed as follows:

1 Activate the element in the diagram or the diagram in the model tree.

2 Press Shift+F10 to reveal a pop-up menu.

3 Use your downward arrow key to select the appropriate command.

Key/Key Combination Function

Ctrl+C or Ctrl+Ins Copy (a highlighted text or activated/selected diagram elements)

Ctrl+V or Shift+Ins Paste (a text or diagram elements)

Ctrl+X or Shift+Del Cut (a highlighted text or activated/selected diagram elements)

Ctrl+D Duplicate (in some types of diagrams you can use this to duplicate activated/selected 
diagram elements)

Del Delete activated/selected diagram elements or diagram, or highlighted text

Ctrl+S Save

Alt+BkSp or Ctrl+Z Undo (e.g., to delete the diagram element just created or return to the previous 
layout)

Enter (Return) Used to change the contents of an activated diagram element: press Enter to open the 
contents dialog; after making your changes, press Enter again to confirm the entries 
and close the dialog

Esc Close an active dialog without confirming entries; deactivate symbol appearance 
mode (see note on Page 399)

Tab Switch to next element (field, button, etc.) in a dialog

Shift+Tab Switch to previous element (field, button, etc.) in a dialog

Shift+F10 Open pop-up menu of the activated diagram element or diagram in the model tree

Alt+underlined character Open menu with underlined character (e.g., to open the Edit menu, use Alt+E)

Ins In a DD diagram, use to define a field of a record data type

F6 Activate symbol appearance mode, allowing you to shift the positions of text and 
pictures in an activated diagram element; press F6 again to deactivate this mode

F4 Set default size (activate a diagram element, then press F4 so that all subsequently 
created diagram elements of this type will be the same size as the originally activated 
element)

F5 Refresh window; redraws diagram to correct minor cosmetic defects; this command 
is only rarely needed

Table 10-3: Keys/key combinations for drawing/modifying diagrams
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4 Press Return (Enter) to confirm your choice.

As another alternative, you can use keys and key combinations to activate commands via the 
menu:

1 Hold down Alt, then type the letter that is underlined in the menu name. (For example, 
Alt+D to open the Diagram menu.)

2 Use your downward arrow key to select the appropriate command.

3 Press Return to confirm your selection.

4 If you have opened a dialog window and made entries, you can usually press Return to 
confirm your entries and close the window. If you decide to cancel the operation, press 
Esc.

Shortcuts for Navigating the Model Tree

You also can navigate the model tree without using your mouse, as shown in the following table:

Key/Key Combination Function

Home Activates the top left diagram of the model (GLO, STE, PIC, TAG, and EXT 
are not affected)

End Activates the last diagram displayed in the model tree

Down arrow/Up arrow Activates the diagram below/above the current diagram

Tab Activates the root diagram of the next free subtree

Shift+Tab Activates the root diagram of the previous free subtree

Left arrow Activates the previous associated diagram (in that row)

Right arrow Activates the next associated diagram (in that row)

Page down/Page up Activates the diagram 10 rows below/above

Table 10-4: Keys/key combinations for navigating the model tree
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Miscellaneous Shortcuts

The following shortcuts also may come in handy:

Key/Key Combination Function

. (period) “Zoom in” on the area in a diagram or model tree where your mouse pointer is 
positioned

, (comma) “Zoom out” of the area in a diagram or model tree where your mouse pointer is 
positioned

- (minus) Collapse or expand (e.g., a subtree in a model tree or ORG diagram)

+ (plus) Expand by one level (e.g., to display the next subtree level in a model tree or 
ORG diagram)

F1 Open a help window

Ctrl+N New (in a model tree, use it to create a new diagram; in the repository window, 
use it to create a new model)

Ctrl+P Print

Ctrl+R Rename an activated diagram or model

Ctrl+F4 Close active repository, model tree, or diagram

Alt+F4 Quit GRADE

Esc Deselect objects in a model tree, dictionary, or table (see also “What Other 
Operations Can Be Performed With GRADE Tables?” on Page 428)

Ctrl+F Find (initiates a search for diagram elements or diagrams in the model tree)

F3 Continue search (find next)

Alt+F9 Analyze activated diagram

Shift+F9 Analyze activated subtree

F9 Reanalyze all diagrams

Shift+F5 Cascade windows

Shift+F4 Tile windows

Ctrl+T Toggle between a CO diagram and its associated PD

Table 10-5: Additional keys/key combinations available in GRADE
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10.17 How Can I Open a DD Diagram as a Table?

GRADE now supports the editing of data-type definitions in tabular form. You can view or edit 
any DD (data-type definition) diagram in the standard graphical form or as a table. The 
diagram contents are stored in the repository using a common internal data format.

To open a DD diagram as a table:

1 Open the corresponding model tree and activate the DD diagram.

2 Open the Diagram menu and select Edit as table.

A table window, containing one or more tables, will be opened. In the first table, all data-type 
names defined in the diagram are listed. There may be one or more additional tables containing 
record data-type definitions (each table row describes one record field).

If you wish to hide the first (i.e., data-type) table, open the Options menu and activate Set filter... 
Switch off the Data type table check box and click OK.

You can edit the existing data types or introduce new data types by opening the Edit menu and 
activating the Edit row... and Insert row... commands. (Or use a shortcut: activate the row in 
question, then press Return to edit that row or Ins to insert a row below it.)

�
As shown by the previous tables, the function of the Esc key differs, depending on the situation. Let 
us assume you have clicked on a symbol with your right mouse button, then selected the Symbol 
appearance command (this allows you to alter the placement of text or change the display of a 
picture within the symbol). Once you have made any desired changes in symbol appearance, you 
can press the Esc key to achieve the following:

Press Esc once to deactivate symbol appearance mode (the inner red frame will disappear).

Press Esc again to deactivate the symbol itself; the symbol no longer will be the “current” one, and 
the red frame around it will disappear.

Press Esc again to initiate the process of closing the diagram (you will need to answer the 
confirmation question with Yes).
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The Data Type Table Entry dialog box looks like this:

Figure 10-29:  Dialog used for altering a DD table

Here, the fields have the following meanings:

• Category is the category of the object represented in the active table row: FIELD (i.e., record 
field), ATOM (i.e., simple data type), RECORD, ARRAY, SET or LIST.

• Name of the field or the data type. The name can be entered directly or with the aid of the 
Pick name button.

• Index range is used for arrays only; here, you can enter the minimum and the maximum 
index.

• Type is used for fields and simple data types only. It defines the data type. It can be entered 
directly or with the aid of the Pick type button.

• Description can be any comment text. The key combination Ctrl+Enter may be used to 
obtain a new line. If you want an existing name to be part of your comment, use the Pick 
name button to select it.

• Parent data type is used for fields only and is the name of the corresponding record data type. 
Select the name from the list (by clicking the down arrow next to the field), enter the name 
directly or with the aid of the Pick name button.

DD tables differ from other tables in that their contents must be saved explicitly (other tables 
are saved automatically). You can do this by opening the Diagram menu and selecting Save (or 
Save as free if you want your table to be a new, standalone diagram). Or simply close the table; 
GRADE will then ask whether you want to save it.
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10.18 How Can I Rearrange My System Model to Focus 
Attention on a Particular Object?

Sometimes it is interesting or necessary to shift the focus of attention from one object in a 
GRADE system model to another. In the CO hierarchy, there is a specific object known as the 
“Target System”; its structure and behavior are those being described. In some cases, you may 
want to see what happens if a different object is selected as the “Target System” to see how it 
then would relate to the rest of the system. The Build environment info command can be used 
for this purpose.

Proceed as follows:

1 Open the model.

2 Activate the CO diagram symbol of the object of interest by clicking it.

3 Open the Tools menu and select the Build environment info command.

4 Find and open the new free CO Environment_of_... diagram that has been created.

5 The previously selected object will now be placed in the center of the CO diagram 
surrounded by “partner” objects. You can double-click the connecting lines to open the 
corresponding transfer object tables.

10.19 How Can I Create a Link Between a Document and a 
GRADE Diagram?

Let’s assume you are writing a report concerning your model. You create a Microsoft Word 
document and would like to include links from it to the model itself, so that the reader can see 
exactly what you are talking about. For this situation and similar ones, GRADE allows you to 
insert a diagram or model tree as an icon in other documents. Clicking these linkage icons in 
your Windows application will start GRADE, which will open the required diagram or model-
tree window. The diagram contents are not embedded in the document; they are stored only in 
the GRADE repository.

To take advantage of this feature, proceed as follows:

1 In Windows, register a new file type (extension .grd). To do this, locate My Computer on 
your desktop or in the Explorer. Click it. Then open the View menu and select Folder 
Options... Click File Types, then New Type..., and register the new type (enter GRADE 
diagram for the description and grd for the extension). Click Change Icon... to select any 
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desired icon, then click OK. Click New..., then define the action Open, and for the 
application enter C:\Grade4\Bam\bambapp.exe, assuming that C:\Grade4 is the 
installation folder on your computer. Click OK, then Close and Close.

2 Prepare the *.grd file. To do this, start GRADE; close any irrelevant models, then open 
the desired model tree or the desired diagram and maximize its window. Select Save link 
file as... from the Model or Diagram menu; select a path for storing the new (temporary) 
file; if necessary, correct the filename; click OK; exit GRADE. The file created contains 
the link information that will allow GRADE to find the repository, model and diagram 
to be opened.

3 Insert the diagram (model-tree) icon into your document: For example, if you are 
working with a Microsoft Word document, select Insert - Object - Create from file from 
the menu, browse and select the desired *.grd file and click OK. (Do not use the Link to 
file option.) The GRADE icon and the filename appear in the document. Now you may 
delete the *.grd file, if you wish.

4 Double-click the icon to check the result; you may edit the diagram, but do not rename 
or delete it. You may switch to other GRADE windows, navigate, etc., before exiting 
GRADE and returning to the other application.

10.20 How Can I Use a CL Diagram as the Basis for a Business 
Model?

If you have read Chapter 4, you know that it is sometimes helpful to start out the modeling 
process by creating a CL (class) diagram; it can be the initial draft of your model.

GRADE now provides an automatic feature that uses some of the information in your CL 
diagram (also known as an object model) to create an initial business model (BM).

Proceed as follows:

1 Activate the top CL diagram symbol of your object model by clicking it.

Only one instance of GRADE can be opened at any given time on your computer, i.e., you can 
open only one of the GRADE diagrams linked to your document simultaneously.

If your document contains links to GRADE diagrams, it is not totally “portable.” If you copy the 
document to another computer, the links will remain correct only if the repository path is the 
same as on your computer; the repository contains the same model (i.e., a model having the same 
name); and the model contains the same diagram (i.e., a diagram having the same type, subtype 
and name).
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2 Open the BM tools menu and select Build business model.

3 In the model tree, three new symbols appear: a BM symbol having the same name as the 
previously activated CL diagram and, below this new BM symbol, new ORG and DD 
symbols. Double-click either of these to view the contents; the ORG diagram now can 
be used as a basis for creating a new BP diagram (as described in Chapter 3).

To help you better understand what is included in the new BM diagram, here are the steps 
GRADE takes to generate it:

1 As mentioned, a new BM symbol (with the corresponding ORG and DD symbols) is 
created in the model window.

2 The CL diagram is scanned and each class and each “is part of” association is registered.

3 Classes are converted into organizational units and represented in the ORG diagram (“is 
part of” associations are retained).

4 Classes are converted into record or atomic data types and represented in the DD 
diagram (“is part of” associations are converted into “is field of” associations).

10.21 How Do I Generate Database Initialization Scripts for 
DB2, Microsoft SQL Server, INFORMIX-Online, Oracle7 
and SQLBase?

You can generate initialization scripts (i.e., text files containing CREATE TABLE and other 
SQL DDL statements) for a particular database in your model.

Proceed as follows:

1 First make sure that the ER model of the database for which you wish to generate an 
initialization script is syntactically correct. You can easily check this by examining the 
diagram-status cube next to the ER icon in the model tree; if the front panel of this cube 
is green, the diagram has been checked for syntax and found to be correct. (If no cube 
is visible, open the Options menu, activate Settings..., then remove the check mark in 
front of the Hide diagram status option. If you need to perform syntax analysis, activate 
the ER icon, then open the Tools menu and activate Analyze current diagram, Analyze 
subtree or Reanalyze all diagrams.)

2 With the ER symbol activated, open the Tools menu and select Generate DB 
initialization...
Tips and Tricks 403 

• 
• 
• 
•
•
•



404 

• 
• 
• 
•
•
•

3 The following dialog will be displayed:

Figure 10-30: Dialog for generating a database initialization script

4 Select the desired target system and mode parameters.

5 If necessary, change the destination file by clicking the Change button and making 
another selection.

6 Click the OK button.

7 Wait for the message “Generation completed,” then click the OK button.

Use the script files as needed.
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10.22 How Can the Data Dictionary Facilitate My Work?

In GRADE, the information contained in a model is summarized via two different lists of 
contents: the model-tree window and the model-dictionary window.

As you know, the basic elements of the model tree are diagrams. By contrast, the basic elements 
of the model dictionary are names that occur in the model. You can see this in the following 
figure, which is a fragment of an actual model dictionary:

Figure 10-31: Fragment of a model dictionary

You will read more about the contents of the dictionary and how to work with it later in this 
section. For now, you should note that the dictionary supports the following functions:

• Providing an overview of all names occurring in the model (or you can retrieve a list filtered 
according to criteria of name patterns and/or name types)

• Providing an overview of the diagrams where a name has been defined

• Providing an overview of all diagrams in which a name is mentioned (i.e., referenced)

• Providing easy navigation to the diagrams so found (and, conversely, easy navigation from a 
name occurring in a diagram to the relevant dictionary information)

• Providing an overview of errors and warnings detected by the syntax analyzer and easy 
navigation to the corresponding diagrams
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• Allowing global and selective name changes in the model

• Allowing copying of the dictionary contents to a text file

• Allowing deletion of names that are no longer used.

All these dictionary functions can be achieved via the dictionary window.

In addition, it is the dictionary that allows you to easily reuse a name defined in the model: 
Thanks to the dictionary, many GRADE dialogs offer a Pick name button, which opens a dialog 
allowing you to select names previously used.

Opening the Dictionary Window

If you are viewing a model tree, you can access the dictionary by opening the Model menu, then 
selecting Dictionary...

If you are viewing a diagram, you can access the dictionary by opening the Diagram menu, then 
selecting Dictionary...

In both cases, the dictionary window is either opened immediately, or the Dictionary Filter 
dialog appears first, as shown in the following figure:

Figure 10-32: Dictionary Filter window

Certain GRADE keywords should not be used as the names of diagrams, objects, etc., as these 
names will not be displayed in the dictionary. For a list of these keywords, see “Rules for the 
Selection of Names in GRADE” on Page 29.
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In the latter case, specify the desired filter settings and click OK. (For more information about 
the available settings, see “Explanation of the Dictionary Filter Dialog” on Page 409.) If you 
specify nothing, only a list of names occurring in the model will be displayed.

If you want to retrieve the full information related to any given name, double-click it in the 
dictionary window.

Understanding the Dictionary Window

As you can see in this dictionary fragment, the dictionary window is organized as a tree with 
levels:

Figure 10-33: Fragment showing dictionary levels

• The top-left symbol indicates the name type (or types) included in this tree (All names).

�
If you are working with a very large model (with thousands of diagrams), the generation of the full 
dictionary contents can be time-consuming, and the resulting information can be unwieldy. To 
avoid these problems, use reasonable filter settings. (For example, set the filter so that all name 
definitions are shown, but name references are not.)
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• The next level contains the actual names appearing in the model (e.g., Acceptable, Approved 
Order). Names having at least one definition or reference are portrayed with a gray 
background, as seen here; names that, for some reason, are not used in the model have a white 
background. (For example, a diagram element that was introduced into the model but was 
later deleted would appear with a white background.)

• The next levels contain DEF and REF boxes. A DEF box indicates a case where something 
was defined in the model. Every place in the model where a name has been introduced counts 
as a definition of this name. It may be a data diagram for a data-type name, an ER diagram 
for an entity or an ET table for an event. Depending on its visibility and type, a name may 
be defined in several parts of a model for different functions. By contrast, all locations in the 
model where a name is mentioned count as references and are indicated in the data 
dictionary as REFs. For example, a variable name can be referenced in PDs, a data-type name 
in TOs and ETs, an event name in BPs, etc.

• To the right of the REF and DEF boxes you will see small squares reflecting the design status 
of the corresponding diagram (for more information about design-status definitions, see 
“Can a Whole Team Work on a GRADE Model, Then Merge the Results?” on Page 371). 
Here, white indicates Not Started status, gray is In Work, cyan is Approved and blue is Final.

• To the right of the small square, you find the type of element: event, task, class, 
organizational unit, etc.

General Tips for Working With a Data Dictionary

To open a diagram containing a definition or reference, simply double-click the DEF or REF 
symbol.

To open a pop-up menu, click with your right mouse button on a symbol.

There is always one symbol in the dictionary tree that is highlighted (marked in red); this is the 
active symbol. To activate a symbol, click it once with your left mouse button. Most menu 
commands and other operations refer to the active symbol.

Some menu commands and other operations refer to selected symbols. Selected dictionary 
symbols are highlighted in blue. To select one or more dictionary symbols, hold down the Ctrl 
key and click the desired symbols. An alternative way of selecting the currently active dictionary 
symbol is to press the spacebar (or click the symbol with your right mouse button, then activate 
Selected in the pop-up menu).

To activate (highlight in red) a node, simply click it. To select (highlight in blue) a node, press 
Ctrl and click it.

To jump to the next selected symbol, press the F3 key.

To deselect (a selected) dictionary symbol, make it active and then press the spacebar (or click 
Selected in the corresponding pop-up menu).

To deselect all (selected) dictionary symbols, press Esc.
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Changing the Filter Settings

By using the Dictionary Filter dialog you can determine the extent and the sequence of the 
information represented in the dictionary window.

Proceed as follows:

1 Open the Options menu and select the Set filter... command. (Or click anywhere in the 
dictionary with your right mouse button, then select Set filter... in the pop-up menu.) 
The Dictionary Filter dialog appears.

Figure 10-34: Dictionary Filter dialog

2 Choose the desired filter settings. (For help, see the explanation of the Dictionary Filter 
dialog, below.)

3 Click OK. The dialog closes, and the contents of the dictionary window are updated in 
accordance with the new filter settings.

Explanation of the Dictionary Filter Dialog

Name pattern

Here, you can define the names that will appear in your dictionary list. You can use an asterisk 
(*) as a placeholder. For example, DE* finds all names beginning with DE (e.g., Department); 
*DE finds all names ending with DE (e.g., Trade). *DE* finds all names containing DE (e.g., 
Order). An empty pattern means all names will be included in your dictionary (unless certain 
ones are ruled out by other filter options).

Scan options
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If you select Scan - names, the dictionary will be built by scanning all the names belonging to 
the model (names will appear in alphabetical order).

If you select Scan - definitions, the dictionary will be built by scanning all the definitions 
belonging to the selected scope (in that case, undefined, but possibly referenced, names will not 
appear in the dictionary). The dictionary contents will be sorted first by name types (e.g., Org. 
unit, Class, Task), and then, within types, in alphabetical order by name.

Show definitions option

If this check box is marked, definitions of all names currently contained in the dictionary will 
be shown. If not, definitions will not be shown.

Show references option

If this check box is marked, all references to all names currently contained in the dictionary will 
be shown. If not, references will not be shown.

Sort by update time option

If this check box is marked, definitions currently contained in the dictionary will be sorted by 
update times in descending order (i.e., newer definitions will be listed first). If not, definitions 
will be sorted first by name types, and, within types, in alphabetical order by name.

Scope options

Entire model means GRADE will scan names/definitions/references throughout the model.

Visible from current diagram means GRADE will scan definitions/references visible from the 
current diagram (i.e., from the active diagram in the model tree).

Current subtree means GRADE will scan definitions/references throughout the current subtree 
(i.e., under the active diagram in the model tree).

Current diagram means GRADE will scan definitions/references throughout the current 
diagram (i.e., the active diagram in the model tree).

Ignore TDs

Switch this on if you want events and tasks referenced in TD diagrams to be ignored in REF 
lists.

Ignore SDs

�
For more about the concept of visibility, see the Glossary.
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Switch this on if you want data types and variables referenced in SD diagrams to be ignored in 
REF lists. (SD stands for specification diagram. SD diagrams are used to describe the external 
interface of procedures and functions, as well as modules.)

Choose types button

You can use this to restrict the types of names to be represented in the dictionary.

Proceed as follows:

1 Click the Scan definitions radio button.

2 Click Choose types. The Choose Types dialog appears.

3 Select the name types that you would like to see in your dictionary.

4 Remember that nothing selected means all are selected!

5 Click OK.

Restoring the Filter Settings

From the Options menu, select the Restore filter command. The contents of the dictionary 
window change to reflect the previous filter settings. (Or simply click your right mouse button, 
then click Restore filter in the pop-up menu.)

Double-Clicking a Name

Double-clicking a name symbol changes the filter settings: Only all definitions and references 
for the name clicked will be displayed. To return to the previous filter settings, click the name 
with your right mouse button, then select Restore filter from the pop-up menu.

Hiding Name Types

To reduce the contents of the dictionary, you can hide some name types (e.g., you can hide all 
organizational units).

To hide all types except the active one, proceed as follows:

1 With the dictionary open, click the name type you want to have displayed. (Be sure you 
click a name type, such as Org. unit, and not on a specific name!)

2 Then press your right mouse button to open a pop-up menu and select the Hide other 
types command.

To hide an activated name type, proceed as follows:

1 With the dictionary open, activate a name type.
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2 Then press your right mouse button to open a pop-up menu and select the Hide 
command.

As an alternative, you can use the commands in the Type menu: either Hide selected types or Hide 
unselected types.

Navigating the Dictionary

Aside from the usual mouse-oriented techniques for working in Microsoft Windows and the use 
of the scroll bar to scan the dictionary tree, the following keyboard commands exist for 
navigating the dictionary:

Searching for a Name: Go to Name Option

You can locate a particular name in a dictionary.

Proceed as follows:

1 Open the Search menu and select the command Goto name... The Enter Name dialog 
appears.

2 In the field, type several of the first letters of the name.

3 Click OK. If the current filter setting allows it, the dictionary window is scrolled to the 
first matching name, which will be activated (marked in red).

Searching for an Owner: Go to Owner Option

From the current definition/reference you can jump to the name of its “owner,” for example, to 
the name of the diagram in which the definition/reference is located.

Key Function

Home Go to the first entry

End Go to the last entry 

Left arrow Go to the parent entry (e.g., from a DEF/REF to the corresponding name entry) 

Right arrow Go to the next child entry 

Down arrow/Up arrow Go to the next/previous entry at the current tree level (e.g., from the current name to 
the next name) 

Page down/Page up Jump several rows down or up

Table 10-6: How to navigate the data dictionary
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Proceed as follows:

1 Activate a DEF or REF.

2 Click your right mouse button, then select the Goto owner name command. If the 
current filter setting allows, the dictionary window is scrolled to the place where the 
owner is located and the owner is activated (marked in red).

Navigating from the Dictionary to Diagrams

You can easily open the diagram where a particular definition/reference is located by double-
clicking the desired definition/reference symbol.

Alternate ways:

• Press the Enter key to open the active definition/reference.

• Click the symbol with your right mouse button, then select the Show command from the 
corresponding pop-up menu.

Navigating from Diagrams to the Dictionary

GRADE lets you get an overview of all definitions and references for a name occurring in a 
diagram.

Proceed as follows:

1 Click the desired name in the given diagram.

2 Click the right mouse button. A pop-up menu appears.

3 Select the Navigate to dictionary command.

Changing a Name

You can change a name at all or at selected locations of the model.

Proceed as follows:

1 With the dictionary window open, hold down the Ctrl key and click the name to be 
changed. All definitions and references under it will be selected.

2 If you do not want the name changed at a particular location, hold down Ctrl and click 
the corresponding definition/reference.

3 Now press your right mouse button and click the Rename... command. The Rename 
dialog appears.

4 Enter the new name in this dialog, and click OK to carry out the renaming procedure.
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Changing a Particular Definition/Reference

You can change the name at a particular location in the model.

Proceed as follows:

1 Click the definition/reference to be renamed to make it active.

2 Press the right mouse button and select the Rename... command in the corresponding 
pop-up menu. The Rename dialog appears.

3 Enter the new name in this dialog, and click OK to carry out the renaming procedure.

Deleting Names no Longer in Use

The dictionary may contain names no longer used in the model. You can recognize such names 
by the fact that neither definitions nor references exist for them. Some of the names may be 
useful for reference purposes, but most names that are not used any more have no further 
significance.

To delete all names no longer in use, close the model and select the Compact command in the 
Model menu of the repository window. Confirm your intention with Yes, then press OK.

To delete a particular name that is no longer in use, proceed as follows:

1 In the dictionary window, click the name to be deleted.

2 Press the Del key. The current name is deleted from the dictionary. If the name is still 
being used somewhere, however, a message appears that the name cannot be deleted.

To delete several names that are no longer in use, proceed as follows:

1 Hold down the Ctrl key and click the names to be deleted.

2 Select the Delete selected names command in the Name menu. The selected names are 
deleted from the dictionary. If a name is still being used somewhere, however, a message 
appears that the name cannot be deleted.

Copying a Name to the Clipboard

Proceed as follows:

1 Click the desired name symbol with your right mouse button.

2 Select the Copy to clipboard command from the pop-up menu.

To paste the name elsewhere (e.g., into a diagram), use Ctrl+V.
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Defining a New Diagram Via the Dictionary

If you find (for example, while editing a diagram) that another diagram to which you want to 
refer does not yet exist, you can create it directly. For this purpose, GRADE makes the Define 
option available in diagram, dictionary and model-tree windows.

If you have a dictionary window open and want to define a new diagram, proceed as follows:

1 Open the Name menu and select the Define... command.

2 The Define dialog appears. Click the Diagrams tab:

Figure 10-35: Diagrams tab

3 From this point on, proceed as described in “How Can I Create a Diagram?” on Page 
433, starting with Step 5. (Make sure you fill in the Parent diagram field either with the 
name of the desired parent diagram or with FREE for an independent diagram.)

Refreshing the Dictionary Window

If you have modified diagrams with an open dictionary window (or if in the multi-user version 
of GRADE several developers are working on the same model), it can happen that the contents 
shown in the dictionary window are no longer current. In that case, you must update the 
dictionary window.

To do this, open the dictionary. Then press F5 (or open the Dictionary menu and activate the 
Refresh command). The dictionary window is updated.
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Exporting the Dictionary to a File

Proceed as follows:

1 Open the dictionary.

2 In the Dictionary menu select the Export to file command. Then select in text format... 
or as plain text... (see below).

3 The Copy dictionary in file dialog appears. Here, select the desired directory and enter 
the filename under which the dictionary contents are to be stored. As default, GRADE 
suggests dict.lst.

4 Confirm your entry by clicking OK, or terminate the operation with Cancel.

The current dictionary contents are stored in one of two formats:

• Text format means the information will have tabs and line breaks and automatically 
generated tables, for example, in Microsoft Excel.

• Plain text means the information will appear as a simple text file.

Exporting the Dictionary in HTML Format

Please see instructions on Page 422, starting with Step 8.

Examining Errors and Warnings via the Dictionary

Error and warning messages generated by the GRADE syntax analyzer appear in the dictionary 
under two specific name types: Error and Warning. (For more information about syntax analysis, 
see the Simulation Guide.) Each error/warning is named after the diagram (event, competency, 
etc.) in which it has been detected and appears as a specific DEF symbol with the full message 
text to the right of it.

To view the full list of error and/or warning messages, proceed as follows:

1 Select the Scan definitions option in the Dictionary Filter dialog box.

2 Click Choose types. The Choose Types dialog box appears.

3 Mark the Error and/or Warning check boxes and click OK. Now the dictionary contains 
only error and/or warning messages. (If there are no errors or warnings to view, the field 
will be blank.)
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Searching for Inappropriate Names

If you plan to simulate your model (see the Simulation Guide), you should be careful about the 
characters you choose for names of elements. All names containing characters other than letters, 
digits and underscores (blanks in names are replaced by underscores automatically) will be 
qualified as “inappropriate” during the syntax analysis and simulation process. Use of such 
names in expressions can lead to ambiguities and outright errors.

If you wish to detect inappropriate names in your model, proceed as follows:

1 Open the model and its dictionary.

2 Hold down your right mouse button to display a pop-up menu, then click Set filter...

3 Make sure that the Scan - names and Scope - Entire model options are on, and that the 
Name pattern window is empty.

4 Click OK.

5 Choose the Select inappropriate names command from the Search menu. A message 
appears containing the number of inappropriate names found.

6 Click OK. All the inappropriate names are shown in blue (i.e., they are marked as 
selected). The first name found is activated (shown in red).

7 By pressing the F3 key you can jump to the next name found.

Searching for Similar Names

If you wish to detect names similar to a given name, proceed as follows:

1 Open the dictionary window.

2 Hold down your right mouse button to display a pop-up menu, then click Set filter...

3 If filtering is not needed, make sure that the Scan - names and Scope - Entire model 
options are on, and that the Name pattern window is empty. Click OK.

4 Activate the Select similar names command in the Search menu. The dialog Enter Name 
appears. 

5 By default, the name window contains the currently active name. If needed, you can 
type in a different name.

6 Click OK. A message appears announcing the number of names found similar to the 
given name.

7 Click OK. All names found are shown in blue (i.e., they are selected). The first name 
found is activated (red).

8 By pressing the F3 key you can jump to the next name found.
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Two names are recognized as similar if they contain a common substring that is at least half as 
long as the longer name.

10.23 How Can I Export Diagrams and Models?

GRADE offers many possibilities for exporting diagrams and models. This section covers the 
following topics:

• Copying a diagram to a file as a picture

• Copying a diagram to the clipboard

• Exporting a model/subtree in HTML format

• Exporting and importing diagrams and models in Export/Import Format (EI)

• Exporting in the Object Definition Language of the Object Database Standard ODMG.

10.23.1 Copying a Diagram to a File as a Picture

GRADE allows you to export diagrams in several graphical formats (BMP, TIFF, PCX, WMF, 
GIF). These graphics are suitable for inclusion in documents prepared with other tools and can 
be useful for creating presentations.

Proceed as follows:

1 In the model tree, activate the diagram that you wish to export. 

�
Because the export and import of diagrams to and from Rational Rose is a specialized topic 
involving the Unified Modeling Language (UML), it is covered in Chapter 6. See “Preparing 
GRADE Diagrams for Export to Rational Rose” on Page 212 and “Exporting Diagrams in Rational 
Rose” on Page 217.

Note that comment texts also can be imported and exported. See Page 340. For more export 
possibilities, see “Exporting the Dictionary to a File” on Page 416 and “How Can I Export and 
Import Tables?” on Page 427.
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2 Choose Copy as picture / to file... from the Diagram menu. The Copy To File As Picture 
dialog appears:

Figure 10-36: Copy To File As Picture dialog

3 Click the Destination... command button to select the filename from the file dialog.

4 In the Format area, select the file format. 

5 Click OK. 

The diagram will be saved in a file with the specified format. This file can then be inserted in a 
document as a picture or published on a Web page.

10.23.2 Copying a Diagram to the Clipboard

If you want to use a GRADE diagram in another Windows program, you can transfer it via the 
Windows clipboard in Windows metafile (WMF) or bitmap (BMP) format.

Proceed as follows:

1 Open the diagram you want to copy.

2 Choose Copy as picture / to clipboard / Diagram... from the Diagram menu.
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3 The Copy To Clipboard As Picture dialog appears.

Figure 10-37: Copy To Clipboard As Picture dialog

4 Select the file format in which you want to copy the diagram to the clipboard by 
marking the appropriate radio button.

5 Determine whether the picture is to be in color or black and white and mark the 
appropriate radio button.

6 Confirm your entries with OK or terminate the action with Cancel.

The diagram is copied to the clipboard in the selected format and remains there available for 
input into another Microsoft Windows application (for example, by using Ctrl+V) until you 
copy something else to the clipboard. More details about use of the clipboard can be found in 
your Microsoft Windows manual.

An alternative to copying the diagram into the document is to create a link from the document 
into GRADE; see “How Can I Create a Link Between a Document and a GRADE Diagram?” 
on Page 401.

10.23.3 Exporting a Model/Subtree in HTML Format

Exporting models or subtrees in HTML (Hypertext Markup Language) format is useful if you 
want to share the results of your work with others via intranet/Internet.

The export process consists of two stages:

1 exporting the model or subtree,

2 exporting the model dictionary.

Proceed as follows:

1 With the model tree displayed, activate (click) the root diagram of the subtree to be 
exported. If you want to export the entire model, it does not matter which diagram is 
activated.
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2 Choose the Export in HTML format command from the Model menu.

3 Depending on what you want to export, select either model... or subtree... 

4 The Customize Your HTML Files dialog appears:

Figure 10-38: Dialog for customizing HTML files

5 Click OK, or, if needed, change the settings, then click OK. (See also “Customizing Your 
HTML Files” on Page 423.)
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6 An Export in HTML Format dialog appears:

Figure 10-39: Dialog for exporting models, subtrees in HTML format

Leave the default path as is, or specify another directory (folder) in which you want to store the 
exported model or subtree.

7 Confirm your entry by clicking OK.

8 After you have exported the model (or a subtree of it) as a collection of HTML pages, 
you can add the model’s dictionary page to this collection. Open the dictionary window 
and adjust the filter as needed. (See “Changing the Filter Settings” on Page 409 and 
“Explanation of the Dictionary Filter Dialog” on Page 409.)

9 Choose the Export in HTML format... command from the Dictionary menu. The 
Customize Your HTML Files dialog appears. Click OK, or, if needed, change the default 
settings. The Export in HTML Format dialog appears. 

10In this dialog, confirm the default path by clicking OK (or select or enter another path, 
then click OK). 

The exported directory contains the following files:

1 The index.htm file, which contains the list of the exported diagrams. You can use this file 
as a starting point for navigating in the model via browser.

2 Other htm and gif files (one htm and one gif per diagram).

3 If you exported the model dictionary, you will find it in the dict.htm file. You can use 
this file as an alternative starting point for navigating in the model via browser.
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4 If you chose to create the catalog.htm file (see below), it will appear here and contain a 
list of any exported class diagrams; the class names defined in these diagrams; class 
bookmarks, which will force navigation from CL diagram class symbols to this text file; 
and, when available, class descriptions from the corresponding glossary entries.

Customizing Your HTML Files

When exporting a model or subtree in HTML format, you can specify the following features of 
your HTML pages in the Customize Your HTML Files dialog:

• Export of the GLO, STE and TAG tables. By default, GRADE does not export these tables. 
To export any of them, mark the corresponding check box.

• Show...diagram types, links to glossary or links to dictionary. By default, GRADE displays only 
the diagram name and the link to a diagram list at the top of diagram pages. To include the 
diagram type (e.g., BUSINESS PROCESS Check_Order), and/or the links to a GLO table or 
dictionary, mark the corresponding check boxes.

• Allow navigation to dictionary. Normally, GRADE lets you navigate from name references to 
name definitions. If an appropriate name definition cannot be found in the model, GRADE 
either does nothing (by default) or lets you navigate to the dictionary (if you have enabled 
the Allow navigation to dictionary check box).

• Allow navigation to TDs. When, in an exported BP diagram, you click on a task occurrence, 
GRADE attempts to navigate to the BP diagram of the corresponding task. If such a diagram 
does not exist, GRADE either does nothing (the default) or lets you navigate to the TD 
diagram of the task (if you have enabled the Allow navigation to TDs check box).

• In ORGs, navigate to ORGs only. When, in an ORG diagram, you click on a diagram element, 
GRADE either does nothing or lets you navigate to the dictionary (by default), or it attempts 
to navigate to an element in another ORG diagram having the same name and task (if this 
is your preference, mark the check box).

• Use catalog.htm. Mark this check box if you wish  to generate the text file catalog.htm, which 
contains the list of exported CL diagrams; class names defined in these diagrams; class 
bookmarks, which will force navigation from CL diagram class symbols to this text file; and 
(when available) class descriptions from the corresponding glossary entries.

• HTML file extension. The default file extension for HTML pages is htm. You can change it 
to html, shtml, etc. Note, however, that if you choose an extension containing 4 or more 
letters (for example, html), then GRADE will create all HTML files by using only the first 3 
letters, and you will need to rename all generated files manually. In HTML links GRADE 
will use your extension setting as is (i.e., completely).

• <TITLE>. This will define the title to appear at the top of the browser window. You must 
follow HTML syntax and include the tags <TITLE> and </TITLE>.

• <BODY>. By default, GRADE inserts into each file the following BODY statement: 
<BODY BGCOLOR="#ffffff" LINK="#0000ff" VLINK="#ff0000" ALINK="#ff0000" 
TEXT="#000000">. These 4 RGB constants mean that the background color = white, text 
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color = black, links = blue, visited links = red. You can change the colors as needed (but do 
not ignore HTML syntax!). After <BODY …> you can append any syntactically correct 
HTML text, which will appear at the top of the file.

• </BODY>. By default, GRADE inserts simply </BODY> into each file. You can place any 
syntactically correct HTML text in front of it to create a text at the bottom of the file.

GRADE will save these settings in the file grahtml.ini in your Windows folder each time you 
click the OK button of the dialog.

Instead of changing these settings each time via the dialog, you can enter your standard choices 
in the file grahtml.ini. Here, 0 means that this option is turned off; 1 means that it is turned on 
(e.g., use ExportGLO=1 to ensure that the GLO table is exported). By default, the grahtml.ini 
file looks like this:

[HTML]
ExportGLO=0
ExportSTE=0
ExportTAG=0
ShowDgrType=0
ShowLinkGLO=0
ShowLinkDICT=0
NavigDICT=0
NavigTD=0
NavigORGNames=0
UseCatalog=0
Extension=htm
TITLE=<TITLE>GRADE Modeler 4.0 Diagram</TITLE>
StartBODY=<BODY BGCOLOR="#ffffff" LINK="#0000ff" VLINK="#ff0000" 
ALINK="#ff0000" 
TEXT="#000000">xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

GRADE will use your settings instead of its own defaults. Do not create line breaks within value 
fields.
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The following figure shows an HTML page created by GRADE from a class diagram of a bank. 
This is how it appears in a Web browser:

Figure 10-40: GRADE diagram as seen in Web browser

10.23.4 Exporting and Importing Diagrams, Models in Export/Import Format

You can export diagrams, subtrees, or entire models in Export/Import (EI) format. These can 
then be imported into other models.

To export an entire model or subtree in EI format, proceed as follows:

1 Activate the model-tree window and, if you want to export a subtree, activate (click) the 
root diagram of that subtree.

2 Choose Export in EI format from the Model menu, then the model... or subtree... 
command.

3 The Export in EI Format dialog appears. Here, enter the path of the folder (directory) in 
which you want to store the exported model or subtree. You can also use the list to select 
the desired folder.

4 Confirm your entries by clicking OK.
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To export a diagram in EI format, proceed as follows:

1 Open the model window and activate (click) the diagram that you want to export.

2 Choose Export in EI format from the Model menu, then diagram...

3 The Export diagram in EI format dialog appears.

4 In this dialog, enter the file name (including the complete path) for the file in which the 
diagram is to be stored. GRADE suggests .eif as the default extension. You also can use 
the list to select the desired folder.

5 Confirm your entry by clicking OK.

Note that GRADE lets you import exported models and diagrams for data exchange.

If a model or subtree has been stored in export/import (EI) format and you want to incorporate 
in into another model (it may be an empty model), proceed as follows:

1 Open the model tree into which you want to import a model or subtree. 

2 If you are planning to import a subtree and make it subordinate to an existing element 
in the model, select that element. (For example, you can import a new class diagram that 
will be part of an existing package; in that case, click the corresponding package symbol.) 
If you want your new subtree to replace an existing one, select the existing one. 

3 Choose Import in EI format from the Model menu, then model... or subtree...

4 If you are importing a subtree, you must now decide whether you want it to be an 
independent element in the model (choose As free...), whether you want it to be 
subordinated to the current (activated) model element (choose Under current 
diagram...), or whether you want it to replace the selected element (choose Replace 
current subtree...).

5 The Import from EI Format dialog appears. Use the Directories list to select the directory 
(folder) from which the model or subtree is to be imported. (Click the drive where it is 
to be found, then on the folder, etc.)

6 Confirm your entry by clicking OK.

If a diagram has been saved in EI format and you wish to incorporate it into a model, proceed 
as follows:

1 Open the model tree of the model into which you want to import the diagram.

2 If you want to import the diagram to a specific location in the model tree or replace an 
existing diagram, activate the diagram in the model tree under which or in place of 
which the new diagram should be positioned.

3 Choose Import in EI format from the Model menu, then choose diagram. 

4 Depending on how you wish to incorporate the diagram into the model tree, select 
either As free..., Under current diagram..., or Replace current diagram...
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5 The Import diagram in EI format dialog appears. Here, select the file to be imported.

Click OK.

10.23.5 Export in the Object Definition Language of the Object Database 
Standard ODMG

CL diagrams can be exported in the Object Definition Language of the Object Database 
Standard ODMG.

Proceed as follows:

1 With the model tree open, select the CL diagram that you want to export.

2 Open the Tools menu, then activate the Export CL in ODMG ODL... command.

3 Select the desired folder, then click OK.

10.24 How Can I Export and Import Tables?

To use the contents of a GRADE table in another program as textual material, you can export 
the table to a file or to the clipboard in rich text format (RTF) or in “text-only” format (TXT, 
with tabs and line breaks).

RTF format can be used to export tables, for example, to Microsoft Word, and the TXT format, 
to export tables, for example, to Microsoft Excel.

Exporting Tables

Proceed as follows:

1 Open the window of the table you want to export.

2 Open the Edit menu and select the Export in text format or the Export in RT format 
command.

3 Then select to file... or to clipboard.

4 If you selected the to file... option, you will need to select the file to which the table will 
be copied. Then click OK.

If you saved a table to the clipboard, you can then paste it into another document (e.g., by 
pressing Ctrl+V). If you saved it to a file, you can then import the file into another document.
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Importing Tables from Text Files

You can import table rows from a file that has been prepared in the “text-only” format (TXT, 
with tabs as cell delimiters and line breaks as row delimiters).

Proceed as follows:

1 Open a GRADE table and select Import from text file... from the Edit menu. A standard 
file selection dialog appears.

2 Select the desired path and file name and confirm your entries with OK, or terminate 
the action with Cancel.

To import table rows from a table prepared in Microsoft Excel you must first save the Excel 
spreadsheet as text.

You also can import a table from a text file that was obtained by exporting a GRADE table to 
TXT format (as described above).

10.25 What Other Operations Can Be Performed With GRADE 
Tables?

Activating Parts of Tables

When a table is open, a cell (and therefore also the corresponding row) is always activated. The 
currently active row is displayed in red, while the currently active cell of it is indicated by a gray 
frame.

Selected rows are displayed in blue. Use Ctrl and a mouse click or press the spacebar to 
select/deselect a row; press Esc to deselect all selected rows and close the table.

Be careful when preparing text files for import: The columns and column ordering in your text 
file must correspond exactly to the ordering of the table elements as shown in the Table Column 
Settings dialog (to view this, open the GRADE table, then select Column settings... from the 
Options menu). Note that the sequence numbers in the Table Column Settings dialog are ignored 
for purposes of importing. Hence, your file must contain all of the possible columns of the target 
GRADE table, including the invisible ones. Only the last columns, which are always empty, can 
be omitted.

For example, a table to be imported into an event table (ET) should have the following column 
content: Event name, Alt. name, Category, Data type, Persistence interval, Transfer time, 
Description. The file may or may not contain the column headings. These will be ignored and 
taken from the Column Settings window of the GRADE Modeler.
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After syntax analysis (see the Simulation Guide), erroneous rows are marked in green; erroneous 
cells are indicated by blue frames.

You can change the active table row as follows:

The active cell within the table row may be changed as follows:

Inserting and Deleting Table Rows

There are various ways to delete table rows:

• To delete the active row, press the Del key. (Or open the Edit menu and select Delete.) 
Confirm with Yes.

• To delete several rows, select them (use Ctrl + a mouse click, or press the spacebar to 
select/deselect the active row), press the Del key (or use Edit-Delete), and answer Yes to the 
confirmation query.

There are various ways to insert new table rows:

• To insert a new row after the activated row, select Insert row... from the Edit menu.

• You may alternatively insert a new row: a) by clicking with the right mouse button on a table 
row and selecting Insert row... from the pop-up menu, b) by clicking the New Row symbol in 
the symbol palette, or c) by pressing the Ins key.

Direction Operation

Forward/Next Click the appropriate cell, press the downward arrow key

Backward/Previous Click the appropriate cell, press the upward arrow key 

Move 15 rows forward Press the Page Down key

Move 15 rows backward Press the Page Up key

Go to first row Press Ctrl+Home

Go to last row Press Ctrl+End

Table 10-7: Activating table rows

Direction Operation

Forward/Next cell on right Click the appropriate cell, press right arrow key or Tab

Backward/Next cell on left Click the appropriate cell, press the left arrow key or Shift+Tab

Go to first cell in row Press Home

Go to last cell in row Press End

Table 10-8: Activating a cell within a table row
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Editing Table Contents

To define or modify the contents of the active table row, select Edit row... from the Edit menu. 
Alternatively, you may open the edit dialog by clicking with the right mouse button on the table 
row, and selecting Edit row... from the pop-up menu. Make your entries, then click OK.

Hiding Table Columns

Proceed as follows:

1 Select Column settings... from the Options menu. The Table Column Settings... dialog 
appears.

2 Switch the Visible check boxes on or off as desired and click OK. The table appears as 
required.

The modified settings apply to all tables of the same type and they are saved with the user 
configuration file (i.e., they remain in effect for all subsequent work sessions until you change 
them).

Filtering Table Rows

By default, all table rows are visible in the table window. You can filter out table rows according 
to the values appearing in particular columns.

Proceed as follows:

1 Select Set filter... from the Options menu. The Filter dialog appears.

2 Make your entries/selections and click OK. The filtered table appears in the window.

The modified settings apply to all tables of the same type and they are saved with the user 
configuration file (i.e., they remain in effect for all subsequent work sessions until you change 
them).

The following table explains what you will see/what you can enter in the Filter dialog.

Dialog Element Function

Filter pattern Enter any character string, *string, string* or *string* (where * is used as a placeholder). 
Enter the pattern string directly or with the aid of the Pick name button. For example, 
if you enter t*, your table will display only rows that begin with the letter t.

Show empty If this is switched on, you will be able to see rows having no values in this column.

Show non-empty Switch off if you do not wish to see rows having values in this column. 

Table 10-9: Elements in the table filter dialog
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Rearranging (Sorting) Table Rows

By default, table rows appear sorted by object names. You can rearrange the rows based on the 
values appearing in any given column in ascending order (for example, if the column contains 
words, the rows will be sorted in alphabetical order from A-Z).

Proceed as follows:

1 Select Column settings... from the Options menu. The Table Column Settings dialog 
appears.

2 Click the Sort by radio button identifying the desired column and press OK. The table 
rows appear in the required order.

The modified settings apply to all tables of the same type and they are saved with the user 
configuration file (i.e., they remain in effect for all subsequent work sessions until you change 
them).

Grouping Table Rows

You can rearrange the rows of a table in subtables in ascending order based on the values 
appearing in a given column.

Proceed as follows:

1 Select Column settings... from the Options menu. The Table Column Settings dialog 
appears.

2 Click the Group by radio button identifying the desired column.

3 If necessary, hide the column (switch off the Visible check box identifying it).

4 Click OK. The table rows appear grouped in subtables.

Errors only Switch on if you wish to see only those rows that have errors in them. 

Selected only Switch on if you wish to see the selected rows only (use Ctrl + a mouse click or press the 
spacebar to select/deselect a row). 

Data type table Switch off if you wish to see only record field lists (applicable to DD table forms only) 

RECORDs Switch off if you do not wish to see record field lists (applicable to DD table forms only) 

Set default values Click this button to replace all filter-data values with the standard values.

Dialog Element Function

Table 10-9: Elements in the table filter dialog
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The modified settings apply to all tables of the same type and they are saved with the user 
configuration file (i.e., they remain in effect for all subsequent work sessions until you change 
them).

Changing Table Column Widths

Open the table in question and proceed as follows:

1 Move the cursor to the desired column separator.

2 Hold down the left mouse button.

3 Move the mouse to the left or right, and when the desired column width is achieved, 
release the button.

Here is an alternative way to change table column width:

1 Open the table.

2 Select Column settings... from the Options menu. The Table Column Settings dialog 
appears.

3 Enter the desired Width values and click OK.

The modified settings apply to all tables of the same type and they are saved with the user 
configuration file (i.e., they remain in effect for all subsequent work sessions until you change 
them).

Changing Table Column Titles

To change table column titles, proceed as follows:

1 Open the table.

2 Select Column settings... from the Options menu. The Table Column Settings dialog 
appears.

3 Make the desired entries in the Title field(s) and click OK.

The modified settings apply to all tables of the same type and they are saved with the user 
configuration file (i.e., they remain in effect for all subsequent work sessions until you change 
them).
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Changing the Sequence of Table Columns

To change the order of the table columns, proceed as follows:

1 Open the table.

2 Select Column settings... from the Options menu. The Table Column Settings dialog 
appears.

3 Enter the desired Sequence values (assign 1 to the column that is to be farthest left, 2 to 
the next column, etc.) and click OK.

The modified settings apply to all tables of the same type and they are saved with the user 
configuration file (i.e., they remain in effect for all subsequent work sessions until you change 
them).

Numbering Table Rows

To add numbers to table rows, proceed as follows:

1 Open the table.

2 Select Column settings... from the Options menu. The Table Column Settings dialog 
appears.

3 Switch on the Show row numbers check box and click OK.

The modified settings apply to all tables of the same type and they are saved with the user 
configuration file (i.e., they remain in effect for all subsequent work sessions until you change 
them).

10.26 How Can I Create a Diagram?

As mentioned earlier, the process of adding new diagrams to a model is often automatic. For 
example, when you add a class-diagram symbol to a package, the model tree will be updated 
automatically to display the new CL diagram. However, some diagram types, for example, a new 
top-level business process (BP) diagram, must be created by you.

To do this, carry out the following steps:

1 Select the appropriate existing parent diagram as the current one. For example, to enter 
a new top-level task, make the BM diagram the current one.
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2 Then click the New diagram button:

3 The Define dialog box appears, as seen in the following figure:

Figure 10-41: Define dialog

4 The Diagrams tab should appear on top, as seen in the previous figure. If it is not, click 
the word Diagrams.

5 Select the diagram type (for example, ORG or ER MODEL), by marking one of the radio 
buttons.

6 Enter the name of the new diagram in the Name field.

7 Close the dialog window by clicking the Define button; the new diagram appears in the 
model tree. (If you would like to define the diagram and immediately open it for editing, 
click the Define & Open button.)

Not every diagram type can be created in this way. Some diagram types (for example, CO) can 
be created only by adding a symbol in the superordinate diagram. All diagram types, including 
CO, can be created as free diagrams, however.
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Inserting a New, Free Diagram

To insert a “free” diagram (one that is not linked to the rest of the model tree), follow the steps 
above, starting with Step 2. After Step 4, open the combo box entitled Parent diagram by 
clicking the downward arrow at the right, then select FREE. Continue with Steps 5-7.

10.27 How Do I Create a Repository?

Most users will start with the repository created during installation (by default 
C:\Grade4\Reposit) and create new ones when necessary to better organize their models.

If you want to create another repository, proceed as follows:

1 Close all models and diagrams by using the 

button.

2 Close the active repository by opening the Repository menu and selecting Close repository. 
You will now be in the main GRADE window:

Figure 10-42: GRADE main window
Tips and Tricks 435 

• 
• 
• 
•
•
•



436 

• 
• 
• 
•
•
•

3 Select the Repository menu, then Create repository... The Create repository box appears, as 
seen in the following figure: 

Figure 10-43: Create repository dialog box

4 In the New path field, enter the full path, including the name, of the new repository (for 
example, C:\REPOSIT2). The name must not already exist, must not exceed 8 
characters and must not include blanks. Then click OK.

Avoid storing repositories within one another, as GRADE may have difficulty locating a 
repository that is hidden within another valid repository. Also, do not store a repository in any 
directory in which the directory names exceed eight characters or include blanks.

Now you can select the repository to be opened from a list, as described in Section “Starting a 
GRADE Session” on Page 16. You can access only one repository at a time. You can have many 
models open at the same time, but they all must be stored in the same repository.
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10.28 How Can I Use GRADE to Generate Reports?

GRADE offers a basic reporting functionality, allowing you to view various types of data in the 
form of tables and export these tables as text.

You can export glossaries (GLO), class definition tables (CLA), stereotype tables (STE), event 
tables (ET), competencies tables (CMP) and other types of tables to a file in RTF (rich text 
format). Then open a Microsoft Word document and import the file. For more information, 
see “How Can I Export and Import Tables?” on Page 427.

To generate a report based on the model dictionary, export it (or a fragment thereof) in text 
format, as described in “Exporting the Dictionary to a File” on Page 416. The resulting table 
first must be imported into Microsoft Excel. There, you can delete any unnecessary columns 
and extraneous formatting. Then copy the relevant part to a Microsoft Word document as a 
normal table. The main advantage of using the dictionary is the various filter settings available; 
see “Explanation of the Dictionary Filter Dialog” on Page 409.

Once you have exported the desired data to tables, you may need to combine the tables in 
Microsoft Word to obtain the report you need.
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Below, we describe typical report types that can be generated via GRADE:

1 Classes in a package. This report can be obtained directly from the corresponding CLA 
table. Export it to a file in RTF, then open it in Word and delete any unnecessary 
columns (by default, all columns are displayed). 
Here, you see part of a report generated from our Automatic Teller Machine example; it 
displays classes found in the ATM Object Model package:

Table 10-10: Fragment of a report exported from a CLA

2 Name definitions from glossary. The model glossary can be exported in RTF in a ready-
to-use format, for example:

Account
Account: a single bank account that can be involved in various transactions. Accounts 
may be of different types; at a minimum, we assume there are checking or savings 
accounts. A customer can hold more than one account.

ATM
ATM: A station that allows customers to enter their own transactions using ATM cards 
as identification. The ATM interacts with the customer to gather transaction 
information, then sends this information to the central computer for validation; if the 
transaction is approved, the ATM dispenses cash to the customer. We assume that an 
ATM need not operate independently of the network.

Glossary data may be combined with class lists.

Class Name Stereotype Attributes

Account balance
credit_limit
type

ATM cash_on_hand
dispensed

ATM_Card bank_code
card_number

Bank name

Bank computer

Card authorization data PIN
limit
expiration_date

Cashier Actor name
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3 Model’s complete class list, including the package where each class is defined. This 
report can be obtained from the model dictionary. Set the dictionary filter as follows:
Scan definitions
Show definitions
Choose type – check Class entry
Scope – Entire Model

Then export the dictionary to a file in text format. Import the text file into Microsoft 
Excel (i.e., into an Excel spreadsheet), delete any unnecessary columns, then copy the 
relevant part to a Microsoft Word document (you automatically obtain a table in Word).

Here is an example of such a class list:

Table 10-11: Class list from dictionary

GRADE lets you generate many similar types of reports.

Name Diagram

Accepted PACKAGE Domain Objects Conceptual

Aircraft PACKAGE Database

Aircraft PACKAGE Domain Objects Conceptual

Aircraft PACKAGE Domain Objects Ready for C++

Airline PACKAGE Database

Airline PACKAGE Domain Objects Conceptual

Airline PACKAGE Domain Objects Ready for C++
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Appendix A: Overview of GRADE Diagrams

Let us assume that you are just about to start modeling a real-life system and want to see at a 
glance what types of diagrams are available to you, depending on your approach. Take a look at 
the following tables.

The first table lists diagram types available for business models; the second shows you your 
possibilities for object modeling; the third is for system models; and the fourth is for component 
modeling. In the fifth table, you will see diagrams that can be used with all types of approaches.

�
Note that the following tables include only the most essential diagram types used for GRADE 
modeling and simulation.

For information about other types of diagrams and for definitions of any unfamiliar terms, 
please see “Appendix B: Glossary” on Page 443.
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Business Modeling Diagrams

Abbreviation Name and Explanation

AT Access table; specifies access rights to database entities

ATR Attribute table; specifies attributes associated with a task type (for more information about 
ATR tables, see the Simulation Guide)

BM Business model diagram; the top diagram in the business modeling subtree; may contain 
comments concerning the model

BP Business process diagram; represents the flow of tasks; allows for the representation of 
complex tasks as combinations of simpler tasks and messages sent between them

CMP Competencies table; lists competencies, skills, authorities and qualifications of ORG 
elements/performers

ER Entity-relationship diagram; represents relationships among entities as well as database and 
data-store structures

ET Event table; describes all named events appearing in a business model

ORG Organizational/resource structure diagram; represents the structure of organizational 
units, resources, etc.

PD Process diagram; used in the context of a business model to informally describe how a task 
is performed

SP Simulation parameter table; defines the parameters to be used during the simulation of a 
model (for details, see the Simulation Guide)

TD Task details diagram; describes all properties of a task and its possible links to other tasks

VT Variable table; supports the use of global variables during business model simulation (for 
details, see the Simulation Guide)
 



Object Modeling Diagrams

Abbreviation Name and Explanation

CL Class diagram; describes the conceptual structure of a system by representing structural 
objects, behavioral objects, data objects, etc., and their relationships in a single diagram.

CLA Class definition table; contains definitions of all classes belonging to the corresponding 
package.

PCK Package diagram; used as a “folder” for an object model; each package consists of zero or 
more nested packages and zero or more CL diagrams.

TAG Tag table; lists tags used in CL diagrams. For example, if you are drawing a diagram in 
which object symbols represent computers, you could open the tag table and specify an 
object-symbol tag named Monitor size having values up to 17”. When creating a new object 
symbol, you simply select this tag in the dialog window, confirm your selection, then fill 
in the desired value.

View In the case of a large CL diagram, it is sometimes convenient to define a part of that 
diagram as a separate “view.” Views are represented in the model tree as CL diagrams 
marked View. 
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System Modeling Diagrams

Abbreviation Name and Explanation

AT Access table; defines access rights to database entities

CO Communicating objects diagram; contains communicating objects (active objects) and 
communication paths. A communicating object represents a real, physical entity that 
performs some activity. A communication path joins two communicating objects, 
indicating some communication, i.e., exchange of passive (transfer) objects. 

ER Entity-relationship diagram; represents relationships among entities as well as database and 
data-store structures

PD Process diagram; in a system model, depicts the behavior of an active object in a system

SD Specification diagram; describes the external interface of procedures and functions, as well 
as modules

TO Transfer object table; displays the contents of communication in a CO

VT Variable table; supports the use of global variables (for details, see the Simulation Guide)
 



Component Modeling Diagrams

Abbreviation Name and Explanation

BP Business process diagram; typically used in a component model to reflect processes that the 
customer initiates online, such as applying for a loan.

CL Class diagram; describes the conceptual structure of a system by representing structural 
objects, behavioral objects, data objects, etc., and their relationships in a single diagram.

CLA Class definition table; contains definitions of all classes belonging to the corresponding 
package.

DD Data definition diagram; reflects data structures.

ER Entity-relationship diagram; represents relationships among entities as well as database and 
data-store structures

PCK Package diagram; used as a “folder”; each package consists of zero or more nested packages 
and zero or more CL diagrams.
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General-Use Diagrams

Abbreviation Name and Explanation

CMT Comment diagram; may contain comments about other diagrams

DD Data definition diagram; used to define data structures

EXT External link table; a table for storing external links, e.g., you can link an icon in your 
diagram to a Web site or a document.

GLO Glossary table; information about the GRADE model can be entered here, i.e., you can 
enter names found in the GRADE model, then add definitions, descriptions or comments.

GSF Graphical screen form diagram; used to prototype the user interfaces of software 
applications

PIC Table of pictures; a table containing WMF, GIF, and/or BMP graphics that can be used to 
enhance diagrams.

PRE Presentation diagram; used in the creation of talking presentations.

STE Stereotype table; lists all stereotypes defined in a model. For example, you can define a 
stereotype as a class symbol named document, specify its description as confidential and its 
style as a blue parallelogram. When creating class symbols, you simply select this 
stereotype, and the desired type of symbol will appear in the diagram.

TAB Custom table; a user-defined table that can contain up to nine columns.
 



Appendix B: Glossary

This is a guide to the terminology used by the GRADE family of modeling tools and in the 
corresponding documentation.

Terms printed in Arial (this font) are cross-referenced.

Term Definition

abstract fork In CL diagrams, a fork (an association symbol) whose meaning can be defined by the 
user

abstract line In CL and PCK diagrams, a line whose meaning can be defined by the user

AC An activity; in the context of the GRADE Registrator, AC is one of the five types of 
objects used. An AC contains procedures, tasks, etc., performed by active objects. 
passive objects can be manipulated and processed by these functions.

access path In the context of BP diagrams, a line that connects tasks to data stores and data
objects. In the context of CO diagrams, it connects an object to a database.

access rights In the context of GRADE, access rights are privileges for viewing/changing 
information; for example, if an active object has delete access rights for a particular 
entity in a database, the active object can delete instances of that entity. By contrast, 
read rights would mean that the active object merely can “read” (view) the entity.

access table See AT.

activate In GRADE diagrams, you can activate a symbol by clicking it with your left mouse 
button. Activation is usually the initial step before resizing or repositioning a symbol, 
deleting or copying it or changing its contents. An activated symbol appears in a red 
frame. (In the context of prototyping, activation has a different meaning; see also 
activation path.)

activation path Used in CO diagrams for prototyping purposes; any activated object can activate 
another object via an activation path.

active object In the context of system modeling, an active object is a bounded part of the physical 
world that is capable of performing a process, i.e., receiving inputs, acting upon them 
and producing outputs for other active objects. Typical examples are companies, 
departments within companies, information systems, machines, as well as any 
combination of these. In the context of the GRADE Registrator, the abbreviation AO 
is used.
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activity In the context of GRADE, an activity is a task or group of tasks executed by one or 
more performers. In the GRADE Registrator, an activity is abbreviated as AC.

Administrator A utility that is installed as part of the multi-user version of GRADE. The 
Administrator is used for managing and controlling a shared model-development 
process. Via the Administrator, the project leader can specify who has what type of 
access to which model (or other “software object”) using which tool.

aggregation In CL diagrams, an aggregation is an “is part of” relationship connecting one or more 
“part classes” to a “container” or “assembly” class. For example, in a CL diagram of a 
department, the employees, the building and the equipment all could be connected to 
the department itself via an aggregation (part association). In an aggregation symbol, 
a diamond points to the assembly class.

alphanumeric screen form See ASF.

alternative In the diagram definition window, select the Alternative diagram type to create an 
alternative version of a BP diagram.

alternative name In the context of GRADE, you can enter an alternative name for a symbol or diagram 
to provide another way of referring to it. This is especially useful if you want to 
abbreviate a long name. For example, you might name a symbol the High Value Auto 
Parts Company and give it the alternative name HVAPC.

analyze syntax This GRADE function can be used to check a model or part of a model to find possible 
syntax errors. Correct syntax, i.e., adherence to formal guidelines for model definition, 
is important if you plan to use a model for simulation or prototyping.

anchorline A dashed-line connector used in CL diagrams. Straight anchorlines connect note 
symbols to class, object or N-ary association symbols. A slope anchorline can be 
used to connect boxes to lines, i.e., a class, object, N-ary relationship or note to an 
association, subclass association, part association, dependency or straight 
anchorline symbol. In PCK diagrams, anchorlines connect a note to a class diagram
symbol, a package or another note; slope anchorlines connect a class diagram 
symbol, package or note to a dependency, anchorline or abstract line.

animation A GRADE feature that allows you to view the operation of your model “live” on your 
computer screen. You can see which tasks are active and how events flow through the 
system.

AO An active object; in the context of the GRADE Registrator, AOs perform tasks, 
carry out procedures, etc.

array data type An aggregate that consists of data objects with identical attributes, each of which may 
be uniquely referenced by subscripting (indexes); used in DD diagrams

array dimension For each array type in a DD diagram, one or more index ranges may be specified, one 
index range for each array “dimension.” To help you understand what is meant by a 
dimension of an array, imagine a U.S. city in which there are numbered streets 
intersected by numbered avenues. In this situation, you could define one dimension as 
being 6th Street through 47th Street (index 6..47); another dimension could be 
defined as 12th Avenue through 28th Avenue (12..28).

Term Definition
 



ASCII American Standard Code for Information Interchange; used for standardizing the 
transmission of data to achieve hardware and software compatibility. 

ASF Stands for alphanumeric screen form; if you are modeling an “old style” software 
system in GRADE, you can use ASF diagrams to prototype the user interface. An ASF 
consists of characters arranged in rows and columns.

assign In the context of PD diagrams, the assign symbol can informally describe a process 
step or formally assign the value of an expression to a variable (e.g., Total Price := 
Amount * Item_Price).

association In CL diagrams, associations are used to establish relationships between classes or 
objects. A binary association appears as a simple line, while an N-ary association 
has a hexagon at its hub. The ends of association lines may be marked by crowfeet
notation or UML notation, indicating cardinality. An association between two classes 
is known as a binary association; an association between two objects is known as a 
binary link.

ASYN Asynchronous transmission; in the context of system modeling, this means that a 
transfer object will be sent whenever the sender is ready, without regard as to whether 
the receiver is ready to receive it.

asynchronous transmission See ASYN.

AT Access table; may be used in a business model or system model to define access rights 
to databases

atomic data type A data type that gives a new name to an existing data type and possibly adds new 
constraints. This is known as a “simple” or “non-structured” data type because it 
defines a single value. 

ATR An attribute table; specifies user-defined task attributes associated with a task type; 
used in business models

attribute table See ATR.

autoactivated In the context of CO diagrams, an object or object type instance that is 
autoactivated will be started automatically during test runs of the diagram 
(prototyping).

Automatic layout GRADE-controlled layout style aimed at “keeping order” in diagrams and optimizing 
their appearance

automatic syntax prompter In PD diagrams, this is available to help you create symbols with valid formal syntax.

Automatic with oblique lines See Oblique semiauto.

binary association See association.

binary link See association.

Term Definition
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BM Business model/business modeling; in a broad sense, this refers to the modeling of a 
sociotechnological system, which is a part of the real world, usually a business 
enterprise or part of it, typically consisting of people, computers, communications, 
etc., unified to achieve a common goal.

In a narrower sense, BM refers to the BM subtree of a GRADE model, where a system 
is represented from a business-process point of view.

And in the narrowest sense, BM refers to a BM diagram, which is the top diagram in 
the business modeling subtree. It may contain comments concerning the model.

BMP Bitmap format (for graphics)

BNF Backus Naur Form; a generally accepted format for syntax notation introduced by J. 
Backus and P. Naur

body In the context of PDs, a body is a part of a structured symbol that contains other 
symbols.

Boolean constant In the context of GRADE, either of the reserved words TRUE or FALSE, or a 
constant of type BOOLEAN specified in a VT.

BOOLEAN data type This is one of GRADE’s predefined data types. Contains two predefined values, 
TRUE or FALSE, which are both reserved keywords in GRADE. See also Boolean
expression/Boolean formula.

Boolean expression/Boolean 
formula

In GRADE, these terms are used synonymously; this expression/formula can have 
two possible outcomes: TRUE or FALSE. Such an expression/formula can be used, for 
example, to specify a triggering condition.

BP Business process diagram; represents a task, which may be very simple or very 
complex; BPs are used in business models.

BPR Business process re-engineering

breakpoint A breakpoint is a condition that, when fulfilled, interrupts the simulation of the 
GRADE model and allows you to examine this model. You have various possibilities 
for specifying the breakpoint; it can be a certain moment in model time, can reoccur 
at specified intervals, or can occur when certain requirements have been fulfilled (e.g., 
a given task has been initiated a specified number of times). Breakpoints also can be 
used when prototyping models.

business model/business 
modeling

See BM.

business process diagram See BP.

cardinality Represents a number or range of numbers; e.g., 1..N is used to represent a cardinality 
of one or more. In CL diagrams, cardinalities can be represented by crowfeet notation 
or UML notation.

case In PD diagrams, case is similar to the decision symbol, but more generic, with 1..N 
outputs.
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channel In the context of system modeling, objects communicate with each other via 
channels. While communication paths indicate communication, channels describe 
this communication. A channel generally connects two active objects: the sender 
and the receiver. Each channel transmits a particular message type in a particular 
direction.

CHAR constant See CHAR data type.

CHAR data type This is one of GRADE’s predefined data types. The value range of CHAR data types 
comprises all single characters belonging to the extended ASCII character set, or, more 
precisely, all characters of ASCII codes 1 through 253. The constants of this data type 
can be all individual printable characters except the quotation mark. Quotation marks 
are used to enclose CHAR constants.

character set The entire range of characters that may be used in GRADE: the letters a-z and A-Z, 
the digits 0-9, and the following special characters: + - * / \ # $ < > = _ . , ; : ( ) ^ & [ 
] { }. In most cases, certain restrictions apply to your choice of characters (see also 
identifier). Exceptions to this rule are comments and STRING constants; here, you 
have free choice of the characters used.

CL A class diagram; describes the conceptual structure of a system by representing the 
structural objects, behavioral objects, data objects and their relationships in a single 
diagram. CL diagrams are used in object modeling. See also class.

CLA A class definition table; contains definitions of all classes belonging to the 
corresponding package. CLAs are used in object modeling and appear adjacent to 
PCK symbols in the model tree.

class Classes in CL diagrams may represent data, concepts, physical objects, individuals, 
organizational units, etc.

class diagram symbol Used in PCK diagrams to represent a CL diagram.

clipboard A temporary storage site. For example, you can copy a symbol to a clipboard, then 
paste the symbol from the clipboard into another diagram of the same type.

cluster In a diagram, these are the elements that seem to belong together. By using the 
Oblique semiauto layout option and the Reposition command, you can rearrange 
your diagram so that the clusters become more apparent.

CMP A competencies table; lists possible competencies, skills, authorities and 
qualifications of ORG elements/performers

CMT A comment diagram; may contain extensive comments about the related diagram or 
model. These comments may be in the form of text or as a reference to an external 
application (Word, Excel, Paint, etc.). The comment symbol initially resembles a 
blank sheet of paper (which is not marked CMT!); once a comment has been entered 
or a link to an external editor has been established, the symbol appears to have tiny 
writing on it. To locate a comment, open a model tree and look just to the right of 
the diagram names.
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CO As a rule, communicating objects diagrams contain communicating objects (active
objects) and communication paths. A communicating object represents a real, 
physical entity that performs some activity. A communication path joins two 
communicating objects, indicating some communication, i.e., exchange of passive
objects. CO diagrams are used in system modeling.

comment GRADE supports various types of comments. They may appear as comment diagrams 
in the model tree (see CMT), as notes or free comment symbols within diagrams or 
within other types of diagram symbols (when defining the symbol, fill out the 
Description field).

comment diagram See CMT.

communicating objects 
diagrams

See CO.

communication path See CO.

compacting This feature, which can be turned on or off, means that the symbols in a diagram will 
be arranged to minimize the amount of space they occupy. Compact is a subcommand 
of Reposition.

competencies See CMP.

complex task See task.

component modeling A technique for component-based development of systems and high-level design 
specification. Component modeling makes use of PCK, BP, CL, DD and/or other 
types of diagrams to describe systems in terms of business components. A component 
model typically depicts applications (e.g., Online Banking), business processes 
(typically, processes initiated by a customer online, such as Apply for Loan) and data 
structures (e.g., Loan Application Form).

condition In the context of GRADE, a condition is a requirement that must be met before 
something else can occur. In a PD, a condition must be fulfilled before a specific 
branch can be executed. In a BP, a condition must be fulfilled before a specific task 
can be executed. In a BP, the outcome of a decision also can be a condition that triggers 
a task. 

“consists of” See relationship.

constant A language object that takes only one specific value. In the context of GRADE, 
constants can be defined in VTs, e.g., you can define an employee’s hourly wage.

continue In PD diagrams, this symbol is used at the end of a control routine to continue event 
or loop processing. (A control routine is a fragment of a PD diagram; control routines 
are activated by events triggered by the user.)

control flow Control flows simply express the fact that one task is completed and the next task may 
start. 

critical path In the context of GRADE, the most time-consuming sequence of tasks in a process
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crowfeet notation This is a marker at the end of a connecting line; the marker indicates cardinality (a 
number or range of numbers). For example, if your line end is intersected by a single, 
short line, this indicates a cardinality of 1.

Ctrl Control key (normally at the bottom left of your keyboard)

Custom table See TAB.

d day

data definition diagram See DD.

data dictionary In the context of GRADE, this is the part of the repository that manages all names 
in the model (their definitions and references to them). You can specify what part of 
the dictionary you wish to see via a filter; this information then appears in the 
dictionary window. The dictionary makes it easier for you to navigate to diagrams 
using certain names and to make global name changes. You can also examine errors 
and warnings via the dictionary.

data object In the context of BP diagrams, data objects are individual units of data or goods that 
are stored temporarily. 

data store In the context of BP diagrams, data stores represent a persistent (long-term) store of 
data or goods. 

database A data structure for accepting and storing data; these data can be provided to multiple, 
independent users. In the context of BP diagrams, a database can be represented by a 
data-store symbol. In CO diagrams, a database can be represented by a database 
symbol. The structure of databases is described in ER diagrams.

data type A set of values together with a set of permitted operations for an item. See also DD, 
INTEGER data type, FLOAT data type, CHAR data type, STRING data type, 
BOOLEAN data type, array data type, atomic data type, elementary data type, 
enumerated data type, nested, predefined data type, record data type, set. For 
an explanation of data type objects used in the GRADE Registrator, see TY.

DD Data definition diagram; used to define data structures. DDs can be used for all types 
of modeling.

debugging In the context of GRADE simulation and prototyping, debugging means running the 
model with the aim of detecting possible errors. Errors can be detected by running the 
model step-by-step or by stopping the model at specified breakpoints and examining 
variables (for example, you can check to see the percentage of time that a given 
performer is being utilized).

decision path In BP diagrams, connects a decision task to a decision symbol

decision symbol In BP diagrams, represents the result of a decision. In PD diagrams, a decision symbol 
may have two possible outputs: TRUE or FALSE.

decision task A decision-making task; it branches out to one or more decisions (e.g., customer credit 
approved, customer credit not approved); used in BP diagrams.
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DEF In the context of GRADE’s data dictionary, it represents an occurrence where a name 
is defined in a diagram.

default settings Standard, predefined settings; e.g., in GRADE, each type of box symbol has a default 
shape and color. Of course, you can often define your own settings, thus overriding the 
GRADE default.

definition dialog See editing window.

dependency In CL and PCK diagrams, dependencies are used to connect elements that depend on 
each other. For example, a manufacturer may depend on a supplier. A dependency is 
represented by a dashed line with an arrow.

developer In the context of the GRADE Administrator, a developer is a person who works on a 
“software object,” for example, a GRADE model.

DFD Data flow diagram; may contain not only data flows, but also processes, data stores 
and external entities (agents). Note that a DFD is not a GRADE diagram, but 
GRADE can be used to create models containing the same information as DFDs.

diagram frame Every GRADE diagram has a frame, which is not visible on your computer screen but 
can be seen in the printout. By default, this frame is the same for all diagram types 
and subtypes. You do have the option, however, of making any part of the frame, or 
the entire frame, invisible in the printout by changing the default settings. By default, 
the frame includes such information as the name of the diagram and model, the date 
and time of the printout, the diagram type, etc.

diagram hierarchy Every GRADE model has a tree-like structure represented by a model-tree diagram. 
Each diagram in a model has a defined position in the hierarchical structure of the 
model tree. A diagram located directly above another diagram in the same branch in 
the model hierarchy is called its parent diagram.

The model tree defines the relationships among diagrams; it also shows which 
diagrams lie in the “visible” area of other diagrams and can therefore be referenced by 
them. (See also visibility.)

GRADE also supports diagrams and diagram structures (subtrees) that appear in the 
model-tree window but are not attached to the model tree. These are called free
diagrams/free subtrees.

diagram type Each diagram type in GRADE describes a specific aspect of a system using a specific 
set of symbols available for that diagram type; these symbols are combined in 
accordance with the rules applicable to the diagram type. Examples of diagram types 
are ORG, CO, CL. (Some diagrams, having a more textual appearance, are called 
tables, e.g., TO, VT.) Some diagram types also have subtypes, i.e., variations on the 
basic type. For example, PD diagrams have the subtypes PROCESS, PROCEDURE 
and MACRO.

dictionary See data dictionary.

double-sided layout In ORG diagrams, this refers to the possibility of setting up subtrees having child 
symbols that branch off both to the left and right.
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drag-and-drop editing In most GRADE diagrams, you can click (activate) a diagram element, then press 
down the left mouse button and hold it down, then drag the element to another 
position. This is known as drag-and-drop editing. This technique also can be used to 
connect diagram elements. For example, if you have created a Sales Department in an 
ORG diagram, you can drag an unconnected Secretary symbol over to the Sales 
Department group, overlap the upper left corner of the Secretary over any other 
organizational unit symbol in the department, then release the mouse button. Secretary 
becomes part of the Sales Department. This technique also can be used in the model
tree to attach/detach diagrams or subtrees.

duration In the context of BP diagrams, this is the task’s required execution time.

edit Alter, modify; for example, you can edit a GRADE diagram symbol by changing the 
text within it. You can edit a diagram by deleting or moving elements, etc.

editing window When you activate a diagram symbol and press Return, a window opens in which you 
can change the contents of the symbol; this is known as the editing window (or 
definition dialog).

EI format Export-import format; can be used to export or import GRADE models

elementary data type Elementary data types are defined with the elementary data-type symbol. In an 
atomic data type, the elementary data-type symbol would be the lower box; in a 
record data type with three fields that are not further refined, each field is considered 
an elementary data type. Elementary data types include not only the predefined types 
(see predefined data type) but also user-defined enumerated types (see enumerated
data type).

elementary task See task.

end In the context of PD diagrams, the end symbol represents the termination of a 
procedure.

Enter Key used to confirm entries; same as Return

entity In the context of ER diagrams, entity actually refers to an entity type; it is a data group 
having a specific structure.

entity-relationship 
diagrams/models

See ER.

enumerated data type A data type with a user-defined value domain; for example, Colors = pink, lime green, 
turquoise.

ER Entity-relationship diagram; used in the context of system modeling and business
model/business modeling to describe relationships among entities as well as 
database and data store structures; these structures are called ER models.

ET An event table; describes all named events appearing in a business model

Ev1, Ev2, etc. Input events of a task
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event In the context of GRADE, events link or initiate tasks. The term “event” is used 
broadly; see also material event, message event, control flow and timer event.

event arrow This is a connector used in BP diagrams to indicate the flow of events. (See also 
material event, message event, control flow and timer event.)

event table See ET.

exit In PD diagrams, this symbol is used to exit a control routine (see also continue).

export To create a new file in a format that is different from that normally used by the software 
package at hand. In the context of GRADE, for example, you can export a model in 
EI format.

expression In GRADE, an expression is a formula that can be simple or complicated. For example, 
the Boolean expression/Boolean formula “e1 AND e2” can be used to define a 
triggering condition; in this case, both event 1 and event 2 must take place to trigger 
the next task. A performer expression could be as simple as “Secretary” or could be
“<3> Headquarters.Programmer WITH COMPETENCE = Pascal” to define 3 
programmers who are skilled in the Pascal programming language and who work at 
company headquarters.

EXT External link table; a table for storing external links. For example, you can link an icon 
in a diagram to a Web site or a document. When you double-click the icon, the 
corresponding Web site or document is opened. The EXT is global for the GRADE 
model.

external comment These are comments created with an external tool such as MS Windows Notepad, 
Paint, Word, Excel, etc., and used in a CMT

external communication path In the context of CO diagrams, an external communication path connects a symbol 
that is visible in the diagram to one that is not.

external elements Belonging to an external partner of the system to be modeled; for example, if you have 
created a model of a bakery, the farmer who brings eggs to the bakery every week could 
be designated as an external partner. 

external link See EXT.

external task In the context of BP diagrams, this is a task that affects the business system, but is not 
formally part of it: e.g., a customer prepares an order. 

field Fields are widely used in GRADE; they generally have a name and can be assigned a 
value or values (e.g., Type, Description, triggering condition fields).

Note that the record data type also has fields; for example, if the record represents an 
employment application, one of the fields might be applicant’s name, another might 
be birth date, etc.

FIFO The principle “first in, first out”
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FLOAT data type This is one of GRADE’s predefined data types. The value range of the FLOAT data 
type (more precisely, its absolute value) lies between 1.6 * 10-38 and 6.2 * 1037. The 
mantissa consists of up to 11 significant decimal places. FLOAT constants are positive 
or negative floating-point numbers with at least one digit before the decimal point. A 
FLOAT constant may consist of up to 11 digits (before and after the decimal point; 
scientific notation is not used in FLOAT constants). Examples: 12.1, 0.12, 12., -2.7.

foreign key In the context of ER diagrams, this is the field that helps an entity uniquely identify a 
“foreign” entity. From the point of view of a corporation, the foreign key of a customer 
might be the customer number.

fork In ORG diagrams, a fork is a node used to achieve the desired layout.

formal syntax In the context of GRADE, formal syntax means you must adhere to certain restrictions 
when filling in the contents of diagram symbols. Formal syntax is obligatory for 
models that are to be used for simulation or prototyping and for CL diagrams that are 
to be exported to Rational Rose.

free comment Free comments may appear in various types of diagrams. They appear by default as 
gray, rectangular symbols with rounded corners. Free comments can contain text or 
graphics and can be placed at any location in the diagram. Free comments are not 
affected by automatic diagram layout mechanisms and can be moved independently 
of other diagram symbols. 

free diagrams Stand-alone (independent) diagrams not linked to the rest of the model; see also 
diagram hierarchy.

function In ORG diagrams, this represents a function carried out within the business process.

generalization A generalization represents an “is subclass of” relationship between a subclass and a 
superclass. For example, the managers, programmers and testers who work in a 
software-development department may be considered subclasses of the employees’ 
superclass. Subclasses are considered to be refined versions of the superclass; the 
superclass is said to “generalize” the subclasses. In a generalization symbol, the arrow 
points to the superclass. Generalizations are used in CL diagrams.

GIF Graphics Interchange Format; a picture in this format can be stored in the PIC table 
and imported into a GRADE diagram.

GIGO Garbage in, garbage out; i.e., the principle that faulty input produces faulty output

GLO Glossary table; a list in which you can enter information about the GRADE model; 
i.e., enter any name from the model, then add a definition, description or comment. 
The glossary table is global for the model.

GRADE Graphical Re-engineering Analysis & Design Environment; a comprehensive 
technology that encompasses a PC-based modeling and simulation tool. GRADE is 
both a technique for representing complex sociotechnological systems in the form of 
models (“blueprints”) and a graphical language making it possible to use these models 
to simulate and dynamically analyze a current or planned system.
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GRADE-BM A semiformal graphical language for modeling and simulation of complex business 
systems 

GRADE/4GL GRADE/4GL represents an expanded and improved version of the earlier GRAPES-
86 graphical language used with GRADE. (4GL = fourth-generation language.)

GSF Graphical screen form; if you are modeling a Windows-based software system in 
GRADE, you can use GSF diagrams to prototype the user interface.

GUI Graphical user interface; allows “pictures” such as icons, menus, etc., to be displayed 
on the screen and manipulated via the mouse

h hour

home entry See home symbol.

home symbol In the context of a presentation, a home symbol is a diagram element, i.e., a symbol 
or line, that is associated with a slide. This symbol or line is displayed as activated 
during the entire playback of the slide. The home symbol usually corresponds to the 
central concept within the spoken text recorded for the slide. By default, the 
presentation cursor also points to the home symbol; however, this cursor can be 
repositioned to any diagram location (one position per interval). In tables, the term 
home entry is used instead of home symbol.

Horizontal layout This style will tend to give your layout a horizontal orientation.

HTML Hypertext Markup Language; contains universal codes used for the World Wide Web 
to tell Web browsers how a document is to be managed and displayed and where the 
hypertext links will lead

identifier In the context of GRADE, this is the name of a diagram, diagram element, etc. In 
accordance with current rules, identifiers must not exceed 64 characters and must not 
contain certain characters such as periods, commas, parentheses, etc.

The term is also used more generically; for example, mon is an identifier used in 
GRADE to represent Monday.

import To transfer information from one system or program into another; usually, this 
information must be converted into a format that can be accepted by the new system 
or program. For example, you can take a model that has been converted to EI format
and import it into a GRADE application.

incoming label In PD diagrams, this is a label for an incoming connector.

informal syntax In the context of GRADE, informal syntax means that you are not subject to as many 
restrictions as with formal syntax. Models created with informal syntax cannot be 
used for simulation or prototyping.

inline task In BP diagrams, inline tasks are so-called “nameless tasks.” If you wish, you can use 
the Operation field to enter a description of the task, e.g., Wait for order confirmation. 
The use of inline tasks, where appropriate, can speed up the modeling process and keep 
the model from becoming unnecessarily complicated. 
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input TO table A table showing the transfer objects received by a given active object (e.g., a 
customer receives a product and invoice)

integer In contrast to fractions, an integer is a whole number, either positive or negative; 
examples: 3, -5, 300.

INTEGER data type This is one of GRADE’s predefined data types. The value range of an INTEGER 
data type lies between -2147483648 and +2147483647. Permissible constants are 
numbers between -999999999 and +999999999.

Integer expressions may include operators such as * (multiplication), DIV (division), 
+ (addition), etc. E.g., the expression “m DIV n” equals the integer (whole number) 
part of the quotient resulting when m is divided by n. If the division produces the 
quotient 6.5, the resulting integer would be 6.

internal comment Simple, textual comments that can be entered and edited in a CMT using GRADE’s 
built-in text editor

internal communication path In the context of CO diagrams, an internal communication path connects two 
symbols that are visible in the diagram.

internal elements Belonging to the system to be modeled; if you have created a model of a university to 
show how all departments interact, then all departments in the university would be 
considered internal elements. 

interval In the context of presentations, an interval is a specific time segment of a slide. 
During this segment, the presentation cursor is at one fixed position within the 
diagram associated with the slide. An interval corresponds to a fixed time slot within 
the playback time of the slide’s audio file. 

The term interval is also used more generically. In BP diagrams, for example, timer
events may be generated at certain intervals by a timer.

“is part of” relationship See aggregation.

“is subclass of” relationship See generalization.

ISO International Organization for Standardization; a worldwide federation of national 
standards bodies whose objective is to promote the development of standardization 
and related activities in more than 90 countries

layout In the context of GRADE, this is the arrangement of elements in a diagram, as well as 
the GRADE mechanisms for controlling this arrangement. See also Manual layout, 
Oblique manual, Automatic layout, Oblique semiauto, Reposition, Vertical
layout, Horizontal layout, layout assistant, and double-sided layout.

layout assistant In ORG diagrams, the layout assistant is a mechanism that lets you design subtrees in 
which the child symbols of a single parent symbol can be arranged both vertically and 
horizontally.
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license In the context of the GRADE Administrator, a minimum of one license object must 
be defined for each tool used. For example, if developers are to use the GRADE 
Modeler, the GRADE Registrator, and Microsoft Word in their work on a particular 
project, the project leader must set up at least three license objects. (If two developers 
plan to work with the same tool at the same time, then at least two license objects must 
be defined for that tool.)

list In the context of DD diagrams, lists are ordered collections of elements of some type.

locking In the context of the GRADE Administrator, the locking mechanism is used to ensure 
that only one developer can change a given set of data at a time. The Modeler can 
temporarily lock an entire model or a subtree so that it cannot be changed by other 
users. In the Registrator, the locking mechanism is implicit; objects being edited are 
automatically locked to other users.

loop In the context of PD diagrams, a loop permits the repetition of an operation or 
sequence of commands.

m minute

Manual layout In contrast to Automatic layout, this style gives you more freedom to place diagram 
elements where you wish. 

Manual with oblique lines See Oblique manual.

material event In BP diagrams, this is an arrow representing the flow of materials from one task to 
another.

message event In BP diagrams, events with the category “message” correspond to objects produced 
by one task and transmitted to another. This may be an informal object, such as a 
notice that something has been completed, or formal, such as an invoice, bill, report, 
etc. Message events always have a name, which is displayed next to the arrow. 

miniGRADE A subset of the GRADE Modeler, miniGRADE is a tool that makes use of UML for 
object modeling. A typical miniGRADE model contains class diagrams grouped in 
packages. miniGRADE can be used for modeling complex business and IT systems. 
Completed models can be exported to the Rational Rose modeling tool for source-
code generation.

MO In the repository window, this abbreviation represents a model.

model tree When you open a model window, the structure you see is known as the model tree; it 
is the hierarchical table of contents of the model. If all branches of the tree are in the 
expanded state, you will see a symbol for each diagram in the model.

A diagram and all of its subordinated diagrams are referred to as a subtree; activate 
any diagram, and all diagrams branching down from it are considered part of this 
subtree. If a diagram has no other diagrams branching down from it, the diagram by 
itself is considered a subtree.

modeling Representing aspects of a system as a set of standardized diagrams; these are created by 
following principles of systematic representation.
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module Modules represent collections of procedures, functions, data types, variables, 
constants and/or initialization routines. The main purpose of modules is to isolate 
functional units of a specific object or operation so that they can be reused. A module 
is represented primarily by an SD diagram of the subtype MODULE.

mon, tue, wed, thu, fri, sat, sun These identifiers are used in GRADE for weekdays

name In the context of GRADE, this is a name of a diagram, diagram element, etc. In 
accordance with current rules, names must not exceed 64 characters and must not 
contain certain characters such as periods, commas, parentheses, etc.

N-ary association In CL diagrams, an N-ary association is used to represent a relationship among three 
or more classes. 

nested The incorporation of one or more structures into another structure. In GRADE DD 
diagrams, data types may be nested; for more information, see subtype.

NOSTART A transaction-control option that prevents the starting of the current-level transaction 
and all simultaneous upper ones 

note In CL and PCK diagrams, a note symbol can be used to add comments or to attach 
informal text to concepts.

NOTID Used to prevent the transfer of a transaction identifier along with an event; see TID.

object In CL diagrams, an object symbolizes an instance of a class. In CO diagrams, an 
object represents a communicating object (active object) or an object type instance.

object modeling Describing the static structure of a system by representing data, concepts, processes, 
organizational units, physical objects, etc., and the relationships among them.

object type instance In the context of CO diagrams, an object type instance is a type of object containing 
the name of the related object type definition as a type reference. 

Oblique manual This layout style gives you quite a bit of freedom to create your diagram according to 
your needs and allows you to use oblique lines.

Oblique semiauto This layout style controls the look of your diagram to some extent to “keep order,” but 
does allow you to use oblique lines.

occurrence symbols These tasks/timers are actually part of the business process being depicted. These 
symbols are framed by solid lines.

ODL Object Definition Language 

ODMG Object Database Management Group

OMT Object Modeling Technique; developed by J. Rumbaugh et al. 

ORG Organizational/resource structure diagram; represents the structure of organizational 
units (such as departments), positions, resources, etc.; used in business
model/business modeling
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organizational structure 
diagram

See ORG.

organizational unit See ORG.

outgoing label In PD diagrams, this is a label for an outgoing connector.

output TO table A table showing the transfer objects sent by a given active object (e.g., a company 
sends out products and invoices)

package See PCK.

parallel control In PD diagrams, this symbol permits the parallel execution of several branches of a 
process, with synchronization at the end; in other words, the branches usually merge, 
and execution is continued to the next symbol after all branches have reached the 
merge point.

parent diagram Also known simply as parent; see diagram hierarchy.

part association See aggregation.

passive object In the context of system modeling, passive objects are created, sent, received or 
otherwise worked upon by active objects. Some examples of passive objects are 
documents, pure information, materials and consumable resources. In the GRADE
Registrator, passive objects are abbreviated as PO.

PCK Package diagram; used as a “folder” for an object model; each package consists of zero 
or more other packages and zero or more CL diagrams.

PD A process diagram; in the context of system modeling, depicts the behavior of an 
active object in a system; in the context of business modeling, used informally to 
describe how a task is performed.

performer In the context of GRADE, performers are those who execute tasks (e.g., a department, 
an employee, a customer).

person In ORG diagrams, the person symbol is used to represent a particular individual 
(usually, an employee).

PIC Table of pictures; a table containing WMF, GIF and/or BMP graphics that can be used 
to enhance diagrams. By default, the table contains dozens of pictures that are 
delivered with the GRADE installation; the user can add more. The PIC table is global 
for the GRADE model.

PID A process identifier used in the SDL language

plug In the context of system modeling, the point at which an active object is connected 
to a channel; transfer objects are sent to/sent from this point. GRADE generates 
plugs automatically; you may need to create them manually only in rare, complex 
cases.

PO See passive object.
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position In ORG diagrams, the position symbol represents a particular employee/person (e.g., 
Gertrude Crabapple) or a position or role in an organization (e.g., Vice President for 
Marketing).

PRE See presentation.

predefined data type GRADE’s predefined (built-in) data types are standard data types characterized by a 
value range and by constants containing values of that type. See also the following 
entries describing GRADE’s predefined data types: INTEGER data type, FLOAT
data type, CHAR data type, STRING data type, BOOLEAN data type.

presentation A “talking model,” that is, a recorded audiovisual lecture based on a GRADE model. 
During the playback of the presentation, a lecturer’s recorded voice is heard while 
elements of the model are automatically displayed in a specified order. The element 
currently being described is marked by means of a “pointer,” a so-called presentation
cursor. Thus, a presentation is a complete imitation of a live lecture. A presentation is 
contained in a diagram of type PRE, which consists of an ordered chain of slides. 
GRADE supports both the creation and playback of presentations.

presentation cursor This symbol is used in GRADE presentations to point out the diagram element 
currently being described by the narrator. The symbol consists of a special icon 
(“Grady”) and an arrow.

primary key Used in ER diagrams; if you think of the contents of an entity as a series of rows in a 
table, the primary key is the field containing the unique identifier for each row. For 
example, in the entity Invoice there is a row of data for each invoice, and the field 
Invoice Number could serve as the primary key, which uniquely identifies a given 
invoice.

procedure In the context of PD diagrams, a procedure is part of a process; e.g., preparing an 
invoice may be defined as a procedure within the larger process of filling a customer 
order.

process In the context of system modeling, a process is a series of tasks performed to produce 
some result (passive object). An active object from a CO diagram that is refined in 
a PD diagram is called a process object.

In the context of BP diagrams, a process is one or more tasks, or “pieces of work.”

process diagram See PD.

prototyping In the context of GRADE, prototyping is used to “run” a system model (analogous to 
the simulation of business models).

Rational Rose A UML modeling tool of the Rational Software Corporation

receive In PD diagrams, this symbol represents the reception of an incoming message (message 
is used in a broad sense and may refer to materials, as well).

record data type A set of data elements treated as a unit. In the context of DD diagrams, a record 
represents a collection of components of various data types that are structured and 
grouped together by means of field names.
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REF In the context of GRADE’s data dictionary, it represents an occurrence where a name 
is referenced (mentioned) in a diagram.

reference symbols In ORG diagrams, a reference symbol is a reference to a performer depicted elsewhere 
in the model. 

In BP diagrams, reference symbols (e.g., referenced tasks, referenced timers) are 
related to the business process being depicted, but are not actually a part of it. These 
symbols serve as connectors to neighboring diagrams. For example, if your diagram 
depicts the process of packing computers in cardboard boxes for shipment, the delivery 
of the computers themselves to the packing crew could be a referenced task.

referenced task See reference symbols.

Registrator The GRADE Registrator is a tool that supports the “bottom-up” modeling of 
organizational and/or technical systems, particularly information-processing systems. 
It is particularly useful in the early, fact-gathering stages of modeling. You can initially 
enter data without specifying a hierarchy; in a step-by-step process, you can then 
incorporate the various relationships among the registered objects, thus completing 
your model. This Registrator model can be analyzed, simulated and exported for 
further use in the GRADE Modeler.

relationship Relationships are widely used in GRADE to represent interdependencies/interactions.

For example, in the GRADE Registrator, the “consists of”/“is part of” relationship 
can link two active objects; in that case, one object “consists” (at least in part) of 
another and the other “is part of” the first. Another example is the “sends to” / “receives 
from” relationship, which represents interaction between two active objects; in this 
case, one of them sends a passive object and the other receives it.

Relationships are also depicted in GRADE business, object and system models. In ER 
diagrams, relationships refer specifically to connecting lines reflecting the 
interdependencies among entity types.

Reposition This command can be used to optimize your diagram layout.

repository Storage site; in the context of GRADE, this is where models are stored.

resource In the context of ORG diagrams, resources are non-expendable, non-human resources 
that are referenced as performers, e.g., a PC, car or factory. Resources are also used in 
the Registrator (e.g., AO.Computer refers to an active object resource that is a 
computer).

Return Key used to create a new paragraph (also known as Enter)

RF Report form; used to display data as a form

RGB constants RGB stands for red, green, blue; RGB constants are used to define colors by defining 
the intensity of red, green and blue.

s second

Term Definition
 



scope Scope represents the set of diagrams from which a given diagram is visible. See also 
visibility.

screen form See ASF, GSF.

SD A specification diagram; used in system modeling to describe the external interface 
of procedures and functions, as well as modules.

SDL Specification and Description Language

seizing a performer A performer is put to use

select If you wish to copy/cut/paste/move more than one diagram element at a time, you 
should select these items. In contrast to activation, which involves clicking an element 
with your left mouse button to place a red frame around it, selection marks the element 
or group of elements in blue. One way of selecting items is to hold down the Shift key, 
then click with your left mouse button on each item you want selected. 

selective wait Used in PD diagrams; when a process arrives at a selective wait symbol, the system 
“decides” what to do next. This symbol allows the execution of only that branch for 
which the start signal indicated at the beginning of the branch has been received. 
Whenever the process reaches this point, only one branch can be executed. If no start 
signal is received, the process waits until one arrives.

send In PD diagrams, the send symbol represents the transmission of a message (message is 
used in the broad sense and may refer to materials, as well).

send and wait In PD diagrams, the send and wait symbol represents the synchronous transmission 
of messages, i.e., the message is sent when the receiver is ready to receive it.

set In the context of DD diagrams, a set is an unordered collection of elements of the 
specified data type.

simulation In the context of GRADE, this is “running” a business model; simulation allows you 
to see the model in action and gather statistics on the modeled system’s performance; 
these are known as simulation statistics.

simulation parameter table See SP.

simulation statistics See simulation.

single-nested entity Also known as 1-nested entity; reflects a situation in which one entity is a subset of 
another, e.g., the entity Customer might contain a 1-nested entity New Customer.

slide An elementary building block of a presentation; a slide corresponds to a lecture 
fragment. Embedded in the slide is both an audio file and visual information. A slide 
is associated with a diagram whose fragment is explained by the voice recording. A slide 
is even more closely associated with a single symbol in that diagram, called the home
symbol of the slide. The active pointer (presentation cursor) may point to several 
objects in the diagram (classes, associations, attributes, etc.), one after another, 
during the slide playback.

SM See system modeling.
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software object In the context of the GRADE Administrator (GRADE multi-user version), 
developers work on software objects, which typically are GRADE models, but also 
could be manuals or applications.

SP A simulation parameter table; used in business models to define the parameters that 
can be used during the simulation of a model

specification diagram See SD.

START A transaction-control option that starts one or more transactions with the specified 
name

statement In GRADE, the term statement is sometimes used synonymously with symbol; for 
example, a receive symbol in a PD also can be called a receive statement.

STE A stereotype table; lists all stereotypes defined in a model.

stereotype A stereotype is an additional feature or set of features that can be added to one or 
more diagram elements of a particular type to distinguish them. For example, if you 
are creating an organizational structure diagram representing hundreds of employees, 
you could define a particular stereotype to distinguish those having C++ programming 
skills. For example, you might define the stereotype’s style as a dark-blue ellipse and 
thus visually distinguish these employees from the others.

stop In the context of PD diagrams, the stop symbol represents the termination of a 
process.

STRING data type This is one of GRADE’s predefined data types. The value range of STRING data 
types contains all strings made up of the individual characters of the extended ASCII 
character set. Here are three examples of STRING values: 
ELVISISALIVEANDWELL, 4705 18th Ave. S., 677*-xxxljAA.

subclass association See generalization.

subtree See model tree.

subtype Some GRADE diagrams have subtypes; for more information about this, see diagram
type.

In the context of GRADE DD diagrams, a subtype refers to a nested data type
(nesting means to incorporate one or more structures into another structure). For 
example, in a record data type, one of the fields in the record can be further refined 
by a subrecord, i.e., a record within a record.

synchronous transmission In the context of system modeling, this means that a transfer object will be sent 
when the receiver is ready to receive it. (Note that the standard setting in GRADE for 
the transfer of objects is asynchronous; see also ASYN.)

syntax prompter See automatic syntax prompter.

system modeling This type of modeling focuses on the parts that make up the system. Diagrams in this 
type of model may include CO, DD, PD, etc.
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TAB Custom table; a user-defined table that can contain up to nine columns.

TAG A tag table; lists all tags defined in an object model. It is global for the model.

tag An extension mechanism in UML that makes possible the definition of tagged values 
describing classes, attributes, etc. Tagged values are parts of the properties of the 
corresponding UML elements.

target system In the CO hierarchy, the object whose structure and behavior are being described is 
the target system. 

task A “piece of work”; within the context of GRADE business model/business
modeling, we use the term to refer to an activity performed in a business system. Tasks 
may be very large, for example, manufacturing within a multi-national enterprise, or 
very small, like signing a document. An elementary task is one that has no further 
refinement in a BP diagram, e.g., this might be a task like File rejection letter, which is 
not broken down further. A task is called complex if it has at least one refinement via 
a BP; e.g., Do morning chores might be further refined by the following tasks: Milk 
cows, Feed chickens, and Make breakfast for my lazy husband.

task access table See AT.

task details diagram See TD.

task reference A task reference is similar to an external task. It is not formally a part of the business 
process under consideration; however, it is part of the overall business model. A task 
reference represents a link to a related task within the business model. 

TD A task details diagram; in a business model, a TD describes all properties of a task 
and its possible links to other tasks.

team development In the context of GRADE, team development means that several people work on a 
project simultaneously. This can be achieved either via a centralized or a decentralized 
approach. In the centralized approach, the GRADE multi-user version is installed; 
team members can work at their individual workstations on a central project; the 
GRADE Administrator makes sure that no two developers are changing the same 
data at the same time. In the decentralized approach, team members work at their 
individual workstations on individual models or parts of models; the results of their 
work are merged later.

ternary association In CL diagrams, an association involving three classes

TID A transaction identifier; the number assigned to each new instance of a transaction.

time constant A direct value or a constant reference that represents time, date or duration. A direct 
value representing duration could be given as “1h:30m”; the constant reference for this 
duration could be given as ThreeMartiniLunch. 

timer Timers are used to prompt tasks and events that are time dependent. For example, if 
the mail, which contains customer orders, is delivered every workday at 1:30 p.m., a 
timer could be set in the BP diagram to reflect this. 
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timer event In BP diagrams, timer events “appear” at a certain time or are “generated” at certain 
intervals by an imaginary “timer,” which is represented as a small clock and connected 
to a task by an arrow. Each timer event has a name.

TO A transfer object table; displays the contents of communication in a CO.

tool In the context of the GRADE Administrator (multi-user version of GRADE), a tool 
is an object used by developers for working on a project. For example, a tool could be 
the GRADE Modeler (for creating a model of a business system), the GRADE 
Registrator (for creating a model of an information-processing system), or Microsoft 
Word (for creating a manual).

trace In the context of GRADE, a trace is a protocol of events that occurred during 
simulation or prototyping. A trace browser can be used to examine the information 
gathered during the trace.

trace browser See trace.

transaction In the context of GRADE business model/business modeling, a transaction 
describes a chain of activities, from the moment an external event arrives and initiates 
the transaction, until the end, when further events and activities are beyond our scope 
of interest. For example, a transaction might be the processing of a customer query, 
from the moment the query arrives until the moment an answer is sent to the 
customer.

transfer object A passive object that is exchanged between active objects. See also TO.

transfer time In the context of GRADE, transfer time specifies the time required to transfer an 
event/transfer object from the sender to the receiver.

transformation task An ordinary task, which does not result in a decision

triggering condition Requirement(s) that must be fulfilled before a task can occur, i.e., which input event 
or combination of events must be present

TY A data type object; used in the GRADE Registrator to represent a standard data type

UA User attribute object; one of the five types of objects used in the GRADE Registrator; 
UAs provide additional information about objects, e.g., cost, weight.

UML Unified Modeling Language

user attribute object See UA.

variable A language object that may take different values, one at a time. (Note: The values of a 
variable usually are restricted to a certain type, e.g., integer.) For example, in a model 
of a tire factory, a variable might be the cost of producing a single tire; this may vary 
from week to week, depending on rubber prices, wage increases, etc. See also VT.

variable table See VT.

variant records Record types with variable field structures

Vertical layout A layout style that is vertical in orientation.
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view In the case of a large CL diagram, it is sometimes convenient to define a part of it as a 
separate “view.” That way, you can inspect a specific part of the CL diagram without 
being distracted by other elements. Views are represented in the model tree as CL 
diagrams marked View. 

visibility Visibility is aimed at keeping system complexity manageable. In the GRADE context, 
if we are modeling a system with Parts A and B and then refine our diagram of B, we 
do not need to know all that is going on within A; only its interface to B is relevant. 
On a simpler level, the visibility of a given diagram extends to its “neighboring” 
diagrams (in the same branch of the subtree) and those “above” it (higher in the 
subtree). For example, when you define an entity in an ER diagram, you can pick a 
data type for this entity. If you have activated the Visible option, you will be limited 
to picking a “visible” data type, i.e., one that is defined in that part of the model; you 
will not need to look through a long list of all the model’s data types, many of which 
may not be relevant. The concept of visibility influences the GRADE dictionary, pick 
functions, navigation, etc. See also scope.

VT A variable table; supports the use of global variables during simulation

warm-up period In the context of GRADE simulation, the warm-up period is the initial phase of 
model simulation, during which statistics are not gathered. The user decides whether 
to specify a warm-up period and, if so, how long this period should be. The idea 
behind the warm-up period is that the system does not usually behave typically during 
this initial phase; queues are shorter, and there is a lesser degree of performer 
utilization. Thus, statistics gathering is initiated only after the system has had a chance 
to “warm up.”

wildcard character A placeholder representing one or more other characters. For example, in the context 
of the GRADE dictionary, you can use an asterisk (*) when specifying a name filter; 
here, the asterisk can represent 0, 1 or more characters. If you enter *Department, you 
could retrieve names such as Finance Department or Sales Department. If you enter 
Department*, you could retrieve Department for Affirmative Action. If you enter 
*Department*, you can retrieve Finance Department, Sales Department and Department 
for Affirmative Action.

WMF Microsoft Windows metafiles; a picture in this format can be stored in the PIC 
(pictures) table and imported into a GRADE diagram.

WorkParty A Siemens Nixdorf workflow tool

zoom The zoom function can be used to reduce or increase the size of a diagram on the 
screen. 
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Index

A
Abstract fork 135, 165
Abstract fork symbol

creating a 165
Abstract line 135, 165, 189, 197
Abstract line symbol

creating a 165
Access path 85, 98, 226, 230
Access rights in AT tables 254
Access rights in BP diagrams 99
Access rights in CO diagrams 230
Access tables. See AT
Activation path 226, 231
Activation versus selection 45, 67
Activation via key combination 392
Active diagram 23
Active object 221, 223, 226, 227
Activity diagram 207
Add rights in AT 254
Aggregation 126, 135, 154
Aggregation symbol

creating a 154
Aggregations for DDL generation 213
All option 390
Alternate name 47, 56
Analysis of diagrams and subtrees 395
Anchorline 129, 135, 160, 197
Anchorline symbol

creating a 160
AND

use of 77
Animation 2
Application 265

creating 268
Application repository 268
Applications

linking other applications to GRADE models
340

Approved status 369
Array 228

Array data type 273, 276
defining 279

Array dimensions
specifying 279

Array style for box symbol 352
Arrows

copying 112
Assembly class 126
Assign symbol 249
Association 121, 124, 135
AT 231, 254, 438, 440
Atomic data type 272, 276, 329
ATR 438
Attaching symbols or trees to parents 56
Attaching symbols to other symbols 55
Attribute dialog 143
Attribute tables. See ATR
Attributes

defining 140
importing from stereotype 141

Attributes card 202
Attributes of a class 124
Audiovisual presentation. See Presentation
Auto BP to TD 391
Auto edit option 390
Autoactivated object 226
Automatic layout style 114, 182
Automatic syntax prompter

deactivating 391
uses for 391

Availability 35

B
Back icon 191
Background

changing default 359
Backup mechanisms 372
Binary association 124, 135, 151
Binary association symbol

changing 181
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creating 151
Bitmap icon 324
Bitmaps

inserting in user interface 328
Blanks in names 29
Blueprints

concept of 1
BM 36, 438

converting to system model 262
merging 369

Bookmarks in HTML files 310
Borders

changing 353
Bottlenecks

detecting 385
Box style 352
BP diagram symbol 188, 197
BP diagram window 83
BP diagrams 13, 14, 33, 438, 441

detecting critical path 385
lanes in 114
layout 114
menu bar 84
realigning elements 118
selecting elements 117
triggering condition 77
use of lanes in 365

BP modeling
basic concepts 75

BP to TD 391
Branching task 76
Business component 265

creating 268
Business component method 265

creating 269
referencing 269

Business component repository 268
Business modeling diagrams

overview of 438
Business models. See BM
Business process

structure of 81
Business process (in component model) 266
Business process diagrams. See BP diagrams
Button icon 324
Buttons

how to define 327

C
C++ code 219
C++ header generation 212, 215

Cardinality 125
Cardinality for DDL generation 213
Cascade windows 395
Case symbol 242, 250
CBD 265
Centimeters

how to select 379
Changing

aggregations 182
appearance of model tree 23
appearance of pictures in symbols 355
binary association 181
connectors 181
defaults in diagrams 357
endpoints of lines 112
generalizations 182
height of diagram elements 69
lane color 366
lane headings 366
name via dictionary 411
order of branches in diagrams 57
part associations 182
placement of text in symbols 355
position of diagram elements 51
sequence of lanes 366
shape of lines 112
size of diagram elements 51
size of diagrams 70
style of lines 354
subclass associations 182
symbol from external to internal 112
symbol from internal to external 112
symbol style 352
texts accompanying lines 112
width of diagram elements 69

Channel 231
creating 234
defining via global TO table 236
deleting 237
GRADE’s management of 239
modifying 237
redirecting 238
refining 238

Check box 324
Check box group 324
Child fragment 35
CL diagram window 133
CL diagrams 13, 14, 121, 439, 441

changing alignment of symbols 180
changing sizes of symbols 180
copying diagram elements 180
 



copying lines 181
creating 194
creating different view of 374
elements in 123
exporting 423
free 191
generating from ER models 385
making text invisible 181
modifying elements in 179
modifying lines in 181
operations on elements in 180
selecting diagram elements 179
using to build business model 399

CL icon 187
CL menus 134
CL symbols

changing contents of 180
CLA 190, 200, 439, 441
CLA icon 187
Class 121, 123, 135, 137

copying an existing 191
modifying package references in classes 203

Class attributes
defining 140
importing from stereotype 141

Class definition dialog 202
Class definition tables. See CLA
Class definition vs. class reference 190
Class diagram symbol 188, 197

copying and pasting 199
creating 198

Class diagrams. See CL diagrams
Class name 124
Class operations

defining 145
Class symbol

creating a 137
Clip art

using 383
Closing models and diagrams 18, 395
Closing the application 28, 395
Closing windows

key combination for 395
Clusters 363, 364
CMP 37, 438
CMT diagrams 22, 339, 442
CO diagrams 14, 25, 223, 395, 440

connection paths 230
path names in 391

Code generation 223
Collaboration diagram 210

Collapsing a subtree 22, 64, 395
Colors

changing 353
changing in lanes 366
meaning of 22

Column settings for DDL generation 213
Columns

displaying and hiding 232
Columns for data-type definitions 283
Combo box 324
Command line for external editors 342
Commands

various ways of executing 6
Comment diagrams. See CMT diagrams
Comments

external and internal 339
Communicating object 223, 226
Communicating objects diagrams. See CO

diagrams
Communication path 223, 226
Compacting diagrams 62
Company structure

how to depict 33
Competencies 35, 37
Competencies tables. See CMP
Component model

working with 268
Component modeling 14, 265
Configuration 9
Connectors

copying 112, 181
modifying 112

Container class 126
Continue symbol 250
Control flow 77, 207
Control menu 39, 40
Copying

a diagram to a file 415
a diagram to the clipboard 416
a model 372
diagram elements 66
presentation models 301
styles 355
via key combination 393

Cost per hour 35
Creating

a new diagram 395, 412, 429
a new line 47, 94
a new model 19, 37, 395

Critical path 385
Crowfeet and UML notation 390
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how to switch 151
Cubes

color and meaning of 22
how to hide 390

Current diagram 23
Custom paper size 383
Custom tables. See TAB
Cutting diagram elements 67
Cutting via key combination 393
Cyrillic alphabet 361

D
Data definition diagrams. See DD diagrams
Data dictionary. See Dictionary
Data object 75, 79, 85, 108
Data repository 268
Data store 75, 79, 85, 98
Data type

definition of 271
how to specify 271
nested 274
predefined 272

Database
connecting object to 230

Database initialization scripts
generating 400

Database symbol 226, 229
Data-type definitions

arranging in columns 283
DB2 400
DD diagram symbol 189, 197
DD diagrams 14, 79, 222, 271, 441, 442

layout 283
opening as table 396
symbol palette 276
window 276

DDL generation 212, 213, 219
Decision 76, 85, 91
Decision path 76, 85, 106
Decision symbol 207, 242, 250
Decision task 76
DEF in data dictionary 405
Default path names in CO diagrams 391
Default size of symbols

how to set 393
Default styles in GRADE diagrams 35
Default width of symbols

how to set 52
Defaults in diagrams

changing 357
Defining a diagram via the dictionary 412

Defining attributes 140
Defining operations 145
Delete rights in AT 254
Deleting diagram elements 52
Deleting via key combination 393
Dependency 128, 135, 164, 189, 197
Dependency symbol

creating a 164
Description of a class 124
Deselect 41, 85, 135, 197, 226, 258, 324
Design of Presentation dialog 297
Design status 369
Designer 369
Designer name 369
Detaching symbols from symbols/subtrees 57
Diagram

defining a link to 316
Diagram contents

repositioning 283
Diagram icons 391
Diagram status 22, 369

how to hide 390
Diagram types 13
Diagrams

activating 26
assigning status to 369
cosmetic changes in 393
creating new 429
deciding which type to use 13, 437
deleting 26
displaying as icons 387
displaying as short names 387
dragging and dropping 25
duplicating 26
inserting free 431
moving 25
opening 23
renaming 27
replacing 25
selecting 26

Diagram-type codes 316
Dialog

how to define 326
prototyping a 324

Dialog graphics 390
Dictionary 402

creating diagrams via 412
explanation of filter dialog 406
exporting 413
filter settings 406
functions of 402
 



go to name option 409
go to owner option 409
hiding name types 408
navigation 409, 410
opening 403
refreshing 412
restoring filter settings 408
window 404
working with 405

Displaying hidden contents 368
Document

defining a link to 310
Double-sided layout 61
Drag-and-drop mechanism 25
Drawing area 324
Duplicating a model 372
Duplicating via key combination 393
Duration of a task 77

E
E-business 265
Editing diagram elements 52
Efficiency level 36
E-mail address

defining a link to 303
End symbol 249
Ending a work session 28
Endless loop 243
Enhanced dialog graphics 390
Enlarging diagrams 70
Entity 255, 258

changing definition 261
defining 258

Entity-relationship diagrams. See ER diagrams
Equate sizes command 117
ER diagrams 222, 229, 255, 438, 440

symbol palette 258
window 257

ER model
converting to CL diagram 385

Errors
examining via dictionary 413

Errors during export to Rational Rose 218
Esc 393, 395, 396
ET 37, 77, 96, 438
Event 85

definition of 75
Event arrow 95

how to label 91
Event tables. See ET
Event type 76

Excel 2, 339, 340, 423
Executable program

defining a link to 315
Exit symbol 250
Expanding a subtree 22, 64, 395
Explicit link 303
Export of diagrams and models 415
Exporting a model in HTML 417
Exporting in EI format 421
Expression 249
EXT 131, 302, 303, 442

editing a row in 309
External comments

how to create 340
External communication path 230
External editor

changing 344
links to 339
registering 341
specifying 343

External element 35
External link 3

assigning a reusable 309
how to open 302, 303
to a file 310
to a URL 303
to a Web site 303
to an e-mail address 303
to an executable program 315
to another diagram 316
to the glossary 311

External link icon 187
External link table. See EXT
External reference 78
External task 78, 85, 88
External task reference 85, 108

F
Field

how to define 327
Field array 324
Field icon 324
File

defining a link to 310
Final status 369
Finding diagram elements or diagrams 71, 395
FLOAT 272
Fonts

changing default 361
changing for given symbols 353
using non-Latin alphabet 361
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Foreign key 256
Foreign keys for DDL generation 213
Fork 41, 61, 453
Formal mode 240
Formal modeling 223, 240
Frame icon 324
Frame options

setting 377, 379
Free comment 41, 50, 85, 109, 135, 161,

197, 226, 258, 276, 324
as used for pictures 336

Free diagram
creating 431

Function 34, 41, 46, 453

G
General access rights in AT 254
Generalization 127, 135, 158
Generalization symbol

creating a 158
Generalizations for DDL generation 213
General-use diagrams

overview of 442
GIF

creating new 306
using in GRADE models 331
using in presentations 285

GLO 131, 337, 442
creating an entry 337
customizing 337
defining a link to 311
editing an entry 339
icon 187

Glossary tables. See GLO
Glossary. See GLO
GRADE

advantages of using 3
control menu 40
creating shortcut to 29
customizing the application 387
definition of 1
icons 15, 29
installation 7
keywords 403
language 4
license number 7
main window 17
scope of 1
starting 16
toolbar 40
what can it do for you? 3

why use it? 2
GRADE language 223
GRADE models

creating as a team 368
GRADE Registrator 3
GRADE/4GL 223
Grady 285
GRAPES-86 223
Graphical screen form diagrams. See GSF diagrams
Graphical user interfaces

how to prototype 323
Graphics

changing appearance of 355
Grids used for layout 63
Groups of diagram elements 392
GSF diagrams 323, 442

definition of subtypes 323

H
Hardware requirements for GRADE 7
Headphones 7, 286
Height of diagram elements 69
Help 395
Hidden pictures 335
Hiding text 367
Home symbol 285, 293
Horizontal lanes in diagrams 114
Horizontal layout style 59, 114
Horizontal scroll bar 324
HTML 3, 302

I
Icon

defining a 320
modifying a 320

Iconized link 303
Iconized mode for pictures 335
Icons 186

how to display 23
Identifiers 29
Illegal characters 44
Importing in EI format 421
Importing tables 424
In Work status 369
Inappropriate names 44
Inches

how to select 379
Incoming label symbol 250
Index range 397
Informal mode 240
Informal modeling 240
 



INFORMIX-Online 400
Inline task 79, 85, 109, 269
Input TO tables 233
Installation 7

earlier versions 8
instructions 7
system configuration 9

Instance of a class 124, 150
Instances

showing number of 35
INTEGER 272
Internal comments

how to create 340
Internal communication path 230
Internal element 35
Internet 3
Intervals in presentation 294
Intranet 3
Invalid name message 44
Is part of 135
Is part of relationship 126
Is subclass of 135
Is subclass of relationship 127

K
Keys and key combinations 392
Keywords 30, 403

L
Labeling event arrows 91
Landscape (printer setting) 379
Lane headings 366
Lanes

changing color of 366
changing sequence of 366

Large diagrams
how to print 383

Layout 182
automatic 114, 182
changing default style 360
changing style 183, 362
horizontal 59, 114
horizontal lanes 114
how to create oblique 364
manual 104, 114, 182
oblique manual 114, 183, 362
oblique semiauto 114, 182, 362
optimizing 116, 184, 365
repositioning 62
use of lanes 365
using a grid 63

vertical 59, 114
vertical lanes 114

Layout assistant 61
License 7

expiration 391
obtaining 391

License number
entering 391

Lines
changing 353
changing style of 354
copying 112, 181
modifying 102, 112

Linking a document and a diagram 398
List box 324
List data type 274, 276

defining 281
Logical view 186
Loop symbol 243, 250

M
Main window 17

how to define 324
Manager 369
Manager name 369
Manual

conventions used in 5
target readership for 6

Manual layout style 104, 114, 182
Manual line break 47
Manuals

deciding which to read 5
scope of 4

Margins
setting 379

Material event 77
Maximizing on background 335
Maximizing pictures 335
Maximizing with title 335
Memory needed for GRADE 7
Menu

how to define 329
opening 393

Menus
opening without mouse 394

Merging business models 369
Merging GRADE models 3
Message event 76
Messages related to syntax analysis 390
Microphone 7, 286
Microsoft Excel. See Excel
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Microsoft Notepad. See Notepad
Microsoft Paint. See Paint
Microsoft Word. See Word
Minus button 22
Model

creating a 130
Model icon 187
Model information window 371
Model tree 186

appearance of 21
changing appearance of 387
collapsing 27
displaying icons 23, 186
expanding 27
reducing elements in 391

Model types 20
Modeling

definition of 13
Models

comparing versions 371
converting earlier 8
copying 372
copying with presentation 301
creating new 19, 37
deciding which type to use 13, 221
duplicating 372
navigating 394
opening 20
restoring from backup copy 370, 373

Model-tree styles
switching 188

Mouse
working without a 392, 393

Moving diagram elements 67
Multiple positions (in ORG) 46
Multiplicity 125

N
Names

changing via dictionary 411
characters used in 30, 44
deleting unused 411
discovering inappropriate 414
maximum length of 29
searching for 409
searching for similar 414
selecting a valid name 29
setting range of 390

N-ary association 126, 135, 163
N-ary association symbol

creating a 163

Navigation to parent diagram 225
Nested data types 274

defining 282
Nested entity

defining 259
New line 47, 94
nl button 94
No background style for box symbol 352
No border style for box symbol 352
No shape style for box symbol 352
Not Started status 369
Note 135, 160, 197
Note symbol 128

creating a 160
Notepad 339, 340

O
Object 121, 124, 135, 150, 207

categories of 397
Object Database Standard ODMG 423
Object flow 207
Object modeling 13

basic concepts
Object modeling diagrams

overview of 439, 441
Object Modeling Technique. See OMT
Object symbol

creating an 150
Oblique layouts 364
Oblique lines 114
Oblique manual layout style 114, 183, 362, 364
Oblique semiauto layout style 114, 182, 362,

364
OMT 121
Online help 395
Operating systems 7
Operation dialog 147
Operation parameter dialog 149
Operations 202

defining 145
Operations card 202
Operations of a class 124
OR

use of 77
Oracle7 400
Ordinary task 76
ORG diagram symbol 188, 197
ORG diagram window 39
ORG diagrams 13, 33, 438

defining new 36
external elements 47
 



layout for 59
menus 40
symbol palette 41

Organizational diagrams. See ORG diagrams
Organizational structure attributes 35
Organizational unit 34, 41, 43
Organizational/resource structure diagrams. See

ORG diagrams
Outgoing label symbol 250
Output TO tables 233
Overview class diagram 205
Owner

searching for 409

P
Package 197

modifying package references in classes 203
Package as used in GRADE 185
Package as used in UML 185
Package diagrams. See PCK diagrams
Package symbol

creating 198
Page borders

displaying 381
Page setup

changing default 361
Page setup for printing 383
Paint 339, 340
Paper orientation 379
Paper size 379

selecting custom 383
Parallel control symbol 244, 250
Parameters

defining for operations 149
for executable programs 316

Parent data type 397
Parent diagram 225
Parent fragment 35
Part association 126, 135, 154
Part class 126
Passive object 221
Pasting diagram elements 67
Pasting via key combination 393
Path 85
Path names in CO diagrams 230
PCK diagrams 14, 122, 131, 185, 439, 441

definition of 188
how to create 192
moving 194
when are they necessary? 191

PCK icon 186

PCK symbol palette 197
PCK tree 188
PCK window 196
PD 240, 395, 438, 440

diagram window 248
displaying diagram 240
generating contents of 240
opening and editing 240
relationship to CO 225
symbol palette 249
uses for 241

PD macro diagrams 240
PD procedure diagrams 240
Performer 33, 77
Performer lanes 365

creating 365
Person 34, 41, 46
PIC 331, 442

editing row in 332
PIC icon 187
Pick name button 140
Pick tags 215
Picking names 390
Picture appearance

changing 355
Picture tables. See PIC
Pictures

adding to symbol 353
inserting in diagram element 333
inserting in user interface 328
making invisible 335
maximizing 335
maximizing on background 335
maximizing with title 335
moving within diagram 336
removing from a diagram element 335
storing 331
using iconized mode 335
using in GRADE diagrams 331

Placeholders
use of 406

Playback of Presentation dialog 289
Plotter

printing GRADE diagrams on 383
Plug 232
Plus button 22
Pop-up menu

opening 393
Portrait (printer setting) 379
Position 34, 41, 44

multiple 46
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Posters
creating with GRADE 383

PRE diagrams 285, 286, 442
Predefined attributes 35
Presentation 3, 285

changing home symbol 299
creating 291
display of 289
hard- and software requirements 286
inserting pause 300
intervals 294
modifying 299
playing back 286
recording voice files 293, 300
rerecording slide 299
troubleshooting 290
use of Position button 300
working with as diagram 300
zoom factor 289

Presentation cursor 285
Presentation diagrams. See PRE diagrams
Primary key 255
Print headings

changing default 361
Print preview 383
Printing 376

a model tree 378
all diagrams of a model 378
all diagrams of a subtree 378
color options 377
frame options 377
key combination for 395
large diagrams 383
moving borders to make your diagram fit paper

size 382
possibilities for 3
poster-size business graphics 383
single diagram 376
special tips 379
zooming diagram to fit page 382

Private visibility 144
Procedure symbol 242, 249
Process 222
Process diagrams. See PD
Prompting of names 390
Properties 211
Properties of a class 124
Protected visibility 144
Prototyping 30, 223, 226
Public visibility 144

Q
Quitting GRADE 28

key combination for 395

R
Radio button 324

how to define 328
Radio button group 324
Rational Rose 3, 122, 140, 179, 212

export to 212, 217
import to 218

Read and write access in BP 99
Read rights in AT 254
Read rights in CO diagrams 230
Realignment 117
Rearranging symbols in diagram 57
Receive symbol 241
Record data type 273, 276

defining 278
Record field

adding 279
defining 278

Recording presentations 293, 300
Reducing diagrams 70
REF in data dictionary 405
Reference 35, 41, 53, 75
Refresh window 393
Registrator 3
Relationship 258

changing definition 261
defining 260

Relationship in ER diagram 256
Renaming

key combination for 395
Repeat loop 243
Reports

using GRADE to generate 433
Reposition command 364
Repositioning diagram elements 51, 62, 116,

181, 365
Repository

creating a 431
how to open 18

REPOSITORY window 16
Resizing diagram elements 51, 117
Resource 34, 41, 46
Restoring model from backup copy 370, 373
Reusable link 303
RTF 423
Russian language
 



using for GRADE 361

S
Saving via key combination 393
Saving your work 42
Scale

changing for diagrams 70
Scan options 407
Scope of dictionary 407
Scroll bars 41
SD diagrams 407, 440
SD module diagrams 240
SD procedure diagrams 240
Searching for a name 409
Searching for diagram elements or diagrams 71,

395
Searching for owner of a name 409
Selected elements

operations on 117
Selection versus activation 45, 67
Selection via key combination 392
Selective wait symbol 243, 250
Self-service mechanisms 265
Semantics of the GRADE language 2, 4
Semiformal syntax 390
Send symbol 241
Sequence diagram 207
Set data type 272, 276

defining 278
Shadow style for box symbol 352
Shortcut to the GRADE Modeler 15
Shortcuts used in GRADE 392
Show box 85, 110
Showing hidden contents 368
Simulatable syntax 390
Simulatable syntax option 30
Simulation 30

what it involves 2
Simulation parameter tables. See SP
Simulation show box 110
Single versus multiple diagram elements 35
Single-nested entity 256, 258

defining 260
Slides for presentations 285

creating 292
modifying 299
reordering 301

Slope anchorline 129, 135, 161, 197
Slope anchorline symbol

creating a 161
Sloping lines 114

Sociotechnological system 1
Software design with GRADE 3
Software requirements for GRADE 7
Sorting a dictionary 407
Sound card 7, 286
Source-code generation 3
SP 438
Spaces in names 29
Speakers 7, 286
Specification diagrams. See SD diagrams
SQL Servers 400
SQLBase 400
Standard styles in GRADE diagrams 35
Start stereotype 207
Start symbol 241, 249
Start window

how to define 325
Starting GRADE 16
State diagram 210
Statistics gathering via GRADE 2
Status bar

changing default 361
Status line 41
STE 131, 169, 317, 442
STE icon 187
Stereotype 49, 124, 317, 442

applying a 174, 320, 322
availability of 318
creating "on the fly" 173
defining a 170, 318
general use of 167
management of 322
modifying a 319
removing a 322
restoring modified 320
use of in UML 167

Stereotype table. See STE
Stop symbol 241, 249
Straight anchorline 129
STRING 272
Subclass 127
Subclass association 127, 135, 158
Subtree option 390
Subtrees

collapsing and expanding 64
dragging and dropping 25
moving 25
replacing 25

Subtypes 274
defining 282

Subwindow
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how to define 326
prototyping a 324

Subwindow icon 324
Superclass 127
Symbol

changing contents of 393
editing appearance of 181
repositioning 181
setting default size of 393

Symbol appearance command 181, 355
Symbol appearance mode 393
Symbol palette

modifying 320
Symbol style

adding picture 353
changing borders and lines 353
changing box style 352
changing color 353
changing text style 353
copying 355
dialog for changing 350
editing 355
how to change 349
keeping symbol in front 352
transferring to another symbol 355

Symbols
grouping of 392

Syntax 4, 44, 240, 390
Syntax analysis 390
Syntax of the GRADE language 2
Syntax prompter 241

deactivating 391
uses for 391

System configuration 9
System font

changing default 361
System modeling 14

basic concepts 221
System modeling diagrams

overview of 440
System models

automatic creation of 262
converting to business models 264
focusing attention on different object in 398

T
TAB 345, 442, 449

cloning a custom table 347
creating a custom table 345
creating a link to a custom table 347
editing a row in a custom table 347

setting up columns in a custom table 346
Tables

activating parts of 424
changing column titles in 428
changing column widths in 428
changing default settings 362
changing sequence of columns 429
editing contents of 426
exporting and importing 423
filtering rows 426
grouping rows in 427
hiding columns in 426
inserting and deleting rows 425
inserting rows 425
numbering rows in 429
sorting rows 427
user-defined. See TAB

TAG 131, 175, 211, 439
Tag

picking a 215
TAG icon 187
Tag table. See TAG
Tags 211

adding to diagram element 177
entering in TAG table 175

Tags for DDL generation 213
Talking presentation. See Presentation
Target system 398
Task 85

definition of 75
Task details diagrams. See TD diagrams
Task duration 385
Task reference 78, 85, 106
Task symbol 75, 90
Task type 76
TD diagrams 37, 407, 438
Team approach to GRADE modeling 368
Team use of GRADE 3
Template files for external editors 342
Ternary association 126
Testing printed image 383
Text

how to define 326
making invisible 367

Text icon 324
Text placement

changing 355
Text style

changing 353
Three-dimensional style for box symbol 352
Tile windows 395
 



Time-critical path 385
Timer 75, 85
Timer event 77
Timer reference 85, 106
Timer reference symbol 106
Timer symbol 75, 96
TO 25, 223, 440

how to open 234
To 19
Tool tips

changing default font 361
Toolbar 40

changing position of 390
Trace 2
Transfer object tables. See TO
Transfer object. See TO
Transformation task 76
Triggering condition 77, 93
Troubleshooting presentations 290
TXT format 423
Type of data 397
Type of field 397

U
UML 3, 14, 122

GRADE class diagram compliance with 205
UML and crowfeet notation 154

how to switch 151
UML stereotype 167
UML syntax 147
UML syntax for class attributes 140
Underscores in names 29

hiding and displaying 390
Undo delete 53
Undo last operation 393
Undo layout change 116, 183
Unified Modeling Language. See UML
Unifying height and width of diagram elements 69
Uninstalling GRADE 11
Units of measurement 379
Update rights in AT 254
URL

defining a link to 303
Use-case diagrams 206
User settings

how to change 387
User-defined attributes 36

V
Variable 249
Variable tables. See VT

Variant record 274
Variant record data type 276, 281
Vertical lanes in diagrams 114
Vertical layout style 59, 114
Vertical scroll bar 324
View diagrams 439
View mechanism 212
Views

creating 374
deleting 376
updating 376

Visibility 31, 144, 228, 390
Visible option 390
VT 263, 438, 440

W
Wallpaper print option 377
Warnings

examining via dictionary 413
Web site

defining a link to 303
While loop 243
Width of diagram elements 69
Window

prototyping a 324
Windows

minimizing and maximizing 39
WMF files 331
Word 339, 340, 423
Words to avoid 30
Working without a mouse 392
WorkParty syntax 390
Write access in BP 99
Write rights in CO diagrams 230

Z
Zoom for printing 382
Zooming diagrams

via the camcorder option 70, 395
via the toolbar 70
via the zoom command 71
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